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Get Help

Get Help
There are a number of ways to learn more about your product and interact with Oracle and other users.

Get Help in the Applications
Some application pages have help icons    to give you access to contextual help. If you don't see any help icons on
your page, click your user image or name in the global header and select Show Help Icons. If the page has contextual
help, help icons will appear.

Get Training
Increase your knowledge of Oracle Cloud by taking courses at Oracle University.

Join Our Community
Use Cloud Customer Connect to get information from industry experts at Oracle and in the partner community. You
can join forums to connect with other customers, post questions, suggest ideas for product enhancements, and watch
events.

Share Your Feedback
We welcome your feedback about Oracle Applications user assistance. If you need clarification, find an error, or just
want to tell us what you found helpful, we'd like to hear from you.

You can email your feedback to oracle_fusion_applications_help_ww_grp@oracle.com.

Thanks for helping us improve our user assistance!

i

https://www.oracle.com/education/
https://cloudcustomerconnect.oracle.com/pages/home
https://community.oracle.com/customerconnect/categories/idealab-guidelines
mailto:oracle_fusion_applications_help_ww_grp@oracle.com
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1  Expenses Configuration

How You View Details About Predefined Scheduled
Processes  
You can use web services to run predefined scheduled processes.

Scheduled Processes
Before you can schedule a process, you must sign in as a corporate card administrator, expense auditor, or travel
administrator. When you sign in as a specific job role, you can then see processes that relate to your job role.

To schedule processes, perform the following steps:

1. Navigate to the Navigator and click the Scheduled Processes link to open the Scheduled Processes page.
2. Click the Schedule New Process button.
3. In the Schedule New Process dialog box, select the applicable process and click OK to open the Process Details

dialog box.
4. Select the applicable parameters for your process and click Submit.

Security
Privileges provide the necessary access to run specific scheduled processes. Privileges are granted to duty roles, which
are granted to job roles. To see which job roles inherit the needed privileges, use the Security Console or the security
reference manuals for the appropriate product family.

Set Up and Use HTML Email Approval Notifications  
You can conveniently receive HTML-based expense report approval notifications in emails.

Displaying Fields
The following table contains the rules that determine whether fields are displayed on HTML email approval
notifications.

Value Display Behavior on HTML Approval Notification

Currency
 

Amounts are converted to the approver's currency.
 

• Expense Report Owner's Name

• Expense Report Total

• Purpose

The header section contains the Expense Report Owner's Name, Expense Report Total, Purpose,
Expense Report Number, and Submitted Date. These values provide an overview of key expense report
details.
 

1
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Value Display Behavior on HTML Approval Notification

• Expense Report Number and
Submitted Date

• Merchant Name

• Description

• Location

Merchant Name, Description, and Location are dynamic values that display when they exist in the
expense report.
 

• Date

• Expense

• Amount

Date, Expense, and Amount are static values that always display on the notification.
 

Itemizations
 

Itemizations only display if they exist for the parent expense item.
 

• Violation Type

• Justification

Violation Type and Justification only display as a line-level violation when a policy violation occurs.
 

• Project

• Task

Project and Task display for each itemized line if they're different for each itemized line. When they're
the same, they display at the parent expense level.
 

Cost Center
 

Cost Center only displays if the cost center is different from the default cost center.
 

Sort Order
 

Expense item lines are sorted by:
 

• Absolute amount in descending order

• Date in ascending order

• Expense type in ascending alphabetic order

Airfare
 

Airfare displays as a separate table on the notification because it's typically a large expenditure.
 

Related Topics
• Overview of Profile Options

• Create and Edit Profile Options

• Set Profile Option Values

• Hierarchy in Profile Levels

• How can I access predefined profile options?
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Overview of Financials Configurable Workflow
Notifications  
The Financial applications, as part of certain business flows, automatically send notifications for review or approval. For
example, when a user submits an expense report, the approvers receive an email containing the approval request.

In addition to getting notifications in email, users can also view in-app notifications, for example, by:

• Clicking the Notifications icon in the global header and opening a notification

• Going to the Worklist: Notifications and Approvals work area and opening a notification

• Clicking the In-App Notification link at the end of an email notification

Oracle Analytics Publisher reports generate the notification content and format for some flows. You can enable
Analytics Publisher-based notifications, which are ready to use as delivered. You can easily configure the notification
templates to meet other specific requirements. If required, you can change the delivered template layouts and content,
to add images, change colors and styling, add or remove attributes or modify text.

This table shows the product that has configurable notifications, along with its associated feature. You can configure
only the email notifications.

Product Feature Name Report or Notification Name Workflow Task Name

Bill Management
 

User Registrations Notifications
 

Registration Confirmation
 
New Account Registration
Confirmation
 
Account Access Revocation
Notification
 
Access Revocation Notification
 

N/A
 

This table shows the products that have configurable notifications, along with their associated features, and workflow
task names. You can configure both the email and in-app notifications for these workflow tasks.

Product Feature Name Report or Notification Name Workflow Task Name

Advanced Collections
 

Configurable Collections
Bankruptcy Workflow Notification
 

Bankruptcy Notification
 

BankruptcyApproval
 

Advanced Collections
 

Configurable Collections Activity
Management Notification
 

Collections Activity Management
 

ActivityManagement
 

Budgetary Control
 

Configurable Budgetary Control
Override Workflow Notifications
 

Budget Override Request
Notification Budget
 

OverrideNotificationFyi
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Product Feature Name Report or Notification Name Workflow Task Name

Budgetary Control
 

Configurable Budgetary Control
Override Workflow Notifications
 

Override Taken Notification
 

OverrideNotificationFyi
 

Cash Management
 

Configurable Cash Management
Workflow Notifications
 

Bank Transfer Approval
Notification
 

BankAcctTransferRequestForAction
 

Expenses
 

Expense Report Approval
Notifications
 

Expense Report Approval
Notification
 

FinExmWorkflowExpenseApproval
 

Expenses
 

Expense Reimbursement
Notifications
 

Reimbursement Paid to Card Issuer
Notification
 
Reimbursement Paid by Check
Notification
 
Reimbursement Paid by Direct
Deposit Notification
 

FinExmReimToCardIssuerFyi
 
FinExmReimToEmpByCheckFyiFin
 
ExmReimToEmpByDepositFyi
 

Expenses
 

Expense Audit and Receipt
Management Notifications
 

Expense Report Adjusted by
Auditor Notification
 
Expense Report Rejected by
Auditor Notification
 
Pending Payment with Warnings
Notification
 
Expense Report Returned by
Auditor Notification
 
Short-Paid Report with Receipt
Issue Notification
 
Short-Paid Report with
Noncompliance Notification
 

FinExmExpenseAuditFyi
 
FinExmExpenseAuditFyi
 
FinExmExpenseAuditFyi
 
FinExmReceiptManagementFyi
 
FinExmReportShortpaidReceiptIssue
 
FinExmReportShortpaidPolicyIssue
 

Expenses
 

Cash Advance Notifications
 

Cash Advances Approval
Notification
 

FinExmWorkflowCashAdvanceApproval
 

Expenses
 

Expense Audit and Receipt
Management Notifications
 

Payment is Held Notification
 

FinExmReceiptManagementFyi
 

Expenses
 

Expense Audit and Receipt
Management Notifications
 

Payment is Released Notification
 

FinExmReceiptManagementFyi
 

Expenses
 

Expense Reimbursement
Notifications
 

Reimbursement Has Been Paid to
Employer Notification
 

FinExmReimToEmpByCheckFyi
 

Expenses
 

Expense Audit and Receipt
Management Notifications
 

Mileage Adjustment Notification
 

ExpenseAuditMileageAdjustmentFyi
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Product Feature Name Report or Notification Name Workflow Task Name

Expenses
 

Expense Audit and Receipt
Management Notifications
 

Missing Receipt Declaration is
Required Notification
 

FinExmReceiptManagementFyi
 

Expenses
 

Cash Advances Notifications
 

Overdue Cash Advance
Notification
 

FinExmWorkflowOverdueNotification
 

Expenses
 

Cash Advances Notifications
 

Cash Advances Automatically
Applied Notification
 

FinExmWorkflowCashAdvanceAutoAppliedFyi
 

Expenses
 

Expense Audit and Receipt
Management Notifications
 

Inactive Employee's Outstanding
Transactions Notification
 

FinExmInactiveEmployeeSubmitExpenseFyi
 

Expenses
 

Expense Audit and Receipt
Management Notifications
 

Inactive Employee-Accept
Responsibility Notification
 

FinExmInactiveEmployeeAcceptResp
 

General Ledger
 

Configurable Journal Workflow
Notifications
 

Journal Approval Report
 

FinGlJournalApproval
 

Intercompany
 

Configurable Intercompany
Workflow Notifications
 

Intercompany Transaction
Approval Notification
 
Intercompany Enter Receiver
Distribution Notification
 

FinFunTransactionApproval
for Intercompany Transaction
Approval Notification
 
FinFunEnterDistRequestForAction
for Intercompany Enter Receiver
Distribution Notification
 

Payables
 

Configurable Invoice Approval
Email Notifications
 
Configurable Invoice Approval In-
App Notifications
 

Invoice Approval Report
 

FinApInvoiceApproval
 

Payables
 

Configurable Hold Resolution Email
Notifications
 
Configurable Hold Resolution In-
App Notifications
 

Hold Resolution Notification
 

FinApHoldApproval
 

Payables
 

Configurable Payment Approval
Email Notifications
 
Configurable Payment Approval In-
App Notifications
 

Payment Approval Notification
 

PaymentApproval
 

Payables
 

Invoice Account Coding
Notifications
 

Invoice Account Coding Email
Notification
 

FinApInvoiceAccountCoding
 

Receivables
 

Configurable Credit Memo Request
Approval Workflow Notification
 

Manual Credit Memo Request
Notification
 

FinArTrxnsCreditMemosCreationPostProcessing
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Product Feature Name Report or Notification Name Workflow Task Name

Receivables
 

Configurable Receivables Credit
Memo Request Manual Entry
Workflow Notification
 

Credit Memo Request Manual
Entry Notification
 

FinArTrxnsCreditMemosManualEntryRequestForAction
 

Process Overview
Generating configurable notifications through Analytics Publisher involves various types of objects in the BI catalog,
including data models, subtemplates, style templates, and reports. Reports pull data from data models and generate
notifications in an HTML format. The report layout templates use common table and paragraph styles and refer to a
central subtemplate that contains reusable notification components.

This figure shows how these BI objects work together to generate the notification content.

• Data Sources: Store the attributes and attribute values for business objects and transactions in the application
(example of data sources being transaction tables)

• Data Model: Determines which attributes from data sources that you can include in the notification and how to
retrieve that data.

• Subtemplate: Provides common components, such as a branding logo and buttons that you can reuse in
multiple reports.

• Style Template: Provides styles such as the type of lines and fonts to use in tables, or the font type, size, and
color to use for headings

• Report: Contains a layout template that determines:
◦ Which attributes appear in the notification, from the data model used for the report

◦ What the notification looks like, using components from the subtemplate and styles from the style
template of the report

6
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• HTML: Format of the output generated by the report

• Email Notification: Has the HTML output embedded in the email body

• In-App Notification: Has the HTML output embedded in the application UI

Each workflow task with configurable notifications has a corresponding predefined report in the BI catalog. For
example, the Invoice Approval report contains the Invoice Approval Notifications report layout template and uses the
Invoice Approval Data Model.

Notification Modifications
After you enable configurable workflow notifications, the predefined reports and related objects in the BI catalog start
working. The report-based notifications provide the same information as the standard notifications. In addition, mobile
devices use an optimized format of report-based notifications. If you need to modify the notifications, you can edit
copies of the predefined reports, data models, and subtemplate. However, you can't change the style template. You
proceed as you would edit any report, data model, or subtemplate in the catalog, for example:

1. Find a predefined report for expense approval in the BI catalog.
2. Use the Customize option to create a copy, or copy the report and paste it within the Custom folder.
3. Edit the copied report layout template.

Before modifying configurable notifications, Oracle recommends that you familiarize yourself with Analytics Publisher in
general. This improves your ability to format your notifications to meet your business requirements.

Analytics Publisher-based notifications let you do the following.

• Use only the Template Builder for Word add-in to edit the .rtf template in Microsoft Word. This works better
than using the layout editor or other tools available for creating and editing report layout.

• Edit a copy of predefined layout templates, rather than creating reports or layout templates.

Note:  For more information, see Configurable Workflow Notifications: Implementation Considerations
(2215570.1) on My Oracle Support at https://support.oracle.com.

Related Topics
• Overview of Notifications and Approval Workflows

• Best Practices for Content and Layout in Workflow Notifications

• Example of Modifying Expenses Email Notifications Using Oracle Analytics Publisher

• Example of Editing Invoice Approval Workflow Notifications Using Oracle Analytics Publisher

Enable Expenses Configurable Email Notifications  
You can use workflow email approval notifications to submit approvals to approvers. These approval notifications are
based approval notifications that are embedded in emails.

If you want to change the content or appearance of your email approval notifications, you can modify the content or
format of the Oracle Analytics Publisher templates.
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Before you can use or modify workflow email approval notifications, you must enable in Setup and Maintenance any or
all of the following sets with their corresponding notifications:

• Expense Report Approval Notifications

◦ Expense report approval notification

• Expense Reimbursement Notifications

◦ Expense report payment notification to employee (check)

◦ Expense report payment notification to employee (direct deposit)

◦ Payment to card issuer notification

• Expense Audit and Receipt Management Notifications

◦ Expense report is rejected by auditor

◦ Expense report is returned to employee

◦ Expense report is short paid due to receipt issue

◦ Expense report is adjusted

◦ Expense report is short paid due to non-compliance issue

◦ Pending payment with warnings

• Cash Advance Notifications

◦ Cash advance approval notification

Enabling Configurable Email Notifications
To enable workflow email approval notifications, follow these steps:

1. Navigator > My Enterprise > Offerings.
2. In the Offerings work area, select Financials.
3. Click Opt In Features.
4. On the Opt In: Financials page, select Expenses.
5. Click the Edit icon.
6. On the Edit Features: Expenses page, select Configurable Expenses Email Notifications.
7. Click the Edit icon.
8. In the Feature Name: Configurable Expense Email Notifications dialog box, select any or all of the

notification sets.
9. Click Save and Close.

Configure Expense Digest
The expense digest is a notification email delivered to the user's email. A separate digest email is sent to each expense
delegate. The email includes an overview of all expenses and highlights the expenses that require the user's attention,
such as items with missing information, possible matches to corporate card charges, outstanding corporate card
charges, and so on. You use the options in the Expense Digest section in the Manage Auto Submission and Matching
Options page to configure the delivery of expense digest. To access this page, in the Setup and Maintenance work area,
go to the following:

• Offering: Financials

8
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• Functional Area: Expenses

• Task: Manage Auto Submission and Matching Options

Here are the different settings you can configure to set up the delivery of expense digest:

Option Description

Schedule
 

Use this option to enable and disable the delivery of email digest. By default, this option is set to Yes.
 

Frequency
 

Specify the days of the week when the email digest is sent to the users. This option is enabled when
the Schedule option is set to Yes. Monday is the default day for sending email digests.
 

Test Notification Email Address
 

Use this field in the development and test environments to specify a test email to which email digests
are delivered. This is helpful in testing if email digests are delivered as required.

Note:  The email digests are sent only to the email address specified in this field. If the field is left
blank, then the email digests are sent to the employees.

 

How Rules Determine the Display Behavior of Fields on
Email Approval Notifications  
You can configure Expenses email approval notifications that are based on Oracle Analytics Publisher templates. When
you enable these notifications, the application automatically generates them.

For the Oracle Analytics Publisher based email approval notifications, Expenses uses predefined rules. The following
table contains the rules that determine whether the fields are conditionally displayed on the email approval notification.

Display Rule Number Values Display Rules

1
 

Currency
 

If an approver has a different user-
preferred currency from the expense report
reimbursement currency, the expense report's
approximate amount in the user preferred
currency is displayed to the approver.
 

2
 

• Merchant Name

• Description

• Location

Displayed if applicable.
 

3
 

• Violation Type

• Justification

A line-level violation is displayed when a policy
violation occurs.
 

4
 

• Project Displayed if applicable.
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Display Rule Number Values Display Rules

• Task

5
 

Cost Center
 

Displayed if applicable.
 

6
 

Itemized Lines
 

Displayed if applicable.
 

7
 

Number of Days
 

Displayed if applicable.
 

8
 

Personal
 

When an employee specifies an amount
as Personal, this amount is shown on the
notification and marked as Personal.
 

9
 

Card
 

A corporate card transaction is displayed with
Card to indicate a card transaction. A cash
transaction is displayed as an amount without
displaying Cash.
 

10
 

Receipt Required
 

When an expense item line is Receipt Required,
 it is displayed with a Receipt Required icon.
 

Example of Modifying Expenses Email Notifications
Using Oracle Analytics Publisher  
This example shows you how to modify the Expense Report Approval email notification template using Oracle Analytics
Publisher templates.

Oracle Analytics Publisher

The following table summarizes questions to consider for this scenario.

Questions to Consider This Example

Do I want to change in the header of the
email approval notification?
 

Add a word to the header.
 

Do I want to add fields or columns to or
remove fields or columns from the email
approval notification?
 

Add a field to the template.
 

You can modify an Expenses BI Publisher email approval notification by:

1. Exporting the Expense Approval Data Model
2. Downloading the Expense Report Approval template

10
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3. Editing the Expense Report Approval template
4. Adding field and table attributes to the Expense Report Approval template
5. Previewing the modified Expense Report Approval template
6. Uploading the modified Expense Report Approval template

Prerequisites
Before you can modify an Expenses workflow email approval notification, complete these steps:

1. Download and install the Template Builder for Word, which is a BI Publisher add-on for Microsoft Word.
a. Sign into the Oracle Analytics Publisher server with the BI Administrator Role.
b. On the Oracle Analytics Publisher home page by the Get Started section, click the Download BI

Publisher Desktop Tools link.
c. Select and install Template Builder for Word.

2. Download a copy of the subtemplate, which is the FinFunWorkflowNotificationSub.rtf file, to your local drive.
a. Click the Catalog menu.
b. In the BI Catalog, expand Shared Folders > Common Content > Templates.
c. Click the Edit link for Workflow Notification Subtemplate.
d. On the Workflow Notification Subtemplate - Sub Template page in the Templates section, click the

language name link in the Locale column.
e. Save the FinFunWorkflowNotificationSub.rtf file to your local drive.

3. Create an expense report and note the expense report number. You enter the expense report number when you
export the data model .xml file.

Exporting the Expense Approval Data Model
Before you can modify the Expense Report Approval template, you must export the .xml file that contains the
predefined data model attributes for the notifications. Complete these steps:

1. Sign into the Oracle BI Publisher server with the BI Administrator Role.
2. Navigator > Tools > Reports and Analytics.
3. On the Oracle BI Publisher home page, click the Catalog menu.
4. On the Catalog page in the Folders pane, expand Shared Folders > Financials > Workflow Notifications.
5. Expand the Expenses folder.
6. Click the Expenses subfolder to display the data models and the notification templates.
7. Click the Data Models link.
8. By Expense Approval Data Model, click the Edit link.

The Diagram tab displays data sets for the Expense Approval Data Model.
9. Scroll to see all the data sets.

10. To ensure that all data sets include requested elements with null values in the output XML data, complete these
steps:

a. In the Data Model pane, click the Properties link.
b. In the Properties section, select the Include Empty Tags for Null Elements check box.

11. In the Data Model pane, click the Data Sets link.
12. On the Expense Approval Data Model page, select the Data tab and scroll to locate the Expense Report

Number field.
13. In the Expense Report Number  field, enter the expense report number that you created in the third step of the

Prerequisites section in this document.
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14. Click View to see the sample data and all the available attributes.
15. Click Save As Sample Data.
16. Click OK.
17. Click Export.
18. Click Save as to save the Expense Approval Data Model .xml file to your local drive.

Downloading the Expense Report Approval Template
The Expense Report Approval template contains the structure of the email approval notification. To download a copy of
the Expense Report Approval template to your local drive, complete these steps:

1. Click the Catalog menu.
2. On the Catalog page in the Folders pane, expand Shared Folders > Financials > Workflow Notifications >

Expenses.
3. Click the Expenses subfolder to display data models and the notification templates.
4. By Expense Report Approval, click the More link, and select Customize.

An image of the predefined Expense Report Approval Email Notification appears. A copy of the Expense Report
Approval template is automatically created in the Custom folder. You can find the copy by expanding Shared
Folders > Custom > Financials > Workflow Notifications > Expenses.

5. By the predefined Expense Report Approval Email Notification template, click the Edit link.
6. Click Save as to save the Expense Report Approval Email Notification template to your local drive as an .rtf file.

Tip:  Save the downloaded template with the name UpdatedExpenseApprovalNotificationReport.rtf to
distinguish it from the predefined template.

Editing the Expense Report Approval Template
To edit the header section of the Expense Report Approval Email Notification template, complete these steps:

1. Double click the UpdatedExpenseApprovalNotificationReport.rtf file you saved to your local drive.
2. In the header section, place your cursor between Expense and Approval.
3. Type Report. The text now reads Expense Report Approval.

You can add, delete, or change words in the Expense Report Approval template.
4. Save and close the .rtf file.

Adding Field and Table Attributes to the Expense Report Approval
Template
To add field and table attributes to the Expense Report Approval template, complete these steps:

1. In Microsoft Word, open your local copy of the UpdatedExpenseApprovalNotificationReport.rtf file.

Note:  Depending on your version of Microsoft Word or your installation of Template Builder for Word, you
may see either a BI Publisher tab or you may find BI Publisher by the Add-ins menu.

2. From the Add-ins menu, select BI Publisher > Data > Load Sample XML Data.
3. In the Select XML data dialog box, search for and select the Expense Approval Data Model .xml file you

downloaded.
4. Click Open.

A message displays that indicates your .xml data was successfully loaded.
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5. Click OK.
6. To insert a field in the Expense Report Approval template, place your cursor at the end of the line you want to

insert into, and press the Enter key on the keyboard.
7. From the Add-ins menu, select BI Publisher > Insert > Field.
8. In the Field dialog box, scroll to the EXPENSES folder, select IMG_REQ_FLAG, and click Insert.

This step inserts text that indicates a receipt image is required. You can add fields from the data model
anywhere in the Expense Report Approval .rtf template.

9. From the Add-ins menu, select BI Publisher > Insert > Field.
10. In the Field dialog box, scroll to the RECENTSIMILAREXPENSES folder, select any field that you want to insert,

and click Insert.

Note:  You can also insert fields that are associated with the following folders: RecurringViolations,
RecentSimilarExpenses, and UnappliedCashAdvances.

11. Save and close the UpdatedExpenseApprovalNotificationReport.rtf file.

Previewing the Modified Expense Report Approval Template
Before uploading your modified Expense Report Approval template to the BI Catalog, you can preview the changes you
made. By previewing changes, you can avoid uploading a modified template that displays errors in the emails sent to
users.

1. Open your local copy of the UpdatedExpenseApprovalNotificationReport.rtf file in Microsoft Word.
2. At the beginning of your modified .rtf template, save the path information for future reference so you can

replace it after previewing. The path information may look like this: <?import:xdoxsl:///Common Content/
Templates/Workflow Notification Subtemplate.xsb?>

3. Replace the path at the beginning of your modified .rtf template with the location of the subtemplate that you
downloaded as a prerequisite. For example, change <?import:xdoxsl:///Common Content/Templates/Workflow
Notification Subtemplate.xsb?> to <?import:file:///C:/Template_Directory/FinFunWorkflowNotificationSub.rtf?
>

Note:  In the preceding example, part of the replacement path, C:/Template_Directory, represents the folder
in which the user downloaded the subtemplate to in the second step of the Prerequisites section in this
document. Ensure that you change all backward slashes to forward slashes.

4. From the Add-ins menu, select BI Publisher > Preview > HTML.
5. If the preview reflects your expected changes, then change the path at the beginning of your modified .rtf file

back to the original path.
6. From the Add-ins menu, select Validate Template.
7. Save your changes in Microsoft Word.

Uploading the Modified Expense Report Approval Template
To upload and use the modified Expense Report Approval template for email approval notifications, complete these
steps:

1. On the Oracle BI Publisher home page, click the Catalog menu.
2. On the Catalog page in the Folders pane, expand Shared Folders > Custom > Financials > Workflow

Notifications > Expenses.
3. Click the Expenses subfolder to display the data models and the notification templates.
4. By the Expense Report Approval, click Edit.
5. On the Expense Approval Report page, click Add New Layout.
6. In the Upload or Generate Layout section, click the Upload icon.
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7. In the Upload Template File dialog box, Layout Name field, enter
UpdatedExpenseApprovalReportTemplate. The entry represents the name of the Expense Report Approval
Template .rtf file that you downloaded and saved to your local drive with the prefix Updated.

8. In the Template File field, browse for your modified UpdatedExpenseApprovalReportTemplate.rtf file on your
local drive, select the template, and click Open.

9. In the Upload Template File dialog box from the Type choice list, select RTF Template.
10. From the Locale choice list, select English (United States).
11. Click Upload to open the Processing dialog box and return to the Expense Approval Report page.

The uploaded modified .rtf file appears.

Note:  Configurable workflow notifications are refreshed every 24 hours so that they perform better for
your users. But when you're making changes to reports, subtemplates, or data models, you can apply your
changes immediately so they're available for testing. For more information, see the Apply Changes to
Workflow Notifications Immediately After Upload topic.

12. On the Expense Approval Report page, click the View a list link.
13. In the Layout section in the row for the Updated Expense Report Approval Template, select the Default Layout

check box. This step enables your modified Expense Report Approval Notification template to act as the default
email approval notification.

14. Click the Save Report icon.

Related Topics
• How You Modify Copies of Predefined Reports

• Set Up for RTF and Excel Report Layout Templates

Reflect Changes from Edited Reports Sooner  
When you use the Customize option to edit a predefined report, your changes won't be reflected until a refresh that
happens every 24 hours. For changes to take effect sooner, use profile options to change the refresh interval.

The refresh applies your changes to Oracle Fusion Cloud Applications, but you can immediately see your changes in
Microsoft Word and Oracle Analytics Publisher. For example, you download a predefined .rtf layout template and edit
the file in Word. You can see the modified output using the preview in Word. After you upload the .rtf file to the catalog,
you can open the report in Analytics Publisher and see your changes. But, if you're accessing the report from Fusion
Applications, you see the updated output only after the refresh.

When you're done configuring and testing reports, use the same profile options to turn the refresh back to every 24
hours. But even if you don't, the refresh automatically resets to 24 hours when it's been more than 8 hours since you set
the profile options. The 24-hour refresh interval helps optimize performance.

Create Profile Options to Control the Refresh
Your profile options can apply to all workflow tasks, a product family, or a product. Based on the scope you want, your
profile option must have a profile option code that follows a certain format.

Scope Profile Option Code Examples

Global BIP_CLIENT_REFRESH_TIME BIP_CLIENT_REFRESH_TIME
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Scope Profile Option Code Examples

   

Product Family
 

BIP_CLIENT_REFRESH_TIME_<FAMILY>
 

• BIP_CLIENT_REFRESH_TIME_FIN

• BIP_CLIENT_REFRESH_TIME_HCM

• BIP_CLIENT_REFRESH_TIME_PRC

• BIP_CLIENT_REFRESH_TIME_PRJ

• BIP_CLIENT_REFRESH_TIME_SCM

Product
 

BIP_CLIENT_REFRESH_TIME_<FAMILY>_
<PRODUCT>
 

• BIP_CLIENT_REFRESH_TIME_FIN_AP

• BIP_CLIENT_REFRESH_TIME_HCM_PER

• BIP_CLIENT_REFRESH_TIME_PRC_PON

• BIP_CLIENT_REFRESH_TIME_PRJ_PJE

• BIP_CLIENT_REFRESH_TIME_SCM_EGO

The profile options with a smaller scope take precedence. For example, you have profile option A with a global scope
and profile option B with a product scope. If you're currently configuring notifications for a particular product, use
profile option B to adjust the refresh time just for that product. But based on profile option A, the refresh is still at 24
hours for all other configurable notifications in all other products. Profile option B takes precedence over profile option
A only for that one product.

Tip:  To find the product family or product code, go to the Setup and Maintenance work area. Use the Manage
Taxonomy Hierarchy task in the Application Extensions functional area for any offering. In the hierarchy, expand
the root node and then the Oracle Fusion node. Find the row for the family or product and look in the Module Key
column for the code.

Now you're ready to create your profile options!

1. In the Setup and Maintenance work area, go to the Manage Applications Core Profile Options task in the
Application Extensions functional area for your offering.

2. On the Manage Applications Core Profile Options page, click the New icon.
3. On the Create Profile Option page, enter the profile option code in the format that corresponds to the scope

you want.
4. Enter a display name that you can easily remember to help you find the profile option later.
5. From the Application list, select Oracle Middleware Extensions for Applications.
6. From the Module list, select Application Core.
7. Specify a start date.
8. Click Save and Close.
9. On the Manage Applications Core Profile Options page, make sure that your new profile option is selected in

the Search Results: Profile Options subsection.
10. In the <Profile Option>: Profile Option Levels subsection, select the Enabled and Updatable check boxes for

the Site level.
11. Save your work.

Set the Refresh Interval
In the Setup and Maintenance work area, go to the Manage Applications Core Administrator Profile Values task in
the Application Extensions functional area. Set your profile option at the Site level and enter 15 or higher for the refresh
interval in minutes. If you enter 15, your changes are reflected in Fusion Applications 15 minutes after they're saved
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in the BI catalog. For example, 15 minutes after you upload an edited .rtf layout template to the catalog, or after you
update report properties in Analytics Publisher.

CAUTION:  Make sure to enter a whole number.

When you're done making and testing your changes, set the profile option back to 1440, which is 24 hours in minutes. If
you forget and leave your profile option as is for longer than 8 hours, don't worry! At that point, the profile option resets
itself back to 1440 minutes.

Related Topics
• How do I update existing setup data?

• Set Profile Option Values

• Modules in Application Taxonomy

Example of Modifying Expenses Spend Authorization
Approval Notification Using Oracle Analytics Publisher  
This example shows you how to modify the Authorization Approval Notification template using Oracle Analytics
Publisher templates.

The following table summarizes questions to consider for this scenario.

Questions to Consider This Example

Do I want to change the header of the
authorization approval notification?
 

Add a word to the header.
 

Do I want to add fields or columns to
or remove fields or columns from the
authorization approval notification?
 

Add a field to the template.
 

You can modify an Expenses BI Publisher authorization approval notification by:

• Editing the Spend Authorization Approval Notification template

• Adding field and table attributes to the Spend Authorization Approval Notification template

Prerequisites
Before you can modify an Expenses workflow authorization approval notification, complete these steps:

1. Download and install the Template Builder for Word, which is a BI Publisher add-on for Microsoft Word.

a. Sign into the Oracle Analytics Publisher server with the BI Administrator Role.
b. On the Oracle Analytics Publisher home page by the Get Started section, click the Download BI

Publisher Desktop Tools link.
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c. Select and install Template Builder for Word.
2. Download a copy of the subtemplate, which is the AuthorizationApprovalNotificationReport.rtf file, to your local

drive.

a. Click the Catalog menu.
b. In the Catalog pane, expand Shared Folders > Common Content > Templates.
c. Click the Edit link for the Authorization Approval Notification template.
d. On the Authorization Approval Email Notification page, click the Edit link.
e. Select the Save File option and click OK.
f. Save the AuthorizationApprovalNotificationReport.rtf file to your local drive.

3. Create an spend authorization and note the spend authorization number. You enter the spend authorization
number when you export the data model .xml file.

Editing the Spend Authorization Approval Notification Template
To edit the header section of the Authorization Approval Notification template, complete these steps:

1. Double click the UpdatedAuthorizationApprovalNotificationReport.rtf file you saved to your local drive.
2. In the header section, place your cursor after Authorization Approval.
3. Type Notification. The text now reads Authorization Approval Notification.

You can add, delete, or change words in the Authorization Approval Notification template.
4. Save and close the .rtf file.

Adding Field and Table Attributes to the Spend Authorization Approval
Notification Template
To add field and table attributes to the Authorization Approval Notification template, complete these steps:

1. In Microsoft Word, open your local copy of the UpdatedAuthorizationApprovalNotificationReport.rtf file.

Note:  Depending on your version of Microsoft Word or your installation of Template Builder for Word, you
may see either a BI Publisher tab or you may find BI Publisher by the Add-ins menu.

2. From the Add-ins menu, select BI Publisher > Data > Load Sample XML Data.
3. In the Select XML data dialog box, search for and select the Authorization Approval Data Model .xml file you

downloaded.
4. Click Open.

A message displays that indicates your .xml data was successfully loaded.
5. Click OK.
6. To insert a field in the Authorization Approval Notification template, place your cursor at the end of the line you

want to insert into, and press the Enter key on the keyboard.
7. From the Add-ins menu, select BI Publisher > Insert > Field.
8. In the Field dialog box, scroll to the SPEND_AUTH_HEADER_DS folder, select

SA_FUNCTIONAL_CURRENCY_CODE, and click Insert.
9. Save and close the UpdatedAuthorizationApprovalNotificationReport.rtf file.

Related Topics
• Example of Modifying Expenses Email Notifications Using Oracle Analytics Publisher
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Enable Contingent Workers to Enter Expense Reports  
Contingent workers are workers who don't have a direct employment relationship with your company. They're typically
supplied by an employment agency or self-employed contractors.

Before you can enable and reimburse contingent workers for incurred business expenses, you must perform the high-
level steps listed in the following table.

Note:  The first two steps are prerequisites for the last step.

High-Level Step Application Selected Action Steps

1
 

In your human resource application, create a
person as a contingent worker.
 

Ensure that you set up the contingent worker
with a Worker Type of Contingent Worker.
 

2
 

In your procurement application, set up a:
 

• Supplier

• Supplier site

• Supplier bank account at the supplier or
supplier site level

You must set up a default payment method at
the supplier or supplier site level.
 

Tip:
When you create an invoice, a payment
method is required. If you don't specify a
default payment method at the supplier site
level, the payment method automatically
populates from the supplier setup.
 

Note:
Bank account information is used to pay
supplier invoices by EFT.
 

3
 

In Oracle Fusion Expenses, associate the
contingent worker with the supplier.
 

In the Auditing Tasks pane, click the Manage
Contingent Workers link and select the
applicable supplier and supplier site.
 

Related Topics
• Payment Methods

• Payment Method Defaulting

• Set Up a Supplier's Bank Account

• Create a Supplier and Supplier Site

• How can I create a user?

18

https://www.oracle.com/pls/topic/lookup?ctx=fa26a&id=s20031994
https://www.oracle.com/pls/topic/lookup?ctx=fa26a&id=s20031951
https://www.oracle.com/pls/topic/lookup?ctx=fa26a&id=s20043134
https://www.oracle.com/pls/topic/lookup?ctx=fa26a&id=s20035442
https://www.oracle.com/pls/topic/lookup?ctx=fa26a&id=s20032574


Oracle Fusion Cloud Financials
Implementing Expenses

Chapter 1
Expenses Configuration

Translate an Expense Report Template into Another
Language  
You can translate the BI Publisher expense report template from the default English language into another language.

These are the high-level steps:

1. Download the default Expense Report template.
2. Translate the template into a different language.
3. Upload the translated template.
4. Update the system options to use the translated template.

Before You Start
You need to download and install the Template Builder for Word, which is a BI Publisher add-on for Microsoft Word.
Here's how you download and install the Template Builder for Word:

1. Sign into the Oracle Analytics Publisher server with the BI Administrator Role.
2. In the Get Started section of the Oracle Analytics home page, click the Download BI Publisher Desktop Tools

link and select Template Builder For Word.
3. Click Downloads.
4. Select and install the version of Oracle BI Publisher Desktop.

Downloading the Expense Report Template
To download the Expense Report template, complete these steps:

1. Sign into the Oracle BI Publisher server with the BI Administrator role.
2. Select the Catalog menu.
3. In the Folders pane, expand Shared Folders > Financials.
4. Click Expenses.
5. Select the row for the Printable Expense Report Template.
6. In the Tasks section, click the Download link and save the FinExmReports.xdoz file to your computer.
7. Rename the downloaded FinExmReports.xdoz to change the extension from .xdoz to .zip.
8. Extract the contents of the FinExmReports.zip file.
9. From the extracted folder, copy the default template file, FinExmExpenseTemplate_en.rtf, to make a backup.

Translating the Template into a Different Language
To translate the default Expense Report template from English into a different language, follow these steps:

1. Rename the template file, FinExmExpenseTemplate_en.rtf, to use the two-letter code of the language into
which you want to translate. For example, if you want to translate the English template into Spanish, you
rename the template layout file to FinExmExpenseTemplate_es.rtf.

2. In Word, open the renamed layout file.
3. Open the BI Publisher tab and select Tools > Translation > Localize Template.
4. Click OK.
5. In the open dialog box, browse to the extracted FinExmReports folder.
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6. Select the XLF file of the language into which you want to translate. For example, if you want to translate into
Spanish, select the FinExmExpenseTemplate_es.xlf file.

7. Click Open. The layout file starts converting to the selected language.
8. After the translation is complete, save the translated Expense Report template layout file.

Uploading the Translated Expense Report Template
After you get the translated Expense Report template layout file, you need to upload it to BI Publisher. Here are the steps
to upload the translated Expense Report template:

1. Sign into the Oracle BI Publisher server with the BI Administrator role.
2. Select the Catalog menu.
3. In the Folders pane, select Shared Folders > Custom > Financials.
4. Create an Expenses folder and select it.
5. Click the New icon and then click Report.
6. Close the Create Report dialog box.
7. In the Upload or Generate Layout section, click Upload.
8. In the Upload Template File dialog box, enter a layout name.
9. Browse and select the translated template file for the Template File field.

10. Select RTF Template as the type.
11. Select the translated language as the locale.
12. Click Upload. After the template file is uploaded, the layout you created is listed.
13. Click the Properties link for your layout.
14. Verify if the language to which you translated the template is set as default. Click Return.
15. Click the View a List link.
16. Ensure that only PDF is selected as the output format. Click Save As.
17. In the Save As dialog box, enter a name and description.
18. Click Save.
19. Sign out from Oracle BI Publisher.

Setting the System Options
After uploading the translated Expense Report template, you need to modify the system options to use the translated
Expense Report template. To modify the system options, follow these steps:

1. Log in as application implementation consultant.
2. In the Setup and Maintenance work area, select:

a. Offering: Financials
b. Functional Area: Expenses
c. Task: Manage Expenses System Options

3. On the Manage Expenses System Options page, select the BI template you uploaded in the Printable Expense
Report Format list.

4. Click Save and Close.

Users can now print the Expense Report in the translated language.

Enable Creating Expenses from Email Receipts  
Your company can choose to allow the employees to create their expenses by mailing electronic expense receipts.
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This is how it works. An employee sends an email with an expense receipt to a designated email address. After verifying
the employee's email, the Expenses application extracts relevant details from the email receipt and creates an expense.
The application also matches the expense to the appropriate corporate card charges and can optionally submit it in an
expense report to the approver, if this has been configured by you.

Here are the setups that you need to do to allow creating expenses from email receipts:

1. Enable electronic receipts processing
2. Obtain email address for forwarding receipts.

Enable Electronic Receipts Processing
When the application creates an expense from an email receipt, the application also attaches the email receipt to the
expense. You can configure the application to attach the email itself to the expense or to attach the primary receipt from
the email. Attaching the email is the default configuration.

The application uses the primary receipt for creating the expense and filling in the expense details such as amount,
location, merchant, and so on. The primary receipt can be an electronic expense receipt attached to the email or the
email itself with an embedded receipt.

Here are the two attachment preferences that you can configure:

• Attach the email

This is a default configuration. The forwarded email is attached to the expense.

When an employee forwards an email receipt to the designated email address, the application verifies the
employee's email address. After verification, the application extracts relevant details from the email receipt
and creates an expense. The application converts the forwarded email to a PDF and adds the PDF document
to the expense as an attachment. If the original email has other attachments, the application only attaches the
primary receipt from the email's attachments and discards the rest of the attachments. If the email itself is the
primary receipt, then the application only adds the email as an attachment to the expense in PDF format.

• Attach the primary receipt from the email

When you select Attach the primary receipt from the email: the primary receipt from the forwarded email is
attached to the expense created from the email.

◦ If the email has no attachments, then the application adds the email as an attachment to the expense in
PDF format.

◦ If the email has multiple attachments, the application attaches only the primary receipt to the expense.
The application will discard the email and other attachments from the email.

Examples of the application configured to Attach the primary receipt from the email.

◦ Employee forwards a flight itinerary email with the boarding pass and invoice as attachments. The
application creates an expense based on the invoice attached, so the application adds the invoice as an
attachment to the expense.

◦ Employee forwards a hotel reservation email with the credit card statement added to the email as an
attachment. The application creates expenses from the email body, and the email is the primary receipt
and is attached to the expense.

◦ Employee forwards an Uber email receipt with no attachments added to the email. The application
creates an expense from the email receipt. Since there's no attachment in the email, the application adds
the email to the expense as an attachment.

You can enable electronic receipts processing for your entire organization or specific business units.
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Here are the steps to enable electronic receipts processing and setup expense attachment preference for the entire
organization.

1. In the Setup and Maintenance work area, select these to navigate to the Manage Auto Submit and Matching
Options Page:

◦ Offering: Financials

◦ Functional Area: Expenses

◦ Task: Manage Auto Submission and Matching Options
2. In the Electronic Receipt Setup section, select Yes for the Enable Electronic Receipts Processing option.
3. In the Electronic Receipt Setup section, select the Expense Attachment Preference,

◦ Select Attach the email to attach the email as an attachment to the expense.

◦ Select Attach the primary receipt from the email to attach only the primary receipt to the expense.

4. To allow expense creation from employees' personal email addresses that are defined in the system, select Yes
for the Allow Expense Creation from Personal Emails option.

5. Click Save and Close.

These are the steps to enable electronic receipts processing and setup expense attachment preference for a specific
business unit:

1. On the Manage Auto Submit and Matching Options page, click a business unit in the Specific Business Unit
section.

2. In the Edit Auto Submit and Matching Options dialog box, select Electronic Receipt Setup.
3. Select Yes for the Enable Electronic Receipts Processing option.
4. In the Electronic Receipt Setup tab, select the Expense Attachment Preference,

◦ Select Use setup from all business units if you want to configure the Expense Attachment Preference
same as all business units.

◦ Select Attach the email to attach the email as an attachment to the expense.

◦ Select Attach the primary receipt from the email to attach only the primary receipt to the expense.

5. To allow expense creation from employees' personal email addresses that are defined in the system, select Yes
for the Allow Expense Creation from Personal Emails option.

6. Click Save and Close.

Note:  The option selected at the business unit level overrides the organization-level settings.

Obtain Email Address for Forwarding Receipts
Only users with the Travel Manager role can generate the email to which employees send email receipts. Here's how you
can obtain the email address:

1. Sign in as a travel manager and navigate to the Scheduled Processes work area.
2. Click the Schedule New Process button.
3. Select the Create Expenses from Email Receipts process and click OK.
4. You can select Yes for the Debug Switch option. This can be useful in debugging issues if required.
5. Click Submit.
6. In the Confirmation box, click OK.
7. After the process has successfully completed, check the text output file.
8. The output file mentions the email address to which receipts can be sent. You can note the email address and

share it with other users.
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Process Emailed Receipts
After the setup is completed, the travel manager also needs to run the Create Expenses from Email Receipts process
at regular intervals to process the email receipts received from the other users. You can also choose to set a recurrence
schedule for the process to run at specific intervals.

Related Topics
• Submit Scheduled Processes and Process Sets

Set Up Drill Down to Expense Reports and Expense Items
from OTBI  
Expenses provides Oracle Transactional Business Intelligence or OTBI reports in these subject areas:

Subject Areas

• Cash advances

• Employee expense overview

• Expense transactions

You can add action links on column, such as expense report identifier or expense report number, to enable users drill
down to the appropriate expense report or expense item. These action links use deep link, which is a URL that allows
users to open a page in an application without navigating through the application menu structure. Users can easily
navigate back and forth from the analysis to the application to review details.

Note:  Application pages are displayed to the user based on their security privileges. If the user doesn't have access to
a page, a drill down to the page doesn't display anything.

To configure a drill down, you need to perform these tasks:

1. Create a deep link
2. Add action links in an OTBI report

Create a Deep Link URL
Here is the format for a deep link URL:

https://<host name>/faces/deeplink?
objType=<objecttype>&action=<action>&objKey=<name1=value1;name2=value2...>

The URL contains several parameters and their values. These are some parameters you can use in a deep link URL:

Parameter Description

object type
 

The identifier of the application page to be accessed by deep link. You must enter its value in
upper case. For example, to create a deep link to access the View Expense Report page, use EXM_
VIEWREPORT.
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Parameter Description

 

action
 

The action performed on the page. You must enter its value in upper case. Possible values are NONE,
 CREATE, EDIT, and VIEW.
 

name and value
 

This combination is used to fetch a specific record. For example, to access an expense report with
report number 3001001431, set name as expenseReportId and value as 3001001431.
 

Here is an example of a deep link URL:

https://<host name>/faces/deeplink?objType=EXM_VIEWREPORT&action=VIEW&objKey=expenseReportId=3001001431

Add Action Links in an OTBI Report
Here are the steps to configure drill down in an OTBI report:

1. To build a report, on the OTBI home page, click New > Analysis.
2. Select a subject area. For example, you can select the Expenses Transaction Real Time subject area. The Criteria

tab of the new OTBI appears.
3. From the Subject Area pane, select a column and drag it to the Selected Columns section. Repeat the step to

add all the columns you need in your report.
4. To add an action link, click a column and select Column Properties from the context menu.
5. In the Column Properties dialog box, click the Interaction tab.
6. In the Value section, select Action Links as the primary interaction.
7. Click the Add Action Link icon.
8. In the New Action Link dialog box, click the Create New Action icon and then select Navigate to a Web Page.
9. Enter the deep link URL of the target page in the URL field and click Define Parameters. The values of

parameters in the URL are changed to tokens and their values are defined in the Value column of the Define
Parameters section. As an example, this table shows input parameters.

Parameter Name Value Fixed Hidden Optional

1
 

EXM_VIEWREPORT Y
 

Y
 

N
 

2
 

VIEW Y
 

Y
 

N
 

3
 

(Column value) -
 Select Expense
 report id

Y
 

Y
 

N
 

10. If the value of a parameter needs to be obtained from a column in the report, in the Value column, select
Column Value and then select the column from which the value needs to be derived.

11. After you've defined all the tokens in your URL, click Options.
12. In the Action Options dialog box you can configure how information is displayed to the user when the drill down

action is invoked. For example, if you select the Open In New Window option, the target page is displayed to
the user in a different tab from the OTBI report.

13. Keep clicking the OK buttons to close all dialog boxes until you reach the Criteria tab.
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14. Save the changes.
15. To test the drill down functionality, click the Results tab. The report is displayed in the Compound Layout pane.
16. In the report, click a cell in the column to which you added the action link. The target page is displayed.

Related Topics
• Register Business Intelligence to Support Deep Linking

• Create Deep Links

• Create and Modify Analyses and Dashboards

• Create and Edit Analyses Using a Wizard

Allow Adding Attachments After Submission of Expense
Report  
Users can add attachments to an expense report after approval.

Sometimes employees have to add more information to an approved expense report for post-accounting audits.
They can search for the approved expense report and add the required documents to it. To use this feature enable the
ORA_EXM_RECEIPT_AFTER_APPROVAL opt-in. Configure the Enable Attachments option on the Manage Expenses
System Options page, and select Yes for the Allow Adding Attachments After Submission option. You can configure the
Enable Attachments option for either the Header and Line items or any one of them.

In the Setup and Maintenance work area, use the following to navigate to the Manage Expenses System Options page:

• Offering: Financials

• Functional Area: Expenses

• Task: Manage Expenses System Options

FAQs for Expenses Configuration  

How can I configure an employee's address for payments?  
You can allow employees to use a mailing address in HCM to receive reimbursement for business expenses. You can
choose to configure their home, office, or a different mailing address for them to receive payments. This address is used
to send checks when the payment method is by check. When the payment method is electronic, this address is used in
the payment file of the employee's bank.

To configure an employee's address for payments:

1. Sign in to in Oracle Fusion Global Human Resources as a Human Resources specialist.
2. Do one of the following:

◦ For new employees, navigate to the Hire an Employee page.

◦ For existing employees, navigate to the Person Management page and search for the employee.
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3. In the Expenses Information section of the Manage Employment page, select any of the following options from
the Expense Check Send-to Address list:

◦ Home

◦ Office

◦ Mail

Note:  Mail is only supported for expense report payments, and not for cash advance payments.

How can I access Expenses predefined flexfields?  
Access predefined flexfields using the Define Flexfields task list as follows:

1. In the Setup and Maintenance work area, search for the Define Flexfields task list.
2. Click the Define Flexfields task list link to display the tasks.
3. Click the task link that corresponds to the flexfields you are searching for.
4. Enter data for any of the search parameters and click Search.
5. If you don't know the flexfield name or the code, open the Module choice list and click the Search link.
6. In the User Module Name field, enter Expenses and click Search.
7. Select Expenses and click OK.
8. Click Search.
9. Select a flexfield and click the Edit icon to view its details.

How can I access Expenses predefined lookups?  
Access Oracle Fusion Expenses predefined lookups using the Define Lookups task list as follows:

1. In the Setup and Maintenance work area, search for the Define Lookups task list.
2. Click on the Define Lookups task list link to view the Define Lookups tasks.
3. Click the task link that corresponds to the lookups you are searching for.
4. Enter data for any of the search parameters and click Search.
5. If you don't know the lookup type or the meaning, open the Module choice list and click the Search link.
6. In the User Module Name field, enter Expenses and click Search.
7. Select Expenses and click OK.
8. Click Search.
9. Select a lookup type to view its lookup codes.

Tip:  To filter the lookup codes, click the Query By Example icon. Enter the term you want to filter on and
press Enter on the keyboard.

How can I access Expenses predefined profile options?  
Access Oracle Fusion Expenses predefined profile options using the Define Profiles task list as follows:
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1. In the Setup and Maintenance work area, search for the Manage Profile Options task.
2. Click on the Manage Profile Options task link to open the Manage Profile Options page.
3. Enter data for any of the search parameters and click Search.
4. Alternatively, from the Application choice list, select Expenses and click Search.
5. If you don't know the profile option code or the display name, open the Module choice list and click the Search

link.
6. In the User Module Name field, enter Expenses and click Search.
7. Select Expenses and click OK.
8. Click Search.
9. Select a profile option to view its details.

Can I implement Expenses in another country if I have already
implemented Expenses in one country?  
Yes. You must set up applicable expense policies and rules, expense templates, and corporate card programs for the new
country's business units. New users can start entering expenses as soon as setup is complete.

Why do I have to configure the barcode font mapping?  
To display and print the barcode properly on expense reports, you must map the barcode font to the correct font in
Oracle Analytics Publisher.

To do this, perform the following steps:

1. In Oracle BI Publisher Enterprise, sign in as a user with Administrator access.
2. In the toolbar, click the Catalog menu.
3. In the Catalog pane, open Shared Folders and then open the Financials folder.
4. Select the Expenses folder and then select the Printable Expense Report Template icon.
5. Click the Edit link. The Printable Expense Report Template tab appears.
6. In the toolbar, click the Properties icon. The Report Properties dialog box appears.
7. In the Report Properties dialog box, select the Font Mapping tab.
8. In the RTF Templates region, add a new row.
9. In the Font Family field, enter Bookman.

10. From the Target Font choice list, select 128R00.TTF.

Note:  Code 128 is the barcode symbology provided with Oracle Fusion Applications.

11. Click the OK button.
12. To save the barcode font mapping, click the Save icon in the toolbar.

To use another barcode symbology, you must load the barcode font to the Oracle BI Publisher Enterprise Server and
then perform steps 1 to 12.

Note:  At any point in time, you can have only one active barcode font mapping for the Printable Expense Report
Template. That is, only one active mapping can be used for the barcode font in the Printable Expense Report
Template.
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Can I implement a country-specific version of Oracle Fusion
Expenses?  
No. A country-specific version of Expenses isn't available. Expenses supports both global and local requirements.

How can I enable employees to enter expense reports?  
To enable employees to enter expense reports, you must sign in to Oracle Fusion Global Human Resources as a Human
Resources specialist. Then you can create employee records.

Whether you create an employee record for an existing or a new employee, the mandatory Expense Entry Duty is
automatically assigned.

For an existing employee, navigate to the Manage Employment page, select the employee's business unit on the
Assignment Details tab in the Assignment section. Then select the default expense account in the Expenses Information
section.

For a new employee, navigate to the Hire an Employee page, select the employee's business unit on the Assignment
Details tab in the Assignment section. Then select the default expense account in the Expenses Information region.

How can I enable only a set of users to charge expenses against
projects?  
The Project Expense Allocation Duty allows employees to charge expenses against projects and tasks. Manually grant
this duty role to the user when he or she is identified as a project user.

To grant the duty role to the user, you must create a custom role that contains the Project Expense Allocation Duty.
Then assign the new custom role to the user.

Alternately, you can also create custom roles based on the Project Team Member abstract role or the Project Manager
job role, and assign them to the user. The user can then charge expenses to projects and tasks.

To enable project users to charge expenses to a project, they must also have a job assigned to them. Assign the job to
the user in the Setup and Maintenance work area by using the Manage Users page. Alternately, you can assign the job
to the user in the Person Management work area by using the Manage Employment page.
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How can I enable some or all users to charge against other
accounts or cost centers?  
The expense accounting privilege named Override Expense Account Allocation allows employees to charge expenses
against companies and cost centers that aren't their default company or cost center.

If users must charge expenses to other companies or cost centers, you can assign the privilege to some or all
employees. To do so, navigate to: Setup and Maintenance > Tools > Security Console.

How can I enable all account segments for expense report users?  
Set the value for the EXM_ALLOW_FULL_ACCT_OVERRIDE profile option to Yes. When you set the profile value to Yes,
expense report users can change the segment values of expense accounts during expense entry to accurately reflect
the charge allocations of their expenses.

You can set the value to Yes in the Account field on the Create Expense Item page. Navigate to: Setup and Maintenance
> Search Tasks: Manage Administrator Profile Values > Search: EXM_ALLOW_FULL_ACCT_OVERRIDE.

How can I prevent automatic population of expense fields?  
By creating the profile option, EXM_DFLT_FROM_PREV_EXPENSE, on the Manage Administrator Profile Values page
and setting the Profile Value to N at the site, product, or user level.

On the Create Expense Item page, when you create a new expense item, these fields are automatically populated from
the previous expense item:

• Date

• Template

• Expense Location

• Currency: Ledger currency and reimbursement currency

• Expense Template

• Accounting fields: Company and Department

• Project fields: Project Number and Task Number

When the profile option value is set to N, the application automatically populates the following fields when you create a
new expense item:

• Currency: Populates with the ledger currency as set up in Human Capital Management.

• Company and Department: Populates with values that are set up in your default expense account in Human
Capital Management.

When the profile option value is set to N and you create a new expense item, the application leaves these fields blank:

• Template
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• Expense Location

• Project Number and Task Number

When the profile option value is set to Y, all values that populate fields from a previous expense item will continue to
populate the same fields for new expense items.

Note:   You can optionally prevent automatic population of the Conversion Rate field by deselecting the Default
conversion rate check box on the Edit Conversion Rates and Policies page for a business unit.

What's an expense location?  
The location where the expense was incurred. Oracle Expenses captures expense location to enforce corporate policies.
The expense location can determine specific merchant tax fields that appear in the UI, including the tax classification
code.

The application uses the location information, which is centrally stored.

Can I deploy Oracle Expenses Cloud as a stand-alone application?  
Yes. You can deploy Oracle Expenses Cloud as a stand-alone application if you perform specific product tasks. In Setup
and Maintenance, search and select the Define Ledger Configuration for Rapid Implementation task list and the Define
Taxes for Rapid Implementation task list.

Additional tasks to perform include: Manage Common Options for Payables and Procurement, Manage Disbursement
System Options, Manage Payment Methods, and Manage Payment Process Profiles. You must also set up employees
and their assignments in the application.

How can I enable third-party integration for expense report
payments?  
You can specify a third-party reimbursement application on the Manage Expenses System Options page. The default
option processes employee expenses through Oracle Fusion Payables.
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2  Credit Card Data

How Corporate Card Transaction Files Are Processed  
Before you can begin processing corporate card transaction files, your company must establish connectivity with the
corporate card issuers. You must also determine the transaction file format and the transaction file delivery frequency.

After establishing a secure connection, your company receives transaction files.

The application loads the transaction file and validates the transactions. The application loads eFolio summary and
detail transactions if they're present in the file. All valid transactions are created as expense items and are available to
employees for inclusion in the expense reports. All invalid transactions are available for corporate card administrators to
review and correct. After correction, these transactions are validated again and become available for expense reporting.

When you implement corporate credit card functionality, you must decide whether your company or its employees are
responsible for paying the credit card issuer. The three payment options that you can implement in Expenses are the
following:

• Individual Pay: The employee pays the corporate card issuer for all corporate card transactions

• Company Pay: Your company pays the corporate card issuer for all transactions

• Both Pay: Your company pays the corporate card issuer for business expenses and the employee pays the
corporate card issuer for personal expenses
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This figure shows an overview of the corporate card transaction files processing.

A Setting That Affects Corporate Card Transaction Files
The process flow of corporate card transaction files is based on which of the three payment options your company
decides to implement. Your company can implement one, two, or all three of the payment options by geographical
region, organizational hierarchy, or other criteria. For example, a global company might have Both Pay implemented in
the US and Individual Pay implemented in the UK. Another company might have Both Pay for one set of organizations
and Individual Pay for another set of organizations within the UK.

When creating a company account for a card program, select a payment option from the Payment Due From list on the
Create Company Account page.

How Corporate Card Transaction Files Are Processed
This section provides examples of the corporate card transaction files process flow for each payment option. For each
example, assume that an employee reports cash and categorizes card transactions as both business and personal when
creating and submitting an expense report.
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Individual Pay
The Individual Pay payment option is simpler than Both Pay or Company Pay. Whether you identify corporate card
transactions as business or personal expenses, the employee pays the corporate card issuer for both business and
personal expenses. When the employee creates an expense report, both business and personal transactions are
reported. The employee is, however, reimbursed by your employer for the corporate card business expenses.

The following table provides an example of Individual Pay corporate card transaction files processing:

Action Description

Set up company account and download
data file.
 

Obtain the corporate card transactions data file from your corporate card provider.
 

Upload data file into Expenses.
 

Upload and validate your corporate card transactions files.
 

Create and submit expense report.
 

When you create an expense report, you select the corporate card transactions that you want to
submit on the report. You determine if transactions are business or personal expenses. By default,
 transactions are identified as Business.
 
You're only reimbursed by your employer for business expenses. Once processed on an expense
report, corporate card transactions are no longer available in the list of transactions to be added to
expense reports. This rule applies to both business and personal expenses.
 

Review and approve expense report.
 

After you submit the expense report, your manager must approve it. After managerial approval, the
report is verified to ensure that required receipts are attached and that the report is in compliance with
your company's policies.
 

Reimbursement.
 

After the expense report has been reviewed and approved, it's ready for invoice creation in Payables
to facilitate payment processing. To create an invoice with the amount due to the employee, run the
Process Expense Reimbursements program. Then the payment to the employee is processed through
Oracle Fusion Payments.
 

Company Pay
For the Company Pay payment option, your employer pays the corporate card issuer for all corporate card transactions
incurred by its employees. The employee is only reimbursed for cash business expenses. Corporate card transactions
reported as business expenses have no effect on the amount that is reimbursed to the employee.

Note:  If the employee reports any transactions as personal expenses, these transactions are offset against any cash
business expenses reported. Therefore, the amount reimbursable to the employee is reduced by the amount of the
corporate card personal expenses.

The following table provides an example of Company Pay corporate card transaction files processing:

Action Description

Set up company account and download
data file.
 

Obtain the corporate card transactions file from your corporate card provider.
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Action Description

Upload data file into Expenses.
 

Upload and validate your corporate card transactions files.
 

Create and submit expense report.
 

When you create an expense report, select the corporate card transactions that you want to submit.
You determine if transactions are business or personal expenses.
 
Cash expenses aren't charged to the company corporate card but are considered business expenses.
Cash expenses aren't reimbursed as corporate card business expenses. Corporate card transactions
designated as personal expenses reduce the amount you're reimbursed.
 
You are only reimbursed by your employer for cash business expenses. Once processed on an expense
report, corporate card transactions are no longer available in the list of transactions to be added to
expense reports. This rule applies to both business and personal expenses.
 

Review and approve expense report.
 

After you submit the expense report, your manager must approve it. After managerial approval, your
report is verified to ensure that required receipts are attached and that the report is in compliance with
your company's policies. Any corporate card transactions designated as personal expenses are also
displayed to the managers for review.
 

Export the expense report from Expenses
to Payables.
 

After the expense report has been reviewed and approved, it's ready for invoice creation in Payables to
facilitate payment processing.
 
To create the invoice with the amount due to the employee, run the Process Expense Reimbursements
program. Then the payment to the employee is processed through Oracle Fusion Payments.
 
To create an invoice with the amount due to the card issuer, run the Create Corporate Card Issuer
Payment Requests process. Then the payment to the employee is processed through Oracle Fusion
Payments. The card issuer can be paid at any time, regardless of the status of the expense report.
 

Both Pay
For the Both Pay payment option, your company pays the corporate card issuer for transactions that are categorized
as business expenses. The employee pays the corporate card issuer for all corporate card transactions reported as
personal expenses. An invoice can't be created for the corporate card issuer until the expense report is exported to
Payables as an invoice.

The following table provides an example of Both Pay corporate card transaction files processing:

Action Description

Set up company account and download
data file.
 

Obtain the corporate card transactions data file from your corporate card provider.
 

Upload data file into Expenses.
 

Upload and validate your corporate card transactions files.
 

Create and submit expense report.
 

When you create an expense report, select the corporate card transactions that you want to submit.
 
You are reimbursed only by your employer for cash business expenses. Once processed on an expense
report, corporate card transactions are no longer available in the list of transactions to be added to
expense reports. This rule applies to both business and personal expenses.
 

34



Oracle Fusion Cloud Financials
Implementing Expenses

Chapter 2
Credit Card Data

Action Description

Review and approve expense report.
 

After you submit the expense report, your manager must approve it. After managerial approval, your
report is verified to ensure that required receipts are attached and that the report is in compliance with
your company's policies. When the Payables review process is complete for an expense report, a new
expense report containing only corporate card transactions is created. The new report is based on the
existing report by copying only the business transactions, which are used to pay the card issuer. If the
expense report contains transactions charged to two corporate cards, two reports are created to pay
the corporate card issuers. These reports are named 1 and 2 respectively.
 

Process expense reimbursements.
 

After the card issuer expense report is created, it's ready for invoice creation in Payables to facilitate
payment processing.
 
To create the invoice with the amount due to the employee and to the card issuer, run the Process
Expense Reimbursements program. Then the payment to the employee and the corporate card issuer
is processed through Oracle Fusion Payments. The invoice due to the employee contains accounting
distributions and project accounting, when applicable, for both the cash and corporate card expenses.
 
The corporate card issuer invoice contains a single accounting distribution for all corporate card
expenses against the expense clearing account.
 

Related Topics
• Options for Deciding Who Pays the Corporate Card Issuer

Options for Deciding Who Pays the Corporate Card
Issuer  
Deciding who's responsible for paying the corporate card issuer is an important decision. You can choose from the
following options:

• Individual Pay: The employee pays the corporate card issuer for all corporate card transactions.

• Company Pay: Your company pays the corporate card issuer for all transactions.

• Both Pay: The employee pays the corporate card issuer for personal expenses and your company pays the
corporate card issuer for business expenses.

Individual Pay
For the Individual Pay option, the employee pays the corporate card issuer for both business and personal transactions.
The employee reports both expenses in expense reports. To ensure that required receipts are attached and that the
report is in compliance with your company's business policies, the employee's expense report is verified. When the
report is approved by the employee's manager, the employee is reimbursed for corporate card business expenses and
cash business expenses.

Note:  Cash business expenses are paid by cash or check instead of a corporate card.
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The following table describes the Individual Pay option where employees pay the corporate card issuer for corporate
card business and personal expenses. Your company reimburses employees for corporate card business and cash
business expenses.

Employees Pay Corporate Card
Issuer

Company Pays Corporate Card
Issuer

Company Doesn't Pay Company Reimburses Employees

• Corporate card business
expenses

• Corporate card personal
expenses

Not Applicable
 

Corporate card personal expenses
 

• Corporate card business
expenses

• Cash business expenses

Company Pay
For the Company Pay option, the employee doesn't pay the corporate card issuer. Your company pays the corporate
card issuer for corporate card and cash business transactions incurred by the employee. When the employee creates
an expense report, business and personal expenses must be reported, but your company reimburses the employee for
corporate card and cash business expenses. Any personal expenses are deducted from the cash business expenses and
recovered by your company.

Note:  Your company can pay the corporate card issuer at any time, depending on the payment terms. Submission or
approval of expense reports isn't required for payment to the card issuer.

The following table describes the Company Pay option where your company pays for corporate card and cash business
expenses. Your company also reimburses employees for corporate card and cash business expenses.

Employees Pay Corporate Card
Issuer

Company Pays Corporate Card
Issuer

Employees Reimburse Company Company Reimburses Employees

Not Applicable
 

• Corporate card business
expenses

• Corporate card personal
expenses

Corporate card personal expenses
 

Cash business expenses
 

Both Pay
For the Both Pay option, the employee pays the corporate card issuer for corporate card transactions reported as
personal expenses and your company pays the corporate card issuer for business expenses. When the employee
creates an expense report, he selects corporate card business transactions. When the report is approved, the employee
pays the corporate card issuer for corporate card personal expenses. Your company reimburses the employee for cash
business expenses. This payment option is also referred to as joint liability.

The following table describes the Both Pay option where employees pays for personal expenses. Your company pays the
corporate card issuer for business expenses.
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Employees Pay Corporate Card
Issuer

Company Pays Corporate Card
Issuer

Company Doesn't Pay Company Reimburses Employees

Corporate card personal expenses
 

Corporate card business expenses
 

Corporate card personal expenses
 

Cash business expenses
 

How Accounting Entries for Corporate Card Transactions
Are Distributed  
Accounting entries vary depending on which payment option is used by your company.

The following table illustrates a sample expense report with various payment liabilities and amounts.

Payment Method Amount

Cash
 

500 USD
 

Corporate Card Business Expenses
 

650 USD
 

Corporate Card Personal Expenses
 

299 USD
 

Corporate Card Transactions from
Corporate Card Issuer
 

949 USD
 

Data in the preceding table is used in subsequent sections to illustrate how accounting entries are distributed for each
payment liability.

Settings That Affects Payment Options
The following options available from the Payment Option choice list in the Create Company Account dialog box affect
payment liability: Both, Company, and Individual.

How Accounting Entries for Payment Options Are Calculated
When an employee's expense report is exported to Payables, the amount of the payment request equals the amount
due the employee.

The following table summarizes amounts owed by a company to an employee and the corporate card issuer based on
the payment liability.

Payment Liability Expense Report Total Amount Due Employee Amount Due Corporate Card
Issuer

Individual Pay 1,150 USD 1,150 US 0
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Payment Liability Expense Report Total Amount Due Employee Amount Due Corporate Card
Issuer

    

Both Pay
 

1,150 USD
 

500 USD
 

650 USD
 

Company Pay
 

1,150 USD
 

201 USD
 

949 USD
 

Accounting Entries for Individual Pay
Since the payment option is Individual Pay, a single payment request is created to reimburse the employee. It's the
employee's responsibility to pay the card issuer.

The following table describes the accounting distributions for a corporate card with Individual Pay liability.

Account Debit Credit

Cash and other expenses
 

500 USD
 

Not Applicable
 

Corporate card business expenses
 

650 USD
 

Not Applicable
 

Employee liability
 

Not Applicable
 

1,150 USD
 

Accounting Entries for Both Pay
With Both Pay liability, two payment requests are created, one to pay the employee for any out of pocket expenses and a
second one to pay the card issuer.

The following table describes the accounting distributions for a corporate card with Both Pay liability.

Account Debit Credit

Payment Request for Employee
 
Cash and other expenses
 

500 USD
 

Not Applicable
 

Due to employee
 

Not Applicable
 

500 USD
 

Corporate card business expenses
 

650 USD
 

Not Applicable
 

Expenses clearing account
 

 650 USD
 

Payment Request for Card Issuer
 
Expenses clearing account
 

650 USD
 

Not Applicable
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Account Debit Credit

Due to card issuer
 

Not Applicable
 

650 USD
 

Accounting Entries for Company Pay
With Company Pay liability, a company can pay the card issuer at any time. The payment request for an employee is
created when an expense report is approved and processed, while the payment request for the card issuer is created
separately.

The following table describes the accounting distributions for a corporate card with Company Pay liability.

Account Debit Credit

Payment Request for Employee
 
Cash and other expenses
 

500 USD
 

Not Applicable
 

Corporate card business expenses
 

650 USD
 

Not Applicable
 

Expenses clearing account
 

Not Applicable
 

949 USD
 

Due to employee
 

Not Applicable
 

201 USD
 

Payment Request for Card Issuer
 
Expenses clearing account
 

949 USD
 

 

Due to card issuer
 

Not Applicable
 

949 USD
 

Related Topics
• Options for Deciding Who Pays the Corporate Card Issuer

Steps Your Administrator Takes to Receive Transaction
Files from a Card Issuer  
Before your company can receive transaction files from a corporate card issuer, your administrator must perform the
following steps:

• Select the correct transaction file format.

• Establish file transfer connectivity.

• Test sample transaction files.
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Selecting the Correct Transaction File Format
Your company must verify that the corporate card issuer's file format is supported by Oracle Expenses. Expenses
supports the following corporate card transaction file formats:

Note:  You can no longer load files that contain full card numbers. Card numbers must be masked or tokenized
according to the format.

• American Express GL1025 Card Number Disguising Format

• Diner's Club Standard Data File format with Tokens

• MasterCard Common Data Format, version 3.0 (CDF 3.0) Masked

• Visa VCF4 Format with Tokens

Corporate card issuers require your company to provide organizational hierarchy information that they set up in their
system to satisfy your reporting and billing needs. The organizational hierarchy associates the corporate cards issued to
your employees with the appropriate organizations within your company.

Corporate card issuers can provide your company with a single file that contains all company transactions or a separate
transaction file for each organizational hierarchy. Expenses processes both types of transactions files. To obtain the
appropriate file for your company, communicate your preference to the corporate card issuer.

Establishing File Transfer Connectivity
Work with your card issuer to determine the secure file transfer method that meets your company's security
requirements. A secure connection between the card issuer and your company is required to receive the transaction file
from the card issuer's server. To process the transaction files, Expenses must have read access to the directory location
in which the transaction files are stored.

Note:  For American Express files, Expenses supports automatic download of corporate card transaction files from the
American Express server.

Testing Sample Transaction Files
The corporate card issuer provides your company with transactions file format specifications and sample test files
applicable to your company. Work with your card issuer to identify transactions that you want to include in the test files
and the number of test files required.

Note:  Before you can test the sample transaction files, you must complete the corporate card program setup.

If you automatically assign newly created corporate cards to company accounts based on your setup within the card
issuer's system, then you must set up the company account with the following:

• Company account number

• Card issuer number

• Processor-assigned number

• Market code

• Billing control account number based on your card brand
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If you don't plan to automatically assign newly created cards, then you must create one company account per business
unit that pays the card issuer. The application then assigns the corporate card to a company account that's defined for
the business unit of the employee.

If you do plan to automatically assign corporate cards to company accounts based on your setup within the card issuer's
system, you must set up data on the Create Corporate Card Program page.

To test the card issuer's sample transaction files, copy the data from the sample transaction files into the applicable
fields on the Create Corporate Card Program page. To do this, use the data from the sample transaction files to identify
what to enter on the Create Corporate Card Program page.

The following table shows the location of the setup data in the card issuer's sample transaction files.

Tip:  Use this table with the file specification from the card issuer to locate the data in the sample transaction files.

Transaction File
Format

Field Name on the
Create Corporate
Card Program Page

Type of Record Data Element Name Data Location in
the Card Issuer's
Transaction File

Tag

American Express
GL1025 Card Number
Disguising Format
 

Company Account
Number
 

Type 1
 

Global Client Origin
Identifier
 

5-19
 

N/A
 

Market Code
 

Type 1
 
Type 8
 

Market Code
 
Market Code
 

2-4
 
37-39
 

N/A
 

Diner's Club Standard
Data File Format with
Tokens
 

Company Account
Number
 

N/A
 

Link_acct
 

71-89
 

N/A
 

MasterCard Common
Data Format, version
3.0 (CDF 3.0) Masked
 

Company Account
Number
 

N/A
 

N/A
 

N/A
 

<CorporateEntity>
 
<CorporationNumber>
 

Card Issuer Number
 

N/A
 

N/A
 

N/A
 

<IssuerEntity>
 
<IssuerNumber>
 

Processor-Assigned
Number
 

N/A
 

N/A
 

N/A
 

<IssuerEntity>
 
<ICANumber>
 

Visa VCF4 Format with
Tokens
 

Company Account
Number
 

Block Header
 

Company
Identification
 

Field #2
 

N/A
 

Card Issuer Number
 

Block Header
 

Issuer Identification
Number
 

Field #9
 

N/A
 

Processor-Assigned
Number
 

Block Header
 

Processor
Identification Number
 

Field #10
 

N/A
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You can use the following table with the file specification from the card issuer to locate employee numbers in the charge
files.

Transaction File Format Type of Record Data Element Name Data Location in Card
Issuer's File

Tag

American Express GL1025
Card Number Disguising
Format
 

Type 1
 

Employee ID
 

328 to 342
 

N/A
 

MasterCard Common Data
Format, version 3.0 (CDF
3.0) Masked
 

N/A
 

N/A
 

N/A
 

<EmployeeId> in
<AccountInformation_
4300>
 

Visa VCF4 Format with
Tokens
 

Card Account (Type 3)
 

Cardholder Identification
 

Field #2
 

N/A
 

Visa VCF4 Format with
Tokens
 

Cardholder (Type 4)
 

Cardholder Identification
 

Field #3
 

N/A
 

Visa VCF4 Format with
Tokens
 

Cardholder (Type 4)
 

Employee ID
 

Field #23
 

N/A
 

Related Topics
• How Downloading Corporate Card Transaction Files From American Express Are Processed

Options for Creating Corporate Cards  
You can create corporate cards in two ways. You can choose either of the following actions at different points in time or
you can do both at the same time:

• Automatic corporate card creation

• Manual corporate card creation

Automatic Corporate Card Creation
Automatic corporate card creation applies only to corporate cards that are issued to employees and used primarily for
travel expenses. New employees are typically given new corporate cards, but the information on the cards isn't manually
entered into the application at that time.

You can create corporate cards automatically by selecting an employee matching rule for new cards on the Upload Rules
tab of the Create Corporate Card Program page. Then, when the corporate card transaction file containing transactions
for the new card is uploaded to Expenses for the first time, the corporate card transaction upload and validation process
uses the matching rule to match the new corporate card to the new employee.
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Using the specified employee matching rule, the application automatically enters the transaction data for the new
corporate card and associates it with the applicable employee. If the employee matching rule fails to identify a match,
the application leaves the corporate card unassigned.

Tip:  To reduce or eliminate manual effort, automatic corporate card creation is recommended.

Employee Matching Rules
There are two employee matching rules that can be used for a corporate card program:

• Employee number: This is the most commonly used matching rule. In this matching rule, the application
matches employee number associated to the new corporate card with employee records to identify the
applicable employee.

• Name and employee number: The application matches employee's first name, middle name, last name, and
employee number associated to the new corporate card with employee records to identify the applicable
employee.

Employee Matching Scenarios
Any of these employee matching scenarios can occur for any corporate card brand when the first transaction for a new
card comes in:

• Company account information on the transaction matches the company account information in the application.

The application searches and identifies an employee in the business unit of your company account.

• Company account information on the transaction matches the company account information in the application.

The application searches and doesn't identify an employee in the business unit of your company account.

If the Perform employee matching across all business units check box is selected, the application searches
all other business units and identifies an employee match.

• The company account in the application has no information, such as company account number, billing control
account, or card issuer number.

If no setup data exists, the application matches across business units, identifies the employee and the
employee's business unit, and associates the corporate card to a company account in the same business unit.

Manual Corporate Card Creation
You can manually create corporate cards for employees in the Create Corporate Card dialog box where you enter the
following data:

• Corporate card program

• Company account name

• Token or masked card number

• Employee name and number

• Expiration date

• Maximum amount per transaction: Applicable for procurement cards only
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• Maximum amount per billing period: Applicable for procurement cards only

Note:  Manual creation of corporate cards is the exception, rather than the rule. Corporate cards are company
account-specific. For example, if an employee transfers to another organization within your company and the
organization belongs to another company account, you must create the corporate card again with the applicable
company account name.

Related Topics
• Simplified Configuration for MasterCard CDF3 and Visa VCF4 Files

• How can I configure corporate card issuers?

• What's a corporate card program?

Mapping Rules  
The corporate card expense type mapping rule is a correspondence between the transaction code in the card feed file
and the predefined card expense type. This linkage enables the application to automatically produce expense types for
transactions in the expense report.

To automatically populate expense types in expense reports, you must perform the following steps:

1. Define transaction codes of a corporate card feed file as lookup types.
2. Map predefined corporate card expense types to feed file transaction codes.
3. Assign the mapping rule to the corporate card program.
4. Map predefined corporate card expense types to user-defined expense types in the default expense template

for each business unit.
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This figure shows the setup to automatically populate expense types in expense reports, with uploading and
validating corporate card transaction files. Ultimately, expense items are displayed in the Expenses work area.

Define Feed File Transaction Codes
Corporate card issuers provide the transaction codes for each transaction in a corporate card feed file. These
transaction codes, whether MIS Industry Codes, SIC Codes, or merchant category codes, must be set up in the
application as lookups. Oracle Fusion Expenses provides predefined lookup types so you can define these transaction
codes.

Expenses also provides a preconfigured list of merchant category codes and SIC codes. Here's how you can access
them:

1. In the Setup and Maintenance work area, go to the following:

◦ Offering: Financials

◦ Functional Area: Expenses

◦ Task: Manage Standard Lookups

2. Click the Manage Standard Lookups link.
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3. In the Search section of the Manage Standard Lookups page, search for your required lookup using the lookup
type or its meaning, as shown below:

Lookup Type Meaning

ORA_EXM_MCC_CODES Expense Merchant Category Codes

ORA_EXM_SIC_CODES Expense SIC Codes

Map Corporate Card Expense Types to Transaction Codes
Expenses provides predefined corporate card expense types in a single lookup type. This lookup type can be configured
to include your company's specific expense types. Then you must associate the predefined corporate card expense
types with the corporate card transaction codes. This association is known as a mapping rule.

Expenses also provides a set of preconfigured mapping rules that you can use as is or modify per your business
requirements.

Note:  You must have the Corporate Card Administrator role to review preconfigured mapping rules.

Here's how you can use the preconfigured mapping rules with the preconfigured transaction codes:

1. In the Setup and Maintenance work area, go to the following:

◦ Offering: Financials

◦ Functional Area: Expenses

◦ Task: Manage Corporate Card Expense Type Mapping Rules

2. Click the Manage Corporate Card Expense Type Mapping Rules link.
3. On the Manage Corporate Card Expense Type Mapping Rules page, select one of the following preconfigured

mapping rules:

◦ Expense SIC Codes

◦ Merchant Category Codes

You can use the preconfigured rule as is or modify it to suit your business requirements.

Assign Mapping Rule to Corporate Card Program
To enable the upload process to use the correct mapping rule, you must assign a mapping rule to the corporate card
program. You can set up multiple mapping rules to automatically populate expense types into expense reports for either
of the following:

• Summary transactions, known as eFolio or Level 2

• Detail transactions, known as Level 3

Map Corporate Card Expense Types to Expense Types
To automatically populate expense types for individual expenses, you must perform a final setup. In the expense
template, you associate the predefined corporate card expense types with your user-defined expense types. The upload
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process uses the default expense template mapping for the transaction's business unit to derive the expense type that's
displayed for the card expense.

Wait Days  
Using Oracle Fusion Expenses, you can hold the main corporate card transactions from use until the detail corporate
card transactions arrive. This ensures that employees can include the itemization detail provided by the card issuer in
their expense reports.

Two types of wait days control the maximum duration that the application waits for the detail transactions to arrive:

• Transaction detail wait days

• Merchant wait days

Note:  Wait days are applicable only when the merchant provides Level 3 detail transaction data. No wait period is
applicable for transactions from merchants who don't provide transaction detail.

Transaction Detail Wait Days
Transaction detail wait days are the number of days the application is set up to hold the main transaction data while
waiting for detail transaction data from a merchant. Detail transaction data may or may not arrive.

You can set a wait period at the corporate card program level by selecting a value from the Transaction Detail Wait
Days choice list on the Upload Rules tab of the Create Corporate Card Program page. If defined, the application uses
the smaller value between the transaction detail wait days and the merchant wait days as the wait period for the main
transactions.

Merchant Wait Days
Merchant wait days are calculated by the application. It's the difference, in days, between receiving the main
transactions and receiving detail transactions when they arrive for the first time. Thereafter, merchant wait days are
computed as follows:

• Detail Transactions Arrival Date minus Main Transactions Arrival Date plus Most Recent Merchant Wait Days for
the Main Transactions Upload divided by two.

A merchant can provide detail transactions either with the main transactions or as a separate delivery. If they're
provided as a separate delivery, the Upload Corporate Card Transaction File process holds the main transactions for
a specified time period while waiting for the detail transactions. During this wait period, the main transactions aren't
available for expense reports. After each delivery of detail transactions, the merchant's wait days are updated by the
application according to the preceding formula.

Note:  The actual time that data arrives isn't a factor in the merchant wait days or in the application's wait days'
calculation.
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The following table shows the calculations associated with detail transactions and merchant wait days based on
transaction data arrival dates using sample data. The table data is based on a transaction detail wait days setting of five
days.

Data Upload Main
Transactions
Arrival Date

Detail
Transactions
Arrival Date

Merchant Wait
Days

Application
Transaction Wait
Days

Latest Date
Transactions
are Available in
Expense Report

Actual Date
Transactions
are Available in
Expense Report

First Time: Detail
transactions arrival
date minus main
transactions arrival
date
 
Thereafter, detail
transactions arrival
date minus main
transactions arrival
date plus most
recent merchant
wait days for the
main transactions
upload divided by
2.
 

Application uses
the minimum
of transaction
detail wait days
or merchant wait
days for the main
transactions
upload plus 1 day.
 

Date the
transaction detail
wait days end.
 

Actual date the
main and detail
transactions are
available in the
expense report.
 

Main Transactions
1
 

May 1
 

N/A
 

N/A
 
The merchant has
never provided
detail transactions.
Therefore, no
merchant wait
days exist in the
application.
 

0 Days
 
The merchant
didn't provide
details
transactions.
Therefore, the
application doesn't
wait.
 

May 1
 
Available
immediately.
 

May 1
 
Available
immediately.
 

Detail Transactions
1
 

N/A
 

May 5
 

4 Days
 

N/A
 

N/A
 

May 5
 

Main Transactions
2
 

May 7
 

N/A
 

4 Days
 
Previously
calculated
merchant wait
days.
 

5 Days
 
The application
waits for the
minimum of 5
transaction detail
wait days or 4
merchant wait days
plus 1 day.
 

May 11
 
May 7 + 5
application wait
days = May 12.
 

N/A
 

Detail Transactions
2
 

N/A
 

May 9
 

3 Days
 
(May 9 minus May
7) +4 /2.
 

N/A
 

N/A
 

May 9
 

Main Transactions
3
 

May 12
 

N/A
 

3 Days
 
Previously
calculated

4 Days
 
The application
waits for the

May 15
 

N/A
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Data Upload Main
Transactions
Arrival Date

Detail
Transactions
Arrival Date

Merchant Wait
Days

Application
Transaction Wait
Days

Latest Date
Transactions
are Available in
Expense Report

Actual Date
Transactions
are Available in
Expense Report

merchant wait
days.
 

minimum of 5
transaction detail
wait days or 3
merchant wait days
plus 1 day.
 

May 12 + 4
application wait
days = May 16.
 

Travel Card Processing  
Travel cards, also known as centrally-billed travel cards, business travel accounts, or ghost cards, are used by companies
to centrally charge high value travel expenses, such as airfare, accommodations, and car rental.

The travel card account allows corporate employees to purchase travel expenses using a single card account, rather than
each employee using individual corporate cards. A centrally-billed card is a single card number that's assigned to an
entire company or to a specific business unit.

Your company can realize the following benefits from using a travel card account:

• Greater visibility into total trip cost

• Accurate travel expense allocation

• On time payment to card issuers

• Integration with American Express

• Cost savings

Processing travel cards includes the following actions:

• Schedule the Upload Corporate Card Transactions process.

• View upload results.

• View transaction file upload details.

• Schedule the Create Corporate Card Issuer Payment Requests process.

• View payment requests results.

Schedule the Upload Corporate Card Transactions Process
The Upload Corporate Card Transactions process uploads and validates corporate card or travel card transactions from a
card issuer.

To schedule the Upload Corporate Card Transactions process, navigate to: Navigator > Expenses > Corporate Cards
link > Tasks link > Upload Corporate Card Transactions link > Upload Corporate Card Transactions page.

The following table contains the parameters that you must select on the Upload Corporate Card Transactions page to
schedule the Upload Corporate Card Transactions process.

49



Oracle Fusion Cloud Financials
Implementing Expenses

Chapter 2
Credit Card Data

Parameters Option

Process Type
 

Upload and validate
 

Corporate Card Program
 

Applicable travel card
 

Account Type choice list
 

Centrally-billed card
 

View Upload Results
View upload results in the Corporate Cards work area on the Transactions Upload Results tab. The upload results display
the status of the process, output, number of valid transactions, and any invalid transaction errors. You can click the
View Output icon and the link for the number of invalid transactions to review details and take corrective action.

View Transactions File Upload Details
The Transaction Upload Results tab doesn't display details of the uploaded transaction files. However, you may need
these details to review or rerun the process if something failed. You can find this information on the View File Status
page. To view this page, from the Tasks panel tab click the View File Status link.

On the View File Status page, you can search for a transaction file based on parameters, such as process ID, status,
corporate card program, and so on. You can search for files that were uploaded up to 6 months earlier. From the
searched results, you can check the status of the transaction file, review the other transaction details, and take
appropriate corrective action.

Schedule the Create Corporate Card Issuer Payment Requests Process
The Create Corporate Card Issuer Payment Requests process creates invoices for subsequent payment to corporate card
or travel card issuers.

To schedule the Create Corporate Card Issuer Payment Requests process, navigate to: Navigator > Expenses >
Corporate Cards link > Tasks link > Create Corporate Card Issuer Payment Requests link > Create Corporate Card
Issuer Payment Requests page.

The following table contains the parameters that you must select on the Create Corporate Card Issuer Payment
Requests page to schedule the Create Corporate Card Issuer Payment Requests process.

Parameters Option

Corporate Card Program
 

Travel card
 

Account Type choice list
 

Centrally-billed card
 

View Payment Requests Results
View payment requests results in the Corporate Cards work area on the Card Issuer Payment Requests tab. The
payment requests results display the status of the process, as well as output. You can click the View Output icon to
review details and take corrective action.
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Related Topics
• How can I set up MasterCard as a centrally-billed card for travel expenses?

Card Processing Validation Errors  
When processing credit card transactions provided by card issuers, you may come across some validation errors that
you may have to resolve.

This table provides a list of such errors, explains the cause of the errors, and the corrective action you need to take to
process the transactions successfully.

Error Reason for Error Corrective Action

Inactive corporate card
 

Corporate card is past its inactive date.
 

From the Manage Corporate Cards page, open
the Edit Corporate Card dialog box.
 
Update the inactive date of the card.
 
Run the validation process again.
 

Inactive employee
 

Employee is terminated, suspended, or on an
unpaid leave.
 

On the Manage Expenses System Options page,
 increase the number in the Inactive Employee
Grace Period in Days field.
 
Run the validation process again.
 

Invalid billed amount
 

Billed amount has format errors.
 

On the Review Corporate Card Transactions
page, review the transaction and correct the
billed amount to fix any formatting errors.
 
Run the validation process again.
 

Invalid billed currency code
 

Billed currency code is either invalid or different
from the payment currency configured for the
company account.
 

1. On the Manage Corporate Card Programs
page, select the required corporate card
program.

2. On the Edit Corporate Card Program page,
 select the required company account.

3. From the Edit Company Account
dialog box, note the payment currency
configured for the company account.

4. Then, on the Review Corporate Card
Transactions page, review the transaction
and set the billed currency code same as
the payment currency you noted earlier.

5. Run the validation process again.

Invalid billed date
 

Billed date has format errors.
 

On the Review Corporate Card Transactions
page, review the transaction and correct the
billed date.
 
Run the validation process again.
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Error Reason for Error Corrective Action

 

Invalid corporate card number
 

Card number provided is invalid.
 

Review the transaction to verify that actual card
number isn't stated in the transaction file.
 
Contact your card issuer to get the transactions
file with tokenized or masked card numbers.
 

Invalid merchant category code
 

Merchant category code is null or invalid.
 

On the Review Corporate Card Transactions
page, check the merchant category code and
update it if required. For VISA VCF 4.0 files, if
the transaction code (Field #18) is 10, 11, 20,
 22, or 80, the merchant category code (Field
#17) is required. Here are the different values of
merchant category code that must be used:
 

• If transaction code is 20, merchant
category code can be 6010 or 6011.

• If transaction code is 22, merchant
category code should be 6012.

• If transaction code is 80, merchant
category code can be 6050 or 6051.

Run the validation process again.
 

Invalid merchant name
 

Merchant name of the transaction is null.
 

On the Review Corporate Card Transactions
page, check the merchant name and update it if
required.
 
For VISA VCF4.0 files, the merchant or supplier
name (Field #9) is required in these conditions:
 

• The transaction code (Field #18) is 11, 20,
 22, or 80.

• The merchant category code (Field #17)
isn't 6012.

Run the validation process again.
 

Invalid posted amount
 

Posted amount has format errors.
 

On the Review Corporate Card Transactions
page, review the transaction and correct the
posted amount to fix any formatting errors.
 
Run the validation process again.
 

Invalid posted currency code
 

Posted currency code is invalid.
 

On the Review Corporate Card Transactions
page, review the transaction and select the
correct posted currency code.
 
Run the validation process again.
 

Invalid posted date
 

Posted date has format errors.
 

On the Review Corporate Card Transactions
page, review the transaction and correct the
posted date.
 
Run the validation process again.
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Error Reason for Error Corrective Action

Invalid transaction amount
 

Transaction amount has format errors.
 

On the Review Corporate Card Transactions
page, review the transaction and correct the
transaction amount to fix any formatting errors.
 
Run the validation process again.
 

Invalid transaction currency code
 

Transaction currency code is invalid.
 

On the Review Corporate Card Transactions
page, review the transaction and select the
correct transaction currency code.
 
Run the validation process again.
 

Invalid transaction date
 

Transaction date has format errors.
 

On the Review Corporate Card Transactions
page, review the transaction and correct the
transaction date.
 
Run the validation process again.
 

Invalid transaction type
 

Transaction type is invalid.
 

1. On the Review Corporate Card
Transactions page, select the transaction
and review the details.

2. For VISA, Amex, and MasterCard
transactions, select the correct transaction
type from the list. For Diner's Club
transactions, enter the correct transaction
type.

3. Run the validation process again

Missing company account
 

No company account assigned to the card.
 

From the Manage Corporate Cards page, open
the Edit Corporate Card dialog box.
 
Assign the card to a company account.
 
Run the validation process again.
 

Missing default template
 

No default template available to map card
expense types.
 

On the Manage Expense Report Templates
page, ensure that the business unit has a
default expense report template. This maps
card expense types to application expense
types.
 
Run the validation process again.
 

Unassigned card
 

The employee matching process resulted in
either multiple employee matches for the new
card or no match at all.
 

From the Manage Corporate Cards page, open
the Create Corporate Card or Edit Corporate
Card dialog box.
 
Assign the card to an employee.
 
Run the validation process again.
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How Corporate Card Issuer Payment Requests for
Company Pay Transactions Are Processed  
You can run the Create Corporate Card Issuer Payment Requests process to generate payment requests for corporate
card issuers when there are corporate cards that use the Company Pay payment option.

The Create Corporate Card Issuer Payment Requests process is run only when the Company Pay payment option is
used.

Note:  You can run the process any time. Since your company's objective is to pay the card issuer on time, running the
Create Corporate Card Issuer Payment Requests process isn't dependent on when an employee submits an expense
report.

This following figure shows how the:Create Corporate Card Issuer Payment Requests process
generates payment requests to pay corporate card issuers when corporate cards use the Company
Pay payment option.Process Expense Reimbursement process generates payment requests
to pay employees when corporate cards use the Company Pay Plus Cash payment option.
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Settings That Affect Corporate Card Issuer Payment Requests for
Company Pay Transactions
Settings that affect payment requests for Company Pay transactions are the following:

• Employee Liability Account: Set up as a system option on the Edit Expenses System Options page.

Note:  To use the Payables default liability account, select the Use setup from Oracle Fusion Payables
option. To define a specific liability account that's specific to a business unit, select the Define value specific
to business unit option and then enter an account. This account is used only if there are cash expenses in
the expense report and reimbursement is due to the employee.

• Corporate Card Issuer Payment Liability Account: Set up in Oracle Fusion Payables.

This account records the amount the company reimburses corporate card issuers for expenses incurred by
employees who use their corporate cards.

• Expense Clearing Account and Payment Option: Set up in the Create Company Account dialog box.

This account temporarily holds accounting for corporate card transactions. It's cleared when the expense
reports containing the corporate card transactions are processed by Payables.

How Corporate Card Issuer Payment Requests for Company Pay
Transactions Are Processed
The Create Corporate Card Issuer Payment Requests process has the following components:

• Populate Payables Open Invoice Interface tables

• Create corporate card issuer payment requests

• Handle processed and rejected expense reports

Populating Payables Open Invoice Interface Tables
For each corporate card, the Create Corporate Card Issuer Payment Requests process creates one invoice header
record in the Payables Open Invoice Interface table. All corporate card transactions for the corporate card are created
as child lines. The accounting distributions for the transactions are created using the Expense Clearing Account for the
corporate card.

Creating Corporate Card Issuer Payment Requests
After populating the Payables Open Invoice Interface table, the Create Corporate Card Issuer Payment Requests process
invokes the Import Payables Invoices process in Payables. Payables creates payment requests using the information in
the Payables Open Invoice Interface table. Tax processing isn't applicable for corporate card issuer payment requests.

Handling Processed and Rejected Expense Reports
During payment request creation, Payables rejects records in the Payables Open Invoice Interface table if errors exist,
such as dates in closed accounting periods or invalid payment methods. After payment requests creation is complete,
the Create Corporate Card Issuer Payment Requests process removes any rejected records from the interface table. You
must then reprocess the corporate card transactions for reimbursement.
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Finally, all expense items corresponding to the corporate card transactions, for which payment requests are created, are
updated with a corresponding payment request identifier.

The following table describes the types of payment options for corporate card transactions in expense reports and the
processes that are run to generate their associated payment requests.

Expense Report Payment Options for
Corporate Card Transactions

Process Run Payment Requests Created

• Cash

• Company Pay

• Process Expense Reimbursements

• Create Corporate Card Issuer Payment
Requests

• Employee Payment Requests

• Corporate Card Issuer Payment Requests

• Individual Pay

• Company Pay

• Process Expense Reimbursements

• Create Corporate Card Issuer Payment
Requests

• Employee Payment Requests

• Corporate Card Issuer Payment Requests

• Cash

• Individual Pay

• Company Pay

• Process Expense Reimbursements

• Create Corporate Card Issuer Payment
Requests

• Employee Payment Requests

• Corporate Card Issuer Payment Requests

• Both Pay

• Company Pay

• Process Expense Reimbursements

• Create Corporate Card Issuer Payment
Requests

Corporate Card Issuer Payment Requests
 

• Cash

• Both Pay

• Company Pay

• Process Expense Reimbursements

• Create Corporate Card Issuer Payment
Requests

• Employee Payment Requests

• Corporate Card Issuer Payment Requests

• Individual Pay

• Both Pay

• Company Pay

• Process Expense Reimbursements

• Create Corporate Card Issuer Payment
Requests

• Employee Payment Requests

• Corporate Card Issuer Payment Requests

Company Pay only
 

• Process Expense Reimbursements

• Create Corporate Card Issuer Payment
Requests

Corporate Card Issuer Payment Requests
 

Related Topics
• Options for Deciding Who Pays the Corporate Card Issuer

• How Expense Report Payment Requests Are Processed
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How Corporate Card Transactions for Inactive Employees
Are Processed  
Your company can settle inactive employees' accounts with a card issuer in a timely manner. You can grant managers
permission to submit their inactive employees' unpaid corporate card transactions in expense reports.

You can process corporate card transactions for inactive employees by running either of the following processes from
the Corporate Cards work area:

• Upload Corporate Card Transactions

• Process Inactive Employee's Corporate Card Transactions

Navigate to Corporate Cards work area: Navigator > Corporate Cards link > Overview page or Navigator >Tools >
Scheduled Processes.

An inactive employee is a person who was terminated or who's on unpaid leave. Examples include:

• Military leave

• Extended medical leave

• Educational leave

Settings That Affect Corporate Card Transactions for Inactive Employees
No prerequisites or setup is required to process corporate card transactions for inactive employees. However based on
the requirements of your organization, you can specify a grace period, which is used to determine the cutoff date for
the transactions of inactive employees to be processed. For example, if transactions are posted after the employee's
inactive date, setting a grace period will ensure that such transactions aren't ignored from processing. The default value
of the grace period is 0 days. To change the grace period grace period for your organization, enter a value in the Inactive
Employee Grace Period in Days field on the Manage Expenses System Options page. Here is how you open the page:

In the Setup and Maintenance work area, select these options:

• Offering: Financials

• Functional Area: Expenses

• Task: Manage Expenses System Options

You can also specify different grace periods for specific business units.

The corporate card transaction processes for inactive employees include Both Pay, Company Pay, and Individual Pay
corporate card transactions. For Both Pay transactions, your company pays the corporate card issuer for business
expenses and the employee pays the corporate card issuer for personal expenses. Company Pay transactions are those
where your company pays the corporate card issuer for all corporate card transactions incurred by its employees. The
employee is reimbursed only for cash business expenses. Individual Pay transaction are those where the employee
pays the corporate card issuer for all corporate card transactions. The employee is later reimbursed for the business
expenses.

The following table describes selected parameters for the Process Inactive Employee's Corporate Card Transactions
process.
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Parameters Description

Number of Days
 

Value used by the application that represents an interval of time, which the application uses to
determine whether corporate card transactions for inactive employees exist.
 
The default value for Number of Days is one. However, you can adjust this value depending on how
frequently your company updates information about terminated and inactive employees.
 
If your company updates employee information infrequently, the value for Number of Days should be
greater than one.
 

Tip:
A large value for Number of Days may impact performance. It's advisable to update your employee
data frequently and enter a small value for Number of Days.
 

Business Unit
 

Unit of an enterprise in a management hierarchy that performs one or multiple business functions. The
process named Process Corporate Cards Transactions for Inactive Employees runs for the business unit
identified by this parameter.
 

How Corporate Card Transactions for Inactive Employees are Processed
The figure shows the different starting points of the following processes:

• Upload Corporate Card Transactions

• Process Inactive Employees' Corporate Card Transactions
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To run the Upload Corporate Card Transactions process from the Corporate Cards work area, click the Upload
Corporate Card Transactions link in the Tasks list. First, this process validates and uploads corporate card transactions
to Expenses. Second, if the process identifies unpaid corporate card transactions for an inactive employee, the Process
Inactive Employee's Corporate Card Transactions process initiates.

After Process Inactive Employee's Corporate Card Transactions is initiated and unpaid card transactions are found, a
notification is sent to the inactive employee's manager.

If the direct manager doesn't have delegation, he receives a notification. The notification informs him that corporate
card transactions exist for an inactive employee. He can either accept delegation or reassign it to another person.

If no unpaid corporate card transactions exist for an inactive employee, then delegation is removed from the manager if
it was assigned previously.
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If the direct manager already has delegation, he receives a notification, informing him that corporate card transactions
exist for an inactive employee. The manager can then submit the unpaid corporate card transactions in an expense
report on behalf of the inactive employee.

Note:  If a person other than the inactive employee's manager accepts delegation, every subsequent notification is
sent to both the inactive employee's manager and the delegate.

If the direct manager is also inactive, then the next level manager receives the notification. In case the next level
manager is also inactive, then the users with the corporate card administrator role receive the notification. You can
change this default rule by defining custom routing rules in BPM workflow to send notifications for inactive employee
corporate card transactions as per the requirements of your organization.

When unpaid card transactions for inactive employees are submitted in a report and are paid, delegation is removed
from the manager or other designated person.

Alternatively, you can skip the Upload Corporate Card Transactions process if it's irrelevant, and run the Process
Corporate Card Transactions for Inactive Employees. To run the process, click the Process Corporate Card
Transactions for Inactive Employees link in the Tasks list. This process is run using two parameters: the Business Unit
with which the inactive employee was associated and a value for the Number of Days.

Note:  If the delegate of an inactive employee doesn't have the access to inactive employees' project and accounts,
you can modify the delegation settings and provide the appropriate access. To know more about this, refer the Set Up
Delegations topic.

Related Topics
• How Downloading Corporate Card Transaction Files From American Express Are Processed

• How Corporate Card Transaction Files Are Processed

• How Corporate Card Issuer Payment Requests for Company Pay Transactions Are Processed

• What's a corporate card program?

• Set Up Delegations

How Downloading Corporate Card Transaction Files
From American Express Are Processed  
To download corporate card transaction files from American Express, you must set up Oracle Fusion Expenses to
download data files in conjunction with the Upload Corporate Card Transaction File program.

Note:  You can only download American Express transaction files.
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Settings That Affect Downloading Corporate Card Transaction Files From
American Express
Before you can download transaction files from American Express servers, you must set up a Secure File Transfer
account with American Express and obtain the user name and password that identifies your customer account on the
Secure File Transfer server.

To set up the transaction file transfer parameters for the American Express corporate card program, enter the values in
the following table on the Transfer Parameters tab on the Create Corporate Card Program page.

Parameter Description

Download Profile Name
 

Name you enter to identify the download parameters.
 

Account Name
 

Name provided by American Express that identifies your customer account.
 

Account Password
 

Password for the American Express customer account.
 

File Name Prefix
 

File name prefix provided by American Express.
 

Server
 

Name of the American Express server to connect to for the transaction file download.
 

Tip:
American Express also provides a server at fsgatewaytest.aexp.com for transaction file transfer
testing.
 

How Downloading Corporate Card Transaction Files From American
Express are Processed
After you complete the tasks for corporate card transaction download, you can use the Upload Corporate Card
Transaction File program with the profile name as a download parameter to download corporate card transaction files
from American Express.

Note:  American Express places one or multiple transaction files at a time in a folder called Outbox in your customer
account. The Upload Corporate Card Transaction File program, however, processes only one file at a time. The process
picks up the oldest file each time. To pick up multiple files, you must schedule the Upload Corporate Card Transaction
File process to run multiple times.
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Upload VISA, MasterCard, and Diner's Club Corporate
Card Transactions Files  
Before you can process VISA, MasterCard, and Diner's Club corporate card transaction files, you must set up an HTTPS
server, configure the corporate card programs setup, and verify the HTTPS server setup.

Setting Up the HTTPS Server
When you set up the HTTPS server, ensure the following:

1. Install a web server and enable HTTPS.

◦ The server must be externally accessible.

◦ The server must have a valid certificate, such as Verisign.

2. Create the outbox directory on the server.

◦ Create a directory on the HTTPS server to receive corporate card transaction files.

◦ Secure the directory with a user name and password.

◦ Enable the directory so it's visible to external users who have read access.

Note:  You must either receive corporate card transaction files directly to the directory from the card issuers or move
the transaction files to this directory from an alternate location where the transaction files are initially received.

Configuring the Corporate Card Programs Setup
To configure the corporate card programs setup, perform the following steps:

1. In the Upload Parameters section on the Create or Edit Corporate Card Programs page, do the following:

◦ Create a profile with your server address, user name, and password:

For example, a server address of Vision.com/outbox represents the path to the directory, Vision.com/
outbox, that you created.

◦ Enter the full file name of the corporate card transaction file in the File Name Prefix field.

Note:  Use the same file name for all files. You must remove or rename the processed files on the
server either manually or automatically after every run.

2. Schedule the Upload Corporate Card Transaction Files process to automatically pull and process the transaction
files.

Note:  The Upload Corporate Card Transactions process supports only user name and password-based
authentication.
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Verifying the HTTPS Server Setup
To verify the HTTPS server setup, perform the following steps:

1. Verify that the HTTPS server has a valid certificate.

◦ In your browser, enter the server address, such as https://Vision.com/outbox.

If you don't see an error message that indicates an invalid server certificate or an mistrusted server
certificate, then the certificate is correctly installed.

2. Verify that the directory is accessible and secured.

◦ After navigating to the server address, such as https://Vision.com/outbox, if you see a login screen,
then the directory is accessible and secured.

◦ Sign in with user name and password to ensure that the user has access to the outbox directory.

Related Topics
• How Corporate Card Transaction Files Are Processed

Exclude Adjustment Records in MasterCard Transaction
File Upload  
You can exclude the MasterCard adjustment transactions in the <FinancialAdjustmentRecord_5900> records from
getting created as expenses using the ORA_EXM_MC_EXCLUDE_ADJUSTMENTS lookup type.

To this lookup type, add the adjustment reason codes of the adjustment records that you want to exclude as lookup
codes. During the MasterCard transaction file upload, the Expenses application will process these records and exclude
them from getting created as expenses where the adjustment reason codes match the lookup codes added to this
lookup type.

Note:  Even though the adjustment transactions are added to the lookup table, they will still get loaded to Expenses
and you can view them on the Review Corporate Card Transactions page. However, no expenses are created for these
adjustment transactions.

Before you define the lookup codes in the ORA_EXM_MC_EXCLUDE_ADJUSTMENTS lookup type, ensure that you
have the complete list of adjustment reason codes that you want to exclude. The lookup type is empty by default.
You must add the adjustment reason codes that you want to exclude. Once you add adjustment reason codes to
the ORA_EXM_MC_EXCLUDE_ADJUSTMENTS lookup type, the Expenses application will exclude only the defined
adjustment reason codes.

If you don’t define any lookup codes in the ORA_EXM_MC_EXCLUDE_ADJUSTMENTS lookup type, the upload process
automatically excludes the payment transactions based on any one of these criteria:

• The adjustment description of the <FinancialAdjustmentRecord_5900> record contains the word Payment
without any of these keywords: Fee, Charge, Reversal, Adjustment, Credit, or Debit.

• The transaction type of the <FinancialAdjustmentRecord_5900> record is 0108 or 0440.
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Note:  If the automatic exclusion of the payment transactions works for you or if you are uncertain of the list of
adjustment reason codes to exclude, don't add lookup codes to the ORA_EXM_MC_EXCLUDE_ADJUSTMENTS lookup
type.

This figure shows an example of a <FinancialAdjustmentRecord_5900> record with Payment word in the adjustment
description, and the transaction type is 0108.
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This is a sample adjustment transaction that's eligible for automatic exclusion when there are no adjustment reason
codes defined in the lookup type.

Add the Adjustment Reason Codes to Exclude Adjustment Transactions
This example demonstrates how to exclude the <FinancialAdjustmentRecord_5900> adjustment transactions with
adjustment reason code 0108 from getting created as expenses using the ORA_EXM_MC_EXCLUDE_ADJUSTMENTS
lookup type. With this configuration, the application will process all the other adjustment transactions, such as those
with adjustment reason codes 0160 and 0440, and add them as expenses.

This figure shows an example of the adjustment transaction from the Feed file.

Here's how you can use the ORA_EXM_MC_EXCLUDE_ADJUSTMENTS lookup type to exclude the MasterCard
adjustment transactions in the <FinancialAdjustmentRecord_5900> records from getting created as expenses:

1. In the Setup and Maintenance work area, go to the following:

◦ Offering: Financials

◦ Functional Area: Expenses

◦ Task: Manage Standard Lookups

2. Click the Manage Standard Lookups link.
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3. On the Manage Standard Lookups page, Search section, enter ORA_EXM_MC_EXCLUDE_ADJUSTMENTS in
the Lookup Type field and click Search.

4. In the ORA_EXM_MC_EXCLUDE_ADJUSTMENTS: Lookup Codes section, click the New (+) icon to add lookup
codes for each of the adjustment transactions that you would like to exclude.

5. In the Lookup Code field, enter the adjustment reason code that you would like to exclude, such as 0108.
6. In the Meaning field, enter the description of the adjustment record.
7. Ensure that the Enabled check box is selected.
8. In the Start Date field, provide an older start date so that the transactions after that date are excluded.
9. Click Save or Save and Close.

In this setup, the application will exclude transactions for <FinancialAdjustmentRecord_5900> with the adjustment
reason code 0108. The application will process all the other adjustment transactions and add them to the employee’s
Expenses work area.

Enable Pretty Good Privacy (PGP) for Corporate Card
Transaction Files  
This topic describes how to enable PGP for Visa, MasterCard, or Diner's Club corporate card transaction files. First, you
create a PGP encryption certificate and provide it to the card issuer.

Using the PGP certificate that you provide, the card issuer encrypts your corporate card transaction files and sends
them to the server that hosts the files for you. Finally, you run the Upload Corporate Card Transaction File process,
which decrypts the files in memory and processes the transactions.

Note:  PGP encryption isn't applicable to American Express.

Prerequisites
To receive files directly from Visa, MasterCard, or Diner's Club, you must set up an HTTPS or SFTP server at your site
or with a third party. Alternatively, you can set up an HTTPS or SFTP server at the card issuer's site so it can host your
corporate card transaction files. It's recommended to use SFTP.

Note:  Oracle Expenses Cloud doesn't allow card issuers to directly push corporate card transaction files to your Cloud
environment.

Create a PGP Encryption Certificate
To create a PGP encryption certificate for uploading corporate card transactions files, perform the following steps:

1. Sign in to Oracle Applications Cloud as a user with the IT Security Manager role.
2. From the Springboard, navigate to Tools > Security Console.
3. Select the Certificates tab.
4. Click the Generate button to open the Generate page.
5. From Certificate Type, select the PGP option.
6. In the Alias field, enter an alias.

Note:  Use this alias when defining the Corporate Card Program’s transfer parameters.
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7. In the Passphrase field, enter a password.

CAUTION:  Store the password in a safe location. You require this password to delete this certificate in the
future.

8. From the Key Type choice list, select RSA.
9. From the Key Length choice list, select the length that you want to use.

10. From the Encryption Algorithm choice list, select the algorithm that you want to use.

Note:  Select the length as 2048 and the algorithm as AES256 for stronger encryption.

11. Click the Save and Close button.

Export a PGP Encryption Certificate
To export the PGP encryption certificate to your card issuer, perform the following steps:

1. On the Certificates page, select the row with the alias you defined while creating a PGP Encryption Certificate,
and click the down arrow to open actions available for this certificate.

2. Select Export > Public Key.
3. Save the public key file.
4. Provide the public key file to your card issuer.

Note:  Using the public key, your card issuer must encrypt your corporate card transactions files.

Import a Signature Certificate from Your Bank

1. Sign in to Oracle Applications Cloud as a user with the IT Security Manager role.
2. From the Springboard, navigate to Tools >  Security Console.
3. Select the Certificates tab.
4. On the Certificates page, click Import and select the certificate that you received from your bank for signature.
5. In the Alias field, enter an alias.

Note:  Use this alias when defining the Corporate Card Program’s transfer parameters.

6. Click Save and Close.
7. Sign in to Oracle Applications Cloud as a user with the Corporate Card Admin role.
8. On the Edit Corporate Card Programs page, define the parameters for the card program. Provide the alias that

you used in step 5.
9. Click Save and Close.

Verify Encrypted Files
Contact the card issuer to verify that the files are encrypted.

Process Encrypted Transaction Files
Run or schedule the Upload Corporate Card Transaction File process. The process uses the alias, decrypts the corporate
card transaction files, and processes the transactions.
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Set Up to Receive American Express GL1025 Tokenized
Files  
Your company can receive and process American Express GL1025 files with card disguising numbers, also known as
tokenized GL1025 files. Card disguising numbers, or token numbers, are random numbers generated by American
Express that are used in place of valid card numbers.

The token numbers remain the same throughout the life of the cards. Using tokenized GL1025 files eliminates storage of
full card numbers and lets you use the American Express remittance process, Global Remittance Utility.

Note:  Only American Express GL1025 files support tokenization. You can no longer load files that contain full card
numbers.

To receive tokenized GL1025 files from American Express, you must:

• Set up your company in American Express

• Set up your company in Expenses

• Upload tokenized files

Setting Up Your Company in American Express
To receive tokenized GL1025 files instead of standard GL1025 files, contact American Express through your AMEX
representative. You must decide and inform American Express of the following:

• Regions, territories, or countries for which you want to receive tokenized files

• Mailbox or user account where you want to receive tokenized GL1025 files on the American Express production
server

• File prefix: A unique file prefix that identifies your GL1025 files in the American Express folder. The file prefix is
mutually agreed to by you and American Express.

• Mailbox or user account where you want to receive test files

American Express lets you use production files for testing. It can place production files on the AMEX production server
or the test server. Notify American Express of your server preference for testing.

After American Express sets up your company for tokenized GL1025 files, you can start testing in Expenses.

Setting Up Your Company in Expenses
To receive tokenized GL1025 files, you must create a card program with tokenization enabled by performing the
following steps:

1. Sign in to Expenses as a corporate card administrator.
2. In the Setup and Maintenance work area, go to the following:

◦ Offering: Financials
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◦ Functional Area: Expenses

◦ Task: Manage Corporate Card Programs

3. Click the Create icon.
4. On the Create Corporate Card Program page, perform the following steps:

a. In the Name field, enter a name for your corporate card program.
b. From the Card Type choice list, select Travel.
c. From the Card Brand choice list, select American Express.
d. Select the Upload Rules tab.
e. In the File Format field, American Express GL1025 is read-only.
f. From the Card Number Format choice list, select Token.

g. Select the Transfer Parameters tab.
h. Transfer parameters define the connection details between Expenses and American Express.
i. Click the Create icon to open the Create Transfer Parameter dialog box.

i. In the Download Profile Name field, enter meaningful values to identify the connection details.
For example, if you're creating the connection details for connecting to the American Express test
server, you might enter AMEX Test.

ii. In the Account Name field, enter the user name of the mailbox where GL1025 files are placed.
iii. In the Account Password field, enter a password for your mailbox.
iv. In the File Name Prefix field, enter your prefix for the GL1025 files. The Upload Corporate Card

Transactions process processes files with this prefix.
v. In the Server field, enter the name of the American Express server where your mailbox exists.

GL1025 files are always placed in the outbox folder as follows:

a. fsgatewaytest.aexp.com for test server
b. fsgateway.aexp.com for production server

vi. Click Save and Close.
5. In the Company Accounts section, click on the Create icon to open the Create Company Account dialog box.

a. In the Company Account Name field, enter the name of your company account with American Express.
b. Optionally, enter values that American Express provides to your company in the following fields:

- Company Account Number
- Market Code
- Requesting Control Account Number

c. From the Card Issuer choice list, select the name of the company that's issuing the American Express
card to its employees.

d. From the Card Issuer Site choice list, select the site of the company that's issuing the American Express
card to its employees.

e. From the Payables Business Unit choice list, select the Oracle Payables business unit that reimburses
employees for corporate card charges.

f. From the Payment Currency choice list, select the three-letter code that represents the currency in which
reimbursements are made.

g. From the Payment Option choice list, select the option that determines whether your company, its
employees, or a combination of the two are responsible for paying the credit card issuer.

h. Remittance Details section: Captures additional parameters for the generation of remittance advice.
Remittance advice is a file that provides the amount paid by your company to American Express by credit
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card number. The Global Remittance Utility uses the tokenized card number instead of the real card
number.

i. In the Book Number field, enter the financial accounting identifier used in the US and Canada for
American Express

j. In the Load Number field, enter the sender identifier in a remittance file that's transmitted to American
Express. This identifier is provided by American Express.

k. From the Card Issuer Country Code choice list, select the applicable two-letter country code.
l. In the Card Disguising Control Account Number field, enter the control account for the token numbers.

CAUTION:  If you currently receive standard GL1025 files, you can convert your existing card program to a tokenized
program. However, you should not create a new card program because all cards will be recreated by the new card
program.

Uploading Tokenized Files
Uploading and processing tokenized GL1025 files is exactly the same as the standard GL1025 files. The process creates
tokenized cards and matches them to employees if employee numbers are provided in the GL1025 files. Employee
numbers in the GL1025 files must match person numbers in Oracle Fusion Human Capital Management.

To upload tokenized files, perform the following steps:

1. Manually run or schedule the Upload Corporate Card Transactions process from the Corporate Cards work area.
2. Review the upload results in the Corporate Cards work area and correct any errors.
3. On the Review Corporate Card Transactions page, review unassigned cards and assign them to the correct

employees. On this page, you can see the tokenized card numbers, not the real card numbers.

All corporate card processes support tokenized cards. This includes the following processes:

• Manage Historical Corporate Card Transactions process

• Create Corporate Card Issuer Payment Requests process

Enable Tokenization for Visa VCF4 Files  
Oracle Expenses accepts Visa VCF4 files that are tokenized. Visa tokens can include numbers and characters.

To enable tokenization for Visa VCF4 files, complete these steps:

1. In the Setup and Maintenance work area, select:

◦ Offering: Financials

◦ Functional Area: Expenses

◦ Task: Manage Corporate Card Programs

2. On the Manage Corporate Card Programs page, click the + (Create) icon.
3. On the Create Corporate Card Program page in the Name field, enter a name for your Visa corporate card

program.
4. From the Card Type choice list, select Procurement or Travel.
5. From the Card Brand choice list, select Visa.
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On the Upload Rules tab, the File Format label shows Visa VCF4 as read-only.
6. From the Card Number Format choice list, select Token.
7. Click Save and Close.

Simplified Configuration for MasterCard CDF3 and Visa
VCF4 Files  
You can set up your company account with MasterCard under a single company account number globally. This
simplified configuration supports corporate card transaction files that are generated for multiple entities in your
company under a single company account number.

The same setup is also available for Visa card programs.

To simplify your company account setup on the Create Company Account dialog box, you're not required to enter values
for these fields:

• Company Account Number

• Card Issuer Number

• Processor-Assigned Number

For added convenience, if your company accounts aren't set up so they correspond to business units, the application
can perform employee matching across all business units. This matching occurs when a transaction in a charge file
matches a company account based on the information that came in the transaction, but the employee number isn't in
the same business unit. To match employee transactions across business units, select the Perform employee matching
across all business units check box on the Create Corporate Card Program page, File Details section, Upload Rules tab.

When you run the Upload Corporate Card Transaction Files process, it uploads and validates your corporate card
transactions files.

Related Topics
• Upload VISA, MasterCard, and Diner's Club Corporate Card Transactions Files

• Steps Your Administrator Takes to Receive Transaction Files from a Card Issuer

• How You Upload Corporate Card Transactions with Encrypted Card Numbers

Upload American Express Non-Financial Transactions  
To upload American Express non-financial transactions, you must create the lookup type EXM_CC_AMEX_NF_FEES.
Non-financial transactions are transactions where the MIS transaction code is NF in the corporate card transactions file.
Examples of non-financial transactions include a membership rewards annual fee and a membership reinstatement fee.

Create the lookup type EXM_CC_AMEX_NF_FEES with its associated lookup codes.

1. In the Setup and Maintenance work area, use:

◦ Offering: Financials
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◦ Functional Area: Expenses

◦ Task: Manage Standard Lookups

2. On the Manage Standard Lookups page in the Search Results section, click the New icon.
3. In the Lookup Type field, enter EXM_CC_AMEX_NF_FEES.
4. In the Meaning field, enter an applicable meaning.
5. In the Description field, enter an applicable description.
6. From the Module choice list, search and select Expenses.
7. Click Save.
8. In the EXM_CC_AMEX_NF_FEES: Lookup Codes section, add lookup codes for each of the non-financial

transactions that you would like to load.
9. In the Lookup Code field, enter a code that represents the name of the lookup code, such as NF_MEMRWDS.

10. In the Meaning field, you must enter the same description you receive in the feed, such as MEM RWDS
ANNUAL PROG.

11. In the Description field, enter a description for the lookup code meaning, such as Membership Rewards Annual
Fee.

12. Click Save and Close.
13. Schedule the Upload Corporate Card Transactions process to load the American Express non-financial

transactions.

Related Topics
• Travel Card Processing

Set Up Remittance Advice for American Express
Tokenized GL1025 Files  
If your company uses American Express tokenized GL1025 files, you can use the American Express remittance format,
Global Remittance Utility, to generate remittance advice. The typical company scenario unfolds when employees use
American Express corporate cards for business expenses and then submit expense reports.

After expense report approval, Oracle Payables pays the American Express invoice by making a single payment. You
can optionally send a remittance file to American Express that lists employee card holders and the amounts of their
respective payments.

Before you start, you must add the predefined privilege, Submit Corporate Card Remittance File, to your user account.
This privilege isn't assigned to any roles out of the box.

Enable the transmission of remittance advice for American Express tokenized GL1025 files by doing these tasks:

1. Configure the predefined American Express Global Remittance Utility format.
2. Create a remittance file format.
3. Create a transmission file configuration.
4. Modify the payment process profile.
5. Submit the payment process request.
6. Run the Submit Corporate Card Remittance File process.
7. Transmit the remittance advice to American Express.
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Configure the Predefined American Express Global Remittance Utility
Format
You must configure the predefined remittance advice format to reflect your company details. To configure the Global
Remittance Utility format, sign in as a user with access to Reports and Analytics.

1. Sign into the Oracle BI Publisher server with the BI Administrator Role.
2. On the Oracle BI Publisher home page, click the Catalog menu.
3. On the Catalog page in the Folders pane, expand Shared Folders > Financials > Payments.
4. Locate Disbursement Corporate Credit Card Remittance Formats.
5. From the More menu, select Customize to create a copy of the report so you can upload a custom template.
6. In the Disbursement Corporate Credit Card Remittance Formats page, click the Edit link to download and save

the CorporateCreditCardRemittanceFile.rtf to your local drive.
7. On your local drive, navigate to the saved RTF file and open it.
8. Locate Record Type 00 in the OutboundPaymentInstruction table.
9. At position 3, change the text in the <DATA> column to reflect your company's Global Corporate Identifier.

American Express provides this value.
10. Locate Record Type 01 in the OutboundPayableLine table.
11. At position 3, change the text in the <DATA> column so it reads as follows after IF SUM:

(DocumentPayableLine/LineGrossAmount/Value) < 0 THEN '+' ELSE '-' END IF

12. At position 4, change the text in the <DATA> column so it reads as follows after ABS:
(ROUND (SUM (DocumentPayableLine/LineGrossAmount/Value)*100))

13. Starting at position 223, add the Card Disguising Number Control Account in the <DATA> column. The range of
the position is from 223 to 241.

Note:  The Card Disguising Number may or may not be the control account that the cards belong to.
Regardless, the card number disguising is set up at the control account number. All accounts below this
hierarchy level are disguised.

14. Locate Record Type 02 in the OutboundPaymentInstruction table.
15. At position 85, add the payment date in the <FORMAT> column.
16. At position 85 in the <DATA> column, add InstructionGrouping/PaymentDate.

Tip:  The payment date must be on or after the payment file date.

17. Upload a copy of the modified template to Oracle BI Publisher.

Create a Remittance File Format
To create a remittance file format, complete these steps:

1. In the Setup and Maintenance work area, use:

◦ Offering: Financials

◦ Functional area: Payments

◦ Task: Manage Formats

2. On the Manage Formats page from the Select Type choice list, select Disbursement Corporate Credit Card
Remittance File.

3. Click Create.
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4. On the Create Format page in the Name field, enter a name for the remittance file format.
5. In the Code field, enter a code for the remittance file format.
6. From the BI Publisher Template choice list, select the template that you uploaded to BI Publisher.
7. Click Save and Close.

Create a Transmission Configuration
To create a transmission configuration, complete these steps:

1. In the Setup and Maintenance work area, use:

◦ Offering: Financials

◦ Functional area: Payments

◦ Task: Manage Transmission Configurations

2. On the Manage Transmission Configurations page from the Select Protocol choice list, select Secure File
Transfer Protocol for Static File Names.

3. Click Create.
4. On the Create Transmission Configuration page in the Configuration field, enter a name for the configuration.
5. In the Value field for Sent File Name, enter GRU.<your company ID>.&REQUESTID.&PAYMENTFILEID.&DATE.
6. Obtain the necessary parameter values to enter from American Express.
7. Click Save and Close.

Modify the Payment Process Profile
To modify the applicable payment process profile, complete these steps:

1. In the Setup and Maintenance work area, use:
a. Offering: Financials
b. Functional area: Payments
c. Task: Manage Payment Process Profiles

2. On the Payment File tab, select the Payment date check box.
3. Click Save and Close.

Submit the Payment Process Request
To submit the payment process request to pay American Express, complete these steps:

Tip:  Make a note of the payment file reference number because you will select it later when you run the Submit
Corporate Card Remittance File process to generate the remittance advice.

1. In the Oracle Payments work area, click the Tasks icon and click the Submit Payment Process Request link.
2. On the Submit Payment Process Request page, select the Selection Criteria tab, and complete the applicable

fields.
3. For Pay Groups, select Specific.
4. In the Search and Select: Pay Group dialog box, search and select the pay group that you chose for the

American Express company account when you set up the American Express card program in Oracle Expenses.
This ensures that only invoices related to American Express will be picked up in the payment batch.

5. Select the Payment and Processing Options tab and complete the applicable fields.
6. Click Submit.
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Run the Submit Corporate Card Remittance File Process
Schedule or run the Submit Corporate Card Remittance File process.

1. Navigator > Tools > Scheduled Processes.
2. Click Schedule New Process.
3. In the Schedule New Process dialog box, search and select Submit Corporate Card Remittance File.
4. Click OK.
5. In the Process Details dialog box of the Submit Corporate Card Remittance File process, enter these parameter

values.

Field Name Parameter Value

Payment File choice list
 

Reference number of payment file that was generated when the payment was made to American
Express.
 

Format choice list
 

Name of customized remittance advice format that you configured in BI Publisher.
 

File Sequence Number field
 

User-defined value. This value must be unique and entered within a day of transmission for each
Global Corporate Identifier.
 

File Version Number field
 

The default value is 00.
 
If American Express rejects any remittance file and if you resubmit the same file, you must increment
the value to 01, 02, 03 and so on to represent the new version. The latest version replaces the previous
version.
 

Transmission Configuration choice list
 

Transmission configuration that you set up to transmit Global Remittance Utility files to American
Express.
 

Transmit the Remittance Advice to American Express
In the Process Details dialog box of the Submit Corporate Card Remittance File process, click Submit. The remittance
advice file is then automatically transmitted to American Express.

Related Topics
• How You Use Oracle Analytics Publisher to Modify Templates for Use with Formats

• How You Set Up Transmission Configurations

• Payment Process Profiles

• How You Set Up Formats

Upload dual currency corporate card transactions  
Corporate card administrators can enable a company account to accept corporate card charges in currencies other than
the payment currency configured for the account by enabling the Allow multiple billed currencies option.
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When this option is enabled, Expenses converts the billed amounts in other currencies from the card feed file to the
payment currency of the company account using the daily currency conversion rates available in Oracle Fusion General
Ledger. If the conversion rate isn't defined in the General Ledger Daily Rates table, the transaction is marked invalid with
the status Missing currency conversion rate.

Card issuers in certain countries bill their customers in two currencies through dual currency corporate cards. The local
transactions made within the country are billed in local currency. The foreign transactions are billed in an agreed upon
stable currency. For example, all foreign charges are billed in USD. The transaction file of dual currency corporate cards
contain transactions with billed currencies in local currency and a foreign currency. When the company pays the card
issuer, all the charges are paid in the local currency. To support this payment in local currency, the card issuer provides
an average conversion rate separately.

To enable this feature, perform these steps:

1. Log in as the Corporate Card Administrator.
2. On the Manage Corporate Card Programs page in the Setup and Maintenance work area, select the corporate

card program.
3. In the Company Accounts section, click the company account to modify.
4. In the Edit Company Account dialog box, select the Allow multiple billed currencies option.
5. Click Save and Close.
6. On the Edit Corporate Card Program page, click Save and Close.

The following scenario illustrates how the transactions of a dual currency corporate card are processed when the Allow
multiple billed currencies option is enabled. AMEX GL1025 file format is considered for this scenario.

Linda is an employee based in Argentina and her employer has a dual currency card program with ARS as the payment
currency and USD as the currency for foreign billing. The dual currency card charges her expenses in Argentina in ARS,
which is the local currency. When Linda travels to the US, all the transactions are billed in USD. If Linda travels to Spain,
all the transactions are billed in EUR and converted to USD in the card feed file. The transactions in ARS and USD are
sent in the same card feed file and can be uploaded to Expenses for processing.

In this scenario, Expenses processes the card feed file and pays the card issuer in ARS when:

• Payment Option is set to Both Pay

• Payment Currency of the company account is ARS

• Allow multiple billed currencies option is enabled for the company account

The transactions are processed and all the charges in the file for that company account are converted to ARS using the
conversion rates from GL Daily Rates as of the transaction dates.

These transactions were made on her card:

1. Purchased an item for personal use for 1000 ARS. This transaction was made in the local currency ARS and
captured in ARS in the file.
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2. Paid 120 USD for a business meal which was captured in USD in the file. When the file is uploaded and
processed, the transaction made in USD is converted to ARS by Expenses and is displayed as follows on the
Review Corporate Card Transactions page:

The transaction is rejected if the conversion rates aren't available in GL Daily Rates for a given currency or a
transaction date. You must ensure that conversion rates are available for those currencies for the time ranges
applicable to the transactions.
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3. Purchased a computer peripheral for 25 EUR. This transaction was converted to 30 USD in the card feed file.
The transaction is converted to ARS by Expenses and is displayed as follows on the Review Corporate Card
Transactions page:

American Express sends the billed amounts in two currencies in the data file, which are ARS and USD, and expects a
payment in the local currency as per the market regulation. A total payment of 15,545.50 ARS is to be made.

After successful validation, the transactions are available to employees in their Expenses work area. They can view the
billed amounts converted to ARS and the original receipt amounts.

This image shows the Expenses work area displaying the transaction of 1000 ARS.

78



Oracle Fusion Cloud Financials
Implementing Expenses

Chapter 2
Credit Card Data

This image shows the Expenses work area displaying the transaction of 120 USD and its equivalent amount in ARS.
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This image shows the Expenses work area displaying the transaction of 25 EUR and its equivalent amount in ARS.
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Employees can add these expenses to their expense reports and submit them for reimbursement.

After the expense report is approved and audited, the auditor runs the Process Expense Reimbursement process to
create payment requests for the employees and the card issuers. The payment request is generated in ARS for the card
issuer.
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At statement close, American Express converts the foreign currencies to local currency using the conversion rates as of
the cutoff date. These may differ from the conversion rates in the GL Daily Rates tables. The organization must identify
the variations arising out of such differences in conversion rates outside Expenses, and pay any remaining amounts to
the card issuer or use the debit memo to get refunded for any additional amounts paid.

Change Payment Options for Unpaid Transactions  
A company account can have payment options, such as Individual, Company, or Both. You may have to change the
payment option of a company account based on your requirements.

Change Payment Option
Here are the steps to change the payment option of a company account:

1. In the Setup and Maintenance work area, select these options:

◦ Offering: Financials

◦ Functional Area: Expenses

◦ Task: Manage Corporate Card Programs

2. On the Manage Corporate Card Programs page, select the corporate card program.
3. In the Company Accounts section, click the company account to modify.
4. In the Edit Company Account dialog box, change the payment option as required.
5. Based on the option you selected, you may have to enter additional information.
6. Click Save and Close.
7. If there are existing unpaid transactions, a message is displayed informing that the payment option of existing

unpaid transactions won't be changed. Click Yes.
8. On the Edit Corporate Card Program page, click Save and Close.

After you change the payment option of a company account, all new transactions use the revised payment option.
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Change Payment Option of Existing Transactions
If the expenses corresponding to the existing transactions are already submitted for approval, the payment option
isn't revised automatically when the payment option of the company account is modified. However, you can manually
change the payment options of these transactions if they aren't in the Approval Complete, Ready for Payment, or Paid
status. You can also change the payment option of transactions whose corresponding expenses aren't yet added to an
expense report.

Here are the steps to change the payment option of such transactions:

1. On the Review Corporate Card Transactions page, search for the unpaid transactions using the Transactions
Due Payment Processing saved search.

2. In search options, select the corporate card program and company account name applicable to the transactions
you want to update. Click Search.

3. From the search results, select the transactions whose payment option you want to modify.
4. Select Actions > Update Payment Option.
5. Select the new payment option.
6. In the message dialog box, click Yes.

The payment option of the transactions is modified.

Enable Notifications for Credit Card Charges  
You can configure Expenses to send an email notification to employees when new corporate card charges are available
in their Expenses work area after corporate card transaction files are processed.

The application sends the notification email to the employee's work email. The notification lists all the new card
transactions created for an employee from the processed transaction files. If no new card expenses are added in the
Expenses work area for an employee, the employee will not receive the notification email. If an employee doesn't have a
work email, the application will not send the email notification to the employee.

Employees can either review the expense details in the notification or navigate to the Expenses work area to review and
submit the expense.

To enable notifications for credit card charges, complete these steps:

1. Sign in as an Application Implementation Consultant.
2. In the Setup and Maintenance work area, use the following:

a. Offering: Financials
b. Functional Area: Expenses
c. Task: Manage Expenses System Options

3. On the Manage Expenses System Options page, in the Corporate Options for Expense Report section, set
the system option, Enable Notifications for Credit Card Charges to Yes.

4. Click Save or Save and Close.

You can enable this at the implementation level on the Manage Expenses System Options page, which applies to all
business units. Alternatively, you can enable this for specific business units on the Create/Edit Business Unit window
in the Corporate Options for Expense Report tab.
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Use the Test Notification Email Address field in the development and test environments to specify a test email to which
the application delivers the email notifications. This is helpful in testing if the application delivers the email notifications
as required.

When you add an email address in this field, the application sends all the notifications only to this email address;
employees don't receive any notifications for their card expenses.

Note:  You can add an email address only when Enable Notifications for Credit Card Charges is Yes.

FAQs for Credit Card Data  

What's a corporate card program?  
A corporate card program is an agreement between the corporate card issuer and your company. The agreement
governs the issuance of corporate cards to your employees and the payment to the card issuer.

Your company can have a single card provider that provides corporate cards for your employees globally, which is
referred to as a global card program. Alternatively, you can have multiple card providers that provide corporate cards for
your employees based on the region and the services needed.

A corporate card program consists of one or more company accounts that represent a specific organizational hierarchy
in your company. Each company account is associated with:

• A card issuing bank, known as a card issuer

• Payment terms

• Other agreements

Your company can elect to receive electronic files containing the corporate card transactions of their employees on a
regular basis. The file format and method of delivery are agreed to and set up before your company processes corporate
card transaction files through Oracle Fusion Expenses.

How can I configure corporate card issuers?  
You can set up a corporate card issuer through the Manage Corporate Card Issuers page. You can enter the card issuer's
site information and payment information.

To pay a card issuer, enter a default payment method in the Address Payment Information section on the Edit Corporate
Card Issuer page. Then you associate the newly created card issuer with your company account on the Create Company
Account page. By selecting a payment currency and payment terms on the Create Company Account page, you can
complete the information necessary to pay the card issuer.

Related Topics
• What's a corporate card program?
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How can I enforce corporate card usage policies?  
Your company can set up corporate card usage rules to enforce its policies regarding the use of corporate cards.

On the Manage Corporate Card Usage Policies page, you can define the allowable amount expense category that can
be charged as a cash expense. Over this cash limit, employees are required to use their corporate cards. Employees who
exceed the cash limit receive either a warning message or an error message while completing expense entry. A warning
reminds employees to use the corporate card. An error prevents submission of the expense report. Expenses notifies
the expense auditor and the employee's manager of the policy violations. Alternatively, if no cash limits are defined, you
can submit cash expenses of any amount.

Can corporate card administrators view credit card numbers in
Expenses?  

No. Corporate card administrators can't view real card number in Expenses. They can only view tokenized card numbers.
To view full card numbers, you can request a GL1210 report from American Express.

Can corporate card administrators view full credit card numbers
associated with tokenized card numbers in American Express?  
Yes. Tokenized card numbers are provided only for payment processing. American Express continues to display full card
numbers, even if you receive tokenized card files.

To view full card numbers with their associated tokens, you can request transmission of a GL1210 report to your AMEX
mailbox.

How can I prevent workers from overriding the merchant name on
credit card transactions?  
By creating the profile option, EXM_DISABLE_CC_MERCHANT_NAME, and setting the value to Y. When this occurs, the
value in the Merchant Name field becomes read-only on the Create Expense Item page for both the web-based and the
mobile application.

A read-only value in the Merchant Name field prevents employees from changing it, which maintains data integrity.

Can I change the credit card charges notification template?  
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No. The credit card charges notification template is fixed and you can’t change.

How can I set up MasterCard as a centrally-billed card for travel
expenses?  
Upload MasterCard travel charges from your organization’s centrally-billed account for employee expenses. This
allows employees to pay for travel expenses using a single MasterCard account, rather than using individual corporate
cards. From the Expenses work area, employees can include these travel charges in their expense reports to provide
approvers with full visibility into the total cost of a trip.

There are two ways you can create a new centrally-billed MasterCard travel card:

• Create the card manually:
a. Sign in to Expenses as a corporate card administrator.
b. In the Setup and Maintenance work area, go to the following:

- Offering: Financials
- Functional Area: Expenses
- Task: Manage Corporate Card Programs

c. On the Manage Corporate Card Programs page, click the + (Create) icon.
d. On the Create Corporate Card Program page, enter a name for your Mastercard corporate card program

in the Name field.
e. Set Account Type to Centrally-billed card.
f. In the Card Number Format field, select Token.

Note:  A centrally-billed MasterCard travel card is only supported for tokenized card programs.

g. Ensure that the corporate card number matches the AccountNumber field in the MasterCard CDF3 data
file.

h. Fill out all other required fields as appropriate.
i. Click Save and Close.

• Create the card using a corporate card data file:
a. Schedule the Upload Corporate Card Transactions process, where the card data file contains transactions

from the new corporate card.

See the "Schedule the Upload Corporate Card Transactions Process" section of the Travel Card Processing
topic for more information.

b. On the Review Corporate Card Transactions page, the new card appears as unassigned. Edit the
corporate card and categorize set Account Type to Centrally-billed card.

c. Run the Upload and Validate process with validation only, and without the company account parameter
to revalidate the transactions.

Note the following points while using a centrally-billed MasterCard account for travel expenses:

• Due to the nature of the centrally-billed card, only Company Pay and Both Pay are supported.

See How Corporate Card Transaction Files Are Processed for more information.
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• Employee matching rule only supports employee number in compliance with MasterCard specifications. Every
centrally-billed MasterCard must have a valid employee number for proper matching.

See the "Employee Matching Rules" section of the Options for Creating Corporate Cards topic.

• The employee ID that a centrally-billed MasterCard transaction is tagged with must belong to the same
business unit that the company account for the card belongs to. Otherwise, the transaction returns an "Invalid
employee number" error. The corporate card administrator has to manually assign the transaction to an
employee in the same business unit on the Review Corporate Card Transactions page.

Related Topics
• Travel Card Processing
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3  Expense Policies and Rules

Set Up Delegations  
A delegate is a person who's authorized to perform expense entry and management of another person's expense
reports. A delegation is the relationship between a delegate and the person for whom the delegate enters expense
reports. By setting up delegations, you can:

• Specify a delegate who enters expense reports for one or more people.

• Specify a person, or assignment, for whom the delegate enters expense reports.

• Specify whether the delegate can change any or all accounting segments, such as company and cost center.

• Specify whether the delegate can change project or task information for project-related expenses.

Setting Up a Delegation
To set up a delegation, follow these steps:

1. In the Setup and Maintenance work area, use the following:

◦ Offering: Financials

◦ Functional Area: Expenses

◦ Task: Manage Delegations

2. On the Manage Delegations page, click the Create (+) icon.
3. On the Create Delegation page in the Delegate choice list, enter or select the name of the person who will enter

expense reports for one or more people.
4. From the Assignment choice list, enter or select the name of the person who's assigned to the delegate and for

whom the delegate enters expense reports.

Note:  If you need to assign a delegate for an inactive employee, you can even enter or select the name of the
inactive employee in the Assignment field.

5. If the assignment already has the accounting privilege named Override expense account allocation, select the
Accounting access check box.

6. If the assignment already has the project privilege named Allocate project expense, select the Project access
check box.

CAUTION:  Ensure that you check whether the assignment has the accounting or the project privilege access.
If you select the Accounting access or the Project access check box and the assignment doesn't already
have the applicable privilege set up in the Security module, then the person is given unintended access.

Edit a Delegation
Sometimes, you may have to modify an existing delegation. For example, you may have to edit an existing delegation to
provide accounting or project access to the delegate of an inactive employee.

89



Oracle Fusion Cloud Financials
Implementing Expenses

Chapter 3
Expense Policies and Rules

In such cases, search for the delegation you want to modify on the Manage Delegations page. You can search based on
different parameters, such as delegate, assignment, creation date, and so on. Similarly, if you're searching for delegation
of an inactive employee, searching based on the employee status parameter can help you easily find the delegation.

After you find the delegation, click the delegate and then make the required changes in the Delegation dialog box.

Related Topics
• How Corporate Card Transactions for Inactive Employees Are Processed

• How You Manage Delegates

How You Configure Approval Rules  
Oracle Fusion Expenses supports flexible and configurable approval rules for expense report approval using the
Approvals Management Extensions of the Oracle Service-Oriented Architecture (SOA) suite and Oracle Business
Process Management Suite (BPM). BPM provides the interface to administer the approval rules.

A BPM Worklist administrator who is assigned the role of Financial Application Administrator
(FUN_FINANCIAL_APPLICATION_ADMINISTRATOR) can access the approval rules in the BPM Worklist.

When you submit an expense report, Expenses invokes the approval process, which prompts a set of approval rules
created in AMX to build the list of approvers. Approvals Management Extensions sends approval notifications to
approvers every time it receives a response to an approval notification. AMX continues sending approval notifications to
the next set of approvers in the approval list until all approvals are complete.

The approval rules are managed through the Oracle BPM Worklist. Navigate to: Setup and Maintenance > Select:
Financials > Setup button > Functional Areas: Expenses > Show: All Tasks > Manage Expense Approval Rules >
Oracle BPM Worklist.

To configure or modify rules, perform the following steps:

1. In the BPM Worklist, select the Task Configuration tab.
2. From the Tasks to be configured pane, select FinExmWorkflowExpenseApproval.
3. Select the Assignees tab.
4. Click the Switch to Vertical Layout link. An approval hierarchy displays.
5. By the SoaOLabelExp rectangle, click the diamond icon and select Go to Rule.

The expense approval flow contains predefined rule sets with their associated approvers as described in the following
table:

Rule Set Approval by

ExpenseReportRuleSet
 

• CustomSerialParticipantRuleSet

• CustomParallelParticipantRuleSet

Supervisor
 

• Additional serial approval rules for configuration

• Additional parallel approval rules for configuration

CostCenterRuleSet
 

Cost center owners in parallel mode
 

ProjectManagerRuleSet Project managers in parallel mode
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Rule Set Approval by

  

ExpenseRuleSet
 

A specialist based on expense types in parallel mode
 

SerialCostCenterRuleSet
 

Cost center owners in serial mode
 

SerialProjectManagerRuleSet
 

Project managers in serial mode
 

SerialExpenseRuleSet
 

A specialist based on expense types in serial mode
 

ExpenseReportRuleSet: Approval by Supervisor
The predefined rule set for approval of expense reports using the supervisory hierarchy is called ExpenseReportRuleSet.
The predefined rules include the following:

• Approval by the immediate supervisor of expense reports with a report total over 1000

• Automatic response for all expense reports with a report total equal to or less than 1000

You can change the predefined rules, delete, or add rules as needed. The following table lists the parameters for the
ExpenseReportRuleSet rule set.

Rule Field Predefined Value Description

ExpenseReportManagerApprovalRule
 

Condition
 

Task.payload.getExpenseReportVOResponse.result.expenseReportTotal
 

Attribute that stores the expense
report total in the reimbursement
currency.
 

List Builder
 

Supervisory
 

The rule uses the supervisory
hierarchy to retrieve approvers.
 

Response Type
 

Required
 

The approval notification requires
a response.
 

Number of levels
 

1
 

Number of supervisory levels
required for approval completion.
 

Starting Participant
 

HierarchyBuilder.getManager("supervisory",Task.creator,-1,"","")
 

Person for whom the expense
report is created.
 

Top Participant
 

HierarchyBuilder.getPrincipal("FINUSER30",-1,"","")
 

Last approver in the approval
chain. Approval doesn't go beyond
this participant in a hierarchy. To
use this rule as is, you must change
the predefined last approver user
name to the last approver in your
organization.
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Rule Field Predefined Value Description

Auto Action Enabled
 

False
 

Automatic approval action is
disabled.
 

Auto Action
 

Null
 

No automatic approval action.
 

ExpenseReportAutoApprovalRule
 

Condition
 

Task.payload.getExpenseReportVOResponse.result.expenseReportTotal
 

Attribute that stores the expense
report total in the reimbursement
currency.
 

List Builder
 

Supervisory
 

The rule uses the supervisory
hierarchy to retrieve approvers.
 

Response Type
 

Required
 

The approval notification requires
a response.
 

Number of levels
 

1
 

Number of supervisory levels
required for approval completion.
 

Starting Participant
 

HierarchyBuilder.getPrincipal("workflowsystem",-1,"","")
 

Person for whom the expense
report is created.
 

Top Participant
 

HierarchyBuilder.getPrincipal(Task.creator,-1,"","")
 

Person for whom the expense
report is submitted.
 

Auto Action Enabled
 

True
 

Automatic approval is enabled.
 

Auto Action
 

Approve
 

The response is set to Approve.
 

ExpenseReportInactiveEmployeeManagerApproverRule
 

Condition
 

Task.payload.employeeInActive
 

Attribute that stores the condition.
 

List Builder
 

Supervisory
 

The rule uses the supervisory
hierarchy to retrieve approvers.
 

Response Type
 

Required
 

The approval notification requires
a response.
 

Number of levels
 

1
 

Number of supervisory levels
required for approval completion.
 

Starting Participant
 

HierarchyBuilder.getPrincipal(Task.payload.startingParticipant,-1,"","")
 

Person for whom the expense
report is created.
 

Top Participant
 

HierarchyBuilder.getPrincipal("FINUSER30",-1,"","")
 

Last approver in the approval
chain. Approval doesn't go beyond
this participant in a hierarchy. To
use this rule as is, you must change
the predefined last approver user
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Rule Field Predefined Value Description

name to the last approver in your
organization.
 

Auto Action Enabled
 

False
 

Automatic approval action is
disabled.
 

Auto Action
 

null
 

No automatic approval action. OR
The response is set to Approve.
 

Additional Serial Approval Rules for Configuration: This is an additional predefined rule set for serial approval
called CustomSerialParticipantRule. This rule set doesn't contain any predefined rules. You can use this rule set for
any additional combination of approval rules that needs to be executed sequentially with respect to the rules in
ExpenseReportRuleSet.

Additional Parallel Approval Rules for Configuration: This is an additional predefined rule set for parallel approval called
CustomParallelParticipantRule. This rule set doesn't contain any predefined rules. You can use this rule set for any
additional combination of approval rules that needs to be executed in parallel to the rules in ExpenseReportRuleSet.

ProjectManagerRuleSet: Approval by Project Managers in Parallel Mode
The predefined rule set for approval of expense reports by project managers is called ProjectManagerRuleSet. This
rule set has a single predefined rule. The rule says that if the total amount charged to projects is greater than zero, the
expense report is sent to the project manager for approval. Additionally, if expenses are charged to more than one
project, the applicable project managers receive the approval notification in parallel. The approval is complete when all
project managers identified as approvers have approved the expense report.

You can change the predefined rules, delete, or add rules as needed. The following table lists the parameters for the
ProjectManagerRuleSet rule set.

Rule Field Predefined Value Description

ProjectManagerApprovalRule
 

Condition
 

ExpenseReport/
projectTotalVO.total
 

Attribute that stores the total
expense charged against each
project in an expense report. The
view object only stores details
for expense reports that contain
projects.
 

List Builder
 

Resource
 

Static list of approvers.
 

Response Type
 

Required
 

The approval notification requires
a response.
 

Participants
 

ExpenseReport/
projectTotalVO.managerUsername
 

The approver of the expense report
is the project manager.
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CostCenterRuleSet: Approval by Cost Center Owners in Parallel Mode
The predefined rule set for approval of expense reports by cost center owners is called CostCenterRuleSet. This rule set
has the following predefined rules:

• If the total amount charged to cost centers other than the employee's default cost center is greater than zero,
the expense report is sent to the cost center owner for approval.

◦ If expenses are charged to a cost center other than the employee's default cost center, the applicable cost
center owners receive the approval notification in parallel. The approval is complete when all cost center
owners identified as approvers have approved the expense report.

• If the cost center of the expenses is the same as the default cost center of the employee, an automatic response
is generated that indicates there is no cost center approval.

You can change the predefined rules, delete, or add rules as needed. The following table lists the parameters for the
CostCenterRuleSet rule set.

Rule Field Predefined Value Description

CostcenterIsNotEmpDefaultCostcenterRule
 

Condition
 

ExpenseReport/
costCenterTotalVO.costCenter
 

Attribute that stores the cost
centers in the expense report.
 

Condition
 

Task.payload.getExpenseReportVOResponse.result.defaultCostCenter
 

Default cost center of the
employee.
 

List Builder
 

Resource
 

Static list of approvers.
 

Response Type
 

Required
 

The approval notification requires
a response.
 

Participants
 

ExpenseReport/
costCenterTotalVO.managerUsername
 

The approver of the expense report
is the cost center owner.
 

CostcenterIsEmpDefaultCostcenterRule
 

Condition
 

ExpenseReport/
costCenterTotalVO.costCenter
 

Attribute that stores the cost
centers in the expense report.
 

Condition
 

Task.payload.getExpenseReportVOResponse.result.defaultCostCenter
 

Default cost center of the
employee.
 

List Builder
 

Supervisory
 

The rule uses the supervisory
hierarchy to retrieve approvers.
 

Response Type
 

Required
 

The approval notification requires
a response.
 

Number of levels
 

1
 

Number of supervisory levels
required for approval completion.
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Rule Field Predefined Value Description

Starting Participant
 

HierarchyBuilder.getPrincipal("workflowsystem",-1,"","")
 

Person for whom the expense
report is created.
 

Top Participant
 

HierarchyBuilder.getPrincipal(Task.creator,-1,"","")
 

Person for whom the expense
report is submitted.
 

Auto Action Enabled
 

True
 

Automatic approval is enabled.
 

Auto Action
 

Approve
 

The response is set to Approve.
 

ExpenseRuleSet: Approval by a Specialist Based on Expense Types in
Parallel Mode
The predefined rule set for approval of expense reports based on the template name or any attributes of the expense
type is called ExpenseRuleSet. This rule set has the following predefined rules:

• If the template name for any of the expenses is Relocation Expenses, the expense report is routed to approval
by a predefined user.

• If the expense reports don't contain any expenses with the expense template Relocation Expenses, an
automatic approval response is generated that indicates there is no special approval.

You can change the predefined rules, delete, or add rules as needed. The following table lists selected parameters for
the ExpenseRuleSet rule set.

Rule Field Predefined Value Description

ExpenseTypeIsRelocationExpensesRule
 

Condition
 

ExpenseReport/
expenseVO.expenseTemplateName
 

Attribute that stores the cost
centers in the expense report.
 

List Builder
 

Resource
 

Static list of approvers.
 

Response Type
 

Required
 

The approval notification requires
a response.
 

Participants
 

User ID of the approver
 

The approver of the expense report
is a specialist.
 

ExpenseTypeIsNotRelocationExpensesRule
 

Condition
 

ExpenseReport/
expenseVO.expenseTemplateName
 

Auto approval enabled with
the same list builder criteria as
ExpenseReportAutoApprovalRule
 

List Builder
 

Supervisory
 

The rule uses the supervisory
hierarchy to retrieve approvers.
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Rule Field Predefined Value Description

Response Type
 

Required
 

The approval notification requires
a response.
 

Number of levels
 

1
 

Number of supervisory levels
required for approval completion.
 

Starting Participant
 

HierarchyBuilder.getPrincipal("workflowsystem",-1,"","")
 

Person for whom the expense
report is created.
 

Top Participant
 

HierarchyBuilder.getPrincipal(Task.creator,-1,"","")
 

Person for whom the expense
report is submitted.
 

Auto Action Enabled
 

True
 

Automatic approval is enabled.
 

SerialProjectManagerRuleSet: Approval by Project Managers in Serial
Mode
The predefined rule set for approval of expense reports in serial mode by project managers is called
SerialProjectManagerRuleSet. This rule set contains the same rule as the parallel approval, but the rule set is configured
to send the approval notifications sequentially to the approvers in the list. Each notification to a subsequent approver is
sent only after the current approver approves the expense report. If the current approver rejects the expense report, the
approval process is complete and the report returns to the user.

SerialCostCenterRuleSet: Approval by Cost Center Owners in Serial Mode
The predefined rule set for approval of expense reports in serial mode by cost center owners is called
SerialCostCenterRuleSet. This rule set contains the same rule as the parallel approval, but the rule set is configured to
send the approval notifications sequentially to the approvers in the list. Each notification to a subsequent approver is
sent only after the current approver approves the expense report. If the current approver rejects the expense report, the
approval process is complete and the report returns to the user.

SerialExpenseRuleSet: Approval by a Specialist Based on Expense Types in
Serial Mode
The predefined rule set for approval of expense reports based on a template name or any attributes of the expense type
is called SerialExpenseRuleSet. The rule set contains the same rule as the parallel approval, but the rule set is configured
to send the approval notifications sequentially to the approvers in the list. Each notification to a subsequent approver is
sent only after the current approver approves the expense report. If the current approver rejects the expense report, the
approval process is complete and the expense report returns to the user.
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How You Define Approval Rules  
Approval rules are configurable rules for expense report approval created in Approval Management Extensions. Oracle
Fusion Expenses provides nine predefined rule sets. By using the BPM Worklist, you can define new approval rules or
modify existing ones in AMX.

To manage approval rules, you must be a BPM Worklist administrator, such as a financial application administrator.

If you are authorized to manage the approval rules, you can:

• Modify existing approval rules

• Define new approval rules

• Understand and apply properties of rules and rule sets

If you are authorized to manage the approval rules, an Administration link displays in the corner of the BPM
Worklist. To define new approval rules or modify existing ones, click the Administration link, click the Task
Configuration tab, click the Data Driven tab to display the Data driven configuration page, and then select the
FinExmWorkflowExpenseApproval task from the Tasks to be configured pane.

Each rule set contains one or more approval rules. Each approval rule has an approval condition and a list of approvers.
The list of approvers derived for each rule set is called a participant. To generate the list of approvers, each rule requires
a list builder to be associated with it.

Each expense report can only satisfy one rule within a rule set. If an expense report does not satisfy any rule in a rule
set, the approval process errors and an incident is reported in Oracle Enterprise Manager Grid Control.

Modify Existing Approval Rules
In the Data driven configuration page, select a rule set to modify and click the Edit icon in the Tasks to be configured
pane. You can now add, modify, or delete rules within the specified rule set. The changes take effect when you click the
Commit Task icon in the Tasks to be configured pane. Saving changes by clicking the Save icon saves the changes, but it
does not activate them. If needed, you can undo changes by clicking the Reset icon.

Define New Approval Rules
To create new rules, you must provide values for the following rule components:

• Condition: Criteria that an expense report must satisfy

• Response type: Required or FYI. A response from the approver is required or the notification is informational.

• List builder: Creates a list of approvers for a specific notification

To define a condition, select a value from the list of values in the IF region. The Condition Browser displays. In the
Condition Browser, open a view object (folder) and select the attribute that you want to use as the criteria. You can add
multiple conditions to a rule. An example of a condition is: ExpenseReport.expenseReportTotal more than 1000.

The following table lists view objects (folders) that are visible in the Condition Browser with their associated attributes
and descriptions.
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Note:  The following table contains view objects with their associated attributes and descriptions that you can select
as conditions for expense report approval rules.

View Object in Condition Browser Attribute Description

ExpenseReport
 

ExpenseReportId
 

Expense report identifier
 

ExpenseReport
 

PersonId
 

Person identifier of the employee on the
expense report
 

ExpenseReport
 

AssignmentId
 

Primary assignment identifier of the employee's
assignment
 

ExpenseReport
 

ExpenseReportDate
 

Date of the latest expense in the expense report
 

ExpenseReport
 

ExpenseReportTotal
 

Total amount of the expense report in the
reimbursement currency
 

ExpenseReport
 

ReimbursementCurrencyCode
 

Expense report reimbursement currency
 

ExpenseReport
 

ReportSubmitDate
 

Date on which the expense report was
submitted for approval
 

ExpenseReport
 

ExpenseStatusCode
 

Most recent status of the expense report
 

ExpenseReport
 

ExpenseStatusDate
 

Date of the most recent status of the expense
report
 

ExpenseReport
 

OrgId
 

Business unit identifier of the expense report
 

ExpenseItem
 

ReceiptAmount
 

Expense amount in receipt currency
 

ExpenseItem
 

ReceiptCurrencyCode
 

Currency code of the expense amount
 

ExpenseItem
 

ExpenseSource
 

Source of the expense item, cash, or corporate
card
 

ExpenseItem
 

ExpenseTypeCategoryCode
 

Category of the expense item, such as Airfare or
Accommodations
 

ExpenseItem
 

ExpenseCategoryCode
 

Classification of expense item, such as Business
or Personal
 

ExpenseItem
 

ExpenseTemplateId
 

Expense template identifier for the expense
item
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View Object in Condition Browser Attribute Description

ExpenseItem
 

ExpenseTypeId
 

Expense type identifier of the expense item
 

ExpenseItem
 

PolicyViolatedFlag
 

Check box that indicates whether the expense
item has policy violations
 

ExpenseItem
 

ReceiptMissingFlag
 

Check box that indicates whether the user has
the original receipt
 

ExpenseItem
 

EmpDefaultCostCenter
 

Default cost center of the employee
 

CostCenterTotal
 

ExpenseReportId
 

Expense report identifier
 

CostCenterTotal
 

CostCenter
 

Cost center against which the expense is
incurred
 

CostCenterTotal
 

Total
 

Total expense charged to the cost center
 

CostCenterTotal
 

ManagerId
 

Person identifier of the cost center owner
 

CostCenterTotal
 

ManagerUsername
 

User name of the cost center owner
 

ProjectTotal
 

ExpenseReportId
 

Expense report identifier
 

ProjectTotal
 

PjcProjectId
 

Project identifier
 

ProjectTotal
 

Total
 

Total expense charged to the project
 

ProjectTotal
 

ProjectPartyId
 

Person identifier of the project manager
 

ProjectTotal
 

ManagerUsername
 

User name of the project manager
 

Each approval notification generated from an approval rule must have a response type of Required or FYI. You
specify the applicable response type in the THEN region on the Data driven configuration page of the BPM Worklist.
If the approver should take an action in response to the notification, click the Required radio button. If the approval
notification is designed as information only, click the FYI radio button.

Each rule requires a list builder to build the list of approvers. The following table contains the list builder types with their
associated descriptions that are available in the BPM Worklist.

List Builder Type Description

Supervisory
 

Ascends the primary supervisory hierarchy, starting at the expense report submitter or at a given
approver, and generates the approval chain.
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List Builder Type Description

Job Level
 

Ascends the supervisory hierarchy, starting at a given approver and continuing until an approver with
the appropriate job level is found.
 

Position
 

Ascends the position hierarchy, starting at a given approver's position and continuing until an approver
with the appropriate position is found.
 

Resource
 

A list of approvers. You can choose a user name or a function that returns a set of approvers.
 

Approval Group
 

Group of approvers. You can create approver groups consisting of a list of users for use in the rule sets.
 

Each list builder type requires values for specific fields to build its approval list. In the THEN region on the Data driven
configuration page of the BPM Worklist, select a type of list builder from the List Builder choice list and click the Create
Action button. The Add Variable dialog box displays where you add specific variables for specific list builders.

The following table contains the fields associated with each list builder type for which you must select specific values.

List Builder Type Field Description Values to Select and Sample Data

Supervisor
 

Number of Levels
 

A positive number specifying the
number of levels to traverse the
supervisory hierarchy.
 

A positive number based on your
needs. For example, use 1 for one
level of approval.
 

Supervisor
 

Starting Participant
 

The first participant in the list.
 

From the Add Variable dialog box,
 select:
 

• The Get Manager radio
button

• Supervisory as the List
Builder

• Reference User as
task.creator to start from the
person on the expense report

• An Effective Date if
applicable

This creates the following
string for the start participant:
HierarchyBuilder.getManager
("supervisory",Task.creator,-1,"","").
 

Supervisor
 

Top Participant
 

The last participant in the list. The
approval list does not go beyond
this person in a hierarchy.
 

From the Add Variable dialog box:
 

• Select the Get User radio
button.

• Enter the user name of the
last person in the approval
chain as the Reference User.

• Select an Effective Date if
applicable.
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List Builder Type Field Description Values to Select and Sample Data

This creates the following string
as the highest participant:
HierarchyBuilder.getPrincipal
("<>",-1,"","")
 

Supervisor
 

Auto Action Enabled
 

If automatic response should
be enabled for the approval
notification, set to True.
 

Not applicable
 

Supervisor
 

Auto Action
 

If automatic response is enabled,
 set the response.
 

For expense approval, use
Approve.
 

Position
 

Number of Levels
 

A positive number specifying the
number of levels to traverse the
position hierarchy. This number
can be an absolute value or a value
relative to the Starting Point or
Creator.
 

Not applicable
 

Position
 

Relative to
 

The number of levels to traverse
is relative to one of the following
values: Starting Point, Creator, or
Absolute.
 

• At most 2 relative to Starting
Point

• At least 2 relative to Starting
Point.

Position
 

Starting Participant
 

The first participant in the list.
 

To select a starting participant,
 click the list of values and select:
 

• The Get Manager radio
button

• Position as the List Builder

• Reference User as the
position identifier of the
starting position

• A Hierarchy Type. This is
a mandatory selection for
the position list builder. To
select a hierarchy type, you
must first define a position
hierarchy in Oracle Fusion
Global Human Resources.

• An Effective Date if
applicable

This creates a string for the
starting participant. For example,
to start from position ID 1234,
use HierarchyBuilder.getManager
("position","1234",-1,"","
ENTERPRISE_POSITION
_HIERARCHY") as the start
participant.
 

Position
 

Top Participant
 

The last participant in the list. The
approval list does not go beyond
this person in a hierarchy.

From the Add Variable dialog box:
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List Builder Type Field Description Values to Select and Sample Data

 • Select the Get User radio
button.

• Enter the position identifier
for the last position in
the approval chain as the
Reference User.

• Select an Effective Date if
applicable.

This creates a string for the
highest participant. For example,
 HierarchyBuilder.getPrincipal
"<>",""," ENTERPRISE_POSITION_
 HIERARCHY").
 

Position
 

Utilized Participants
 

Uses only the participants specified
in this option from the calculated
list of participants. Available
options are: Everyone, First and
Last Manager, Last Manager.
 

Not applicable
 

Position
 

Auto Action Enabled
 

If automatic response should be
enabled for the notification, set to
True.
 

Not applicable
 

Position
 

Auto Action
 

If automatic response is enabled,
 set the response.
 

For expense approval, use
Approve.
 

Job Level
 

Number of Levels
 

A positive number specifying the
number of levels to traverse the
job level hierarchy. This number
can be an absolute value, or a
value relative to Starting Point or
Creator.
 

Not applicable
 

Job Level
 

Relative to
 

The number of levels to traverse
is relative to one of the following
values: Starting Point, Creator, or
Absolute.
 

• At most 2 relative to Absolute

• At least 1 relative to Absolute

Job Level
 

Starting Participant
 

The first participant in the list.
 

From the Add Variable dialog box,
 select:
 

• The Get User radio button

• Job Level as the List Builder

• Reference User as
task.creator to start from the
person on the expense report

• An Effective Date if
applicable

This creates a string for the
start participant. For example,
HierarchyBuilder.getManager
("joblevel",task.creator,-1,"","").
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List Builder Type Field Description Values to Select and Sample Data

 

Top Participant
 

The last participant in the list. The
approval list does not go beyond
this person in a hierarchy.
 

From the Add Variable dialog box:
 

• Select the Get User radio
button.

• Enter the user name for the
last approver in the approval
chain as the Reference User.

• Select an Effective Date if
applicable.

This creates the following string
as the highest participant:
HierarchyBuilder.getPrincipal
("<>",-1,"","")
 

Job Level
 

Include all managers at last level
 

If the job level equals that of
the previously calculated last
participant in the list, then it
includes the next manager in the
list.
 

Not applicable
 

Job level
 

Utilized Participants
 

Uses only the participants specified
in this option from the calculated
list of participants. Available
options are: Everyone, First and
Last Manager, Last Manager.
 

Not applicable
 

Job Level
 

Auto Action Enabled
 

If automatic response should
be enabled for the approval
notification, set to True.
 

Not applicable
 

Job level
 

Auto Action
 

If automatic response is enabled,
 set the response.
 

For expense approval, use
Approve.
 

Resource
 

Participants
 

Participants can be users, groups,
 or application roles. For users, use
a static user name or a function to
retrieve a user name.
 

For example, use ExpenseReport/
costCenterTotalVO.managerUsername
for cost center owner.
 

Approval Group
 

Approval Group
 

Enter the approval group name.
To select an approval group as a
list builder, you must create the
static approval groups in the BPM
Worklist.
 

Not applicable
 

For more information on configuring approval rules, see the Using Task Configuration section of the Using Approval
Management chapter in the Oracle Fusion Middleware Modeling and Implementation Guide.
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Understand and Apply Properties of Rules and Rule Sets
The following are properties of rules and rule sets that you need to understand and apply.

• For each expense report, one rule must be true within each rule set. If the expense report does not satisfy any
rule in the rule set, the approval process will error.

• Since there can be only one rule that applies in a rule set for each expense report, you must configure the rules
at the most granular level applicable and use priority within the rule to differentiate overlapping conditions.
AMX does not support nested conditions.

• All rule sets are executed in parallel or in serial with respect to the Expense Report Approval Stage.

• Serial rule sets are designed to execute the approval process in a sequential order. The approvers in the
approval list for any rule included in these rule sets are notified in a sequential order.

• To deactivate a rule set, check the Ignore this participant check box for that rule set.

• If the participants cannot be determined, then AMX sends out a failure notification to the user with an incident
identifier. Administrators can access the incident details through the Support Workbench of the Oracle
Enterprise Manager Grid Control application and restart the approval process in Oracle Enterprise Manager Grid
Control after resolving the issues in the incident report.

How You Set Up Approval Rules for Delegated Expense
Reports  
Oracle Fusion Expenses enables you to delegate expense entry to another person. To understand the approval process
for delegated expense reports, it is necessary to understand the distinction between preparer, or creator, and owner.

The person who submits an expense report for another person called the preparer. The person who incurs the expenses
is called the owner of the expense report.

Expenses provides predefined approval rules to support delegated expense report approval. When a preparer submits
an expense report, the following approval process ensues.

• Approval by expense report owner

In the first part of the approval process, the expense report is routed to the expense report owner for approval.
The expense report has a status of Pending Individual Approval. The rule set for this part of the approval
process is called the ExpenseReportApprovalStageExpenseReportD : ExpenseReportOwnerRuleSet in the BPM
Worklist application.

• Approval by preparer's manager

In the second part of the approval process, the expense report is routed to the preparer's manager hierarchy
for approval. The Expense report has a status of Pending Manager Approval. The rule set for this part of
the approval process is called ExpenseReportApprovalStage : ExpenseReportRuleSet in the BPM Worklist
application.

This topic discusses the following two scenarios that require you to modify the rule sets if your company enables
delegated expense entry.

• Bypass approval by owner
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• Start approval with owner's manager

Based on your company policies, any one of the following scenarios can apply:

• Only bypass approval by owner

• Only start approval with owner's manager

• Both bypass approval by owner and start approval with owner's manager

• Neither bypass approval by owner nor start approval with owner's manager

Bypass Approval By Owner
If your company policy does not require expense report approval by the expense report owner, you can modify the
rule set to bypass this approval. When bypassed, the expense report status is set to Pending Manager Approval. The
expense report is routed to approvers based on the existing approval rules.

To bypass approval by the owner, perform the following steps:

1. Navigate to the Oracle BPM Worklist application.
2. Click the Administration link displayed in the corner of the page. The Administration tab appears.
3. Click the Task Configuration tab.
4. Click the Rules tab.
5. In the Tasks to be configured pane, select the FinExmWorkflowExpenseApproval task.
6. From the Select Ruleset choice list, select the following predefined rule set:

SoaOLabel.ExpenseReportApprovalStageExpenseReportD : ExpenseReportOwnerRuleSet .
7. Select the Ignore this participant check box. This action tells the approval rule to ignore the owner as the first

approver in the approval rule.
8. To save the modified rule set, click the Save icon in the Tasks to be configured pane.
9. To commit the modified rule set, click the Commit task icon in the Tasks to be configured pane.

Start Approval with Owner's Manager
The approval process routes the expense reports to the preparer's manager hierarchy.

If your company policy requires expense reports to be routed to the owner's manager hierarchy for approval, perform
the following steps.

1. To navigate to the expense report approval taskflow, perform steps 1-5 in the preceding section.
2. From the Select Ruleset choice list, select the following predefined rule set:

SoaOLabel.ExpenseReportApprovalStage : ExpenseReportRuleSet.
3. Click the Edit task icon (pencil) on the Tasks to be configured pane.
4. Expand the ExpenseReportManagerApproval rule.
5. In the List builder action 1 region, click in the Starting Participant field and scroll until you see

("supervisory",Task.creator,.
6. In the Starting Participant field, replace Task.creator with Task.payload.Expense Report Owner as shown in the

following table.

Predefined Value Changed Value

HierarchyBuilder.getManager("supervisory",Task.creator,-1,"","")
 

HierarchyBuilder.getManager("supervisory", Task.payload.Expense Report Owner,-1,"","")
 

7. To save the modified rule set, click the Save icon in the Tasks to be configured pane.
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8. To commit the modified rule set, click the Commit task icon in the Tasks to be configured pane.

CAUTION:  Expenses recommends that you evaluate any existing approval rules that use Task.creator as the first
approver in an approval hierarchy to determine whether the first approver should be changed from task.creator to
Task.payload.Expense Report Owner.

Modify the Printable Expense Report Template  
The Printable Expense Report template is a RTF file. You can change the information that displays on the Printable
Expense Report template. First you download the RTF file, FinExmExpenseTemplate, to your local drive from Oracle
Analytics Publisher.

Then you can modify attribute names or attribute display text with their corresponding predefined attributes. Finally,
you upload the modified template to Oracle Analytics Publisher.

On the FinExmExpenseTemplate RTF file, you can modify the following:

• Attribute names: Displayed as UI text on the RTF file.

• Attribute display text: Displayed as bold text on the RTF file.

• Attributes: Code that corresponds to the attribute display text on the RTF file.

The following table contains regions on the Printable Expense Report template that correspond to predefined view
objects.

Regions on the RTF Template Predefined View Objects

Expense Report Header
 

PrintableReportVO
 

Expense Items
 

PrintableExpenseVO
 

Distributions
 

PrintableExpenseDistVO
 

Employee Attendees
 

EmployeeExpenseAttendeeVO
 

Nonemployee Attendees
 

NonemployeeExpenseAttendeeVO
 

Expense Summary
 

ExpenseSummaryVO
 

Attachment
 

AttachmentVO
 

Given the region on the Printable Expense Report template in which your intended change is located, you can then
identify which view object table to consult. The view object tables list the attribute names and their corresponding
predefined attributes. The predefined attributes are available for you to add to the Printable Expense Report template.
To access the view object tables, click the Printable Expense Report Template Attributes related link in this topic.
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The following diagram illustrates the layout of the regions on the Printable Expense Report template.

Prerequisites
Before you can modify the FinExmExpenseTemplate RTF file, you must download and install the Template Builder for
Word, which is a BI Publisher add-on for Microsoft Word. To download and install the Template Builder for Word, follow
these steps:

1. Sign into the Oracle Analytics Publisher server with the BI Administrator Role.
2. On the Oracle Analytics home page by the Get Started section, click the Download BI Publisher Desktop Tools

link.
3. Select and install Template Builder for Word.

Downloading the Printable Expense Report Template
To download a copy of the FinExmExpenseTemplate RTF file from Oracle BI Publisher, complete these steps:

1. Sign into the Oracle BI Publisher server with the BI Administrator Role.
2. Navigate: Navigator > Tools > Reports and Analytics.
3. On the Oracle BI Publisher home page, click the Catalog menu.
4. On the Catalog page in the Folders pane, expand Shared Folders > Financials > Expenses.
5. Click the Expenses folder to display the Printable Expense Report template.
6. By the Printable Expense Report template, click the Edit link.
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The Printable Expense Report Template page appears.
7. By the FinExmExpenseTemplate icon, click the Edit link.
8. Click Save as to save the Printable Expense Report template RTF file to your local drive.

Tip:  Save the downloaded template with the name UpdatedPrintableExpenseReport to distinguish it from the
predefined template.

Adding a Predefined Attribute
To add a predefined attribute to a location on the Printable Expense Report template, complete these steps:

1. Select existing attribute display text, such as ExpenseReportDate.
2. Copy the attribute display text by pressing Ctrl + C on your keyboard.
3. Move your cursor to the location where you want to add the predefined attribute and press Ctrl + V on your

keyboard.
4. Select the new field you pasted, right-click, and navigate: BI Publisher > Properties.

The BI Publisher Properties dialog box appears.
5. In the Text to display field, change the attribute display text.
6. Select the Advanced tab.
7. Click the Printable Expense Report Template Attributes related link in this topic.
8. In the Printable Expense Report Template Attributes topic, determine which view object table to consult based

on the location on which you want to add the predefined attribute.
For example, if you want to add a predefined attribute to the header region of the Printable Expense Report
template, you would consult the PrintableReportVO - Expense Report Header Region table. Then, in the In
the PrintableReportVO - Expense Report Header Region table, locate the UI label and associated predefined
attribute that you want to add.

9. In the Advanced tab, enter the predefined attribute between the question marks.
10. Click OK.

Uploading the Printable Expense Report Template
To upload the FinExmExpenseTemplate RTF file to Oracle BI Publisher, complete these steps:

1. Sign into the Oracle BI Publisher server with the BI Administrator Role.
2. Navigate: Navigator > Tools > Reports and Analytics.
3. On the Oracle BI Publisher home page, click the Catalog menu.
4. Click the New icon.
5. From the New menu, select Report.
6. On the Create Report page, select the Use Data Model icon.
7. In the Select Data Model dialog box, click Cancel to bypass the data model. which is not applicable.
8. Click OK to confirm cancellation.
9. On the Data Model page, click the Upload icon.

10. In Upload Template File dialog box, enter the following:
a. In the Layout Name field, enter FinExmExpenseTemplate.
b. In the Template File field, browse for your modified Printable Expense Report template RTF file on your

local drive, select the template, and click Open.
c. From the Type choice list, select RTF Template.
d. From the Locale choice list, select English (United States).
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e. Click Upload.

The modified RTF file appears with the layout name FinExmExpenseTemplate.
11. Click the Save Report icon.

The Save As dialog box appears.
12. In the Save In field, navigate to the folder where you want to save the modified Printable Expense Report

template.

Tip:  A copy of your modified Printable Expense Report template is automatically saved in the Expenses
folder at: Shared Folders > Custom > Financials > Expenses.

13. In the Name field, enter a name for the modified Printable Expense Report Template, such as
UpddatedFinExmReport.

CAUTION:  When you name the report in the Name field, don't include spaces.

14. Click OK.

Now you can navigate to the Expenses System Option page through Setup and Maintenance. After you click a specific
business unit link in the Specific Business Units section, select the Corporate Options for Expense Report tab. Then you
can select your modified expense report template from the Printable Expense Report Format choice list.

Adding an Attachment Region to the Printable Expense Report Template
If your Printable Expense Report Template is missing the Attachment region, you can add the missing components as
follows:

• <?for-each:Attachment?>

• Placeholder image with alt-text = url:{DOCUMENT}

• <?TITLE?>

• <?end for each?>

To add the missing components, follow these steps:

1. In the RTF Printable Expense Report template, scroll to end of the file.
2. Select and copy any For field and paste on a separate line outside the last table at the end of the template.
3. Select For and navigate: Add-ins > BI Publisher > Field Browser.
4. In the Field Browser dialog box, click Show All.
5. Scroll to the end of the list.
6. Select the last For in the Text and Code fields in the Field Browser dialog box. The last For is the For you just

copied in Step 2 and it's what you must update.
7. In the Edit field, change the code to <?for-each:Attachment?>
8. Click Update.
9. Click Close.

10. After For in your work area of the RTF Printable Expense Report template, press the Enter key on the keyboard
twice.

11. Navigate: Insert > Pictures.
12. Browse to the image.
13. Select the image and click Insert.
14. Click the image.
15. On the image, right-click the mouse and select Picture.
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16. In the Format Picture dialog box, select the Alt Text tab.
17. In the Alternative text field, enter url:{DOCUMENT}.
18. Click OK.
19. After the image in your work area, press the Enter key on the keyboard twice.
20. Copy and paste any field in your work area.
21. Select the field you pasted and navigate: Add-ins > BI Publisher > Field Browser.
22. In the Field Browser dialog box, click Show All.
23. Scroll to the end of the list.
24. Select the final entry.
25. In the Edit field, change the code to <?TITLE?>.
26. Click Update.
27. Click Close.
28. Double-click the field you pasted. The Text Form Field Options dialog box appears.
29. In the Default text field, enter Title.
30. Click OK.
31. After Title in your work area, press the Enter key on the keyboard twice.
32. Select and copy any End For field and paste on a separate line after Title.
33. Select End For and navigate: Add-ins > BI Publisher > Field Browser.
34. In the Field Browser dialog box, the Text and Code fields show exactly what you need, so you don't have to

change the code.
35. Click Close.
36. Click the Save icon in the RTF Printable Expense Report template.

Related Topics
• How can I enable a printable expense report format and assign it to a business unit?

• Example of Modifying Expenses Email Notifications Using Oracle Analytics Publisher

• Printable Expense Report Template Attributes

Printable Expense Report Template Attributes  
The following tables contain attribute names and their corresponding predefined attributes that you can use to modify
the Printable Expense Report template.

Use these view object tables with the figure in the topic titled Modifying the Printable Expense Report Template:
Procedures that is a related link in this topic.

PrintableReportVO - Expense Report Header Region
The following table contains attribute names and their corresponding predefined attributes, which are located in the
Expense Report header region on the Printable Expense Report template.

Attribute Name Predefined Attribute Description

Assignment ID
 

AssignmentId
 

Assignment identifier of the individual on the
corporate card.
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Attribute Name Predefined Attribute Description

Audit Code
 

AuditCode
 

Audit type for the expense report based on
receipt requirements, such as original receipt-
based audit and imaged receipt-based audit.
 

Both Pay Identifier
 

BothPayFlag
 

Indicates whether the expense report contains
corporate card transactions with Both Pay
payment liability.
 

Business Group ID
 

BusinessGroupId
 

Identifier of an enterprise. Used for multi-
tenancy partitioning.
 

Cash Expense Payment Date
 

CashExpensePaidDate
 

Date when cash expense was reimbursed to the
individual.
 

Created By
 

CreatedBy
 

Who column: indicates the user who created
the row.
 

Creation Date
 

CreationDate
 

Who column: indicates the date and time of the
creation of the row.
 

Current Approver ID
 

CurrentApproverId
 

Identifier of the current approver of the
expense report.
 

Display Name
 

DisplayName
 

Derived denormalized name formatted for UI
display. Formatting depends on the legislation
code. Expect first name as first component in
this format.
 

Displayed Field
 

DisplayedField
 

Expense report status.
 

Employee Number
 

EmployeeNumber
 

Number that identifies an employee within a
company.
 

Entertainment Expense Identifier
 

EntertainmentExpenseFlag
 

Indicates whether this report contains any
entertainment expenses.
 

Exchange Rate Type
 

ExchangeRateType
 

Conversion rate type used for calculating the
reimbursable amount.
 

Expense Dates
 

ExpenseDates
 

Expense report date range.
 

Expense Report Date
 

ExpenseReportDate
 

Month, day, and year in which an expense
report is saved or submitted.
 

Expense Report ID
 

ExpenseReportId
 

Identifier of the expense report.
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Attribute Name Predefined Attribute Description

Expense Report Number
 

ExpenseReportNum
 

Number that references an expense report and
follows the numbering policies of the company.
 

Expense Report Processing ID
 

ExpRepProcessingId
 

Identifier of the expense report details, such as
report status change history.
 

Expense Report Request ID
 

ExportRequestId
 

Identifier of a specific instance of the expense
reimbursement process that processed this
report.
 

Expense Report Total
 

ExpenseReportTotal
 

Total amount of the expense report in
reimbursement currency. Amount in approver
preferred currency is also shown if approver has
a different preferred currency.
 

Expense Status Code
 

ExpenseStatusCode
 

Expense report approval status, such as
Approved, Pending Manager Approval, or Paid.
 

Expense Status Date
 

ExpenseStatusDate
 

Date when expense report acquired the current
status.
 

First Name
 

FirstName
 

Person's first name.
 

Formatted Report Submit Date
 

FormattedReportSubmitDate
 

Formatted date representing the date the
expense report was submitted.
 

Formatted Total
 

FormattedTotal
 

Formatted report total amount based on
reimbursement currency code.
 

Full Name
 

FullName
 

System constructed version of name. Used in
more formal display purposes
 

Home Address
 

HomeAddress
 

Person's home address.
 

Imaged Receipt Status Code
 

ImagedReceiptStatusCode
 

Represents the imaged receipt status for the
expense report.
 

Last Name
 

LastName
 

Person's last name.
 

Last Update Date
 

LastUpdateDate
 

Date the expense report was last updated.
 

Last Update Login
 

LastUpdateLogin
 

Login ID of the last person who accessed the
expense report.
 

Last Updated By
 

LastUpdatedBy
 

Login ID of the last person who updated the
expense report.
 

112



Oracle Fusion Cloud Financials
Implementing Expenses

Chapter 3
Expense Policies and Rules

Attribute Name Predefined Attribute Description

List Name
 

ListName
 

Constructed version of a person's name,
intended for use in an alphabetically-ordered
list. The value may naturally differ depending
on the Legislation Code. Expect the last name
as the first component in this format in most
cases.
 

Middle Name
 

MiddleNames
 

Person's middle name.
 

Mileage Expense Identifier
 

MileageExpenseFlag
 

Indicates whether this report contains any
mileage expense items.
 

Missing Images Reason
 

MissingImagesReason
 

Reason imaged receipts are not submitted with
the expense report.
 

Object Version Number
 

ObjectVersionNumber
 

Used to implement optimistic locking. This
number is incremented every time that the row
is updated. The number is compared at the
start and end of a transaction to detect whether
another session has updated the row since it
was queried.
 

Order Name ID
 

OrderName ID
 

System-constructed version of name used for
sorting. A value is always stored in this location.
 

Organization ID
 

OrgId
 

Identifier of the business unit associated with
the row.
 

Override Approver ID
 

OverrideApproverId
 

Identifier of the person chosen as the initial
approver by the individual.
 

Parent Expense Report ID
 

ParentExpenseReportId
 

Identifier of the parent expense report.
 

Payment Method Code
 

PaymentMethodCode
 

Method of payment for this expense report,
 such as check, cash, or credit.
 

Person ID
 

PersonId
 

Identifier of the person whose expenses are
included in this expense report.
 

Preparer ID
 

PreparerId
 

Identifier of the person who created the
expense report.
 

Purpose
 

Purpose
 

Purpose of the expense report as entered by
the user.
 

Receipt Filing Number
 

ReceiptFilingNumber
 

Receipt filing number that is manually entered
by the expense auditor.
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Attribute Name Predefined Attribute Description

Receipt Status Code
 

ReceiptsStatusCode
 

Receipt status of an expense report, such as
Missing, Required, or Received.
 

Receipts Receive Date
 

ReceiptsReceiveDate
 

Date when receipts for the expense report are
received
 

Regular Expense Identifier
 

RegularExpenseFlag
 

Indicates whether this report contains any
regular expenses, such as those that are not
mileage, not entertainment, or not per diem.
 

Reimbursement Currency Code
 

ReimbursementCurrencyCode
 

Currency of the amount to be reimbursed to the
individual for the expenses incurred.
 

Report Submit Date
 

ReportSubmitDate
 

Month, day, and year in which an expense
report is submitted.
 

Single Reimbursement Code
 

SingleReimbCurrencyCode
 

The expense report reimbursement currency
shown in the expense item table when all
expense items have the same currency.
 

ExpenseSummaryVO - Expense Summary Region
The following table contains attribute names and their corresponding predefined attributes, which are located in the
Expense Summary region on the Printable Expense Report template.

Attribute Name Predefined Attribute Description

Amount
 

Amount
 

Amount that is due from employer or
employee.
 

Card ID
 

CardId
 

Identifier of the corporate card transaction.
 

Card Number
 

CardNumber
 

Token or encrypted card number.
 

Currency Code
 

CurrencyCode
 

Currency of the amount to be reimbursed to the
individual for the expenses incurred.
 

Estimated Total
 

EstimatedTotal
 

Estimated expense report total.
 

Expense Report ID
 

ExpenseReportId
 

Identifier of the expense report.
 

Formatted Amount
 

FormattedAmount
 

Formatted amount based on the currency code.
 

Payment Due From
 

Payment DueFrom
 

Party responsible for payment.
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Attribute Name Predefined Attribute Description

Summary Type
 

SummaryType
 

Indicator of payment responsibility.
 

Total
 

Total
 

Total amount of the expense report in
reimbursement currency.
 

PrintableExpenseVO - Expense Items Region
The following table contains attribute names and their corresponding predefined attributes, which are located in the
Expense Items region on the Printable Expense Report template.

Attribute Name Predefined Attribute Description

Assignment ID
 

AssignmentId
 

Identifier of the assignment for the person on
the expense report.
 

Billed Amount
 

BilledAmount
 

Amount billed to the corporate card account.
 

Billed Currency Code
 

BilledCurrencyCode
 

Corporate card transaction billed currency code.
 

Billed Date
 

BilledDate
 

Date of the statement on which the transaction
appears.
 

Billed Decimal Placement
 

BilledDecimal
 

Number of decimal places used to display the
billed amount.
 

Business Amount
 

BusinessAmount
 

Expense business amount.
 

Card ID
 

CardId
 

Identifier of a specific corporate card.
 

Card Member Name
 

CardmemberName
 

Card member name.
 

Card Number
 

CardNumber
 

Token or encrypted card number.
 

Card Program ID
 

CardProgramId
 

Identifier of the corporate card program.
 

Card Program Name
 

CardProgramName
 

Corporate card program name.
 

Card Reference ID
 

CardReferenceId
 

Identifier of the corporate card in Oracle Fusion
Payments.
 

Card Status Code
 

CardStatusCode
 

Status of a corporate card, such as Active,
Inactive, or Unassigned.
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Attribute Name Predefined Attribute Description

Category Code
 

CategoryCode
 

Expense type category code.
 

Code Combination ID
 

CodeCombinationId
 

Identifier of the accounting code combination
to which that expense is charged.
 

Company Account ID
 

CompanyAccountId
 

Identifier assigned by the card issuer to the
deploying company or its business unit.
 

Company Number
 

CompanyNumber
 

Corporate account number assigned by the
card issuer to the deploying company or its
business unit.
 

Cost Center
 

CostCenter
 

Cost center to which an expense item is
assigned.
 

Created By
 

CreatedBy DisplaySequence
 

Who column: indicates the user who created
the row.
 

Creation Date
 

CreationDate
 

Who column: indicates the date and time of the
creation of the row.
 

Credit Card Transaction ID
 

CreditCardTrxnId
 

Identifier of a specific corporate card
transaction.
 

Currency Conversion Rate
 

CurrencyConversionRate
 

A rate that represents the amount one currency
can be exchanged for another at a specific
point in time. Oracle Applications can access
daily, periodic, and historical rates. These
rates are used for foreign currency conversion,
 revaluation, and translation.
 

Default Project Expenditure Type
 

DefaultProjExpendType
 

Project expenditure that is assigned to an
expense type that has not been set up at the
project level.
 

Description
 

Description
 

Description of an expense item.
 

Default Corporate Card Expense Type ID
 

DfltCcExpTypeId
 

Card expense type used if no mapping rule has
been specified.
 

Expense Type Category
 

DisplayedField
 

Expense type category.
 

Expense Source
 

DisplayedField1
 

Source of the transaction, either Cash or
Corporate Card.
 

Display Policy Violation Identifier
 

DisplayPolicyViolationFlag
 

Indicates whether an expense item has a policy
violation.
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Attribute Name Predefined Attribute Description

Display Policy Violation Identifier
 

DisplayViolationFlag
 

Indicates whether employees are warned when
they submit expenses that exceed defined
entertainment expense policy rate limit.
 

Display Receipt Violation Identifier
 

DispRcptViolationFlag
 

Indicates whether a receipt missing policy
warning is displayed to the user.
 

Dispute Date
 

DisputeDate
 

Date when the individual placed this transaction
or dispute.
 

Employee Default Cost Center
 

EmpDefaultCostCenter
 

Employee's default cost center defined in
Oracle Human Capital Management.
 

Employee Name
 

EmployeeName
 

Employee's name defined in Oracle Human
Capital Management.
 

Enable Corporate Card Mapping Identifier
 

EnableCcMappingFlag
 

Indicates whether the lookup codes from the
charge file are associated with the company's
expense types.
 

Project Enabled Identifier
 

EnableProjectsFlag
 

Indicates whether the expense item is enabled
for projects.
 

End Date
 

EndDate
 

Distribution end date.
 

Exchange Rate
 

ExchangeRate
 

Rate that represents the amount one currency
can be exchanged for another at a specific point
in time.
 

Attendee
 

ExpenseAttendee
 

Attendee identified at the distribution level.
 

Expense Category Code
 

ExpenseCategoryCode
 

Expense category.
 

Expense ID
 

ExpenseId
 

Identifier of a specific expense item..
 

Expense Report ID
 

ExpenseReportId
 

Identifier of a specific expense report.
 

Expense Source
 

ExpenseSource
 

Source of the transaction, either Cash or
Corporate Card.
 

Expense Template ID
 

ExpenseTemplateId
 

Identifier of a specific expense template.
 

Expense Template Name
 

ExpenseTemplateName
 

Name of the expense report template.
 

Expense Type Category Code
 

ExpenseTypeCategoryCode
 

Grouping of expense types and additional
data fields that are relevant for a particular

117



Oracle Fusion Cloud Financials
Implementing Expenses

Chapter 3
Expense Policies and Rules

Attribute Name Predefined Attribute Description

grouping of expenses. An example is airfare.
This grouping allows expense types to include
information such as class of fare, merchant,
 ticket number, location from, and location to.
 

Expense Type ID
 

ExpenseTypeId
 

Identifier for a specific expense type.
 

Expense Type Name
 

ExpenseTypeName
 

Name of the expense type.
 

Formatted Amount
 

FormattedAmount
 

Formatted reimbursable amount.
 

Formatted Start Date
 

FormattedStartDate
 

Formatted expense start date.
 

 
Functional Currency Amount
 

FuncCurrencyAmount
 

Amount to be reimbursed to the individual in
functional currency for expenses incurred.
 

Attendees Includes Employees
 

HasEmployeeAttendees
 

Indicator that the expense includes employee
attendees.
 

Attendees Includes Nonemployees.
 

HasNonEmployeeAttendees
 

Indicator that the expense includes
nonemployee attendees.
 

Imaged Receipt Required Identifier
 

ImgReceiptRequiredFlag
 

Indicates whether this expense requires an
imaged receipt.
 

Include Personal Expense Identifier
 

InclPersonalExpenseFlag
 

Indicates whether the expense item includes a
personal amount.
 

Itemization Parent Expense ID
 

ItemizationParentExpenseId
 

Identifier of the parent expense of an itemized
expense item. Possible values are NULL
indicating that the expense is not itemized, -1
indicating that the expense is a parent line with
itemization, and greater than 0 indicating that
the expense is an itemized child line and the
value is the parent line's identifier.
 

Expense Item Sequence
 

ItemSequence
 

Sequence in which expenses items are entered
into an expense report.
 

Justification
 

Justification
 

Reason an expense was incurred.
 

Justification Required Identifier
 

JustificationRequiredFlag
 

Indicates whether the expense requires
justification.
 

Last Update Date
 

LastUpdateDate
 

Who column: indicates the date and time of the
last update of the row.
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Attribute Name Predefined Attribute Description

Last Updated By
 

LastUpdatedBy
 

Who column: indicates the user who last
updated the row.
 

Last Update Login
 

LastUpdateLogin
 

Who column: indicates the session login
associated with the user who last updated the
row.
 

Location
 

Location
 

Expense location.
 

Location ID
 

LocationId
 

Identifier of a specific location.
 

Masked Card Number
 

MaskedCardNumber
 

Token or masked card number.
 

Merchant Document Number
 

MerchantDocumentNumber
 

Receipt number on the receipt issued by the
merchant.
 

Merchant Name
 

MerchantName
 

Name of the merchant where the expense was
incurred.
 

Merchant Reference
 

MerchantReference
 

Purchase identification of a transaction
provided by the merchant at the point of sale.
 

Merchant Taxpayer ID
 

MerchantTaxpayerId
 

Tax payer identifier of the merchant.
 

Expense Template Name
 

Name
 

Expense template name.
 

Number of Days
 

NumberOfDays
 

Number of days that the expense spans.
 

Number of People
 

NumberPeople
 

Number of people that attended the event for
which an expense was incurred. For example,
 the number of people that attended a business
dinner or an entertainment event.
 

Object Version Number
 

ObjectVersionNumber
 

Used to implement optimistic locking. This
number is incremented every time that the row
is updated. The number is compared at the
start and end of a transaction to detect whether
another session has updated the row since it
was queried.
 

Organization ID
 

OrgId
 

Identifier of the business unit associated with
the row.
 

Original Reimbursable Amount
 

OrigReimbursableAmount
 

Original amount to be reimbursed to the
individual for this expense.
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Attribute Name Predefined Attribute Description

Parent Expense Type ID
 

ParentExpenseTypeId
 

Identifier of the parent expense of an itemized
expense item. Possible values are NULL
indicating that the expense is not itemized, -1
indicating that the expense is a parent line with
itemization, and greater than 0 indicating that
the expense is an itemized child line and the
value is the parent line's identifier.
 

Passenger Amount
 

PassengerAmount
 

Passenger amount of the mileage expense.
 

Payment Due From Code
 

PaymentDueFromCode
 

Party responsible for payment.
 

Payment Identifier
 

PaymentFlag
 

Payment identifier from credit card transactions
table.
 

Personal Amount
 

PersonalAmount
 

Amount of the expense that is marked as
personal.
 

Person ID
 

PersonId
 

Identifier of the individual.
 

Policy Short Pay Identifier
 

PolicyShortpayFlag
 

Indicates whether the expense is short paid due
to policy noncompliance.
 

Policy Violated Identifier
 

PolicyViolatedFlag
 

Indicates whether the expense violated
company policies.
 

Posted Amount
 

PostedAmount
 

Transaction amount that was posted to the
statement or account.
 

Posted Currency Code
 

PostedCurrencyCode
 

Currency code associated with a posted
corporate card transaction.
 

Posted Date
 

PostedDate
 

Date the transaction was posted to the
statement.
 

Posted Decimal Placement
 

PostedDecimal
 

Number of decimal places used to display the
posted amount.
 

Preparer ID
 

PreparerId
 

Identifier of the person who created the
expense.
 

Project ID
 

ProjectId
 

Project identifier of the expense item.
 

Receipt Amount
 

ReceiptAmount
 

Amount of the receipt in the receipt currency.
 

Receipt Currency Code
 

ReceiptCurrencyCode
 

Receipt currency of an expense item.
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Attribute Name Predefined Attribute Description

Receipt Missing Identifier
 

ReceiptMissingFlag
 

Indicates whether the receipts are missing for
this expense.
 

Receipt Required Identifier
 

ReceiptRequiredFlag
 

Indicates whether this expense requires a
receipt.
 

Receipt Verified Identifier
 

ReceiptVerifiedFlag
 

Indicates whether the auditor verified the
receipt for this expense.
 

Reference Number
 

ReferenceNumber
 

Corporate card reference number.
 

Reimbursable Amount
 

ReimbursableAmount
 

Expense item reimbursable amount.
 

Reimbursement Currency Code
 

ReimbursementCurrencyCode
 

Expense item reimbursable currency.
 

Request ID
 

RequestId
 

Request identifier in Enterprise Service
Scheduler of the process that created or last
updated the row.
 

Sequence Number
 

SequenceNum
 

Sequence in which expenses items are entered
into an expense report.
 

Source Type
 

SourceType
 

Source of an expense item, such as cash or
corporate card.
 

Start Date
 

StartDate
 

Expense item start date.
 

Transaction Amount
 

TransactionAmount
 

Amount charged by the merchant in the
currency of the transaction.
 

Transaction Date
 

TransactionDate
 

Transaction date of item for detailed
transaction.
 

Transaction Status
 

TransactionStatus
 

Corporate card transaction status.
 

Transaction Type
 

TransactionType
 

Corporate card transaction type.
 

Trip Distance
 

TripDistance
 

Estimated total travel distance for a business
trip for which mileage reimbursement will be
requested.
 

Vehicle Category Code
 

VehicleCategoryCode
 

Category of vehicle driven, such as Company or
Private.
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PrintableExpenseDistVO - Distributions Region
The following table contains attribute names and their corresponding predefined attributes, which are located in the
Distributions region on the Printable Expense Report template.

Attribute Name Predefined Attribute Description

Code Combination ID
 

CodeCombinationId
 

Identifier of the accounting code combination
to which that expense is charged.
 

Cost Center
 

CostCenter
 

Cost center to which the expense is charged.
 

Created By
 

CreatedBy
 

Who column: indicates the user who created
the row.
 

Creation Date
 

CreationDate
 

Who column: indicates the date and time of the
creation of the row.
 

Expense Distribution ID
 

ExpenseDistId
 

Identifier of the expense distribution of a
specific expense item.
 

Expense ID
 

ExpenseId
 

Identifier of the expense for this distribution.
 

Expense Report ID
 

ExpenseReportId
 

Identifier of the expense report, which includes
the expense corresponding to this distribution.
 

Last Update Date
 

LastUpdateDate
 

Who column: indicates the date and time of the
last update of the row.
 

Last Updated By
 

LastUpdatedBy
 

Who column: indicates the user who last
updated the row.
 

Last Updated By Login
 

LastUpdateLogin
 

Who column: indicates the session login
associated with the user who last updated the
row.
 

Object Version Number
 

Object Version Number
 

Used to implement optimistic locking. This
number is incremented every time that the row
is updated. The number is compared at the
start and end of a transaction to detect whether
another session has updated the row since it
was queried.
 

Organization ID
 

OrgId
 

Identifier of the business unit associated with
the row.
 

Project Billable Identifier
 

PJC_BILLABLE_FLAG
 

Indicates whether a project-related item is
available to be billed to customers.
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Attribute Name Predefined Attribute Description

Project Capitalization Identifier
 

PJC_CAPITALIZABLE_FLAG
 

Indicates whether a project-related item is
eligible for capitalization.
 

Project Context Category
 

PJC_CONTEXT_CATEGORY
 

Segment used to identify the descriptive
flexfield application context for project-related
standardized cost collection.
 

Project Contract ID
 

PJC_CONTRACT_ID
 

Identifier of contract. Used when Oracle
Contract Billing or Oracle Grants Accounting is
installed.
 

Project Contract Line ID
 

PJC_CONTRACT_LINE_ID
 

Tracks contract line information. Used when
Oracle Contract Billing or Oracle Grants
Accounting is installed.
 

Project Expenditure Item Date
 

PJC_EXPENDITURE_ITEM_DATE
 

Date on which a project-related transaction is
incurred.
 

Project Expenditure Type ID
 

PJC_EXPENDITURE_TYPE_ID
 

Expenditure type used to build the transaction
descriptive flexfield for project-related
transaction distributions.
 

Project Funding Allocation ID
 

PJC_FUNDING_ALLOCATION_ID
 

Specifies the name of the project funding
override. Used when Oracle Contract Billing or
Oracle Grants Accounting is installed.
 

Project Organization ID
 

PJC_ORGANIZATION_ID
 

Identifier of expenditure organization used to
build the transaction descriptive flexfield for
project-related transaction distributions.
 

Project ID
 

PJC_PROJECT_ID
 

Identifier of the project used to build the
transaction descriptive flexfield for project-
related transaction distributions.
 

Reserved Project Fields
 

PJC_RESERVED_ATTRIBUTE1-10
 

Reserved for project-related functionality.
 

Project Task ID
 

PJC_TASK_ID
 

Identifier of the task used to build the
transaction descriptive flexfield for project-
related transaction distributions.
 

Reserved User Defined Project Fields
 

PJC_USER_DEF_ATTRIBUTE1-10
 

Reserved for user-defined project information.
 

Project Work Type ID
 

PJC_WORK_TYPE_ID
 

Identifier of project-related classification for
worked performed.
 

Prepare Modified Identifier
 

PreparerModifiedFlag
 

Indicates whether the expense preparer
modified the account or project distribution.
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Attribute Name Predefined Attribute Description

Project Name
 

ProjectName
 

Project name to which an expense item is
assigned.
 

Project Number
 

ProjectNumber
 

Project number to which an expense item is
assigned.
 

Reimbursable Amount
 

ReimbursableAmount
 

Amount to be reimbursed to the individual
against this expense distribution.
 

Key Flexfield Segment 1-30
 

Segment1-30
 

Key flexfield: segment of the key flexfield.
 

Sequence Number
 

SequenceNum
 

Sequence in which the distributions are created.
 

Task Name
 

TaskName
 

Task name to which an expense item is
assigned.
 

Task Number
 

TaskNumber
 

Task number to which an expense item is
assigned.
 

EmployeeExpenseAttendeeVO - Employee Attendees Region
The following table contains attribute names and their corresponding predefined attributes, which are located in the
Employee Attendees region on the Printable Expense Report template.

Attribute Name Predefined Attribute Description

Amount
 

Amount
 

Amount spent on the expense attendee.
 

Attendee Party ID
 

AttendeePartyId
 

Attendee party identifier.
 

Attendee Type
 

AttendeeType
 

Attendee or recipient type of the expense
attendee.
 

Created By
 

CreatedBy
 

Who column: indicates the user who created
the row.
 

Creation Date
 

CreationDate
 

Who column: indicates the date and time of the
creation of the row.
 

Employee Identifier
 

EmployeeFlag
 

Indicates whether an expense attendee is an
employee.
 

Employer Address
 

EmployerAddress
 

Employer address of the expense attendee.
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Attribute Name Predefined Attribute Description

Employer Name
 

EmployerName
 

Employer name of the employee or
nonemployee attendee.
 

Employer Party ID
 

ExployerPartyId
 

Employer party identifier.
 

Expense Attendee ID
 

ExpenseAttendeeId
 

Expense attendee identifier.
 

Expense ID
 

ExpenseId
 

Related expense item identifier.
 

Formatted Amount
 

FormattedAmount
 

Formatted receipt amount.
 

Last Update Date
 

LastUpdateDate
 

Who column: indicates the date and time of the
last update of the row.
 

Last Updated By
 

LastUpdatedBy
 

Who column: indicates the user who last
updated the row.
 

Last Updated By Login
 

LastUpdateLogin
 

Who column: indicates the session login
associated with the user who last updated the
row.
 

Name
 

Name
 

Name of the employee or nonemployee
expense attendee.
 

Object Version Number
 

ObjectVersionNumber
 

Used to implement optimistic locking. This
number is incremented every time that the row
is updated. The number is compared at the
start and end of a transaction to detect whether
another session has updated the row since it
was queried.
 

Tax Identifier
 

TaxIdentifier
 

Tax identifier of the employee or nonemployee
expense attendee.
 

Title
 

Title
 

Title of the employee or nonemployee expense
attendee.
 

NonemployeeExpenseAttendeeVO - Nonemployee Attendees Region
The following table contains attribute names and their corresponding predefined attributes, which are located in the
Nonemployee Attendees region on the Printable Expense Report template.

Attribute Name Predefined Attribute Description

Amount
 

Amount
 

Amount spent on the expense attendee.
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Attribute Name Predefined Attribute Description

Attendee Party ID
 

AttendeePartyId
 

Attendee party identifier.
 

Attendee Type
 

AttendeeType
 

Attendee or recipient type of the expense
attendee.
 

Created By
 

CreatedBy
 

Who column: indicates the user who created
the row.
 

Creation Date
 

CreationDate
 

Who column: indicates the date and time of the
creation of the row.
 

Employee Identifier
 

EmployeeFlag
 

Indicates whether expense attendee is an
employee.
 

Employer Address
 

EmployerAddress
 

Employer address of the expense attendee.
 

Employer Name
 

EmployerName
 

Employer name of the employee or
nonemployee attendee.
 

Employer Party ID
 

EmployerPartyId
 

Employer party identifier.
 

Expense Attendee ID
 

ExpenseAttendeeId
 

Expense attendee identifier.
 

Expense ID
 

ExpenseId
 

Related expense item identifier.
 

Formatted Amount
 

FormattedAmount
 

Formatted receipt amount.
 

Last Update Date
 

LastUpdateDate
 

Who column: indicates the date and time of the
last update of the row.
 

Last Updated By
 

LastUpdatedBy
 

Who column: indicates the user who last
updated the row.
 

Last Updated By Login
 

LastUpdateLogin
 

Who column: indicates the session login
associated with the user who last updated the
row.
 

Name
 

Name
 

Name of the employee or nonemployee
expense attendee.
 

Object Version Number
 

ObjectVersionNumber
 

Used to implement optimistic locking. This
number is incremented every time that the row
is updated. The number is compared at the
start and end of a transaction to detect whether
another session has updated the row since it
was queried.
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Attribute Name Predefined Attribute Description

Tax Identifier
 

TaxIdentifier
 

Tax identifier of the employee or non-employee
expense attendee.
 

Title
 

Title
 

Title of the employee or nonemployee expense
attendee.
 

AttachmentVO - Attachment Region
The following table contains attribute names and their corresponding predefined attributes, which are located in the
Attachment region on the Printable Expense Report template.

Attribute Name Predefined Attribute Description

Document
 

DOCUMENT
 

Actual document for the associated document
type.
 

Title
 

TITLE
 

Title that the user gave the attachment.
 

Related Topics
• Modify the Printable Expense Report Template

• Example of Modifying Expenses Email Notifications Using Oracle Analytics Publisher

Modify Terms and Agreements  
The default corporate policy compliance message is an acceptance statement that employees typically acknowledge
by selecting a check box when they create an expense report. The default message states that the worker has read and
accepted the corporate travel and expense policies.

If you choose to display a corporate policy compliance message, you can use the default provided or you can modify
your message text and make it text only or a clickable link that navigates to your company travel and expense policy.

Business units may have their own requirements related to enforcing acceptance of corporate policies. For example,
some business units may require specific terms and agreements text that reflects their unique acceptance message. As
an implementor, you can decide whether you want to:

• Enforce acknowledgment that the worker has read and accepts the corporate polices by presenting a required
check box to select

• Create terms and agreements text specific to a business unit

• Provide specific terms and agreements text that also acts as a link to the corporate policies

• Provide a link to corporate policies that is specific to a business unit
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You decide the text message to display and whether or not to display it as a clickable link to the corporate policy. You
also decide whether or not to enforce workers' acknowledgment and acceptance of corporate policies by including a
check box before the text message that must be selected. These decisions are made on the Create or Edit Expenses
System Options page.

To navigate to the All Business Units section:

1. In the Setup and Maintenance work area, go to the following:

◦ Offering: Financials

◦ Functional Area: Expenses

◦ Task: Manage Expenses System Options

2. On the Manage Expenses System Options page, Corporate Options for Expense Report subsection, select the
Enable terms and agreements check box.

3. Select the Enable corporate policy URL check box.
To navigate to the Specific Business Units section:

1. In the Setup and Maintenance work area, go to the following:

a. Offering: Financials
b. Functional Area: Expenses
c. Task: Manage Expenses System Options

2. On the Manage Expenses System Options page, Specific Business Units section, select and click a specific
business unit.

3. On the Edit Expenses System Options page, select the Corporate Options for Expense Report tab.
4. From the Enable Terms and Agreements choice list, select an option.
5. From the Enable Corporate Policy URL choice list, select an option.

Navigation to a specific business unit: Setup and Maintenance > Search: Manage Expenses System Options >
Click Manage Expenses System Options link > Manage Expenses System Options page > Specific Business Units
section > Select and click a specific business unit > Edit Expenses System Options page > Select the Corporate
Options for Expense Report tab > Enable Terms and Agreements choice list and the Enable Corporate Policy URL
choice list.

Displaying User-Defined Terms and Agreements Text
You have several options to consider before you decide what and how to display terms and agreements text.

The following table contains several combinations of selecting or deselecting terms and agreements text with or
without a corporate policy URL. The table also describes the resulting text and links that are displayed on the Create and
Edit Expense Report page and on the Welcome page. The selections contained in the table are made on the Manage
Expenses System Options setup page for all business units.

Tip:  You can make the same combination of selections for specific business units with the same resulting text and
links displayed on the Create Expense Report Page and on the Welcome Page. Instead of selecting check boxes,
you select options from a choice list. When you make choices on the Edit Expenses System Option page, you select
options from the Enable Terms and Agreements choice list and from the Enable Corporate Policy URL choice list.
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Enable Terms and
Agreements Check Box

Corporate Policy Choice
List

Enable Corporate Policy
URL Check Box

URL Field Resulting Text and Links
Displayed on the Create
Expense Report Page and
the Welcome Page

Selected
 

Default option selected
 

Selected
 

URL Specified
 

• Check box visible
before text.

◦ A worker must
select the check
box to acknowledge
acceptance of the
corporate policies
before submitting an
expense report.

• Text: I have read and
accept the corporate
travel and expense
policies.

• Clickable link that
opens to your
company's travel
and expense policies
document.

• A clickable link,
 Corporate Policies,
 appears on the
Welcome page
that opens to your
company's travel
and expense policies
document.

Selected
 

User-defined option
selected
 

Selected
 

URL Specified
 

• Check box visible
before text.

◦ A worker must
select the check
box to acknowledge
acceptance of the
corporate policies
before submitting an
expense report.

• Text: User-defined
text.

• Clickable link that
opens to a document
specified by the URL.

• A clickable link,
 Corporate Policies,
 appears on the
Welcome page
that opens to your
company's travel
and expense policies
document.

Deselected
 

N/A
 

Selected
 

URL Specified
 

• No check box visible
before text.
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Enable Terms and
Agreements Check Box

Corporate Policy Choice
List

Enable Corporate Policy
URL Check Box

URL Field Resulting Text and Links
Displayed on the Create
Expense Report Page and
the Welcome Page

• Text: Corporate
Policies.

• Clickable link that
opens to a document
specified by the URL.

• A clickable link,
 Corporate Policies,
 appears on the
Welcome page
that opens to your
company's travel
and expense policies
document.

Selected
 

User-defined option
selected
 

Selected
 

Not Applicable
 

• Check box visible
before text.

• Text: User-defined
text.

• No link to corporate
policies.

• No clickable link
appears on the
Welcome page.

Selected
 

Not Applicable
 

Selected
 

Not Applicable
 

• No check box visible in
expense report.

• No link to corporate
policies.

• No clickable link
appears on the
Welcome page.

Selected
 

Not Applicable
 

Selected
 

URL Specified
 

• No check box visible in
expense report.

• Clickable link that
opens to a document
specified by the URL.

• A clickable link,
 Corporate Policies,
 appears on the
Welcome page
that opens to your
company's travel
and expense policies
document.
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Creating Lookup Codes for User-Defined Terms and Agreements Text
To create user-defined corporate policy compliance text that is displayed on the Create and Edit Expense Report page,
perform the following steps:

1. In the Setup and Maintenance work area, go to the following:

◦ Offering: Financials

◦ Task: Define Lookups

2. Click the Manage Standard Lookups link.
3. On the Manage Standard Lookups page, Search section, enter ORA_EXM_TERMS_AGRMT in the Lookup Type

field and click Search. The ORA_EXM_TERMS_AGRMT lookup type appears, along with its associated lookup
codes.

4. In the ORA_EXM_TERMS_AGRMT: Lookup Codes section, click the New (+) icon to add a new row to the table.
5. In the Lookup Code field, you can enter a unique value, such as Business Unit 1.
6. In the Display Sequence field, enter the sequence in which you want the meanings to display.
7. Select the Enabled check box to enable the lookup code.
8. In the Meaning field, enter a business term that defines the lookup code. The meaning of the lookup codes are

displayed in sequential order when you enable terms and agreements.
9. In the Description field, enter a short description for the lookup code meaning. Whatever you enter for the

description is displayed when you hover over a value on the choice list.
10. Click Save or Save and Close.

Related Topics
• Overview of Lookups

Options for Configuring Expense Policies  
To enforce compliance with your company's expense policies, you can specify any of the following options:

• Receipt required

• Corporate card usage

• Conversion rate

Specifying a Receipt Required Policy
If your accounts payable department requires a receipt for each expense, then you must specify the following for each
expense type that you define on the Create Expense Type page:

• A receipt requirement rule that reflects your company's receipt policy. A receipt can be required for cash only or
for corporate card and cash.

• An expense amount, over which a receipt is required

• Warning and error tolerance percentages so the application can warn the user, if opted, of a receipt required
policy violation or, in the case of an error, actually prevent submission of the expense report

Warnings are tracked by the application. You can view them in the Expense Items section on the Edit Expense Report
page. Errors aren't tracked because they prevent submission of an expense report.
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Specifying a Corporate Card Usage Policy
You can set up corporate card usage policies to enforce the use of corporate cards. These policies increase your control
of the cards by enforcing compliance with the usage policies.

You can specify corporate card usage policies in the Edit Corporate Card Usage Policy dialog box by specifying cash
limits for expense categories. A cash limit is a cash ceiling, over which an employee must use a corporate card to pay for
an expense. An expense category is a grouping of expense types. For example, the expense category of Airfare includes
the following expense types: International Air and Domestic Air.

You must also specify tolerance percentages for warnings or errors as they relate to the cash limits for the expense
categories. The following table illustrates how the warning and error tolerance percentages work for corporate card
usage policies.

Cash Limit for Expense
Category of Car Rental

Warning Tolerance
Percentage

Warning Amount Error Tolerance
Percentage

Error Amount

$100
 

5%
 

$100 + $5 = $105.
 
The warning tolerance is
$100 up to $105. Over $105,
 the user sees a warning.
 

10%
 

$100 + $10 = $110.
 
The error tolerance is over
$105 up to $110. Over $110,
the application prevents the
user from submitting the
expense report.
 

If the employee enters a cash amount over $105 for a car rental on the expense report, a warning displays, if opted, that
reminds the employee to use a corporate card, instead of cash, for car rental charges over $100. Warnings are tracked by
the application. You can view them in the Expense Items section on the Edit Expense Report page.

If the employee enters a cash amount over $110 for a car rental on the expense report, the application prevents
submission of the expense report. Therefore, errors aren't tracked by the application.

Note:  If no cash limits are defined, you can submit cash expenses of any amount.

Specifying a Conversion Rate Policy
You can define conversion rate behavior for each business unit in your company. These definitions enable you to
enforce conversion rate policies and to validate the conversion rates that employees enter for foreign currency receipts.
If you enter a conversion rate value in an expense report, or override a defaulted value, the value you enter is validated
against the current conversion rate definitions.

Note:  Conversion rate behavior applies only to cash expenses, not to corporate card expenses.

You can specify the following conversion rate behavior on the Edit Conversion Rates and Policies page:

• Type of conversion rate, whether Corporate, Spot, or User

• Whether you want the conversion rate to default onto a newly created expense report

Note:  The default conversion rate is only applicable to cash transactions.
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• Warning and error tolerance percentages so the application knows when to warn the user, if opted, of a
conversion rate policy violation or, in the case of an error, actually prevent submission of the expense report

• Warning and error tolerance percentages, if opted, for specific currencies

The following table illustrates how warning and error tolerance percentages work for conversion rate policies.

Conversion Rate Warning Tolerance
Percentage

Warning Tolerance Error Tolerance
Percentage

Error Tolerance

Conversion Rate Type =
Corporate where 1 GBP =
1.579 USD.
 
For this example, the
employee reports expenses
on the expense report in
GBP, but is reimbursed in
USD.
 

5%
 

1.579 + .07895 = 1.65795
 
The warning tolerance is
1.579 USD up to 1.65795.
If the user enters a
conversion rate over
1.65795, a warning displays.
 

10%
 

1.579 + .1579 = 1.7369
 
The error tolerance is over
1.65795 up to 1.7369. If the
user enters a conversion
rate over 1.7369, the
application prevents the
user from submitting the
expense report.
 

If the employee enters a cash amount for a meal of 25 GBP on the expense report and indicates a conversion rate over
1.65795, a warning displays, if opted, that reminds the employee to use a conversion rate less than 1.65795. Warnings
are tracked by the application. You can view them in the Expense Items section on the Edit Expense Report page.

If the employee enters a cash amount for a meal of 25 GBP on the expense report and indicates a conversion rate over
1.7369, the application prevents submission of the expense report. Errors aren't tracked by the application.

Note:  If a conversion rate isn't defined for the applicable reimbursement currency in Oracle Fusion General Ledger,
the application can't enforce the conversion rate policy.

Expense Category-Specific Fields  
An expense category is a broad application-defined expense classification, such as Accommodations, Airfare, Car
Rental, Meals, and Entertainment. Each expense category has fields associated with it, known as category-specific
fields. For example, Accommodations is an expense category that has the following category-specific fields:

Merchant Name and Checkout Date. Similarly, the Entertainment expense category has the category-specific field of
Merchant Name. You can capture additional expense information for each expense category by optionally enabling
the category specific fields provided with the application. The category-specific fields are visible in the expense report
based on the display action you set. You can set the display action for each category-specific field as follows:

• Hidden: the field isn't displayed.

• Required: the field is displayed for each expense item in the expense category and the user is required to enter
data.

• Optional: the field is displayed for each expense item in the expense category, but the user isn't required to
enter data.

You can enable the display action for the category-specific fields in each expense category by business unit. The fields
you enable display for all expense reports for the selected business unit.
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Related Topics
• How You Capture Company-Specific Information

Tax Recoverability Determination for Expense Payment
Requests  
You can determine the tax recoverability of payment requests based on the expense type, expense location, and
employee legal entity location.

The Tax Classification Code and the tax product categories associated with the expense types in the expense report
template help in tax recoverability determination. Expense managers can associate the applicable tax product category
when setting up the expense types.

When a tax product category is associated with an expense type, the related tax determining factors are passed to
Payables from Expenses when the payment requests are created for expense reports. The tax determining factors used
in tax rules are:

• Tax Product Category: Indicates the taxable nature of an item or service purchased or sold.

• Expense Location: Different locations may attract different tax rates for the same expense type.

• Employee Location: Depending on the employee’s primary location, the tax on an expense report may or may
not be recoverable.

• Tax Classification Code: One of the determinants for tax applicability, tax recovery rate determination, and other
tax rules.

Payables passes these tax determining factors to Oracle Tax. The tax module uses one or more of these tax determining
factors, based on the tax rules configured, to determine the recoverability for each expense line.

Enabling Tax Recoverability Determination for Expense Payment Requests
To enable Tax Recoverability Determination for Expense Payment Requests, follow these steps:

1. In the Setup and Maintenance work area, select the Financials offering.
2. Click Change Feature Opt In.
3. On the Opt In: Financials page, click the Features icon for Expenses.
4. On the Edit Features: Expenses page, select Enable for the Tax Recoverability Determination for Expense

Payment Requests feature.
5. Click Done.

This feature will be available without enabling the opt in at a later release.

Related Topics
• Product Category Fiscal Classifications

• Manage Transaction Tax Lines
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How to Assign Tax Product Category to an Expense Type 

Before you can assign a tax product category for an expense type, you must perform the following prerequisite setup in
the Tax module.
Prerequisites

1. Configure the tax product category for Expenses in the Tax module. For more information on configuring
product categories, see the Product Category Fiscal Classifications topic in the Manage Product Based Fiscal
Classifications chapter in the Implementing Tax Guide.

2. Set up Configuration Owner Tax Options (COTO) in Tax Setup. For more details on COTO, refer to the Manage
Configuration Owner Tax Options topic in Implementing Tax Guide.

To assign a tax product category to an expense type perform the following steps

1. In the Setup and Maintenance work area, use the following:
a. Offering: Financials
b. Functional Area: Expenses
c. Task: Manage Expense Report Templates

2. On the Manage Expense Report Templates page, click Edit for the template you want to modify.
3. On the Edit Expense Report Template page, click Edit for the expense type you want to modify.
4. Search and select a tax product category you want to assign to the expense type from the Tax Product

Category drop-down.
5. Navigate to the Expense Fields tab and set the Expense Location field to Required.
6. Click Save or Save and Close.

Create Expense page does not display the Tax product category to employees when creating expenses. Expenses
assigns the tax product category to each expense and passes this information together with other tax determining
factors to Payables when the Process Expense Reimbursements process creates payment requests in Payables.

Related Topics
• Product Category Fiscal Classifications

• Manage Transaction Tax Lines

How You Capture Tax-Related Information in Expense
Reports  
You can display tax-related fields in expense reports to capture tax-related information. To do so, you must enable the
option to display tax-related fields in expense reports.

Here's how you can do it:

1. In the Setup and Maintenance work area, use the following:
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◦ Offering: Financials

◦ Functional Area: Expenses

◦ Task: Manage Tax Fields

2. On the Manage Tax Fields page, click the business unit whose tax-related fields you want to display.
3. On the Edit Tax Fields page, select Display tax fields on expense report.
4. For each business unit, define the display action of each tax-related field. You can define the display action of

tax-related fields for all locations and then define exception display action for specific countries.
For example, Merchant Name and Taxpayer ID are tax-related fields for which you can define display action.
The display actions available for each tax-related field are as follows:

◦ Hidden: Tax-related field isn't displayed in the expense report.

◦ Optional: Tax-related field is displayed for each expense item in the expense category, but the user isn't
required to enter data.

◦ Required: Tax-related field is displayed for each expense item in the expense category and the user is
required to enter data

Note:  When you define the display action of the tax-related fields in each expense category at the business unit level,
the enabled fields appear in all expense reports for the given business unit. However, for itemized lines, only the Tax
Classification Code field is displayed.

Options for Showing or Hiding the Tax Classification
Code  
Whether to show or hide the Tax Classification Code choice list from employees on the UI is a management decision
based on your company's practices. Some companies let their employees assign a tax classification code to their
expenses.

don't want employees to have that ability. You can choose from the following options:

• Show the Tax Classification Code on the UI

• Hide the Tax Classification Code from the UI

• Hide the Tax Classification Code from the UI and assign it on the back end

Show the Tax Classification Code on the UI
The following table describes how to show the Tax Classification Code choice list on the UI.

Hide or Show Option Edit Tax Fields Page--Setup and
Maintenance

Create Expense Type Page--
Setup and Maintenance

Create Expense Item Page--
Expense Entry

Show the Tax Classification Code
choice list on the UI.
 

• Implementor selects the
Display tax fields on expense
report check box.

Not applicable.
 

Employees select an option from
the Tax Classification Code choice
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Hide or Show Option Edit Tax Fields Page--Setup and
Maintenance

Create Expense Type Page--
Setup and Maintenance

Create Expense Item Page--
Expense Entry

• Implementor selects Optional
or Required from the Tax
Classification Code choice list.

list when creating an expense
report.
 

Hide the Tax Classification Code from the UI
The following table describes how to hide the Tax Classification Code choice list from the UI.

Hide or Show Option Edit Tax Fields Page--Setup and
Maintenance

Create Expense Type Page--
Setup and Maintenance

Create Expense Item Page--
Expense Entry

Hide the Tax Classification Code
choice list from the UI.
 

• Implementor selects the
Display tax fields on expense
report check box.

• Implementor selects Hidden
from the Tax Classification
Code choice list.

Not applicable.
 

Tax Classification Code choice list
isn't visible for employees to select
from when creating an expense
report.
 

Tip:  When the Display tax fields on expense report option is selected, the Location field becomes required on the
Create Expense Item page.

Hide the Tax Classification Code from the UI and Assign it on the Back End
The following table describes an alternate option to hide the Tax Classification Code choice list from the UI and assign
the tax classification code on the back end.

Hide or Show Option Edit Tax Fields Page--Setup and
Maintenance

Create Expense Type Page--
Setup and Maintenance

Create Expense Item Page--
Expense Entry

Hide the Tax Classification Code
choice list from the UI and assign
the tax classification code on the
back end.
 

• Implementor selects the
Display tax fields on expense
report check box.

• Implementor selects Hidden
from the Tax Classification
Code choice list.

Implementor assigns the same or a
different tax classification code to
each expense type.
 

• Tax Classification Code choice
list isn't visible.

• Tax classification code is
automatically applied behind
the scenes:

◦ To the expense item when the
user saves the page.

◦ To Oracle Fusion Payables.
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How You Capture Company-Specific Information  
You can configure Oracle Fusion Expenses to capture company-specific information about expense reports for each
expense by enabling descriptive flexfields provided at the expense type level. A descriptive flexfield is a configurable
field that captures additional information.

For each expense type, you can capture up to 15 fields of additional information. This can be context-sensitive
information based on the expense type or information that is collected across expense types called global descriptive
flexfields.

To enable the capture of additional company-specific information in expense reports:

1. Set up descriptive flexfields.
2. Enable descriptive flexfields.

Set Up Descriptive Flexfields
Set up the descriptive flexfield, EXM_EXPENSES, that is provided by the application. You can enter expense types and
fields you want to show for each expense type on the Manage Descriptive Flexfields for Expense Reports page.

To implement context-sensitive or global descriptive flexfields in Expenses, you must:

• Identify expense types on the line level for which you want to capture information and the fields you want to
add for each expense type. These fields are context-sensitive descriptive flexfields.

• Identify the common information that you want to capture across expense types. These fields are global
descriptive flexfields.

• Determine how you want the context-sensitive and global descriptive flexfields to render to the user.

Note:  The expense type you enter in the descriptive flexfield definition must exactly match the expense types you
defined in the expense templates. Otherwise the descriptive flexfield won't be visible.

Enable Descriptive Flexfields
To capture the additional information defined in the descriptive flexfields, you must enable descriptive flexfields in the
expense report. You can set the system option, Enable Descriptive Flexfields, to Yes on the Manage Expenses System
Options page. By default, this option is set to No.

You can set this option at the implementation level on the Manage Expenses System Options page, which applies to
all business units. Alternatively, you can specify exceptions for specific business units on the Create System Options:
Specific Business Unit dialog box.
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How You Create Expense Report Header Descriptive
Flexfields  
You can configure Oracle Expenses to capture company-specific information for each expense report by enabling
descriptive flexfields at the expense report level. A descriptive flexfield is a configurable field that captures additional
information.

For each expense report, you can capture up to 27 additional fields of information.

The types of descriptive flexfields that you can create include:

• Global

• Business unit-specific

• User-defined, context-sensitive

For each type of descriptive flexfield you create, you determine how you want the fields to render. To begin, in Setup
and Maintenance on the Manage Descriptive Flexfields for Expense Reports page, select the predefined descriptive
flexfield named Expense Report Header and click the Edit icon. This predefined descriptive flexfield enables you to
create and place descriptive flexfields of your choice in the header section of expense reports.

Creating Global Descriptive Flexfields
Global descriptive flexfields identify the common information that you want to capture across all expense reports. On
the Edit Descriptive Flexfield: Expenses Report Header page in the Global Segments section, you can create global
descriptive flexfields according to your business requirements.

Creating Business Unit-Specific Descriptive Flexfields
Business unit-specific descriptive flexfields identify the common information that you want to capture across a specific
business unit. On the Edit Descriptive Flexfield: Expenses Report Header page in the Context Segment section, do the
following:

1. In the Prompt field, enter Business Unit.
2. From the Value Set choice list, select the predefined value set named ORA_EXM_BUSINESS_UNIT.

This value set contains the names of all business units in your organization.

Then, create a context for each business unit that requires specific descriptive flexfields by clicking Manage Contexts.
For example, if you are creating descriptive flexfields for the business unit, Vision Operations, then you must also
create a context named Vision Operations.

Note:  The business unit name you enter as the context display name must match the business unit name that you
select from the Value Set choice list. Otherwise, the business unit-specific descriptive flexfield that you create won't
work.
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Creating User-Defined Descriptive Flexfields
User-defined descriptive flexfields identify context sensitive information you want to capture for each expense report.
For example, suppose a user-defined context is Expense Purpose, which captures additional descriptive information
related to Sales, Training, Relocation, or Miscellaneous. On the Edit Descriptive Flexfield: Expenses page in the Context
Segment section, do the following:

1. In the Prompt field, enter the user-defined context, Expense Purpose.
2. From the Value Set choice list, select a value set that contains the values for which you intend to create

descriptive flexfields.

Note:  You many need to create a value set if one doesn't already exist.

The value set contains the names of various contexts of interest.

Then, create a context for each business unit that requires specific descriptive flexfields by clicking Manage Contexts.
The user-defined name you enter as the context display name must match the name that you select from the Value Set
choice list. Otherwise, the user-defined descriptive flexfield that you create won't work.

Note:  In the expense report header, you can create either business unit-specific descriptive flexfields or user-
defined descriptive flexfields. You cannot have both in the expense report header at the same time. Global descriptive
flexfields can always appear with either business unit-specific descriptive flexfields or user-defined descriptive
flexfields.

Note:  Display of expense report level descriptive flexfields isn't dependent on the Enable Descriptive Flexfield
option on the Manage Expenses System Options page.

Related Topics
• Overview of Flexfields

• Overview of Flexfield Configuration

• Flexfield Components

How You Create Cash Advance Descriptive Flexfields  
You can configure Oracle Expenses to capture company-specific information for cash advances by enabling the Cash
Advance descriptive flexfield. A descriptive flexfield is a configurable field that captures additional information.

The types of descriptive flexfields that you can create include:

• Global

• Business unit-specific

• Cash advance type-specific

• User-defined, context-sensitive

For each type of descriptive flexfield you create, you determine how you want the fields to render. To begin, in Setup
and Maintenance on the Manage Descriptive Flexfields for Expense Reports page, search and select the predefined

140

https://www.oracle.com/pls/topic/lookup?ctx=fa26a&id=s20030415
https://www.oracle.com/pls/topic/lookup?ctx=fa26a&id=s20042993
https://www.oracle.com/pls/topic/lookup?ctx=fa26a&id=s20053864


Oracle Fusion Cloud Financials
Implementing Expenses

Chapter 3
Expense Policies and Rules

descriptive flexfield named Cash Advance and click the Edit icon. This predefined descriptive flexfield enables you to
create and place descriptive flexfields of your choice in cash advance requests.

Creating Global Descriptive Flexfields
Global descriptive flexfields identify the common information that you want to capture across all cash advances. On
the Edit Descriptive Flexfield: Cash Advance page in the Global Segments section, you can create global descriptive
flexfields according to your business requirements.

Creating Business Unit-Specific Descriptive Flexfields
Business unit-specific descriptive flexfields identify the common information that you want to capture across a specific
business unit. On the Edit Descriptive Flexfield: Cash Advance page in the Context Segment section, do the following:

1. In the Prompt field, enter a display name.

Note:  The display name must match the business unit name from the value set that you select in the next
step. Otherwise, the business unit-specific descriptive flexfield that you create won't work. For example, if
you're creating descriptive flexfields for the business unit, Vision Operations, then you must create a context
named Vision Operations.

2. From the Value Set choice list, select the predefined value set named ORA_EXM_BUSINESS_UNITS.

This value set contains the names of all business units in your organization.

Then, click Manage Contexts to create a context for each business unit that requires specific descriptive flexfields.

Creating Cash Advance Type-Specific Descriptive Flexfields
Descriptive flexfields that are specific for cash advance type identify the common information that you want to capture
across a specific cash advance type. On the Edit Descriptive Flexfield: Cash Advance page in the Context Segment
section, do the following:

1. In the Prompt field, enter a display name.

Note:  The display name must match a cash advance type name from the value set that you select in the next
step. Otherwise, the cash advance type-specific descriptive flexfield that you create won't work. For example,
if you're creating descriptive flexfields for the type, Travel, then you must create a context named Travel.

2. From the Value Set choice list, select the predefined value set named ORA_EXM_CASH_ADVANCE_TYPE.

This value set contains the cash advance types in your organization.

Then, click Manage Contexts to create a context for each cash advance type that requires specific descriptive flexfields.

Creating User-Defined Descriptive Flexfields
User-defined descriptive flexfields identify context sensitive information you want to capture for each cash advance. For
example, a user-defined context is Cash Advance Purpose, which captures additional descriptive information related
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to Sales, Training, Relocation, or Miscellaneous. On the Edit Descriptive Flexfield: Cash Advance page in the Context
Segment section, do the following:

1. In the Prompt field, enter a display name, such as Cash Advance Purpose.

Note:  The display name must match a user-defined field name from the value set that you select in the
next step. Otherwise, the user-defined descriptive flexfield that you create won't work. For example, if you're
creating descriptive flexfields for Cash Advance Purpose, then you must create a context named Cash
Advance Purpose.

2. From the Value Set choice list, select the value set that contains the values for the user-defined descriptive
flexfields.

Note:  You have to create a value set if one doesn't already exist. The value set contains the names of various
contexts of interest.

Then, click Manage Contexts to create a context for each user-defined field that requires specific descriptive flexfields.

You can define both global segments and context segments for the Cash Advance flexfield. You can configure only one
context value set for the descriptive flexfield. For example, you can't simultaneously configure Business Unit and user-
defined context for the Cash Advance descriptive flexfield.

Related Topics
• Overview of Flexfields

• Flexfield Components

• Overview of Flexfield Configuration

Pay Groups for Expense Reports and Cash Advances  

Oracle Fusion Expenses enables you to set up separate pay groups for expense reports and cash advances. These
distinct pay groups allow organizations to process any negative reimbursement separately and also prevent the
negative payment requests from getting applied against positive payment requests and cash advances.

These pay groups are helpful when organizations have to deduct from the employee's payroll or bank account for the
personal expenses that were charged against the credit card in a Company Pay liability card program.

To set up pay groups, you need one of these roles:

• Expense Manager

• Application Implementation Consultant

Set Up Pay Group for Negative Expense Reports
You can assign the pay group at the implementation level on the Manage Expenses System Options page, which applies
to all business units. Alternatively, you can specify exceptions for specific business units on the Create System Options:
Specific Business Unit dialog box.

1. Sign in as the Application Implementation Consultant.
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2. From the Setup and Maintenance work area, navigate to the Manage Expenses System Options page.
3. Under Processing Options for Expense Report, select a pay group for Pay Group for Negative Expense Reports.
4. You can select a value from the list of pay groups available or you can search for a specific pay group and assign

the value.

Set Up Pay Group for Cash Advances
You can assign the pay group at the implementation level on the Manage Cash Advance and Authorization Policies
page, which applies to all business units. Alternatively, you can specify exceptions for specific business units on the
Create Business Unit - Specific Cash Advance Policies dialog box.

1. Sign in as the Application Implementation Consultant.
2. From the Setup and Maintenance work area, navigate to the Manage Cash Advance and Authorization Policies

page.
3. Under Cash Advances, select a pay group for Payment Group for Cash Advances.
4. You can select a value from the list of pay groups available or you can search for a specific pay group and assign

the value.

John, who is traveling, uses his credit card for both official and personal expenses. John makes a total purchase of
$1699 using this credit card of which $199 was a personal expense. Under the Company Pay liability card program, the
company pays the card issuer for both the business and personal expenses incurred on the card. When the Process
Expense Reimbursements process is run, the transaction for $199 is created as a negative expense report as John owes
this amount to the employer. If the company has already assigned a pay group to negative expense reports, then this
expense report gets assigned to that pay group.

In Payables, you can easily find the negative invoices by searching for the pay group.
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Expense Types  
An expense type is a potential expense that employees or contingent workers can incur. Expense types are granular
expenses. For example, if Accommodations is an expense category, then possible expense types are Hotel, Motel, and
Bed and Breakfast.

After you set up an expense type, employees can select it from the Type list on the Create Expenses page. The Type list
can display up to 250 expense types.

Setting up expense types in Expenses includes the following actions:

• Creating expense types

• Itemizing expense types

• Enabling project-enabled expense types

• Enabling automatic population of the tax classification code

Creating Expense Types
When you create an expense type on the Create Expense Type page, you assign an account to the expense type. This
enables the application to allocate expenses to a specific account. Additionally, you can specify whether receipts are
required when users submit expense reports for approval. You can also require submission of a receipt over a specified
amount. Receipt submission requirements can be set up for cash expenses, corporate card expenses, or both.

After creating expense types, associate them with corporate card expense types on the Card Expense Type Mapping tab
of the Create Expense Template page. Corporate card expense types come predefined with Expenses or you can add
them as additional lookups. Associating defined expense types with corporate card expense types enables Expenses to
correctly derive expense types during the corporate card transaction upload process.

Itemizing Expense Types
Itemization is the breaking down of charges in a granular fashion so they can be applied to specific accounts.
Itemization applies to both corporate card expense types and cash.

You set up itemization on the Itemization tab of the Create or Edit Expense Type page according to your company's
requirements. You decide whether to enable, disable, or require itemization by employees or contingent workers when
they create an expense item during expense entry. During itemization setup, you also decide one of the following:

• Whether expense types you define are eligible during expense entry for itemization only.

• Whether expense types you define are also available as an independent, single expense type.

Note:  When itemization is set up as Required or Enabled, include at least one expense type on the Itemization tab of
the Create Expense Type page.

Specify whether a card expense type is a candidate for automatic itemization on the Card Expense Type Mapping tab
of the Create Expense Template page. If you enable automatic itemization for an expense type, you must then select
a default itemization expense type. A default itemization expense type is one to which expenses are automatically
populated when they're outside the defined itemization. For example, suppose a deploying company maps corporate
card expense types to expense types and identifies a default itemization expense type called Miscellaneous. When the
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corporate card feed file is uploaded to Expenses, any unmapped expense types default to the Miscellaneous expense
type.

Note:  If automatic itemization is disabled for a specific expense type, then the expense type isn't automatically
itemized for you.

Enabling Project-Enabled Expense Types
Project-enabled expense types are associated with a project expenditure type in Oracle Fusion Project Costing if the
user is allowed to enter project information. For example, a project-enabled expense type enables a consultant to
allocate his consulting expenses to a specific project and its tasks during expense creation report.

To set up project-enabled expense types on the Project Expenditure Type Mapping tab of the Create Expense Type
page, select the Enable projects check box. You must also select a default project expenditure type, which is a project
expense type to which unspecified project unit expenses are assigned. Additionally, you can specify whether receipts
are required for project expenses when the user submits an expense report.

The project-enabled expense type can be mapped to a specific project unit and a project expenditure type on an
exception basis. It's the association of a project-enabled expense type with a project unit and a project expenditure type
that derives accounting in Oracle Projects Costing.

Note:  Before you can project-enable expense types, you must perform the following prerequisite setup in Oracle
Fusion Project Foundation:

• Project unit: A unique identifier of a group of projects that are managed as a unit.

• Project expenditure type: A classification of cost.

Enabling Automatic Population of the Tax Classification Code
When you create an expense type on the Create Expense Type page, you can specify the tax classification code that
applies to the expense type. The tax classification code specified during the setup of an expense type is automatically
populated onto the Create Expense Item page during expense entry. If necessary, the user can override the specified tax
classification code when creating an expense item if the tax field is enabled on the report.

Prepaid Expenses  
Prepaid expenses are travel or business expenses that a company directly pays to the vendors or merchants before or
after an employee enters them in an expense report.

Entering these expenses in expense reports allows companies to accurately allocate these expenses.

How to Enable Prepaid Expenses
You can enable prepaid expenses for an expense type from the Manage Expense Report Templates page. When you
enable prepaid expenses for an expense type, the Create Expense page displays the This is a prepaid expense check
box when that expense type is selected. Employees can enter the prepaid expenses in the expense report for these
expense types by selecting this check box.
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Note:  You can’t enable prepaid expenses for itemization only expense types.

When the Process Expense Reimbursements process runs, prepaid expenses aren’t passed to Payables and the
employees don't receive reimbursement for the prepaid expenses. The accounting distributions for the prepaid
expenses aren’t passed to Payables because the expenses were prepaid. The companies are expected to have captured
the accounting distributions in the original payments made to the merchants.

To enable prepaid expenses, perform the following steps:

1. In the Setup and Maintenance work area, use the following:
a. Offering: Financials
b. Functional Area: Expenses
c. Task: Manage Expense Report Templates

2. On the Manage Expense Report Templates page, select the template you want to modify.
3. On the Edit Expense Report Template page, search and select the expense type for which you want to allow

prepaid expenses.
4. Select Allow prepaid expense items.
5. Click Save or Save and Close.
6. Repeat steps 3-5 for each expense type you want to enable for prepaid expenses.

You can also create prepaid expenses using these Expenses REST APIs:

• Create an expense record

• Update an expense record.

The expense is marked as prepaid if the PrepaidFlag parameter is set to 'Y' in the expense payload.

Options for Controlling the Behavior of Expense Fields  
You can control the behavior of certain fields on the Create Expense Item page. You can choose to update the following
modifiable expense fields at the most granular level or at a less granular level:

• Description

• Merchant Name

• Number of Days

• Expense Location

If you want to modify expense fields on specific UI pages, you can set up the modifiable expense fields at the most
granular level. The most granular setup occurs at the expense type level.

When you set up modifiable expense fields, you can specify expense field behavior for:

• All expense types associated with an expense template

• Specific expense types

Alternately, you can perform a less granular implementation of the modifiable expense fields with the setups for:

• Expense policies

• Tax fields
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Note:

◦ Expenses mobile application ignores the tax-level configuration.

• Expense fields by category

• The profile option, EXM_LINE_DESCR_REQUIRED, referred to as Description Line Required

A less granular level implementation is set up that's not dependent on a specific expense type.

Modifiable Expense Fields Displayed by Expense Category
The Description field and the Expense Location field display in all expense categories. However, the Merchant Name
field and the Number of Days field only display for certain categories.

The following exception table summarizes the default visibility of the Merchant Name field and the Numbers of Days
field when you initially receive the application.

Expense Category Default Display of Merchant Name Field Default Display of Number of Days Field

Accommodations
 

Yes
 

Yes
 

Airfare
 

Yes
 

No
 

Car Rental
 

Yes
 

Yes
 

Entertainment
 

Yes
 

No
 

Meals
 

Yes
 

No
 

Mileage
 

No
 

No
 

Miscellaneous
 

Yes
 

Yes
 

Per Diem
 

No
 

No
 

If you want to change the behavior of any of the modifiable fields, you can do so.

All Expense Types Associated with an Expense Template
On the Expense Fields tab of the Create Expense Report Template page, you can set a value of Null, Hidden, Optional,
or Required for the modifiable expense fields.

When you create a new expense template, the default value for all of the preceding modifiable expense fields is Hidden.
A Null value indicates that there's no setup and you don't intend to use the expense template to specify the behavior of
the modifiable expense field.

147



Oracle Fusion Cloud Financials
Implementing Expenses

Chapter 3
Expense Policies and Rules

The values you select for the modifiable expense fields at the expense template level are applicable to all expense types
available in the expense template. You can set up any exceptions at the expense type level.

Specific Expense Types
On the Expense Fields tab of the Create Expense Type page, you can set a value of Use setup from expense template,
Hidden, Optional, or Required for the modifiable expense fields.

The default value is Use setup from expense template. If you retain the default value for the modifiable expense fields
and the expense template setup is Null for the modifiable expense fields, it means that no setup exists at the expense
template level or at the expense type level.

On the Policies tab of the Create Expense Type page, you can assign an expense policy to an expense type. Different
expense policies require you to enter information in different expense fields. Contradictions can arise between an
expense field value for an expense policy and the expense field setup at the expense type level or at the expense
template level. If a contradiction occurs, the application asks you to either change the expense field value or select a
different expense policy.

Set Up Precedence of Modifiable Expense Fields
Expenses follow a precedence when multiple behavior setups exist for modifiable expense fields. For example, set the
Description field at the expense type level to Optional. Set the same field at the expense template level to Required. The
application complies with the setting at the expense type level.

Note:  The Expenses web and the mobile application follow the same order of precedence except for the tax level
settings. Expenses mobile application ignores the tax-level configuration.

Description field

The next table explains the Description field behavior based on the setup.

Behavior Set up on

Expense Type Expense Template Category Policy Tax

Display Behavior

Hidden, Optional, or
Required

Any Not Applicable Not Applicable Not Applicable According to Expense
Type setup

Use setup from
expense template

Hidden, Optional, or
Required

Not Applicable Not Applicable Not Applicable According to Expense
Template setup

Use setup from
expense template

NULL Not Applicable Not Applicable Not Applicable Optional

Merchant field

The next table explains the Merchant field behavior based on the setup.

Behavior Set up on

Expense Type Expense Template Category Policy Tax

Display Behavior

Hidden, Optional, or
Required

Any Not Applicable Not Applicable Not Applicable According to Expense
Type setup
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Use setup from
expense template

Hidden, Optional, or
Required

Any Not Applicable Not Applicable According to Expense
Template setup

Use setup from
expense template

NULL Hidden, Optional, or
Required

Not Applicable Hidden According to category
setup

Use setup from
expense template

NULL Hidden or Optional Not Applicable Optional, or Required According to tax setup

Use setup from
expense template

NULL Required Not Applicable Optional, or Required Required

Use setup from
expense template

NULL NULL Not Applicable Not Applicable Optional

Location field

Location is a required field if set as a determinant in the policy. For example, if you set location as an optional field in the
Expense Type and Expense Template setup and set it as a determinant in the policy then it's a required field. However,
the display behavior would vary if it's not set as a determinant in the policy. The next table explains the Location field
behavior if it's not set as a determinant in the policy.

Behavior Set up on

Expense Type Expense Template Category Policy Tax

Display Behavior

Hidden, Optional, or
Required

Hidden, Optional,
 Required, or NULL

Not Applicable Location is NOT a
determinant

Enabled/Disabled According to Expense
Type setup

Use setup from
expense template

Hidden, Optional, or
Required

Not Applicable Location is NOT a
determinant

Enabled/Disabled According to Expense
Template setup

Use setup from
expense template

NULL Not Applicable Location is NOT a
determinant

Enabled Required because tax
setup is enabled

Use setup from
expense template

NULL Not Applicable Location is NOT a
determinant

Disabled Optional because no
setup is available

Number of Days field

The Number of Days field is applicable only for these categories:

1. Accommodation
2. Car Rental
3. Miscellaneous

Number of Days is a required field if set as a determinant in the policy. For example, if you configure Expense Type to
use Expense Template setup, and set the Number of Days field as an optional field in the Expense Template setup but
set as a determinant in the policy then it's a required field. However, the display behavior would vary if it's not set as a
determinant in the policy. The next table explains the Number of Days field behavior if it's not set as a determinant in
the policy.

Behavior Set up on

Expense Type Expense Template Category Policy Tax

Display Behavior

Hidden, Optional, or
Required

Hidden, Optional,
 Required, or NULL

Not Applicable Number of Days is
NOT a determinant

Not Applicable According to Expense
Type setup
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Use setup from
expense template

Hidden, Optional, or
Required

Not Applicable Number of Days is
NOT a determinant

Not Applicable According to Expense
Template setup

Use setup from
expense template

NULL Not Applicable Number of Days is
NOT a determinant

Not Applicable Optional because no
setup is available

Related Topics
• Set Up an Airfare Policy

• Set Up an Accommodations Expense Policy

• Set Up a Miscellaneous Expense Policy

• How You Set Up a Mileage Expense Policy

• Set Up a Meals Expense Policy

Options for Creating Expense Templates  
An expense template is a grouping of related expense types that are defined for a specific business unit. Examples of
groupings of related expense types include expense templates for travel, education, and relocation.

Expense templates enable companies to control the expense types visible to each business unit. Additionally, if your
company processes card transactions and you want expense types automatically assigned during card transaction
processing, you must set a default template.

When creating expense templates, it's advisable to consider the following actions:

• Using expense templates

• Defining default expense templates

• Inactivating expense templates

Using Expense Templates
When employees create expense items in the Create Expense Item dialog box to add to new or existing reports, they
select a specific expense template.

The following rules apply to expense templates:

• Each business unit can have multiple expense templates associated with it.

• Expense templates can't be shared across business units.

Note:  If your company operates in multiple countries, you must create one expense template per business
unit. If your users use multiple languages within a business unit, then you must implement expense
templates in each of those languages.

Defining Default Expense Templates
A default expense template is the first expense template that you create on the Create Expense Template page with
corporate card expense type mapping. The application automatically sets the first template as the default template. This
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action occurs whether or not you select the Set as default check box on the Create Expense Template page. You can
also change the default template, as long as the one you're changing to has corporate card expense type mapping.

The purpose of a default expense template is to automatically populate expense types to credit card transactions.
Thus, when employees or contingent workers create expense reports, they can see the expense types assigned to the
corporate card transactions. The default expense template uses the corporate card expense type mapping to associate
expense types with the corporate card transactions. This association occurs when the corporate card feed file containing
corporate card charges is uploaded to Expenses.

The following rules apply to default expense templates:

• Each business unit can have only one default expense template.

• For any business unit, you can have a default expense template with additional expense templates.

• For any business unit, you can have a default expense template with no additional expense templates.

Note:  If neither a default expense template nor an expense template is associated with a business unit, you can't
implement Expenses.

Inactivating Expense Templates
Deploying companies don't typically inactivate expense templates because they can't use them after the end date. It's
therefore advisable to leave the Effective End Date field blank, unless you intend to retire the expense template. Any
expenses that are incurred after an end date can't be reported using an inactivated expense template. It's more likely
that you would inactivate individual expense types, rather than inactivate an expense template.

To inactivate an expense template, enter a date in the Effective End Date field on the Create Expense Template page.
You can also inactivate individual expense types in the same way on the Create or Edit Expense Type page. However,
the expense template end date overrides the end date for individual expense types. Note that employees can still use
inactivated templates to enter expenses on a report for the period in which the expense report was active.

CAUTION:  If you decide to inactivate a default expense template, then no corporate card mapping occurs if no other
default expense template is identified.

How Expense Item Accounting Is Derived  
This topic provides an example of the expense item accounting flow so you can understand how expense item
accounting works. With this understanding, you can set up default expense accounts properly to generate valid expense
account combinations.

Before you can derive distributions, you must:

• Define default expense accounts in your human resources application for each person who uses Oracle
Expenses Cloud.

• Decide whether or not to give employees the capability of changing the company segment and the cost center
segment

• Decide whether or not to give employees the capability of changing all segments in the default expense
account
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• Set up the natural expense account for expense types in the expense template.

Settings That Affect Expense Item Accounting
The following setups affect expense item accounting:

• Default expense account set up

Every person who uses Expenses must be set up with a default expense account in your human resources
application.

Note:   If you don't set up default expense accounts for all users, they can't submit expense reports.

• Natural expense account setup

When you create an expense report template on the Create Expense Report Template page, you set up expense
types and specify the natural expense account for each expense type. The natural expense account is a
segment in the default expense account.

• Optional expense accounting privilege assignment

You can assign the expense accounting privilege named Override Expense Account Allocation for all
employees. Then, they can change the Company and Cost Center segments of the default expense account on
the Create or Edit Expense Item page.

To set up the Override Expense Account Allocation privilege, navigate to: Setup and Maintenance > Tools >
Security Console.

• Optional accounting profile option setup

You can set the accounting profile option named EXM_ALLOW_FULL_ACCT_OVERRIDE to Yes for all or specific
employees. Then, they can change any segment of the default expense account on the Create or Edit Expense
Item page.

To set the accounting profile option for all employees, navigate to: Setup and Maintenance and
search for and select Manage Administrator Profile Values. Search for the profile option named
EXM_ALLOW_FULL_ACCT_OVERRIDE in the Profile Option Code field and set the Profile Value choice list to
Yes at the site, product, or user level.

How Expense Item Accounting Is Derived
The example in the following table describes how expense item accounting works.

Step Action Initial Expense Account Resulting Default Expense
Account

1.
 

An employee's default expense
account is set up in the human
resources application where:
 

• 10 = Company

• 520 = Department

• First set of four zeros =
Natural Expense Account

01-520-0000-0000-000
 

Not applicable.
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Step Action Initial Expense Account Resulting Default Expense
Account

2.
 

Employee creates an expense
report and selects the expense
type of Hotel.
 
Hotel = 7670 in the Travel expense
template.
 

01-520-0000-0000-000
 

01-520-7670-0000-000
 

3.
 

Employee has the expense
accounting privilege of Override
Expense Account Allocation
assigned him.
 
Employee sees the following
segments on the Create Expense
Item page:
 

• Company segment 01.
Employee changes 01 to 02.

• Department segment 520.
Employee changes 520 to
540.

01-520-7670-0000-000
 

02-540-7670-0000-000
 

4.
 

Accounting profile option named
EXM_ALLOW_FULL_ACCT_
OVERRIDE is enabled.
 
Employee sees the entire default
expense account with all the
segments on the Create Expense
Item page. He can change any or all
segments.
 

• Segment 0000. Employee
changes 0000 to 3251.

• Segment 000. Employee
changes 000 to 478.

02-540-7670-0000-000
 

02-540-7670-3251-478
 

If you change accounting segments on the Create or Edit Expense Item page, the change is applied to the Expenses
accounting distributions in the background. When the expense report is processed for reimbursement, Oracle Payables
Cloud pulls the expense item accounting information from Expenses to generate accounting. The resulting invoice or
payment request reflects the accounting.

Enable Splitting Expenses  
Your company can choose to allow its employees to split some expenses across accounts or projects. For example, an
employee may want to split the monthly telephone expense across the multiple projects on which they're working.

Users can split expenses across accounts or projects based on the privileges that are assigned to them.
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After a user splits the expenses and submits it for approval, the manager can see the split details in the expense
approval report. Similarly, the auditors can review the split details on the Audit Expense Report page.

Here are the steps to enable splitting expenses:

1. In the Setup and Maintenance work area, select these options:

◦ Offering: Financials

◦ Functional Area: Expenses

◦ Task: Manage Expenses System Options

2. In the User Options for Expense Report section, set the value of the Enable Split Allocations field to Yes.

Note:  You can also set this option for specific business units as well.

3. Click Save and Close.

Entertainment Expense Policy  
You define an entertainment expense policy to manage entertainment and gift expenses for which employees are
reimbursed.

Your company must comply with laws and regulations and guard against inappropriate expenditures that may arise
when employees entertain or give gifts to customers. To assist with this effort, you can define entertainment spending
rules, enable entertainment policy violations, and capture information about event attendees and gift recipients.

Here's how you can define and manage entertainment policies:

1. In the Setup and Maintenance work area, select the following:

◦ Offering: Financials

◦ Functional Area: Expenses

◦ Task: Manage Policies by Expense Category

2. Select Entertainment from the Create Policy list to go to the Create Entertainment Policy page.
When you define an entertainment expense policy, you perform the actions as described in the following sections.

Determine Whether to Capture Number of Attendees for Expense Lines
Above the Specified Amount
You can decide whether to capture the number of attendees only when expenses surpass the designated limits. To do
this, select the option Capture number of attendees for expense lines above the specified amount.

After you use this option, employees are required to enter the number of attendees only when an expense is over the
limit. If the expense amount is within the designated limit, entering the number of attendees is optional.

If your company needs to capture other attendee information, such as attendee names, or enforce rate limit policies for
Entertainment expenses, then select the Capture attendee information option.
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Specify Attendee-Related Information to Capture
You decide which of the following event attendee information to capture in the Add Attendees dialog box. You can do
it by selecting any of the following check boxes in the Enable Attendee Information section on the Create Entertainment
Policy page:

• Require attendee amount: If selected, employees are required to enter amounts that were actually spent on
event attendees.

• Require employee name: If selected, employees are required to enter at least one employee as an event
attendee.

• Display employee attendee information: If selected, an Employees section is visible in the Add Attendees
dialog box.

• Display nonemployee attendee information: If selected, a Nonemployees section is visible in the Add
Attendees dialog box.

Define Types of Rate Limits and Number of Currencies
In the Rate Definition section on the Create Entertainment Policy page, you decide whether to enable rate limits for the
entertainment expense policy. If you enable them, you can:

• Select the type of rate limit, whether single instance, yearly, or daily.

• Specify whether the entertainment expense policy rate is defined by a single currency or multiple currencies.

Note:  If a currency rate conversion is necessary to verify a policy rate limit, you must define a conversion rate in
Oracle Fusion General Ledger.

Determine Whether to Include Attendee Types as the Rate Determinant
A rate determinant for an entertainment policy determines the policy rate amount limit that an employee can be
reimbursed for entertainment or gift expenses. An entertainment expense policy has one rate determinant, an attendee
type (employee or nonemployee).

In the Rate Determinants section on the Create Entertainment Policy page, you decide whether to include types of
attendees as the rate determinant. To include them, you can define different policy rates for different attendee types,
such as:

• Employee

If selected, Role is enabled for selection.

You can select Role to enforce single, daily, and yearly limits for entertainment expenses based on employee
grades. If multiple employee attendees are claiming the entertainment expense, enabling this option enforces
limits based on each attendee's grade.

When you enable Role, the Role Type field is automatically populated with Grade.

At the time of expense entry, the employee grade is derived from the system and applicable rates are identified.
If there are no rates for the employee’s grade, the rate defined for All others on the Create Rules page is used.
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• Nonemployee Attendee Type

◦ Public sector attendees

◦ Private sector attendees

When you select rate determinants, the application applies the defined limits on the attendee amounts. If you don't
define rate determinants, then the application enforces the rate limit on the total receipt amount and doesn't enforce a
limit per attendee.

• If you don’t select the rate determinants, then the rate limit is applied to the receipt amount.

For example, if you define an entertainment policy with a daily sum limit of 100 USD without selecting the
rate determinants, the application enforces a daily limit of 100 USD on the total receipt amount across all the
expenses submitted by the employee for a given date for the associated expense type.

For example, consider the following scenario:

Field Value

Capture attendee information
 

Selected
 

Rate Definition
 

Enabled
 

Rate Limit – Daily sum limit
 

Selected
 

Rate Determinants
 

Not Selected
 

Policy Enforcement
 

Policy violation warning - Warning
Tolerance Percentage
 

10%
 

Prevent report submission - Error
Tolerance Percentage
 

20%
 

Daily sum limit 200 USD
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Field Value

  

With the above setup, if an employee submits an expense report, the application enforces a daily limit of 200
USD on the total receipt amount across all the expenses submitted by the employee for a given date for the
associated expense type.

Davis submits an expense report with him and Frank added as attendees of an event. The total amount
reported was 250 USD, with the amount split equally between both attendees.

Since the policy doesn't have rate determinants enabled, the daily limit is enforced on the total amount. In
this case, since it is above the defined error tolerance amount of 240 USD, the application will display a policy
violation error message when Davis tries to submit the report.

• If you select employee or nonemployee as the rate determinant, then the rate limit is applied per attendee.

For example, if you define an entertainment policy with a daily sum limit of 100 USD and Employee as a rate
determinant, the application enforces a daily limit of 100 USD per employee attendee for that expense type for
the given date across multiple reports.

For example, consider the following scenario:

Field Value

Capture attendee information
 

Selected
 

Rate Definition
 

Enabled
 

Rate Limit – Daily sum limit
 

Selected
 

Rate Determinants
 

Employee Selected
 

Policy Enforcement
 

Policy violation warning - Warning
Tolerance Percentage
 

10%
 

Prevent report submission - Error
Tolerance Percentage
 

20%
 

Daily sum limit 200 USD
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Field Value

  

With the above setup, if an employee submits an expense report, the application enforces a daily limit of 200
USD per employee attendee for that expense type for the given date across multiple reports.

Davis submits an expense report for 250 USD with him and Frank as attendees, with amounts equally split
between both (Davis: 125 USD, Frank: 125 USD).

Frank adds the same expense for 250 USD, adds him and Davis as attendees, and splits the amount equally
between both (Davis: 125 USD, Frank: 125 USD). Since the daily limit per attendee is 200 USD with an error
tolerance of 20%, the maximum reimbursable amount for the day per attendee is 240 USD. As 125 USD
was already submitted for both Davis and Frank, Frank can only submit expenses of 115 USD each for these
attendees. So, the application will display an error that both attendees are above the policy limit.

Determine Whether to Enforce the Entertainment Expense Policy and How
In the Policy Enforcement section on the Create Entertainment Policy page, you decide whether to enforce the
entertainment expense policy. To enforce it, select one of the following:

• Reimburse only the rate limit amount when an expense exceeds the defined rate. For example, if the rate limit is
25 USD for a gift to a customer and an employee spends 30, he's reimbursed 25.

• Generate a policy violation when an expense exceeds the defined rate.

◦ Warning: A percentage is used to calculate a warning. The warning tolerance amount is calculated as
follows:

Policy Rate * (1+Warning Tolerance/100)

If you submit an expense in a report that has an amount that's greater than the warning tolerance, you
will see a warning if the Display warning to user check box is selected in the Policy Enforcement section
on the Create Entertainment Policy page.

Note:  A warning is always displayed to the approver, whether or not the Display warning to user
check box is selected.

◦ Error: A percentage is used to calculate an error. The error tolerance amount is calculated as follows:

Policy Rate * (1+Error Tolerance/100)

If you submit an expense in a report that has an amount that's greater than the error tolerance, you're
prevented from submitting the expense report.

Define Rate Limit Amounts
After you finish defining the entertainment expense policy and save it, you can then define entertainment rate limit
amounts in the Create Rates dialog box.

Note:  Rates with overlapping start and end dates are invalid.
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Associate the Entertainment Expense Policy with an Expense Type
Before you can associate the entertainment policy with an expense type, you must first activate the policy from the
Manage Policies by Expense Category page. You can do it by selecting the policy and then selecting the Activate option
from the Actions menu.

The final sequence of steps is as follows:

1. On the Create Expense Report Template page, create a template for entertainment or select an existing
entertainment template.

2. On the Expense Types tab on the Create Expense Report Template page, create an entertainment expense type.
3. In the Create Expense Type dialog box, create an entertainment expense type.
4. On the Policies tab in the Create Expense Type dialog box, select the entertainment expense policy, specify the

start date, and optionally the end date.

After the entertainment policy rate is set, a violation is raised when an employee submits a report that contains an
expense that violates the policy.

Set Up an Accommodations Expense Policy  
Your company can set up and enforce accommodations expense policies to help control, manage, and reduce spending
for accommodations expenses.

Two examples of accommodations expense policies are the enforcement of a hotel expense limit of 200 USD per day
and the enforcement of hotels that are on the company's preferred merchant list.

This topic covers the following aspects of setting up an accommodations expense policy.

• Setting Up an Accommodations Policy

• Setting Up Policy Violations

• Completing the Accommodations Rate Spreadsheet

• Associating the Accommodations Expense Policy with an Expense Type

Setting Up an Accommodations Policy
The following procedure enables you to set up an accommodations expense policy and complete the accommodations
rate spreadsheet for uploading to the application.

1. In the Setup and Maintenance work area, go to the following:

◦ Offering: Financials

◦ Functional Area: Expenses

◦ Task: Manage Policies by Expense Category

2. On the Manage Policies by Expense Category page, select Accommodations from the Create Policy choice list.
3. On the Create Accommodations Expense Policy page in the Rate Definition section, do the following:

a. Select the Single currency radio button.
b. Currency = USD.
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Note:  If a currency rate conversion is necessary to verify a policy rate limit, you must define a conversion rate
in Oracle Fusion General Ledger.

4. In the Rate Determinants section, do the following:

a. Select the Roles check box.
b. Select the Locations check box.
c. Role Type = Job.
d. Select the Geographical locations check box.

5. In the Policy Enforcements section, do the following:

a. Select the Policy violation warning check box.
b. Warning Tolerance Percentage = 10.
c. Select the Display warning to user check box.
d. Select the Prevent report submission check box.
e. Error Tolerance Percentage = 20.

The preceding accommodations expense policy says the following: The accommodations expense policy is set up with a
single instance daily rate in US dollars, by job, by geographical location, and is enforced by a warning and error.

Setting Up Policy Violations
You can set up policy violations for accommodations expense policies as shown in the following table.

Policy Violation Application's Action Effect Calculation

Warning
 

Generates a warning
policy violation when an
accommodations expense exceeds
the defined tolerance.
 

You see a warning if you selected
the Display warning to user check
box.
 
A warning is always displayed to
the approver, whether or not you
select the Display warning to user
check box.
 

Policy Rate * (1+Warning
Tolerance/100)
 

Error
 

Generates an error policy violation
when an accommodations expense
exceeds the defined tolerance.
 

You see an error and you're
prevented from submitting the
accommodations expense.
 

Policy Rate * (1+Error
Tolerance/100)
 

Completing the Accommodations Rate Spreadsheet
To complete an accommodations rate spreadsheet, perform the following steps:

1. On the Create Accommodations Policy page, click the Create Rate button.
2. Download the predefined spreadsheet to your local drive for completion.

Note:  If you select rate determinants in the Rate Determinants section, you complete the predefined
spreadsheet. If you don't select any rate determinants, you create accommodations rates in the Create Rates
dialog box.
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3. On the Create Accommodations Rates spreadsheet, complete the fields as shown in the following table.

Role Geographical Location Daily Limit Start Date

ACC500.Accounting Manager
 

All Others, San Francisco, CA,
 United States
 

200
 

1/1/2014
 

ACC500.Accounting Manager
 

All Others, New York, NY, United
States
 

220
 

1/1/2014
 

ACC500.Accounting Manager
 

All Others, All Others, All Others,
 United States
 

185
 

1/1/2014
 

SAL600.Salesperson
 

All Others, San Francisco, CA,
 United States
 

195
 

1/1/2014
 

SAL600.Salesperson
 

All Others, New York, NY, United
States
 

215
 

1/1/2014
 

SAL600.Salesperson
 

All Others, All Others, All Others,
 United States
 

170
 

1/1/2014
 

SAL700.Salesperson
 

All Others, San Francisco, CA,
 United States
 

250
 

1/1/2014
 

SAL700.Salesperson
 

All Others, New York, NY, United
States
 

255
 

1/1/2014
 

SAL700.Salesperson
 

All Others, All Others, All Others,
 United States
 

222
 

1/1/2014
 

All Others
 

All Others, All Others, All Others,
 All Others
 

200
 

1/1/2014
 

4. Click the Upload button.

When rates are successfully uploaded, the policy status becomes valid. To use this rate policy for calculation of
accommodations expenses, you must:

1. Activate the accommodations expense policy.

a. On the Manage Policies by Expense Category page, select the accommodations expense policy you
created and click the Activate button.

2. Assign the accommodations expense policy to an expense type.
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Assigning the Accommodations Expense Policy to an Expense Type
To assign the accommodations expense policy to an expense type, complete the following steps:

1. In the Setup and Maintenance work area, go to the following:
◦ Offering: Financials

◦ Functional Area: Expenses

◦ Task: Manage Expense Report Templates
2. On the Manage Expense Report Templates page, click the Create icon or select an applicable template for a

business unit.
3. On the Create Expense Report Template page, create a template for accommodations expenses.
4. On the Expense Types tab click the Create icon to open the Create Expense Type dialog box.
5. In the Create Expense Type dialog box, select Accommodations from the Category choice list.
6. On the Policies tab in the Create Expense Type dialog box, select the accommodations expense policy you

created, specify the start date, and optionally specify an end date.

Set Up a Meals Expense Policy  
Your company can set up and enforce meal expense policies to help control, manage, and reduce spending for meal
expenses.

Examples of scenarios where a meals expense policy is applicable include the following: a salesperson requests
reimbursement for a lunch with customers, a consultant requests reimbursement for meals on a business trip, an
employee requests reimbursement for meals while attending an off-site workshop.

This topic covers the following aspects of setting up a meals expense policy.

• Setting Up a Meals Expense Policy

• Setting Up Policy Violations

• Completing the Meals Rate Spreadsheet

• Associating the Meals Expense Policy with an Expense Type

Setting Up a Meals Expense Policy
The following procedure enables you to set up a meals expense policy and complete the meals rate spreadsheet for
uploading to the application.

1. In the Setup and Maintenance work area, go to the following:
◦ Offering: Financials

◦ Functional Area: Expenses

◦ Task: Manage Policies by Expense Category
2. On the Manage Policies by Expense Category page select Meals from the Create Policy choice list.
3. On the Create Meals Expense Policy page in the Rate Definition section, do the following:

a. Select the Single instance limit check box.
b. Select the Single currency radio button.
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c. Currency = USD US Dollar

Note:  If a currency rate conversion is necessary to verify a policy rate limit, you must define a conversion rate
in Oracle Fusion General Ledger.

4. In the Rate Determinants section, do the following:

a. Select the Role check box.
b. Role Type = Job.

5. In the Policy Enforcements section, do the following:

a. Select the Policy violation warning check box.
b. Warning Tolerance Percentage = 10.
c. Select the Display warning to user check box.
d. Select the Prevent report submission check box.
e. Error Tolerance Percentage = 20.

The preceding meals expense policy says the following: The meals expense policy is set up with a single instance rate in
US dollars, by job, and is enforced by a warning and an error.

Setting Up Policy Violations
You can set up policy violations for a meals expense policy as shown in the following table.

Policy Violation Application's Action Effect Calculation

Warning
 

Generates a warning policy
violation when a meals expense
exceeds the defined tolerance.
 

You see a warning if you selected
the Display warning to user check
box.
 
A warning is always displayed to
the approver, whether or not you
select the Display warning to user
check box.
 

Policy Rate * (1+Warning
Tolerance/100)
 

Error
 

Generates an error policy violation
when a meals expense exceeds the
defined tolerance.
 

You see an error and you're
prevented from submitting the
meals expense report.
 

Policy Rate * (1+Error
Tolerance/100)
 

Completing the Meals Rate Spreadsheet
To complete a meals rate spreadsheet, perform the following steps.

1. On the Create Meals Policy page, click the Create Rates button.
2. Download the predefined spreadsheet to your local drive for completion.

Note:  If you select rate determinants in the Rate Determinants section, you complete the predefined
spreadsheet. If you don't select any rate determinants, you create meals rates in the Create Rates dialog box.
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3. On the Create Meals Rates spreadsheet, complete the fields contained in the following table.

Role Single Instance Limit (USD) Start Date

ACC500.Accounting Manager
 

120
 

1/2014
 

SAL600.Salesperson
 

150
 

1/2014
 

SAL700.Sales Manager
 

180
 

1/2014
 

All Others
 

150
 

1/2014
 

4. Click the Upload button.

When rates are successfully uploaded, the policy status is valid. To use the rates spreadsheet for calculation of meal
expenses, you must:

1. Activate the meals expense policy.

a. On the Manage Policies by Expense Category page, select the meals expense policy that you created and
click the Activate button.

2. Assign the meals expense policy to an expense type.

Assigning the Meals Expense Policy to an Expense Type
To assign the meals expense policy to an expense type, complete the following steps:

1. In the Setup and Maintenance work area, go to the following:

◦ Offering: Financials

◦ Functional Area: Expenses

◦ Task: Manage Expense Report Templates

2. On the Manage Expense Report Templates page, click the Create icon or select an applicable template for a
business unit.

3. On the Create Expense Report Template page, create a template for meals expenses.
4. On the Expense Types tab, click the Create icon to open the Create Expense Type dialog box.
5. In the Create Expense Type dialog box, select Meals from the Category choice list.
6. On the Policies tab in the Create Expense Type dialog box, select the meals expense policy you created, specify

the start date, and optionally specify an end date.

Itemize Meals Expense Categories  
You can itemize meals expense categories. Itemizing meals helps you capture the breakdown of meal expenses, such as
tips and taxes.
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You must have one of the following roles to enable meals itemization:

• Application Implementation Consultant

• Application Implementation Consultant Financial Administrator

• Expense Manager

To itemize a meal expense type, complete these steps:

1. In the Setup and Maintenance work area, go to the following:

◦ Offering: Financials

◦ Functional Area: Expenses

◦ Task: Manage Expense Report Templates

2. On the Manage Expense Report Templates page, select the applicable template and click the Edit icon.
3. On the Edit Expense Report Template page, Expense Types tab, select the meal expense type that you want to

itemize and click the Edit icon.
4. On the Itemization tab, select one of the following values from the Itemization choice list:

◦ Enabled: to optionally enable itemization

◦ Required: to make itemization mandatory

5. Click the Include check box for the expense types that you want to make available for itemization.
6. Click Save and Close.

Related Topics
• Set Up a Meals Expense Policy

Set Up an Airfare Policy  
Your company can set up and enforce airfare expense policies to help control, manage, and reduce spending by
employees for airfare.

An example of a scenario where an airfare expense policy is applicable is when a consultant flies to Finland for a
business trip and then submits an expense report for reimbursement of the airfare.

To set up an airfare policy, you perform the following steps:

1. Entering general information
2. Setting up airfare policy violations
3. Creating a flight class policy
4. Activating the airfare policy
5. Assigning the airfare policy to an expense type

Entering General Information
To set up general information, complete the following steps:

1. In the Setup and Maintenance work area, go to the following:

◦ Offering: Financials
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◦ Functional Area: Expenses

◦ Task: Manage Policies by Expense Category

2. On the Manage Policies by Expense Category page, select Airfare from the Create Policy choice list.
3. On the Create Flight Class Policy page, Flight Class Determinant section:

◦ The Role check box is already selected by default.

◦ From the Role Type choice list, select Job.

The preceding airfare policy says the following: The airfare policy is set up by job and a policy violation is enforced by a
warning.

Setting Up Airfare Policy Violations
In the Policy Enforcement section, accept the following defaults:

• Policy violation warning radio button

• Display warning to user check box.

The following table describes what employees see when you set up warning and error policy violations for an airfare
policy.

Application's Action Effect

Warning
 

Generates a warning policy violation when an
airfare expense violates the policy.
 

You see a warning if you selected the Display
warning to user check box.
 
A warning is always displayed to the approver,
 whether or not you select the Display warning
to user check box.
 

Error
 

Generates an error policy violation when an
airfare expense violates the policy.
 

You see an error and you are prevented from
submitting the expense report.
 

Creating a Flight Class Policy
You can optionally create a flight class policy where you define which job roles can fly which flight classes based on
flight duration or type of flight, whether domestic or international. An example of a flight class policy includes the
following:

1. Vice Presidents and over who fly longer than 8 hours for an international flight can purchase a first class ticket.
2. Vice Presidents and under who fly less than 8 hours for a domestic flight must purchase economy class ticket.

Activating the Airfare Policy
To use the airfare policy, you must:

1. Activate the airfare policy.

a. In the Setup and Maintenance work area, go to the following:

i. Offering: Financials
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ii. Functional Area: Expenses
iii. Task: Manage Policies by Expense Category

b. On the Manage Policies by Expense Category page, select the airfare expense policy that you created and
click Activate.

2. Assign the airfare policy to an expense type.

Assigning the Airfare Policy to an Expense Type
To assign the airfare policy to an expense type, complete the following steps:

1. In the Setup and Maintenance work area, go to the following:

◦ Offering: Financials

◦ Functional Area: Expenses

◦ Task: Manage Expense Report Templates

2. On the Manage Expense Report Templates page, select an applicable template for a business unit or click the
Create icon.

3. On the Create Expense Report Template page, create a template for Airfare expenses.
4. On the Expense Types tab, click the Create icon.
5. In the Create Expense Type dialog box, select Airfare from the Category choice list.
6. On the Policies tab in the Create Expense Type dialog box, select the Airfare policy you created, specify the start

date, and optionally specify an end date.

Set Up a Car Rental Policy  
Your company can set up and enforce car rental expense policies to help control, manage, and reduce spending by
employees for car rentals.

An example of a scenario where a car rental expense policy is applicable is when a consultant rents a car during a
business trip and then submits an expense report for reimbursement of the car rental.

To set up a car rental policy, you complete these steps:

1. Setting up a car rental policy
2. Setting up car rental policy violations
3. Completing the car rental rate spreadsheet
4. Activating the car rental policy
5. Assigning the car rental policy to an expense type

Setting Up a Car Rental Policy
To set up a car rental policy, complete these steps:

1. In the Setup and Maintenance work area, go to the following:

◦ Offering: Financials

◦ Functional Area: Expenses

◦ Task: Manage Policies by Expense Category
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2. On the Manage Policies by Expense Category page, from the Create Policy choice list, select Car Rental.
3. On the Create Car Rental Policy page in the Rate Definition section:

a. Select the Single currency option.
b. From the Currency choice list, select USD US Dollar.

Note:  If a currency rate conversion is necessary to verify a policy rate limit, you must define a
conversion rate in Oracle General Ledger.

4. In the Rate Determinants section:
a. Select the Role check box.
b. From the Role Type choice list, select Job.

The preceding car rental policy says the following: The car rental policy is set up with a daily limit in US dollars, by job,
and is enforced by a warning and an error.

Setting Up Car Rental Policy Violations
To set up car rental policy violations, complete these steps in the Policy Enforcement section:

1. Select the Policy violation warning check box.
2. Enter 10 in the Warning Tolerance Percentage field.
3. Select the Display warning to user check box.
4. Select the Prevent report submission check box.
5. Enter 20 in the Error Tolerance Percentage field.

The following table describes what employees see when you set up warning and error policy violations, as well as the
calculation used to derive the policy violation.

Policy Violation Application's Action Effect Calculation

Warning
 

Generates a warning policy
violation when a car rental expense
exceeds the defined tolerance.
 

You see a warning if you selected
the Display warning to user check
box.
 

Note:
A warning is always displayed
to the approver, whether or not
you select the Display warning
to user check box.
 

Policy Rate * (1+Warning
Tolerance/100)
 

Error
 

Generates an error policy violation
when a car rental expense exceeds
the defined tolerance.
 

You see an error and you're
prevented from submitting the
expense report.
 

Policy Rate * (1+Error
Tolerance/100)
 

Completing the Car Rental Rate Spreadsheet
To complete a car rental rate spreadsheet, compete these steps:

1. On the Create Car Rental Policy page, click Create Rates.
2. Download the predefined spreadsheet to your local drive for completion.
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Tip:  If you select rate determinants in the Rate Determinants section, you complete the predefined
spreadsheet. If you don't select any rate determinants, you create car rental rates in the Create Rates dialog
box.

3. On the Create Car Rental Rates spreadsheet, complete the fields as shown in the following table.

Role Daily Sum Limit (USD) Start Date

ACC500.Accounting Manager
 

100
 

1/2014
 

SAL600.Salesperson
 

120
 

1/2014
 

SAL700.Sales Manager
 

150
 

1/2014
 

All Others
 

90
 

1/2014
 

4. Click Upload.

When rates are successfully uploaded, the policy status is Valid.

Activating the Car Rental Policy
To use the car rental rates spreadsheet for calculation of car rental expenses, you must:

1. Activate the car rental policy.

a. In the Setup and Maintenance work area, go to the following: Navigate: Setup and Maintenance >
Manage Policies by Expense Category task > Go to Task > Manage Policies by Expense Category page.

- Offering: Financials
- Functional Area: Expenses
- Task: Manage Policies by Expense Category

b. On the Manage Policies by Expense Category page, select the car rental policy that you created and click
Activate.

2. Assign the car rental policy to an expense type.

Assigning the Car Rental Policy to an Expense Type
To assign the car rental policy to an expense type, complete these steps:

1. In the Setup and Maintenance work area, go to the following:

◦ Offering: Financials

◦ Functional Area: Expenses

◦ Task: Manage Expense Report Templates

2. On the Manage Expense Report Templates page, select an applicable template for a business unit or click the
Create icon.
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3. On the Create Expense Report Template page, create a template for Car Rental expenses.
4. On the Expense Types tab, click the Create icon.
5. In the Create Expense Type dialog box, select Car Rental from the Category choice list.
6. On the Policies tab in the Create Expense Type dialog box, select the Car Rental policy you created, specify the

start date, and optionally specify an end date.

Set Up a Miscellaneous Expense Policy  
You can set up and enforce miscellaneous expense policies to help control, manage, and reduce miscellaneous
expenses. Examples of miscellaneous expense policies include policies for laundry, internet cable, and parking.

This topic covers the following aspects of setting up a miscellaneous expense policy:

• Set Up a Miscellaneous Expense Policy

• Set Up Policy Violations

• Complete the Miscellaneous Rate Spreadsheet

• Associate the Miscellaneous Expense Policy with an Expense Type

Here's how you can set up a miscellaneous expense policy and complete the miscellaneous rate spreadsheet to upload
to the application:

1. In the Setup and Maintenance work area, go to the following:

◦ Offering: Financials

◦ Functional Area: Expenses

◦ Task: Manage Policies by Expense Category

2. On the Manage Policies by Expense Category page, select Miscellaneous from the Create Policy choice list.
3. On the Create Miscellaneous Expense Policy page, you can set any or a combination of these rules:

a. In the Miscellaneous Eligibility Rule section, set the Minimum Number of Days for Miscellaneous
Expense Reimbursement rule.

b. In the Rate Type section, select one of the following:
- Rate limit
- Percentage reimbursement
- Percentage reimbursement with upper limit

c. In the Rate Definition section, define the rate based on any one or a combination of the following rate
limits:

- Single instance limit
- Daily sum limit
- Monthly limit
- Yearly limit

With the Yearly limit selected, you can specify the Period Start Month and Period Start Day to
set the start date of the limit.

- Lifetime limit
This limit enforces the maximum reimbursement allowed for an employee during their entire
period of association with a company or business unit, from the hire date to the current date.

170



Oracle Fusion Cloud Financials
Implementing Expenses

Chapter 3
Expense Policies and Rules

For example, an expense incurred by an employee can be reimbursed up to an amount of $2000
during their tenure as an employee within a company. The employee can choose to claim the total
cost at one go or over a period of time. The total amount claimed or reimbursed can't exceed the
limit set over the lifetime of the employee with the company.

d. Set up Multiple currencies or define a Single currency in the Rate Definition section.
e. Define the rate determinant based on Role, Gender, and Location in the Rate Determinants section.
f. Define the tolerance level of policy violation in the Policy Enforcement section to warn or prevent users

from submitting a report. See the "Set Up Policy Violations" section of this topic for more information.
4. Click Save.
5. Complete the miscellaneous rate spreadsheet and upload it to the application. See the "Complete the

Miscellaneous Rate Spreadsheet" section of this topic for an example.

Example of Setting a Miscellaneous Policy with Eligibility Rule and Rate
Limit
The example shows how to set up a policy where a minimum of 5 days of miscellaneous expenses must be accrued
before the expense is eligible for reimbursement. This part of the policy is typically used when a company wants to
enforce a laundry policy where the employee can only be reimbursed for laundry expenses if the trip is greater than
a specified number of days. The policy is set up with a single instance rate in US dollars, by job, and is enforced by a
warning and an error.

1. In the Setup and Maintenance work area, go to the following:

◦ Offering: Financials

◦ Functional Area: Expenses

◦ Task: Manage Policies by Expense Category

2. On the Manage Policies by Expense Category page, select Miscellaneous from the Create Policy choice list.
3. On the Create Miscellaneous Expense Policy page in the Miscellaneous Eligibility Rule section, do the following:

a. Select Minimum number of days for miscellaneous expense reimbursement.
b. Days = 5.

4. In the Rate Type section, select Rate limit.
5. In the Rate Definition section, do the following:

a. Select Single instance limit.
b. Select Single currency.
c. Currency = USD US Dollar.

Note:  If a currency rate conversion is necessary to verify a policy rate limit, you must define a conversion rate
in Oracle Fusion General Ledger.

6. In the Rate Determinants section, do the following:

a. Select Role.
b. Role Type = Job.

7. In the Policy Enforcements section, do the following:

a. Select Policy violation warning.
b. Warning Tolerance Percentage = 10.
c. Select Display warning to user.
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d. Select Prevent report submission.
e. Error Tolerance Percentage = 20.

Set Up Policy Violations
You can set up policy violations for a miscellaneous expense policy as shown in the following table.

Policy Violation Application's Action Effect Calculation

Warning
 

Generates a warning policy
violation when a miscellaneous
expense exceeds the defined
tolerance.
 

You see a warning if you selected
Display warning to user.
 
A warning is always displayed to
the approver, whether or not you
select Display warning to user.
 

Policy Rate * (1+Warning
Tolerance/100)
 

Error
 

Generates an error policy violation
when a miscellaneous expense
exceeds the defined tolerance.
 

You see an error and you're
prevented from submitting the
miscellaneous expense.
 

Policy Rate * (1+Error
Tolerance/100)
 

Complete the Miscellaneous Rate Spreadsheet
To complete a miscellaneous rate spreadsheet, perform the following steps:

1. On the Create Miscellaneous Policy page, click the Create Rates button.
2. Download the predefined spreadsheet to your local drive for completion.

Note:  If you select rate determinants in the Rate Determinants section, you complete the predefined
spreadsheet. If you don't select any rate determinants, you create miscellaneous rates in the Create Rates
dialog box.

3. On the Create Miscellaneous Rates spreadsheet, complete the fields as shown in the following example:

Role Single Instance Limit (USD) Start Date

ACC500.Accounting Manager
 

155
 

1/1/2014
 

SAL600.Salesperson
 

150
 

1/1/2014
 

SAL700.Sales Manager
 

160
 

1/1/2014
 

All Others
 

150
 

1/1/2014
 

4. Click Upload.
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When rates are successfully uploaded, the policy status is valid. To use the miscellaneous rate policy for calculation of
miscellaneous expenses, you must:

1. Activate the miscellaneous expense policy.
a. On the Manage Policies by Expense Category page, select the miscellaneous expense policy that you

created and click Activate.
2. Assign the miscellaneous expense policy to an expense type.

Assign the Miscellaneous Expense Policy to an Expense Type
To assign the miscellaneous expense policy to an expense type, perform the following steps:

1. In the Setup and Maintenance work area, search for the Manage Expense Report Templates task and click Go to
Task to open the Manage Expense Report Templates page.

2. Click Create or select an applicable template for a business unit.
3. On the Create Expense Report Template page, create a template for miscellaneous expenses.
4. On the Expense Types tab, click Create to open the Create Expense Type dialog box.
5. In the Create Expense Type dialog box, select Miscellaneous from the Category choice list.
6. On the Policies tab in the Create Expense Type dialog box, select the miscellaneous expense policy you

created, specify the start date, and optionally specify an end date.

Capture Attendee Information for Expense Categories  
Several industries have enacted gift and entertainment regulations to provide transparency and to curtail the amount
spent on individuals to prevent gift recipients from influencing business decisions.

To comply with local and industry specific regulations, you can easily capture attendee information for any expense
category.

To capture attendee information, you must:

• Set up an Entertainment policy with only the capture of attendee information specified.

• Assign the Entertainment policy to an expense type.

When an employee creates an expense item that's associated with the Entertainment policy, the application enforces
the entry of attendee and gift recipient details. The attendee details that the employee is required to provide is based on
the selections you specified for the capture of attendee information during the Entertainment policy setup.

Set Up an Entertainment Policy
To set up an Entertainment policy, complete these steps:

1. In the Setup and Maintenance work area, go to the following:

◦ Offering: Financials

◦ Functional Area: Expenses

◦ Task: Manage Policies by Expense Category

2. On the Manage Policies by Expense Category page, click Create Policy, and select Entertainment to create a
policy.
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3. Based on the details of attendee information you need to capture, select one of these options:

◦ If you need to capture only the number of attendees above a designated expense amount:

i. Select the option Capture number of attendees for expense lines above the specified amount.
ii. Specify the amount and select a currency.

This policy can work together with policy rates defined in any expense category except entertainment,
and the rates are enforced to per attendee expense amount.

◦ If you need to capture details, such as attendee names, amount, and so on:

i. Select the Capture attendee information option.
ii. In the Capture Attendee Information section, select the applicable options based on the

information you need to capture.
iii. In the Rate Definition section, deselect the Enable rate limit option.

4. Click Save and Close.
5. On the Manage Policies by Expense Category page, select the newly created Entertainment policy and click

Activate to make it available for use.
6. Click Done.

Assign an Entertainment Policy to an Expense Type
To assign an Entertainment policy to an expense type, complete these steps:

1. In the Setup and Maintenance work area, go to the following:

◦ Offering: Financials

◦ Functional Area: Expenses

◦ Task: Manage Expense Report Templates

2. On the Manage Expense Report Templates page, select an expense template, and click the Edit icon.
3. On the Edit Expense Report Template page, select the expense type to associate with the Entertainment policy.
4. Click the Edit icon.
5. On the Edit Expense Type page, select the Policies tab.
6. In the Attendees Policy section, click the Add Row icon.
7. From the Policy Name choice list, select the Entertainment policy that you created, and enter the start date.
8. Click Save and Close.

How You Set Up a Mileage Expense Policy  
You can set up a mileage expense policy to allow employees to claim mileage reimbursement for travel expenses
incurred by using their personal vehicles for business activities. In most countries, the central government determines
the mileage reimbursement rates.

Based on government mileage regulations and your company policy, you can set up a mileage expense policy by
defining:

• Mileage eligibility rules

• Mileage rate determinants
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• Mileage add-on rates

The application automatically calculates the mileage reimbursement based on your definition of the eligibility rules,
rates determinants, and add-on rates.

In the Setup and Maintenance work area, use the following:

• Offering: Financials

• Functional Area: Expenses

• Task: Manage Policies by Expense Category

On the Manage Policies by Expense Category page, click the Create Policy choice list and select Mileage. The create
Mileage Policy page appears.

Note:  If a currency rate conversion is necessary to verify a policy rate limit, you must define a conversion rate in
Oracle Fusion General Ledger.

Mileage Eligibility Rules
In the Mileage Eligibility Rules section, you specify the rules that determine whether employees can claim mileage
reimbursement for using their personal or company provided vehicles. The following table lists the mileage eligibility
rules and their descriptions.

Mileage Eligibility Rule Description

Standard Mileage Deduction
 

A specified number of miles is deducted from the total miles traveled before the mileage rate
calculation is applied.
 

Minimum Distance for Mileage Eligibility
 

A minimum distance must be traveled before the mileage rate calculation is applied.
 

Commute Mileage Deduction
 

Commute distance between home and office if you're required to deduct it from the trip distance.
 

Mileage Rate Determinants
In the Mileage Rate Determinants section, you specify the determinants on which the mileage reimbursement policy is
based. The following table lists selected mileage rate determinants and their descriptions.

Mileage Rate Determinants Description

Role
 

Mileage rates are based on employees' grades, positions, or jobs.
 

Distance Threshold
 

Mileage rates are based on the distance traveled in a single trip or during a period of time.
 

Vehicle Category
 

Mileage rates are based on vehicle category, such as Company or Private.
 

Vehicle Type
 

Mileage rates are based on vehicle type, such as Car, Motorcycle, or Van.
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Mileage Rate Determinants Description

Fuel Type
 

Mileage rates are based on fuel type, such as Diesel, Petrol, Hybrid, or Electric.
 

Mileage Add-On Rates
In the Add-On Rates section, your company can add passenger rates and company-specific rates for inclusion in the
mileage reimbursement policy. The following table lists additional rate types and their descriptions.

Add-On Rates Description

Single rate per passenger
 

One mileage reimbursement rate that applies to each passenger, regardless of the number of
passengers in the vehicle.
 

Rates by mileage determinants
 

Mileage rate reimbursed per passenger varies by multiple mileage rate determinants that you defined,
 such as Vehicle Category, Vehicle Type, or Role.
 

Rates by range of passengers
 

Mileage rate reimbursed per passenger varies by the number of passengers in the vehicle. For
example, the mileage reimbursement rate is .25 USD per mile for the first three passengers and .20
USD per mile thereafter.
 

Rate by mileage determinants and range
of passengers
 

Mileage rate reimbursed per passenger varies by multiple mileage rate determinants that you defined
and by the number of passengers in the vehicle. For example, the mileage reimbursement rate is .10
USD for the first two passengers traveling in a diesel car and .07 USD for the remaining passengers.
Similarly, .08 USD for the first two passengers traveling in a hybrid car and .05 USD for the remaining
passengers.
 

Restrict number of passengers reimbursed
 

Indicates whether the number of passengers included for reimbursement is limited to a specific
number.
 

Company-Specific Rates
 

Company-specific mileage rate types that you can add to the mileage reimbursement calculation, such
as .30 USD for hauling a trailer and .50 USD for driving on forest roads.
 

Note:  The above add-on rate types are out of the box rate types that come with the application and can be assigned
to your mileage policy. You can also create your own custom add-on rate types per your business requirements. See
How can I create custom mileage add-on rates? for more information.

After you finish setting up the mileage expense policy, you must:

• Complete the mileage rate spreadsheet and load the spreadsheet to the application. Or, complete the Create
Rates dialog box, depending on the complexity of the policy.

• Activate the mileage reimbursement policy.

• Set up cumulative mileage determinants when applicable.

• Assign the mileage reimbursement policy to expense types.
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Example of Completing a Mileage Rate Spreadsheet  
This example demonstrates how to set up a mileage policy given government mileage regulations and how to complete
the mileage rate spreadsheet for uploading to the application.

The following table summarizes key decisions to consider before setting up a mileage policy.

Decisions to Consider In This Example

What country does the mileage
reimbursement policy apply to?
 
What is the general reimbursement policy
for this country?
 

In Finland, mileage is reimbursed if the employee uses his personal vehicle for business purposes.
 

What vehicle types are included in this
country's mileage policy?
 

• For a car, 45 cents per kilometer for the first 5,000 kilometers and 40 cents per kilometer for
additional kilometers.

• For a motorcycle, 34 cents for the first 5,000 kilometers and 30 cents per kilometer for additional
kilometers.

• For a motorboat, 78 cents per kilometer for engine power less than 50 hp and $1.14 cents per
kilometer for engine power more than 50 hp.

• For a snowmobile, $1.08 cents per kilometer.

What is the unit of measure?
 

Kilometers
 

Will the mileage policy rates be defined
for a single currency or for multiple
currencies?
 
If a currency rate conversion is necessary
to verify a policy rate limit, you must
define a conversion rate in Oracle Fusion
General Ledger.
 

Single currency = Euro
 

What determinants are the mileage rates
based on?
 

• Distance threshold = By period.

Selecting By period implies that the mileage calculation is based on cumulative mileage.

• Vehicle type = Vehicle Type

• Fuel Type = Fuel Type

Have you defined the mileage determinant
values?
 

Define lookup types and lookup codes for vehicle types and fuel types.
 

What passenger rates or passenger
information will be included in the mileage
policy, if any?
 

• Single rate per passenger.

• 3 cents per person when the employee transports other persons, where arranging such
transportation is the duty of the employer.
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Decisions to Consider In This Example

What company-specific rates need to be
added to the mileage policy, if any?
 

• 7 cents when the job or duty requires transporting a trailer attached to the car.

• 11 cents when the work or duty requires transporting a caravan attached to the car.

• 21 cents when the work or duty requires transporting a resting hut, or similar facility, attached to
the car.

• 3 cents when the employee transports machines or appliances weighing more than 80 kilos, or
unusually big machines or appliances, or must take a dog in the car to perform his duty or work.

• 9 cents for driving a car on forest roads or on closed building sites because the employee's duty
or work requires such driving.

What are the add-on rate types? Have you
defined the add-on rate types?
 

Define a lookup type and lookup codes for the add-on rate types.
 

Prerequisites
1. Define the mileage determinant values that you want to use.

◦ In this example, you need to define values for the two determinants that you have chosen; Vehicle Type
and Fuel Type.

◦ Create a new lookup type and add the applicable values as lookup codes.

2. Define the company-specific additional rate types that you want to use.

In this example, you need to define the following rate types: Trailer attached to the car, Transporting a caravan,
Transporting a resting hut, Transporting heavy machinery, Dog in the car, and On forest road.

Setting Up a Mileage Policy
1. On the Manage Policies by Expense Category page, click the Create Policy choice list and select Mileage to

open the Create Mileage Policy page.
2. On the Create Mileage Policy page, complete the fields as shown in the following table.

Field Value

Country
 

Finland
 

Rate Currency
 

Single Currency = EUR Euro
 

Unit of Measure
 

Kilometer
 

Distance Threshold Period
 

By period
 

Vehicle Type
 

Lookup type that defines the applicable vehicle types.
 

Fuel Type Lookup type that defines the applicable fuel types.
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Field Value

  

Passenger Rate Type
 

Single rate per passenger.
 

Company-Specific Rate Type
 

Lookup type that defines the additional rate types.
 

Completing the Mileage Rate Spreadsheet
1. On the Create Mileage Policy page, click the Create Rate button.

Note:  In this example, you download a predefined spreadsheet to your local drive for completion because
you selected mileage rate determinants and add-on rates on the Create Mileage Policy page. If, however, you
create a mileage policy for a single currency with no mileage rate determinants or add-on rates, you create
the mileage rate in a dialog box, rather than in a spreadsheet.

2. On the Create Mileage Rates spreadsheet in the Mileage Rates region, complete the fields as shown in the
following table.

Distance Threshold Vehicle Type Fuel Type Rate Start Date End Date

5000
 

Car
 

All Other
 

0.45
 

1/1/2010
 

Car
 

All Other
 

0.4
 

1/1/2010
 

5000
 

Motorcycle
 

All Other
 

0.34
 

1/1/2010
 

Motorcycle
 

All Other
 

0.3
 

1/1/2010
 

Motorboat
 

< 50 hp
 

0.78
 

1/1/2010
 

Motorboat
 

=> 50 hp
 

1.14
 

1/1/2010
 

Snowmobile
 

All Other
 

1.08
 

1/1/2010
 

3. On the Create Mileage Rates spreadsheet in the Passenger Rates region, complete the fields as shown in the
following table.

Calculation Method Rate Start Date End Date

Amount 0.03 1/1/2010
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Calculation Method Rate Start Date End Date

   

4. On the Create Mileage Rates spreadsheet in the Additional Rates region, complete the fields as shown in the
following table.

Distance
Threshold

Vehicle Type Fuel Type Calculation
Method

Rate Type Rate Start Date End Date

Car
 

All Other
 

Amount
 

Trailer
attached to the
car
 

0.07
 

1/1/2010
 

Car
 

All Other
 

Amount
 

Transporting a
caravan
 

0.11
 

1/1/2010
 

Car
 

All Other
 

Amount
 

Transporting a
resting hut
 

0.21
 

1/1/2010
 

Car
 

All Other
 

Amount
 

Transporting
heavy
machinery
 

0.03
 

1/1/2010
 

Car
 

All Other
 

Amount
 

Dog in the car
 

0.3
 

1/1/2010
 

Car
 

All Other
 

Amount
 

Driving on a
forest road
 

0.09
 

1/1/2010
 

5. On the Create Mileage Rates spreadsheet, click the Upload button.

The policy status becomes valid when rates are successfully uploaded. To use this rate policy for mileage
calculation, you must activate the policy and assign it to an expense type.

How You Upload Cumulative Mileage from a Third Party  
You can upload accumulated mileage-to-date from a legacy system into Oracle Expenses Cloud for a midyear
changeover. Uploading accumulated mileage includes the following actions:

• Performing prerequisites

• Creating a cumulative mileage data file

• Uploading a cumulative mileage data file
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• Viewing uploaded cumulative mileage

If both of the following statements are true, you upload cumulative mileage for your employees to Expenses:

• Your mileage rates vary by the total distance traveled during a time period

• You will go live with the application during the current tax year.

Performing Prerequisites
Before you can upload accumulated mileage, you must:

• Define the cumulative mileage determinants in Setup and Maintenance.

• Optionally, create vehicle type, vehicle category, and fuel type lookup codes in Setup and Maintenance.

Creating a Cumulative Mileage Data File
The Upload Cumulative Mileage process accepts cumulative mileage in a text file format as shown in the following table.

CAUTION:  To avoid data corruption, you can only run the Upload Cumulative Mileage process once per business unit,
unless you're editing existing entries before employees submit additional mileage expenses.

Field Type Description

Person Number.
 

Char (30)
 

• Required

• Must match the person number in the
application.

Accumulated Mileage
 

Number (12)
 

• Required

• Last two digits are decimal places.

Cumulative as of Date
 

MMDDYYYY
 

• Optional.

• If empty, it's assumed to be the upload
date.

Vehicle Category Lookup Code
 

Char (30)
 

Required if cumulative mileage determinant is
by vehicle category.
 

Vehicle Type Lookup Code
 

Char (30)
 

Required if cumulative mileage determinant is
by vehicle type.
 

Fuel Type Lookup Code
 

Char (30)
 

Required if cumulative mileage determinant is
by fuel type.
 

Reimbursement Amount
 

Number(12)
 

• Optional.

• Last two digits are decimal places.

Reimbursement Currency
 

Char(3)
 

• Required if reimbursement amount is
present.

• Three-digit currency.
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The following table illustrates sample file entries that you can enter in a text editor to upload cumulative mileage from
a third party. The sample file entries include person number fields with their associated accumulated mileage as of a
certain date, along with the vehicle type.

Person Number Mileage Number Vehicle

10026335772
 

513800000008012014
 

Car
 

10026335790
 

00100210020008022014
 

Car
 

10026335778
 

513800000008012014
 

Car
 

10026335796
 

00100210020008022014
 

Car
 

Uploading a Cumulative Mileage Data File
On the Manage Cumulative Mileage Determinants page, select a cumulative mileage determinant. From the Actions
menu, select Upload. Navigate to: Setup and Maintenance > Search: Manage Cumulative Mileage Determinants.

Viewing Uploaded Cumulative Mileage
After you upload the cumulative mileage, employees can view their mileage in the application by activating the Expense
Items infotile in the Travel and Expenses work area. Then, they select the View Cumulative Mileage option from the
Actions menu. The resulting Cumulative Mileage dialog box allows employees to view cumulative mileage by time
period if the mileage rate is based on a distance threshold. For example, in the UK, employees are reimbursed 45
pounds for the first 10,000 miles traveled in a car or van and 25 pounds over 10,000 miles.

Use Oracle Maps for Trip Distance Calculation  
Your company can opt to use Oracle Maps to enable the employees accurately calculate their mileage trip distance. The
trip distance is then used to calculate employees' mileage reimbursement when submitting expense reports.

This is how it works. Oracle Maps uses starting locations, midway points, and destination locations to calculate trip
distances. Your company's mileage reimbursement policy may deduct the commute distance between home and office
from the total trip distance. If this is the case, the following calculation applies:

Trip Distance = Total Distance - Commute Distance 

Mandatory Setups to Use Oracle Maps
Here are the setups that you need to do to use Oracle Maps for trip distance calculation:

• Enable Oracle Maps: To enable Oracle Maps for trip distance calculation, select Yes for the Enable Oracle
Maps option on the Manage Expenses System Options page. You can set this option for all business units or
for specific business units. In the Setup and Maintenance work area, select these to navigate to the Manage
Expenses System Options page:
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◦ Offering: Financials

◦ Functional Area: Expenses

◦ Task: Manage Expenses System Options

• Create a mileage policy, optionally include a commute deduction rule, and then assign the mileage policy to an
expense type to activate the policy.

Optional Setups to Use Oracle Maps
To use Oracle Maps, you can opt to complete these setups:

• Enable commute mileage deduction.

If enabled on the Create Mileage Policy page, you can opt to set up the commute mileage deduction as
optional or required. If enabled, the application captures the commute distance between home and office
and incorporates it in the trip distance and reimbursement calculation. If you don't set up employees' home
addresses in Human Capital Management, employees can enter their home addresses directly in the Calculate
Mileage dialog box when calculating trip distance.

• Set up preferred locations.

You can optionally set up preferred locations by creating lookup codes for the lookup type
ORA_EXM_MILEAGE_LOCATIONS. Preferred locations are frequent starting locations or travel destinations that
your company defines. You can set up lookup codes to represent preferred locations that you can select when
you want Oracle Maps to calculate a trip distance. A lookup code meaning represents a location that you can
select and a lookup code description is the address of the preferred location.

a. In the Setup and Maintenance work area, select:

- Offering: Financials
- Functional Area: Expenses
- Task: Manage Expense Report Auditing Lookup Types

b. On the Manage Expense Report Auditing Lookup Types page, search and select the lookup type
ORA_EXM_MILEAGE_LOCATIONS.

Related Topics
• How You Set Up a Mileage Expense Policy

• Options for Creating Expense Templates

• Expense Types

• Expense Category-Specific Fields

How You Set Up Expense Report Auditing  
You can examine, verify, and adjust the contents of expense reports as needed. Auditing expense reports ensures that
employees comply with your company's policies without having to audit all submissions. You can automate several
processes related to expense report auditing.
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To set up expense report auditing, you can perform the following first four steps in any order:

1. Create audit selection rules.
2. Create audit list rules.
3. Create expense template and type rules.
4. Create receipt and notification rules.
5. Assign audit rules to business units.

For the last step, you assign the audit rules created in steps 1 to 4 to business units.

Note:  To set up expense report auditing, you must create at least one audit selection rule, audit list rule, or expense
template and type rule and then assign it to a business unit. Otherwise, Expenses can't audit expense reports.

Create Audit Selection Rules
To enable automatic selection of expense reports for audit, select audit selection rules on the Create Audit Selection
Rule page. Audit selection rules are criteria that Expenses uses to automatically select expense reports for audit.

When you set up audit selection rules, you can optionally specify audit types. Audit types are alphanumeric codes
that you create which print on the cover sheet of each expense report. These codes identify the type of audit to be
performed by the auditor.

Expenses divides expense reports into the following audit categories:

• Automatic Approval

• Original Receipts Audit

• Imaged Receipts Audit

• No Receipts Required Audit

For example, your alphanumeric code can read: Autoapproval, Paper Receipts Audit, Paperless Audit, or No Receipts
Required. Alternatively, you can create codes known only to your Expense Audit department. Audit types provide your
audit department with a convenient method for sorting paper receipt packages.

Create Audit List Rules
To enable automatic selection of individuals for the audit list, you can:

• Select audit list rules on the Create Audit List Rule page.

• Specify the number of days a violator remains on the audit list.

Audit list rules are criteria that Expenses uses to automatically place violators on the Manage Audit List Membership
page.

When an employee submits an expense report, Expenses determines whether the employee has violated an audit list
rule. If he has, he's automatically added to the Manage Audit List Membership page with an end date that matches
the value you entered for the Number of Days an Individual Remains on the Audit List. When the end date is before
the current date, the violator becomes inactive. The violator's name, however, remains on the Manage Audit List
Membership page for historical purposes.

If you select the criterion Maximum Number of Days to Wait for Original Receipt Package on the Create Audit
List Rule page and you enter a value for the maximum number of days to wait, you must also enter a value in the
Original Receipt Package Received Date field for all expense reports on the Audit Expense Report page. After you
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save and assign the audit list rule to a business unit, Expenses automatically places employees on the Manage Audit List
Membership page who have:

• Pending receipts greater than the maximum number of days to wait

• Submitted receipts that were received after the maximum number of days to wait

Note:  An employee membership is considered active when the current date is between the start date and the end
date or no end date exists. If an active employee on the Manage Audit List Membership page violates another audit
list rule, Expenses adds the new violation and restarts the count for the number of days to remain on the audit list.

Create Expense Template and Type Rules
To enable selection of expense reports for audit based on expense template and type, set up expense template and
type rules on the Create Expense Template and Type Rule page. These rules can apply to an expense template only or
to an expense type within an expense template. When an employee submits an expense report, Expenses determines
whether it meets the criteria for expense template and type rules. If it does meet the criteria, the report is automatically
selected for audit.

For example, the following table shows Entertainment expense type values associated with the Travel expense template.
Together, they form the Travel and Entertainment rule.

Expense Template Expense Type Expense Type
Amount

Expense Type
Cumulative Amount

Expense Type
Currency

Expense Type Period

Travel
 

Entertainment
 

250.00
 

250.00
 

USD
 

Month
 

The preceding granular Travel (template) and Entertainment (expense type) rule is interpreted as follows: If the
employee spends more than $250 US dollars in a month on Entertainment using the Travel expense template, then the
employee's expense report is selected for audit.

You can also create broader rules that are based solely on a specific expense template without an associated expense
type. For example, suppose you want to create a rule for the Training template, then all expense reports that use the
Training template are selected for audit.

Create Receipt and Notification Rules
To enable receipt and notification rules, set them up on the Create Receipt and Notification Rule page.

Create receipt and notification rules to specify:

• Type of expense report receipts required: original, imaged, or both

• Stage at which imaged receipts must be attached to the expense report

• When missing and overdue receipts are overdue

• When expense report payment holds occur

• Action Expenses takes if an employee doesn't respond to notifications for missing and overdue receipts

When an employee submits an expense report, Expenses determines whether receipts are required and acts according
to the receipt and notification rules you specified. Receipt and notification rules are applied at various points throughout
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the expense report process. Some receipt and notification rules are applied during expense entry, some are applied
during the Overdue Tracking process, and others are applied during the Process Expense Reimbursement process.

Assign Audit Rules to Business Units
The final audit setup step is to assign the following audit rules to business units on the Manage Expense Report Audit
and Receipt Rule Assignments page:

• Audit selection rules

• Expense template and type selection rules

• Audit list rules

• Receipt and notification rules

You can assign all or any audit rules to all business units in the All Business Units section. In the Specific Business Units
section, you can assign specific audit rules to specific business units.

The rules that you assign to a business unit remain active during the effective period that you specify. If you don't enter
an end date, the rules remain active indefinitely. To change the behavior of an audit rule, you must apply an end date
to the existing rule and then create and assign a new one. If you don't assign an audit rule to a business unit, Expenses
doesn't apply the audit rule to any business unit.

Note:  If you assign an audit list rule to a business unit, you must ensure that you also assign an audit selection rule
to the same business unit that has the criterion, Audit expense reports of individuals on the audit list, activated.
This allows Expenses to automatically add employees to the audit list and monitor the number of days they remain
on the list. If you don't assign an audit list rule to a business unit, but you do assign an audit selection rule that uses
the criterion, Audit expense reports of individuals on the audit list, you can still add employees to the audit list
manually.

Audit Selection Rules  
Audit selection rules are criteria that you select on the Create Audit Selection Rule page. These rules determine which
expense reports are automatically selected for audit if the audit selection rule is true.

If you don't select any audit selection rules, Oracle Fusion Expenses automatically approves all expense reports.

Expenses includes the following audit selection rules:

• Audit a percentage of all expense reports

• Audit expense reports greater than a specified amount

• Audit expense reports with required receipts

• Audit expense reports with missing imaged receipts

• Audit expense reports with policy violations

• Audit expense reports of individuals on the audit list

• Audit expense reports with expenses older than a specified number of days

• Audit expense reports of individuals with a specific status

• Audit expense reports with specific keywords
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• Audit expense reports with commute distance variance

Here are the details of some audit selection rules.

Audit a Percentage of All Expense Reports
Expenses randomly selects for audit the percentage of expense reports that you specify in the Audit Percentage field in
the Random Selection section. Reports that aren't selected for audit due to an explicit audit selection rule are candidates
for random audit selection.

Tip:  To audit all expense reports, enter 100 in the Audit Percentage field.

Audit Expense Reports Greater than a Specified Amount
Expenses selects for audit all expense reports where the total report amount is greater than the amount you specify for
the audit selection rule. For this audit selection rule, you specify the amount and the ledger currency to use.

For any expense report where the ledger currency you specified isn't the same as the reimbursement currency,
Expenses converts the report currency to the ledger currency and calculates the expense report amount. Expenses uses
the conversion rate in the General Ledger Daily Rates table that was in effect on the expense report submission date. If
the calculated expense report amount is greater than the amount you specified for the audit selection rule, the report is
selected for audit.

Note:  If no conversion rate is defined in the General Ledger Daily Rates table for the expense report ledger currency
on the expense report submission date, Expenses ignores this audit selection rule and the report isn't selected for
audit.

Audit Expense Reports with Required Receipts
Expenses selects for audit all expense reports with at least one expense line that requires a receipt. This audit selection
rule doesn't consider whether the employee actually provided the receipts.

Audit Expense Reports of Individuals on the Audit List
Expense reports of employees who are listed on the Manage Audit List Membership page are automatically audited if
their status is active as evidenced by no end date or the current date is before the end date.

To ensure automatic auditing of employees' expense reports listed on the Manage Audit List Membership page, you
must:

1. Assign this audit selection rule to the applicable business unit on the Rule Assignments page.
2. Select an applicable audit list rule and assign it to the same business unit you specified in step 1.

Note:  If you don't assign the audit list rule you selected in step 2 to the business unit specified in step 1, you
can only add individuals to the Manage Audit List Membership page manually.
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Audit Expense Reports with Expenses Older than a Specified Number of
Days
Expenses reviews the receipt date of all expenses submitted with an expense report. If at least one receipt date is older
than the expense report submission date by the specified number of days, the report is selected for audit. For example,
if the expense report submission date is October 15 and the maximum age of expenses in the report is 7 days, the report
is selected for audit if it contains expense items earlier than October 8. The audit selection rule calculation is submission
date minus maximum age of expenses.

Audit Expense Reports with Specific Keywords
Expenses selects expense reports for audit based on a list of keywords that you specified. Here are the fields where the
application searches for the keywords:

• In expense reports:

◦ Purpose

◦ Descriptive flexfields of character type, which includes ATTRIBUTE_CHAR_1 through
ATTRIBUTE_CHAR_15

• In expense items:

◦ Description

◦ Justification

◦ Merchant Name

◦ Descriptive flexfields of character type, which includes ATTRIBUTE_CHAR_1 through
ATTRIBUTE_CHAR_15

You can also define a score percentage to include words similar to keywords in the search. If you set the score
percentage as 100%, the application selects expense reports that exactly match the keywords. As you reduce the score
percentage, the application searches for additional words that are similar to keywords.

Audit Expense Reports with Commute Distance Variance
Expenses selects for audit an expense report with a commute distance variance when an employee creates a mileage
expense with a home or office address that's different than what's on the Contact Information page of HCM.

To enable this audit rule, select Audit expense report with commute address variance on the Manage Expense Report
Audit Rules page in Setup and Maintenance.

How You Set Up Keyword Audit  
Organizations can use keyword audit to identify expense reports that auditors need to review. Here are some scenarios
where you can use keyword audits:

• To identify purchases and subscriptions from merchants that aren't permitted by your company.

• To identify expenses from conference and events that your company wants to review for compliance.
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• To monitor expenses involving specific organizations.

You need to do these tasks to set up keyword audits:

1. Add keywords to a keyword lookup.
2. Create an audit selection rule that uses the keyword lookup.
3. Assign the audit selection rule to a business unit.

Add Keywords to Keyword Lookup
After you identify keywords, which you want the application to search in expense reports, add them as lookup code
meanings to a keyword lookup. Generally, you can use the ORA_EXM_KEYWORD_AUDIT lookup type provided by
Expenses to add keywords for audit. You search for the lookup type on the Manage Standard Lookups page and then
add the keywords.

However, if you have different keyword audit requirements for different business units, it's a good practice to create
separate keyword lookups for each business unit to support its requirements. You can add the generic keywords as well
as the keywords specific to the business unit in the keyword lookup. Here are the steps to create a keyword lookup and
add keywords:

1. In the Setup and Maintenance work area, select the Manage Standard Lookups task.
2. On the Manage Standard Lookups page, click the New icon in the Search Results section.
3. In the new row, enter lookup type name, meaning, and description for the keyword lookup.
4. Select Expenses from the Module list.
5. Click Save.
6. Next, you add keywords to the keyword lookup. To add a keyword, click the New icon in the Lookup Codes

section.
7. In the new row, enter a lookup code. Then, enter a keyword in the Meaning column.
8. Repeat steps 6 and 7 to add all keywords.
9. After adding all the keywords, click Save and Close.

Create Audit Selection Rule
Here are the steps to create an audit selection rule:

1. Sign in as an expense manager.
2. In the Setup and Maintenance work area, select the Manage Expense Report Audit Selection Rules task:

◦ Offering: Financials

◦ Functional Area: Expenses

◦ Task: Manage Expense Report Audit Selection Rules
3. On the Manage Expense Report Audit Selection Rules page, click the Create icon.
4. On the Create Expense Report Audit Selection Rule page, enter a name for the rule.
5. In the Additional Selection Rules section, select the Audit expense reports with keywords option.
6. From the Lookup Type list, select the keyword lookup you created earlier.
7. Enter a score percentage to include words similar to keywords in the search. If you set the score percentage

as 100%, the application selects expense reports that exactly match the keywords. As you reduce the score
percentage, the application considers additional words that are similar to keywords as matching. For example, if
you have Vision Web Services as a keyword and set the score percentage as 95%, an expense report containing
text Vision web srv isn't considered a match. However, if you reduce the scoring percentage to 80% the same
expense report is considered a match. Similarly, if Organization is a keyword, application considers an expense
report containing text Org as not matched when the scoring percentage is 95%. However, if the percentage is
set to 90%, the same expense report is considered a match.

8. If required, you can select additional selection rules.
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9. Click Save and Close.

Assign Audit Selection Rule
Here are the steps to assign an audit selection rule to a specific business unit:

1. Sign in as an expense manager.
2. In the Setup and Maintenance work area, select the Manage Expense Report Audit and Receipt Rule

Assignments task:

◦ Offering: Financials

◦ Functional Area: Expenses

◦ Task: Manage Expense Report Audit and Receipt Rule Assignments

3. On the Manage Expense Report Audit and Receipt Rule Assignments page, click a business unit to assign the
audit selection rule.

4. On the Edit Expense Report Audit and Receipt Rule Assignments page, click the Add Row icon in the Expense
Report Audit Selection Rule section.

5. In the new row, select the audit selection rule you created and enter a start date.
6. Click Save and Close.

After the audit selection rule is activated, the application searches for keywords in the expense reports. If a keyword is
found in an expense report, the Keyword Violation audit reason is added to the expense report. The report then requires
an additional review of auditors.

How You Add to or Remove Employees from the Audit
List  
The audit list on the Manage Audit List Membership page is the list of employees whose expense reports are
automatically selected for audit if an audit list rule is violated.

You can also manually add employees to the audit list. The audit list is not maintained by each business unit. Instead,
one audit list is available across all business units.

With Oracle Fusion Expenses, you can:

• Automatically add and remove employees from the audit list.

• Manually add or remove employees from the audit list.

• Manually add or remove employees from the audit list during auditing.

Automatically Add and Remove Employees from the Audit List
During setup on the Create Audit List Rule page, you can select any of the following audit list rules:

• Maximum number of days to wait for original receipt package

• Allowable total monthly amount of all expense reports

• Allowable number of policy violations per month

• Allowable number of expense reports per month
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Expenses automatically adds employees to the audit list if they violate any audit list rules you select.

You can automatically add employees to the audit list by performing all of the following actions:

• On the Create Audit List Rule page, select audit list criteria to create an audit list rule.

Expenses uses audit list rules to automatically place employees on the audit list if they violate the audit list rules
that you select.

• For each audit list criterion that you select, specify the number of days that the application automatically
monitors the expense reports of the active employees on the audit list.

Note:  If another audit list violation occurs for an employee during the time period he remains on the audit
list, the application resets the count for the same number of days to remain on the list.

• On the Create Expense Report Audit Selection Rule page, select the Audit expense report of individuals on
the audit list rule in the Additional Rules section.

Audit selection rules are the criteria that Expenses uses to automatically select expense reports for audit.

• On the Rule Assignments page, associate the audit list rule and the audit selection rule with a business unit.

You can automatically remove employees from the audit list by performing the following action:

• On the Create Audit List Rule page, enter a value for the number of days that the application automatically
monitors the expense reports of employees on the audit list. When the number of monitoring days is complete,
the employee is no longer automatically monitored by the application and he is inactivated on the Manage
Audit List Membership page.

Note:  For both automatic and manual additions or deletions from the audit list, you can add reasons to the Audit List
Addition Reason choice list by configuring the lookup EXM_AUDIT_REASON.

Manually Add or Remove Employees from the Audit List
On the Manage Audit List Membership page, you can select any of the following predefined reasons from the Audit List
Addition Reason choice list to manually add employees to the audit list:

• Expenses amounts near threshold

• High frequency of same expense types

• Disproportionate number of cash expenses

• Violates an undefined policy

You can manually remove employees from the audit list on the Manage Audit List Membership page by:

• Specifying an end date. If no end date is specified, an employee remains on the audit list indefinitely.

• Selecting a reason from the Audit List Addition Reason choice list:
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Manually Add or Remove Employees from the Audit List During Auditing
While auditing an expense report on the Audit Expense Report page, you can manually add employees to the audit list
by:

• Selecting the Add to audit list check box if visible.

• Selecting a reason from the Reason choice list:

While auditing an expense report on the Audit Expense Report page, you can manually remove employees from the
audit list by:

• Selecting the Remove from audit list check box if visible.

• Selecting a reason from the Reason choice list:

Options for Setting Up Receipt Management Rules  
Receipt management ensures that all required expense report receipts are submitted by employees. To do this, you can
create receipt and notification rules to determine:

• When to send notifications to employees

• When to place payment holds on expense reports due to missing or overdue receipts

You can assign receipt and notification rules to each business unit in your company to reflect your business policies.
When you set up receipt and notification rules according to your company's policies, employees aren't reimbursed for
expenditures until missing or overdue original or imaged receipts are submitted.

When you set up receipt management rules for your company, you can specify the following:

• Type of receipts

• Granularity of receipt requirements

• Receipt requirements

Type of Receipts
The first and most important receipt management decision is to specify the type of receipt your company requires for
expense report submission. You can require:

• Original receipts

• Imaged receipts

• Original and imaged receipts

You can specify your company's receipt requirement in the header of the Create Receipt and Notification Rule page.
Original receipts are paper receipts that employees receive after incurring an expense. Imaged receipts are expense
receipts that have been converted to a digital image by a camera, scanner, or fax so they can be attached to the online
expense report.

Note:  If you specify that imaged receipts are required, you must also specify the point in the expense report process
at which their attachment to the expense report is required.
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Granularity of Receipt Requirements
The second receipt management decision is to specify the level on which you want to define receipt rules. You can
specify receipt rules at all, any, or none of the following levels:

• Organization level: Create Receipt and Notification Rule page
Note:  If you don't select a required type of receipt on the Create Receipt and Notification Rule page, then
Expenses selects Originals only as the default type of receipt required.

• Template level: Create Expense Template page, Receipt Requirement tab

• Expense type level: Edit Expense Type page, Receipt Requirement tab

The following table indicates the sequence in which Expenses processes receipt and notification rules. It starts with the
lowest level and moves to the highest level.

Sequence in Which Expenses Processes
Receipt and Notification Rules

Level

Lowest level
 

Expense type
 

Middle level
 

Template
 

Highest level
 

Organization
 

Receipt Requirements
The third receipt management decision is to specify receipt requirements. You can define them on the Receipt
Requirement tabs of the Create Expense Template page or the Edit Expense Type page.

You can specify receipt requirements for:

• Cash expense lines

• Corporate card expense lines

• Negative expense lines

• Disallowance of missing receipts

• Display of missing receipt warning

Audit Rules to Identify Anomalies in the Expense Report  
Audit rules to identify anomalies in the expense reports are preconfigured rules that you can modify based on your
business needs.

Expenses includes these audit rules to identify anomalies:

• Audit rule related to expense report owner
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◦ Audit expense reports of top spenders

◦ Audit expense reports of top policy violators

◦ Audit expense reports with same policy violation for more than specific times

• Audit rule related to Expense report item

◦ Audit expense reports with public sectors attendees

◦ Audit expense reports for duplicate expense

◦ Audit expense reports with same attendees for the same day

◦ Audit expense reports with expense amount below specific threshold of missing receipt policy

Audit expense reports of top spenders
Expenses maintains the total expense of the employees and the business units to identify the top spenders. In the Audit
expense reports of top spenders rule, Expenses selects all the reports in a specified period for audit of the report owner
who's one of the top spenders in the period. You can define these parameters in the rule:

• The number of months in the period

• The number of top spenders in the period

For example, you can define these rules:

• 10 top spenders of past 6 months

• 20 top spenders of past 10 months

Note:  When you enable this rule, schedule the Generate Summary Metrics for Expenses process to update the data of
top senders.

Audit expense reports of top policy violators
Expenses maintains the number of violations (across violations) by the employees and the business units to identify the
top policy violators. In the Audit expense reports of top policy violators, Expenses selects all the reports in a specified
period for audit of the report owner who's one of the top policy violators in the period. You can define these parameters
in the rule:

• The number of months in the period

• The number of top policy violators in the period

For example, you can define these rule:

• 10 top policy violators of past 6 months

• 20 top policy violators of past 10 months

Note:  When you enable this rule, schedule the Generate Summary Metrics for Expenses process to update the data of
policy violators.
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Audit expense reports with same policy violation for more than specified
times
Expenses maintains the count of violations for each policy by the employees and the business units to identify the
repeat policy violators. In the Audit expense reports with same policy violation for more than specified times, Expenses
selects the next expense report for audit if the report owner violates the same policy for more than the defined
threshold limit of violations within a specified period. You can define these parameters in the rule:

• The number of months in the period

• The number of times a policy can be violated in the period

For example, you can define these rules:

• The Airfare class of ticket violation is allowed 5 times in a 1 month

If this violation repeats more than 5 times in a month, the next expense report for the employee is selected for
audit.

.

• The Corporate Card Required violation is allowed 10 times in 2 months

If this violation repeats more than 10 times in 2 months, the next expense report for the employee is selected
for audit.

Note:  When you enable this rule, schedule the Generate Summary Metrics for Expenses process to update the data of
violators by policy violations.

Audit expense reports with public sectors attendees
In the Audit expense reports with public sector attendees, Expenses selects the expense report for audit if it includes
any expense involving attendees from the public sector.

Audit expense reports for duplicate expense
In the Audit expense reports for duplicate expense, Expenses selects the expense report for audit if it includes any
expense item identified as a duplicate based on these attributes: amount, date, currency, expense type, and merchant.

Note:  Enable the Detection of Duplicate Expenses feature to use this audit rule.

Audit expense reports with same attendees for the same day
In the Audit expense reports with the same attendees for the same day audit option, Expenses selects an expense
report for audit when it detects the attendees (employee or non-employee) associated with it in other submitted
expense reports with the same expense item type and expense item date or date range.
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Audit expense reports with expense amount below specific threshold of
missing receipt policy
In the Audit expense reports with expense amount below specific threshold of missing receipt policy audit option,
Expenses selects those expense reports for audit, which are lower than the receipt threshold but have exceeded the
allowed number of incidents as per the defined criteria. You can define the below criteria in the rule:

• Percentage of threshold: Indicates the permissible range of amount less than the threshold amount.

• The number of incidents in the past: Indicates the allowed number of occurrences when the expense amount is
within the permissible amount range.

• The number of months in the period: Indicates the audit period from the expense submission date.

For example, you can define this rule:

• 10% of the threshold amount, occurring more than 5 times in the last 6 months

If the required value of the receipt is set as USD 500 and there are 5 reports in the last 6 months with expense amounts
between USD 450 to 499, all the subsequent expense reports that satisfy this rule are selected for audit.

How You Enable Preconfigured Audit Rules to Identify
Anomalies in the Expense Report  
You can now enable audit rules to identify potential anomalies even when expenses are within the company policies.
You can enable intelligent preconfigured rules for all the business units or a specific business unit.

To set up the additional audit rules identify anomalies in the expense report, follow these steps:

1. In the Setup and Maintenance work area, select the Manage Expense Report Audit Rules task:

◦ Offering: Financials

◦ Functional Area: Expenses

◦ Task: Manage Expense Report Audit Rules

2. On the Manage Expense Report Audit Rules page, complete these steps:

◦ To enable the additional audit rules for All business units for the first time:

i. In the All Business Units section, click Activate Rule.
ii. Enter the start date and end date.

iii. Modify the default values based on the business need.
iv. Click Save and Close.

◦ To enable the additional audit rules for a specific business unit for the first time:

i. In the Specific Business Unit section, add the required business unit.
ii. Enter the start date and end date.

iii. Modify the default values based on the business need.
iv. Click Save and Close.
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Note:  The following audit rules are available in the Manage Expense Report Audit Rules and the Audit Selection Rule
tasks. If you want to use these rules, enable them in the Manage Expense Report Audit Rules task.

• Audit expense reports of individuals on the audit list

• Audit a percentage of all expense reports

• Audit expense reports of individuals with a specific status

Expense Report Payment Hold Rules  
You can set up expense report payment hold rules for individuals and corporate card issuers in the Expense Report
Payment Hold section on the Create Receipt and Notification Rule page.

You can then schedule and periodically run the Process Expense Report Reimbursement process to check whether any
payment hold rules are in effect.

An expense report payment hold rule is a component of the receipt and notification rule that's assigned to a specific
business unit. A payment hold rule places current or future expense reports on hold when receipts aren't received or
when they're overdue. When expense report payment hold rules are implemented, reimbursement to the individual or
payment to the corporate card issuer can't occur until expense report holds are released.

The Process Expense Report Reimbursement process also checks whether expense report payment holds can be
released. Payment holds are released when:

• The expense auditor manually releases the payment hold on the Audit Expense Report page by selecting the
Release Hold option on the Actions menu.

• Based on receipt status, Expenses detects that receipts are received, waived, or declaration received and
automatically releases the payment hold.

Holding expense report payments from individuals and corporate card issuers can include the following reasons:

• Hold payment if receipts are required, but not yet received.

• Hold payment if receipts are overdue on a previously submitted expense report.

All submitted expense reports that require receipts are evaluated. When the rule is set to hold payment when
receipts are overdue, payments for all subsequent reports are placed on hold if any have outstanding receipts.

Note:  If an expense report is placed on payment hold due to overdue or required receipts that aren't yet received,
neither the individual nor the corporate card issuer is reimbursed. This rule is applicable only when the payment
liability for the card issuer is Both Pay and the Apply Hold Rule To option is set to Report of both individuals and
corporate card issuers.

Your company schedules and periodically runs the Process Expense Report Reimbursement process, which checks
whether any payment hold rules are in effect. If the rules are in effect, Expenses places payment holds on expense
reports according to the specified payment hold rules. Individuals who have expense report payments held receive a
notification. When receipts are received or waived, Expenses automatically releases holds. Alternatively, the expense
auditor can manually release a payment hold at his discretion.
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Tip:  By default, payments aren't held for project-only expense reports. However, you can specify inclusion of project-
only expense reports as eligible for payment holds by selecting the Apply hold rules to expense reports check box.
Every expense line contains a project-related information check box in the Expense Report Payment Hold section on
the Create Receipt and Notification Rules page.

Expense Report Risk Indicator in Expense Audit  

The Expenses application calculates the risk of an expense report based on the audit rule violations for the expenses in
the report. The possible risk values associated with each expense report are High, Medium, or Low. This table lists the
risk level for each audit reason code.

Audit Reason Code Audit Reason Meaning Risk Level

AGED_EXPENSE_ITEMS
 

Aged expense items
 

Low
 

AMOUNT_OVER_THRESHOLD
 

Amount over threshold
 

Low
 

AUDIT_LIST_MEMBER
 

Audit list member
 

High
 

EMPLOYEE_INACTIVE
 

Inactive employee
 

High
 

EMPLOYEE_ON_LEAVE
 

Employee on leave of absence
 

High
 

EXPENSE_CUM_AMOUNT
 

Expense type over cumulative amount
 

Medium
 

EXPENSE_TEMPLATE
 

Expense template
 

Low
 

EXPENSE_TYPE
 

Expense type
 

Medium
 

EXPENSE_TYPE_AMOUNT
 

Expense type over amount
 

Medium
 

IMAGED_RECEIPT_MISSING
 

Missing imaged receipt
 

Medium
 

ORA_DUP_ATTENDEE
 

Duplicate attendee
 

Medium
 

ORA_DUP_EXPENSE_ITEM
 

Duplicate expense item
 

High
 

ORA_EX_RECPT_THRESHOLD
 

Exceeded receipt required threshold
 

Medium
 

ORA_KEYWORD_VIOLATION
 

Keyword violation
 

Medium
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Audit Reason Code Audit Reason Meaning Risk Level

ORA_PUB_SEC_ATTENDEE
 

Public sector attendee
 

Medium
 

ORA_SAME_POL_VIO_IN_PAST
 

Same policy violation in past
 

High
 

ORA_TOP_POL_VIOLATOR
 

Top policy violator
 

High
 

ORA_TOP_SPENDER
 

Top spender
 

High
 

POLICY_VIOLATION
 

Policy violation
 

High
 

RANDOM_SELECTION
 

Random selection
 

Null
 

RECEIPT_REQUIRED
 

Receipt required
 

Low
 

To customize the risk level for each audit reason, navigate to the Manage Standard Lookups page and create these
Lookup Types and associate the Audit Reason Codes from the table.

• EXM_AUDIT_RISK_HIGH for the risk level of high

• EXM_AUDIT_RISK_MEDIUM for the risk level of medium

• EXM_AUDIT_RISK_LOW for the risk level of low

When you create a lookup type, the risk levels of the associated audit reason codes are the same as the risk level of the
lookup type because the predefined risk levels are not available anymore. The risk levels of the audit reason codes that
are not associated with one of the new lookup types are set as null and are not considered in the risk calculation. If you
want to include any other audit reason code in risk calculation, you must associate it with one of the new lookup types.

For example, if you create a lookup type as EXM_AUDIT_RISK_MEDIUM and associate a reason code, the risk level of the
reason code is medium even if the predefined risk level is high or low. If required, you can associate other reason codes
to the EXM_AUDIT_RISK_HIGH or EXM_AUDIT_RISK_LOW lookup type with its corresponding risk levels.

If you are associating Audit Reason Code without the ORA_ prefix, add it to the Lookup Code and Meaning
columns. For example, to associate audit reason code EXPENSE_TYPE with Lookup Type EXM_AUDIT_RISK_LOW,
enter EXPENSE_TYPE to the Lookup Code and the Meaning columns. If you are associating Audit Reason Code
with the ORA_ prefix, add it to the Meaning column and add the same reason code without the ORA_ prefix
to the Lookup Code column. For example, to associate audit reason code ORA_KEYWORD_VIOLATION with
Lookup Type EXM_AUDIT_RISK_HIGH, enter KEYWORD_VIOLATION to the Lookup Code column and enter
ORA_KEYWORD_VIOLATION to the Meaning column.

The overall risk for an expense report is calculated by adding the score of each audit reason. An audit reason has a score
of 0 for Null risk, 10 for Low risk, 40 for Medium risk, and 120 for High risk. The risk of the expense report is determined
according to this table.

Expense Report Risk Level Cumulative Score

Null
 

0
 

Low < 40
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Expense Report Risk Level Cumulative Score

  

Medium
 

>=40 and < 120
 

High
 

>=120
 

FAQs for Expense Policies and Rules  

Can expense types be used across expense templates?  
No. You can't define an expense type in an expense template and reference that same expense type in another expense
template.

You can, however, create an expense type with the same name in another expense template. Expense types are
template-specific.

Related Topics
• What's an expense template?

How can I enable users to select reimbursement currencies for
each expense report?  
You can use the Manage Expenses System Options page to enable multiple currencies and allow users to select the
reimbursement currency in expense reports.

You can also limit the display of the allowed currencies by business unit. Thereby, improving compliance with local
regulations by only allowing the selected available currencies to be used in reports.

Here's how you can do it:

1. In the Setup and Maintenance work area, select these options:

◦ Offering: Financials

◦ Functional Area: Expenses

◦ Task: Manage Expenses System Options

2. On the Manage Expenses System Options page, navigate to the Specific Business Units section and click the
business unit whose system options you want to change.
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3. On the User Options for Expense Report tab, set the value of Allow Reimbursement Currency Selection to
Yes.

Note:  To enable reimbursement currency selection across all business units, on the Manage Expenses
System Options page, in the User Options for Expense Report subsection of the All Business Units section,
set the value of the Allow Reimbursement Currency Selection option to Yes.

4. To limit the reimbursement currency selection by business unit, click the Allowed Currencies drop-down list
and select the reimbursement currencies you want the business unit to display in the expense reports.

Note:  This list is enabled only when the Allow Reimbursement Currency Selection option is set to Yes.

You can select up to 50 single or multiple currencies to be displayed in the expense reports.
5. Click Save and Close.

How can I enable users to select payment methods in expense
reports?  
You must set the option, Enable Payment Method, to Yes. If you don't want to allow users to select the payment method
for reimbursement of each expense report, set the option to No.

By default, this option is set to No. The application uses the default payment method, such as check or EFT, that was set
up for the users' reimbursement. You can optionally set the option at the implementation level on the Manage Expenses
System Options page, which applies to all business units. Alternatively, you can specify exceptions for specific business
units in the Create System Options: Specific Business Unit dialog box.

How can I enforce users to attach a required receipt to an expense
line?  
You can configure the setting to enforce users to attach the required receipt to an expense line. To do this, you need to
configure these settings.

• Enable attachment of receipts to expense lines: To enable this setting at the organization level, on the Manage
Expenses System Options page, select the Lines required option for the Enable Attachment field.

Here's how you can enable the setting for a specific business unit:

a. On the Manage System Options page, select the business unit from the Specific Business Unit section.
b. In the Edit Expenses System Options dialog box, select the User Options for Expense Reports tab.
c. Select the Lines required option for the Enable Attachment field.

• Create rule to prevent submission of expense reports if receipts are missing:

a. On the Create Expense Report Receipt and Notification Rule page, select either Imaged or Both for the
Type of Receipt Required field.

b. In the Stage When Imaged Receipts Must Be Attached to Expense Report section, select the Prevent
submission if receipts aren't attached option.
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c. Click Save and Close.

• Assign the rule to a business unit.

After you configure these settings, users need to attach the required receipt to an expense line while submitting
expenses.

How can I display the barcode?  
Set the system option, Display Bar Code, to Yes. The barcode is displayed on the printed copies. This system option
enables you to fax receipts and the expense report cover sheet with the barcode on it to a server.

The server attaches the receipts to the expense reports. You can set this system option at the implementation level on
the Manage Expenses System Options page, which applies to all business units. You can also specify exceptions for
specific business units in the Create System Options: Specific Business Unit dialog box.

Related Topics
• Why do I have to configure the barcode font mapping?

How can I configure expense report number prefixes for different
business units?  
If you select alphanumeric prefixes for expense report numbers, then you must enter the Expense Report Number
Prefix as a setup option. You can define prefixes at the implementation level on the Manage Expenses System Options
page, which applies to all business units.

You can also specify exceptions for specific business units or define the prefix for each business unit on the Create
System Options: Specific Business Unit dialog box.

How can I enable a printable expense report format and assign it
to a business unit?  
Your company can create printable expense report formats in BI Publisher Enterprise to meet legal or expense report
formatting requirements.

You can then assign the formats to any of the business units on the Manage System Options page. To assign a printable
expense report format to an existing business unit, click the applicable business unit link. On the Edit System Options
page, select a value from the Printable Expense Report Format choice list. If the business unit that you want to assign
a printable expense report format to doesn't exist in the Specific Business Units section, click Create. Then select a
business unit from the Business Unit choice list. Now select a value from the Printable Expense Report Format choice
list.
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How can I change a default expense template for a business unit?  
Every business unit can have only one default expense template. If you enable an expense template as the default
template, you can select another template as the default.

Only templates that have corporate card mapping enabled are eligible to become the new default expense template. If
the expense template is eligible, then the Set as default check box in the header section is enabled for selection.

To set another expense template as the default, navigate to the Manage Expense Report Templates page. Find the
template you want to specify as the new default expense template and click its name. In the Edit Expense Report
Template page, select the Set as default check box in the header region and save the template. If the template doesn't
meet the criteria for a default expense template, then the Set as default check box is disabled. In that case, confirm that
the Enable corporate card mapping check box is selected.

How can I enable expense auditors to audit expense reports for
specific business units?  
You can enable expense auditors to audit expense reports for specific business units by assigning them specific expense
auditor data roles for the business units.

What's a rate determinant?  
A rate determinant for an entertainment expense policy is a variable that determines the policy rate amount limit for
which an employee can be reimbursed for entertainment or gift expenses. An entertainment expense policy has one
rate determinant, which is attendee types.

Since attendee types is a rate determinant, you can define different policy rate amounts for different event attendee
types, such as a public sector client or a private sector client.

How can the administrator enable the Oracle Fusion Expenses
mobile application on an iPhone or iPad?  
Using the mobile device, users must download and install the Oracle Fusion Expenses mobile application from the
Apple Store at http://www.apple.com/iphone/from-the-app-store/. Users require the following information to use the
mobile application:

Host URL: If your company has a specific URL for the Oracle Fusion Financials domain, then the host URL is the URL
for the Financials domain. The following URL is an example: https://fusion-fin.mycompany.com:7002. If your company
has a single URL for the entire Oracle Fusion Applications, then the host URL is the one you use for Oracle Fusion
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Applications. The following URL is an example: https://fusion.mycompany.com. The server must use an HTTPS
connection.

User Name and Password: User's user name and password that is used to access the Expenses web-based application.

If your company doesn't enable Oracle Fusion applications outside its firewall, users must connect to your company's
network using a Virtual Private Network (VPN). The VPN is used for the initial connection and to upload expense items
to Expenses web-based application. For convenience, users can enter expenses on the mobile device when they aren't
connected to VPN.

How can I view the audit rules that are configured in the Manage
Expense Report Audit Rules task?  
You can view the audit rules configured for a date range.

Do these steps to view the audit rules that are configured in the Manage Expense Report Audit Rules task:

1. In the Setup and Maintenance work area, select the Manage Expense Report Audit Rules task:

◦ Offering: Financials

◦ Functional Area: Expenses

◦ Task: Manage Expense Report Audit Rules

2. On the Manage Expense Report Audit Rules page, select the date range from the Effective Date Range list.

The page refreshes to display the rules configured for the selected date range.

How can I edit the preconfigured expense audit rules?  
You can edit the preconfigured expense audit rules if there are no expenses submitted in that date range.

Do these steps to edit the preconfigured expense audit rules that are configured in the Manage Expense Report Audit
Rules task:

1. In the Setup and Maintenance work area, select the Manage Expense Report Audit Rules task:

◦ Offering: Financials

◦ Functional Area: Expenses

◦ Task: Manage Expense Report Audit Rules

2. On the Manage Expense Report Audit Rules page, select the date range from the Effective Date Range list for
which you want to edit rules, and click Edit Rules.

3. On the Edit Expense Report Audit Rules page, click Edit Rules.
4. Modify the rules as needed.
5. Click Save and Close.
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You can't edit the existing rules if expenses are already submitted. In that case, you need to create new rules. Do these
steps to create new rules:

1. In the Setup and Maintenance work area, select the Manage Expense Report Audit Rules task:

◦ Offering: Financials

◦ Functional Area: Expenses

◦ Task: Manage Expense Report Audit Rules

2. On the Manage Expense Report Audit Rules page, click Create Rule.
3. Specify the Effective Start Date and Effective End Date.

Note:  You can't create audit rules with dates overlapping the dates of existing rules.

4. Modify the default values as needed.
5. Click Save and Close.

How can I route expense reports to specific account owners for
approval?  
You can update existing or configure new expense approval rules using account segments to route expense reports to
the respective account owners for approval.

The account segments for expense approval routing are available in the Expense Distribution folder as Account
Segment 1, Account Segment 2, and so on. These are a few additional accounting attributes that you can use to set
conditions in the approval rules.

• Detailed Budgeting Allowed Indicator

• Detailed Posting Allowed Indicator

• Account Enabled Indicator

• Account End Date

• Financial Category

• Account Start Date

For information on modifying existing or defining new approval rules, see How You Define Approval Rules.

How can I customize rules for the employee bank accounts?  
You can use REST APIs to create custom rules for each country depending on the regulatory changes or bank
requirements.

When you use REST APIs to create or update custom rules for employee bank accounts in Expenses, provide the value
for PageName as <Expenses>. You must not update the predefined rules when you modify rules for employee bank
accounts.
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How can I view the complete route information for mileage
expenses?  
Auditors and managers can review the interim stops of mileage expenses on the Audit Expense Report and View
Expense Report pages.

Auditors can review the interim stops of a mileage expense trip directly from a mileage expense report by clicking the
View Map button. Clicking this button opens the Trip Details page that lists all the points of travel and the trip distance
for the selected mileage expense report.

Note:  Your company can provide the route visibility to managers by configuring a custom expense report approval
notification using the SEQUENCE_NUM and DISPLAYED_ADDRESS attributes of the EXM_MILEAGE_WAYPOINTS
table in the BI Publisher template. See Example of Modifying Expenses Email Notifications Using Oracle Analytics
Publisher for more information. 

How can I create custom mileage add-on rates?  
Besides using the add-on rate types that come with the application, you can create your own add-on rates to suit your
business requirements.

Create new add-on rate types using the EXM_ADDITIONAL_RATES lookup type. Here's how you can do it:

1. In the Setup and Maintenance work area, use the following:

◦ Offering: Financials

◦ Functional Area: Expenses

◦ Task: Manage Standard Lookups

2. Search for the EXM_ADDITIONAL_RATES lookup type.
3. In the Lookup Codes section, click the New icon and create your additional rate types.

You can access these rate types in the rates spreadsheet that opens when you click Create Rates on the Edit Mileage
Policy page.

Related Topics
• How You Set Up a Mileage Expense Policy

How can I use award funding patterns for project cost distribution
in Expenses?  
Use funding patterns to eliminate the need to determine cost allocation manually as they automatically apply charges to
awards and funding sources based on contractual obligations.

After the Grant Administrator sets up an active funding pattern, employees can enter costs for a project, task, and
expense category without filling in the contract number or funding source. When they submit the expense report with
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those fields blank, the funding pattern automatically assigns the costs, so there’s no need to choose awards or allocate
costs manually.

This automation improves compliance, reduces manual errors, and ensures accurate cost alloction for projects with
complex funding requirements, without requiring employee intervention.

Here's how you can use this functionality in Expenses:

1. Enable the feature for Expenses (one-time setup)
Since this is an Opt In feature, ensure that this feature is enabled for Expenses.

2. Create and activate funding patterns
This step is performed by Grant Administrators after a project is awarded funding.

a. Define funding patterns that include:
- Awards and funding sources
- Distribution percentages
- Task levels
- Valid date ranges

b. Set the funding pattern status to Active.

Note:  Active funding patterns are required for automated cost distribution, and expense items must
fall within the funding pattern’s date range based on the expense item's date.

3. Enter an expense report
When submitting an expense for a sponsored project:

a. Enter the Project, Task, and Expenditure Organization.
b. Leave Contract and Funding Source blank (if enabled).

After submission, the system uses the active funding pattern to automatically:

• Split the expense across multiple awards or funding sources.

• Apply rules based on the task and expenditure item date.

• Initiate the approval process.

No manual intervention is required by the employee.

Error handling and troubleshooting
What happens when cost distribution fails?

• The expense report remains in the Pending manager approval status and doesn't get routed to the manager.

• Distribution-related errors aren't visible to employees and they aren't notified of the failure.

How to view and fix errors?

1. Ensure you have the following required privileges

◦ Manage Expense Auditing (EXM_MANAGE_EXPENSE_AUDITING_PRIV)
Allows access to the Audit work area

◦ Generate Expense Award Distribution (EXM_GEN_AWARD_DIST_PRIV)
Allows viewing and generating distributions for sponsored projects using active award funding patterns
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Note:  You must have access to the relevant business unit for the expenses you need to correct.

2. Go to the Audit work area in Expenses.
3. Search for reports pending manager approval and open a failed report.
4. Go to the View Project Cost Distribution Details section within the report.
5. Review error details, funding rules, and distribution sets.
6. Resolve issues. For example, adjust the funding pattern by coordinating with the Grants Administrator. This is a

manual process performed outside Expenses.
7. Click Distribute Project Cost to regenerate distributions.

Once corrected, the report automatically resumes its approval workflow.

Note:  Employees aren't usually impacted during the correction process, and the expense report moves forward
once resolved. However, if project funding is fully consumed and costs need to be charged to a different project,
the expense report is returned to the employee to update the project, task, and expenditure organization before
resubmitting.

Related Topics
• Project Cost Distribution Using Award Funding Patterns
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4  Travel

How You Set Up Prerequisites for Travel Partner
Integration  
A travel partner is an online booking provider or a travel agency that provides travel services to your employees. Before
you can set up a travel partner and booking sites in Oracle Fusion Expenses, your company must perform the following
prerequisite steps:

• Select a travel partner.

• Configure booking sites.

• Configure travel policies and policy violations.

• Determine employee access methods.

• Set up employees.

Select a Travel Partner
Your company selects a travel partner based on the travel needs of your employees and the travel booking support
provided by the travel partner in countries where your employees are located. If you choose, you can also use the
services of a travel partner for specific countries only.

Expenses supports integration with the GetThere travel partner. In addition, integration with other travel partners is
supported using REST services. Expenses provides you the flexibility to integrate with multiple travel partners to meet
the requirements of your organization. Here are some scenarios that you can set up in Expenses:

• Integrate with GetThere for employees in the US and with another travel partner for employees in Asia-Pacific
region.

• Integrate with a third-party travel partner for the Middle East region and with another travel partner for rest of
the world.

• Integrate with GetThere for US, and with different travel partners for the Middle East and Asia-Pacific regions
respectively.

Here are a few points you must keep in mind when you integrate with multiple travel partners:

• You can't have more than one GetThere integration for your organization.

• There must be no overlap of countries or employment assignments among the travel partner integrations.
Therefore, an employee must have only one booking site applicable to them.

Configure Booking Sites
A booking site is an instance of your travel partner's booking tool that's configured for a group of employees. Your
company may require one or more booking sites, which are configured in the travel partner's system. Your company
may require multiple booking sites depending on your operations.

• Your company operates in multiple countries or regions.

209



Oracle Fusion Cloud Financials
Implementing Expenses

Chapter 4
Travel

• Your company's travel policies vary based on employee job roles.

For example, employees in the management level of executive vice president and over are eligible to stay in
luxury hotels, while employees in the management level of vice president and under aren't eligible. Similarly,
employees in the management level of executive vice president and over are eligible to fly first class, while
employees in the management level of vice president and under are only eligible for business class.

• Your company wants booking sites displayed in the language of each country or region.

Your travel partner configures your booking site instances in its system and provides you with the site names that
represent those instances, as well as the sign in credentials for administrative access.

Configure Travel Policies and Policy Violations
You create travel policies in the travel partner's system to enforce your company's travel policies. For each booking
site that you set up, you must configure travel policies and policy violations. When you set up your travel partner in
Expenses, the travel policy violations and justifications are downloaded to Expenses with the itineraries.

Determine Employee Access Methods
Your company must decide how your employees will access and sign in to the booking sites. Your company can enable
sign in access in one of the two following ways.

• Single sign-on (SSO)

• Authentication by travel partner

If your company already has a system that centrally manages all user accounts and passwords, known as Federated
authentication with an identity provider, and sign in to all systems are routed through this central system, you can use
the same capability for accessing your booking sites. When you enable SSO, employee passwords aren't stored in your
travel partner's system. You can enable SSO for all or for specific booking sites.

CAUTION:  When you set up employees in booking sites with SSO enabled, it's advisable for employee user names
in booking sites to match the corresponding user names in your IdP. For example, if employee user names are their
email identifiers, then it's advisable for the user names in the booking sites to also be email identifiers.

An alternative way to enable sign in access is authentication by your travel partner. In this scenario, you associate
your employees with booking sites in your travel partner's system, along with their user names and passwords. When
employees access the booking sites, they enter their user names and passwords and the booking sites validate the sign
in credentials. For this access alternative, user names don't have to match that of any other system.

Set Up Employees
After your travel partner configures your booking site instances in its system, you can set up your employees and their
sign in credentials in your travel partner's system. If your travel policies vary by job roles or other criteria, you must set
up the relevant information for each employee in the travel partner's system. This information also determines your
employees' access to relevant booking sites.
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How You Set Up a Travel Partner and Booking Sites  
A travel partner is an online booking provider or a travel agency that provides travel services to your employees. A
booking site is an instance of your travel partner's booking tool that's configured for a group of employees.

Before you can set up a travel partner and booking sites, your company must perform the prerequisite steps mentioned
in the How You Set Up Prerequisites for Travel Partner Integration topic.

The following table contains mandatory and optional setups that you complete at the travel partner or booking site
levels to integrate with a travel partner.

Mandatory Setups Level Page

Yes
 
Applicable only for GetThere
 

itinerary import
 

Travel partner
 

Create or Edit Travel Partner
Integration
 

No
 

itinerary validation rules
 

Travel partner or booking site
 

Create or Edit Travel Partner
Integration or Create or Edit
Booking Site
 

Yes
 

booking sites
 

Booking site
 

Create or Edit Booking Site
 

Yes
 

booking site links
 

Booking site or travel partner
 

Create or Edit Booking Site or
Create or Edit Travel Partner
Integration
 

No
 

booking site assignments
 

Booking site
 

Create or Edit Booking Site
 

Only for GetThere, Itinerary Import
If you're setting up travel integration with GetThere as your travel partner, then you must enter these details at the travel
partner level to import itineraries into Expenses.

• Connection user name and password

Your travel partner provides the user name and password to your company.

• Super site name

The travel partner's system assigns a name to your company.

Itinerary Validation Rules
Your reliance on accurate travel data to make strategic, company-wide travel decisions is essential. To improve the
accuracy of travel data and to provide visibility of policy violations to approvers and auditors, you can enable validations
on itineraries when they're imported into Expenses or when they're created using REST services. You manage itinerary
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validation rules on the Manage Travel Itinerary Validation Rules page. You can optionally assign itinerary validation rules
at the travel partner level or the booking site level, based on your company's global and regional business requirements.
You can also override an itinerary validation rule at the booking site level.

Booking Sites
You must create booking sites to import or create itineraries and to permit your employees to navigate to booking sites
from the Expenses work area. When integrating with GetThere, the travel partner provides you with a booking site
identifier for each of your company booking sites. Site identifiers identify your booking sites to your travel partner and
are required for itinerary import.

When integrating with travel partners other than GetThere, called Third Party in the application, the travel partner and
booking site names act as identifiers. Itineraries are created for these travel partners using REST services. When posting
the itineraries from the third-party travel partner sites to Expenses, the travel partner and booking site names used in
the itineraries must match the values used in the setup.

Note:  You must create at least one booking site for your travel partner.

Booking Site Links
To allow employees to access travel booking sites from the Expenses work area, you can define a booking site link in the
following ways:

• Booking site-specific URLs:

Based on region, country, or employment type, your company may have different travel partners or your travel
partner may have multiple travel sites. Each booking site has a specific link. In such a case, you create different
booking sites using specific URLs so that employees are directed to the booking site applicable to them.

Even if you have a single travel partner site, you can define an exception using a site-specific link. You may have
to use booking site-specific URLs when:

◦ Your company uses a SSO for most but not all of its locations.

◦ You need specific booking sites due to local or regional regulations.

To select this option, enter a URL at the booking site level in the Booking Site Link field in the Create or Edit
Booking Site dialog box.
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• Default booking site URL:

In case you use the GetThere travel partner, you can define a default booking URL for employees who are not
assigned to a specific booking site.

To select this option, enter a URL at the partner level in the Default Booking Site Link field in the Booking Sites
section on the Edit Travel Partner Integration page for GetThere. By default, all employees use this URL to
access the travel partner unless you specify a booking site-specific URL on the Create Booking Site page.

Note:  A URL entered at the booking site level on the Create Booking Site page overrides the URL entered at
the partner level on the Create or Edit Travel Partner Integration page.

Note:  If you have a third-party travel partner, you can't use the default booking site URL. You need to create
booking sites and configure specific URLs depending on your company's preferences. You can create one
booking site for all employees if your company has a single travel partner. Or, you can create multiple sites
depending on the travel partners with which your company integrates.

Whether you select the default booking site URL or the booking site-specific URLs option, you can enter any of the
following access links:

• Single sign-on (SSO)

◦ From the Travel tab in the Expenses work area, employees navigate to their assigned booking site after
the application signs them in automatically.

• Authentication by travel partner or travel agency

◦ Employees navigate to the travel partner or travel agency's authentication page where they provide their
user name and password and then they're taken to their assigned booking sites.

If your company permits SSO, you enter the SSO URL from the identity provider as the booking site link. When
employees click Book Travel in the Expenses work area, they're automatically signed in and they automatically navigate
to their assigned booking sites.

If your company doesn't permit SSO, employee credentials are authenticated by the travel partner or the travel agency.
When employees click Book Travel in the Expenses work area, they navigate to the booking site URL that you set up.
However, they must enter their credentials and sign in to the booking site.

The applicable URL can be your travel partner's site URL or a travel agency's booking site URL, depending on how you
access your travel sites.

Booking Site Assignments
Assignment of employees to a booking site on the Create Booking Site page is required only if you select the booking
site-specific URLs option as described in the Booking Site Links section of this topic. When you assign employees to
booking sites, information you enter in Expenses and in travel partner site results in automatic navigation of employees
to the correct booking site when they click Book Travel on the Trips page.

In your travel partner's system, you have set up employees and the travel sites to which they have access. In the Site
Assignments section on the Create Booking Site page, instead of individually assigning employees to sites, you specify
the association based on two parameters, country and employment. Within employment, site assignment of employees
can be set up by job role or job management level.
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The following table contains examples of employee booking site assignments by country, by employment groups, and
by type of employment.

Scenario Assignment by Country Employment Groups to Which
Assignment is Applicable

Assignment by Employment Type

Booking site is accessible to all
employees in the company.
 

All countries
 

All employment
 

Not applicable
 

Booking site is accessible to all
employees in the US.
 

Specific country
 

All employees
 

Not applicable
 

Booking site is accessible to all
senior vice presidents in the
company, except in Australia.
 

All countries with exceptions
 

Specific employment
 

Job management level
 

Note:  Before you can select the Job role or Job management level option in the Site Assignments section on
the Create Booking Site page, you must set up job roles and job management levels in Oracle Human Capital
Management.

Related Topics
• How You Set Up Prerequisites for Travel Partner Integration

• How You Set Up Travel Integration

How You Set Up Travel Integration  
You integrate with your travel partner to improve employee travel booking experience, to provide visibility to travel
actions and patterns, and to facilitate reporting on noncompliant travel. The resulting travel data enables you to make
cost-effective decisions with the travel supplier.

When you enable travel integration, the following actions can occur:

• Itinerary data is received by Expenses from your travel partner and trips are automatically created for valid
itineraries.

• Updates to itineraries are also received by Expenses from your travel partner until the employee takes the trip.

• The travel administrator corrects itineraries with validation errors.

• Employees manage their trips.

• Expense reports are automatically created and appear in the Expenses work area.

• Approvers and auditors can view the difference between booked and actual travel expenses, booking policy
violations, and justifications provided by users.

The following figure illustrates how a deploying company integrates with a travel partner.
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Expenses supports integration with GetThere travel partner. In addition, integration with other travel partners is
supported using REST APIs.

The steps to set up travel integration in Expenses is similar for GetThere and other travel partners but there are some
differences. Here are the required tasks to set up a travel integration:

• Enable Travel Integration

• Assign Travel Administrator

• Configure Travel Partner and Travel Sites

• Only for GetThere, Schedule Import Travel Itinerary Process

• Only for Third-Party Travel Partners, Manage Travel Itineraries
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To improve the quality of travel data and to enhance employees' user experience, you can set up the following optional
tasks:

• Define Itinerary Validation Rules

• Enable Automatic Creation of Trip-Based Expense Reports

Enable Travel Integration
To receive itinerary data from your travel partner, you must enable travel integration. To do this, select Yes for the
Enable Travel option on the Manage Expenses System Options page. You can set this option for all business units or for
specific business units that are enabling travel integration.

In the Setup and Maintenance work area, use the following to navigate to the Manage Expenses System Options page:

• Offering: Financials

• Functional Area: Expenses

• Task: Manage Expenses System Options

Assign Travel Administrator
To monitor imported itineraries, create itineraries using REST APIs, and resolve itinerary data errors, you must have a
travel administrator. To provide the travel administrator with access to the Travel Administration work area, you must
assign him or her the job role of Travel Manager.

In the Setup and Maintenance work area, use the following to navigate to the Manage Users page:

• Offering: Financials

• Functional Area: Users and Security

• Task: Manage Users

Configure Travel Partner and Travel Sites
Your travel partner and its booking sites store the following information about your company's setup:

• Connection information to your travel partner

• Travel sites defined by your company

• Booking site links

• Association of your employees with booking sites.

As a travel administrator, you configure your travel partner and set up booking sites using the Manage Travel Partner
Integrations page.

In the Setup and Maintenance work area, use the following to navigate to the Manage Travel Partner Integrations page:

• Offering: Financials

• Functional Area: Expenses

• Task: Manage Travel Partner Integrations

If your company uses GetThere to book trips, follow these steps to integrate GetThere with Expenses:

1. On the Manage Travel Partner Integrations page, click the Create icon.
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2. On the Create Travel Partner Integration page, select GetThere from the Corporate Online Booking Provider
list.

3. Enter appropriate details in the Customer Account and Contact Person fields.
4. In the Itinerary Import section, enter the connection user name, password, and super site name, which are

provided by your travel partner.
5. Select an itinerary data validation rule.
6. Enter a URL in the Default Booking Site Link field.
7. Click Save and Close.

Here are the steps to configure other third-party travel partners:

1. On the Manage Travel Partner Integrations page, click the Create icon.
2. On the Create Travel Partner Integration page, select Third Party from the Corporate Online Booking

Provider list.
3. Enter appropriate details in the Travel Partner Name and Contact Person fields.
4. In the Itinerary Validation section, select an itinerary data validation rule.
5. Click Save and Close.

Create booking sites for the travel partners as explained in the How You Set Up a Travel Partner and Booking Sites topic.

Only for GetThere, Schedule Import Travel Itineraries Process
To automatically import itineraries into Expenses from GetThere at predefined intervals, you must schedule the Import
Travel Itineraries process. The first run of the process imports itineraries according to the specified import process start
date and time. Subsequent runs import itineraries that are created or updated since the last import. You can schedule
the process to import itineraries for each booking site. The process imports itineraries in both active and ticketed
statuses. A ticketed status means that the travel partner or merchant has issued a ticket to the employee for the trip.
Because the process runs in near real-time, it's advisable to schedule it frequently.

Note:  The Import Travel Itineraries process also imports itineraries that have a status of Canceled. If itineraries were
canceled before importation, they won't have any details. If itineraries are canceled after importation, their status is
updated accordingly.

You can schedule the Import Travel Itineraries process from the Travel Administration work area Tasks pane by clicking
the Import Travel Itineraries link. Navigation: Travel Administration > Import Travel Itineraries > Advanced button >
Schedule tab. Alternately, you can schedule it from the Scheduled Processes work area. Navigation: Navigator > Tools
> Scheduled Processes > Schedule New Process > Job > Name: Import Travel Itineraries.

Only for Third-Party Travel Partners, Manage Travel Itineraries
For third-party travel partners, itineraries are created or modified using REST services. You must have the Travel
Manager role to create or modify itineraries using REST services.

Here are some rules that you need to follow to post travel itineraries to Expenses:

• Only one itinerary at a time must be created or modified using REST services.

• You can post itinerary data at any time from the third-party travel site.

• Your itinerary can have one or more reservations. For example, a single travel itinerary can have air, rail, hotel,
or vehicle rental reservations.

• An itinerary must belong to only one employee.

• The status of an itinerary must be active, ticketed, or canceled.
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Note:  Refer to the Expense Travel Itineraries task in the REST API for Oracle Financials Cloud guide for more
information.

After itineraries are posted, you must run the Validate only process. This process checks the itineraries for violations
and errors. If there are no critical errors, trips are created for the validated itineraries.

You can run or schedule the process to run at predefined intervals from the Travel Administration work area Tasks pane
by clicking the Import Travel Itineraries link. Navigation: Travel Administration > Import Travel Itineraries > Validate
only > Advanced button > Schedule tab.

Optionally, Enable Itinerary Validation Rules
Your reliance on accurate travel data to make strategic, company-wide travel decisions is essential. You can optionally
enable travel itinerary validation rules to be applied when travel itineraries are imported or when validation process is
run on itineraries posted from third-party. An itinerary validation rule identifies data errors so the travel administrator
can correct them. Additionally, you can enable itinerary validation rules if you want expense report approvers and
auditors to view booking policy violations and the associated justifications provided by employees.

Additional setup is required if you choose to enable the following validations for use in creating validation rules:

• Airline class of ticket

• Location

• Merchant

• Policy violation

The following table describes the validations that require additional setup, their validation types, source names, and
high-level setup actions.

Validations Validation Type Source Name High-Level Set Up

Airline class of ticket
 

Lookup
 

EXM_TICKET_CLASS
 

1. Add lookup codes to the
EXM_TICKET_CLASS lookup
type on the Manage Travel
Policy Lookup Types page.

2. Alternatively, you can create
a new class of ticket lookup
type that starts with the prefix
EXM_TRAVEL

In the Setup and Maintenance
work area, use the following to
navigate to the Manage Travel
Policy Lookup Types page.
 

• Offering: Financials

• Task: Manage Travel Policy
Lookup Types

Location
 

Trading Community Architecture
 

Not applicable
 

1. Review geographies on the
TCA Manage Geographies
page.

2. Create a missing geography
hierarchy for all possible city,
 state, and country values for
itinerary reservations.
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Validations Validation Type Source Name High-Level Set Up

In the Setup and Maintenance work
area, use the following to navigate
to the Manage Geographies page:
 

• Offering: Financials

• Task: Manage Geographies

Merchant
 

Table
 

EXM_MERCHANT
 

1. Open the predefined
Merchant Codes spreadsheet
from the Manage Merchant
Codes task in the Travel
Administration work area.

2. Ensure that all merchants for
itinerary reservations appear
in the spreadsheet.

3. Add any needed merchants to
the spreadsheet.

Policy Violation
 

Lookup
 

EXM_POL_VIOLATION_TYPES
 

1. Add lookup codes to the
EXM_POL_VIOLATION _
TYPES lookup type on the
Manage Travel Policy Lookup
Types page.

2. Alternatively, you can create
a new booking policy lookup
type that starts with the prefix
EXM_TRAVEL.

In the Setup and Maintenance
work area, use the following to
navigate to the Manage Travel
Policy Lookup Types page:
 

• Offering: Financials

• Task: Manage Travel Policy
Lookup Types

You can assign itinerary validation rules to your travel partner or to its booking sites. Creation and assignment of the
validation rules occurs on the Create Travel Itinerary Validation Rules page. Navigation: Navigator > My Information >
Expenses > Travel Administration > Manage Travel Itinerary Validation Rules task > Create icon > Create Travel
Itinerary Validation Rules page. Alternatively, you can access the Manage Travel Itinerary Validation Rules page from
the Setup and Maintenance work area.
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Optionally, Enable Automatic Creation of Trip-Based Expense Reports
You can optionally enable automatic creation of expense reports based on trips. Automatic creation of reports simplifies
and expedites expense entry for employees. To do this, you can take the following steps:

1. Select Yes for the Enable Automatic Travel Expense Report Creation option on the Manage Expenses System
Options page. When travel is enabled, the default value for this option is Yes. You can set this option for all
business units or for specific business units.

In the Setup and Maintenance work area, use the following to navigate to the Manage Expenses System
Options page:

◦ Offering: Financials

◦ Task: Manage Expenses System Options

2. Schedule the Processes Trip Expense Report process to automatically create expense reports from trips. This
process creates expense reports from corporate card transactions that match those transacted over the trip's
duration. The timing of the expense report creation is based on each employee's preference as specified on the
Expenses Preferences page. Navigation: Navigator > Tools > Scheduled Processes > Schedule New Process >
Job > Name: Processes Trip Expense Report.

When automatic creation of expense reports is enabled, employees can choose to generate expense reports upon
completion of their trips or when they receive the first corporate card transaction. Employees can also choose to
manually initiate creation of expense reports.

Related Topics
• Automatic Trip Expense Reports

• How You Set Up Travel Itinerary Validation Rules

How You Set Up Travel Itinerary Validation Rules  
Your reliance on accurate travel data to make strategic, company-wide travel decisions is essential.

To improve the accuracy of travel data and to provide visibility of policy violations to approvers and auditors, you can
enable validations that act on itineraries when you import them or run validation process.

You can setup itinerary validation rules on the Manage Travel Itinerary Validation Rules page. You can enforce them by
assigning them to a travel partner or to a specific booking site.

The application executes two types of itinerary validation rules:

• Validations that always occur

• Validations that you can enable

Validations That Always Occur for GetThere
The Import Travel Itineraries process has validations that identify:

• Invalid itineraries to reject
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• Itineraries with critical validation errors

Itineraries that are rejected and didn't import are displayed in the Itinerary Import Failures dialog box by clicking on
the nonzero value of the Itinerary Import Failures count for a process shown in the Travel Itinerary Import Requests table
in the Travel Administration work area. They can have any of the following errors:

• The itinerary status is Null.

• The last modified time stamp on the itinerary is null or is an invalid format.

• The itinerary has an Invalid reservation, where the reservation confirmation number is null.

• An unexpected error occurs while attempting to import the details for an itinerary.

Note:  Validations that always occur don't require any setup.

Trips aren't created for itineraries that failed import and you can't access their details for correction. The Import Travel
Itineraries process attempts to reimport failed itineraries for the number of days past the initial failed import specified
by the process parameter.

Validations That Always Occur for Third-Party Travel Partners
As a travel administrator, you post travel itinerary data from the third-party travel site in the specified format using REST
services. Itineraries aren't created or updated in these conditions:

• A required field isn't available.

• A field doesn't follow its defined data format or length restrictions.

• A field doesn't follow its validation rules.

• If duplicate records are posted.

Itineraries are rejected if value for any of these data fields is missing or invalid:

Segment Data Field

Itinerary
 

Travel Partner Trip Number
 

Itinerary
 

Itinerary Record Locator
 

Itinerary
 

Travel Partner Name
 

Itinerary
 

Booking Site Name
 

Itinerary
 

First Name
 

Itinerary
 

Last Name
 

Itinerary
 

Booking Date Time
 

Itinerary Status Code
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Segment Data Field

  

Reservation
 

Reservation Type
 

Reservation
 

Currency Code
 

Reservation
 

Amount
 

Air
 

Item Confirmation Number
 

Air
 

Departure Date Time
 

Air
 

Departure City
 

Air
 

Arrival Date Time
 

Air
 

Arrival City
 

Rail
 

Item Confirmation Number
 

Rail
 

Departure Location Name
 

Rail
 

Departure Date Time
 

Rail
 

Departure City
 

Rail
 

Arrival Location Name
 

Rail
 

Arrival Date Time
 

Rail
 

Arrival City
 

Hotel
 

Confirmation Number
 

Hotel
 

Start Date Time
 

Hotel
 

End Date Time
 

Hotel
 

Base Rate
 

Hotel
 

Hotel City
 

Vehicle Rental Confirmation Number
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Segment Data Field

  

Vehicle Rental
 

Start Date Time
 

Vehicle Rental
 

End Date Time
 

Vehicle Rental
 

Pickup City
 

Vehicle Rental
 

Return City
 

Itineraries are rejected and errors are displayed when these validations fail:

Segment Data Field Validation

Itinerary
 

Travel Partner Name
 

The travel partner name in the itinerary must
match the assigned travel partner name.
 

Itinerary
 

Booking Site Name
 

The booking site name in the itinerary must
match the booking site names created for the
travel partner.
 

Itinerary
 

First Name
 

The first and last names mentioned in the
itinerary must be present in the existing
employee records.
 

Itinerary
 

Last Name
 

The first and last names mentioned in the
itinerary must be present in the existing
employee records.
 

Itinerary
 

Employee Number
 

The employee number, first name, and last
name must match in the existing employee
records.
 

Itinerary
 

Booking Date Time
 

The time stamp on the new record of an
itinerary, which is posted or patched, must be
later than the booking date time of the existing
record for the same itinerary
 

Itinerary
 

Status Code
 

The status code in the itinerary must match the
expected status codes, such as active, ticketed,
 or canceled.
 

Reservation
 

Reservation Type
 

The reservation type in the itinerary must
match the expected reservation types, such as
air, rail, hotel, or vehicle rental.
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Some validations are performed when itineraries are posted or patched using REST services. If any error is found, the
itinerary is rejected and you need to resolve the errors and send the itinerary again.

For successfully posted itineraries, you must run the validate process to create corresponding trips. If any validation
errors are found, you need to fix them from the Travel Administrator work area and run the validations again.

Fixing Validation Errors
Itineraries with critical validation errors that require you to fix them before a trip can be created include those with:

• Missing or unmatched employee numbers

• Missing pricing information, such as amount and currency, for one or more reservations

• An unexpected error while validating an itinerary

You can fix itineraries with critical validation errors in the Review Travel Itinerary Import Results page. Clicking the
nonzero value of the Critical Validation Errors count for a process shown in the Travel Itinerary Import Requests table in
the Travel Administration work area, navigates you to the Review Travel Itinerary Import Results page displaying those
errors.

Trips are also not created for itineraries with critical validation errors. For itineraries created with GetThere, the Import
Travel Itineraries process continues to revalidate all itineraries with validation errors and create a trip for itineraries once
critical validation errors are fixed. Similarly, validations for itineraries created by third-party travel partner ensure that
trips are created only after the critical validation errors are fixed.

Validations That You Can Enable
To enhance the quality of trip data, you can enable a set of itinerary validations. The following itinerary validations
require additional setup as described:

• Policy violation validations

• Merchant validation

• Location validation

• Ticket's air class validation

• Currency code and amount

• Date and time

• Flight or train number

The following table describes the validations that you can enable with their associated setup steps.

Validation Steps to Enable Validations

Policy violation validations
 

The Import Travel Itineraries process and validation process validate policy violations provided by
your travel partner against the policy violations specified as the source lookup assigned to the policy
violation validation rules on the Manage Travel Itinerary Validation Rules page.
 

1. In the Setup and Maintenance work area, use the following to navigate to the Manage Travel
Policy Lookup Types page.:

◦ Offering: Financials

◦ Task: Manage Travel Policy Lookup Types
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2. Navigate as follows: Setup and Maintenance > Manage Travel Policy Lookup Types task > Go
to Task icon > Manage Travel Policy Lookup Types page.

3. Configure the lookup codes in the EXM_POL_VIOLATION_TYPES lookup type to include the
violations provided by your travel partner or create a new EXM lookup type and codes for booking
violations.

4. Define the lookup code meaning to match the policy violation meaning provided by your travel
partner.

If you receive policy violations in languages other than your base language, you must set up language-
specific text for the lookup code meaning to support policy violations in different languages.
 
For example, your company has two booking sites, US and France. Your travel partner provides policy
violations in the regional language, which is French. Both booking sites enforce a policy violation if
the lowest fare isn't selected. If an employee doesn't select the lowest fare, he must justify the policy
violation using the following reason: Needed a direct flight due to time constraints.
 
To enforce the lowest fare policy for itineraries from both sites during itinerary import or itinerary
validation, you must define the policy violation message as the meaning in English, as well as in
French.
 
Itineraries with policy violations that don't exist in the application are tagged as an Unmatched Value
validation error.
 

Merchant validation
 

1. To add missing merchant codes to merchant reference data, navigate to the Travel Administration
work area.

2. Click the Manage Merchants Codes link.
3. Download the spreadsheet, add new merchants, and upload.

Itineraries with merchants that don't exist in the application are tagged as an Unmatched Value
validation error.
 

Location validation
 

A location validation is performed against the geography data stored centrally in the Oracle Fusion
Applications Trading Community Architecture.
 

1. To add or change a missing location to reference data, first review the values in the Review Travel
Itinerary Import Results page.

2. Define missing locations in Oracle Fusion Trading Community Architecture.

In the Setup and Maintenance work area, use the following to navigate to the Manage
Geographies page:

◦ Offering: Financials

◦ Task: Manage Geographies

Itineraries with locations that don't exist in the application are tagged as an Unmatched Value
validation error.
 

Ticket's air class validation
 

Validation of a ticket's air class is performed against the EXM_TICKET_CLASS lookup type. You can
configure the lookup type to add new classes of air tickets.
 

1. To add a missing ticket's air class to reference data, first review the values in the Review Travel
Itinerary Import Results page.

2. In the Setup and Maintenance work area, use the following to navigate to the Manage Travel
Policy Lookup Types page.

◦ Offering: Financials

◦ Task: Manage Travel Policy Lookup Types

3. To add a missing ticket's air class to reference data, create a new lookup code for the lookup EXM_
AIR_CLASS_OF_TICKETS and define the same meaning provided by your travel partner.
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4. If you use a company-defined lookup code for the ticket's air class validation, add the new code in
this lookup.

Itineraries with air ticket classes that don't exist in the application are tagged as an Unmatched Value
validation error.
 

Currency code and amount
 

Setup isn't required. The currencies from Oracle Fusion General Ledger are used for validation.
 

Date and time
 

Setup isn't required. This is a standard date and time validation.
 

Flight or train number
 

Setup isn't required. The application validates that the flight or train number is present.
 

Note:   For itineraries that fail the validations that you can enable, the application creates trips. The travel
administrator can correct the validation errors and the itineraries as needed.

How You Resolve Travel Itinerary Import and Validation
Issues  
You run the Import Travel Itineraries process to import and validate travel itineraries from the GetThere travel partner
into Oracle Fusion Expenses. Similarly, you run the Validate only process to review the travel itineraries posted from
other third-party travel partners.

When you run these processes, the following results may occur:

• The process completes with an error.

• The process completes with a warning or success but doesn't import any itineraries.

• The process completes with a warning.

Process Completes with an Error
Here are some conditions when the Import Travel Itineraries process completes with an error:

• It can't establish a connection with your GetThere travel partner.

• It encounters an unexpected error.

• The GetThere portal or booking site is unavailable.

To identify the error, review the log and output details of the Import Travel Itineraries process by performing the
following steps:

1. Navigate to the Travel Administrator work area.
2. Select the applicable process.
3. From the Action menu, select View Process Details.
4. In the View Process Details dialog box, click the log .txt file.
5. In the View Output Parameters column, click the output file.
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Verify that the travel partner integration values described in the following table are set up correctly on the Edit Travel
Partner Integration page for GetThere. Follow these steps to navigate to the page:

1. In the Setup and Maintenance work area, use the following to navigate to the Manage Travel Partner
Integrations page.

◦ Offering: Financials

◦ Functional Area: Expenses

◦ Task: Manage Travel Partner Integrations

2. On the Manage Travel Partner Integrations page, select the link for GetThere travel partner.

The Edit Travel Partner Integration page for GetThere is displayed.

Invalid Value Log File Error Page

Connection User Name and Password
 

CreateSesssionWS failed with authentication
error.
 

Edit Travel Partner Integration page for
GetThere
 

Super Site Name
 

CreateSesssionWS failed with authentication
error.
 

Edit Travel Partner Integration page for
GetThere
 

Create Session Web Service Definition
Language (WSDL) location
 

CreateSessionWS failed with
InaccessibleWSDLException.
 
An error occurs only when the travel partner
asks you to change a WSDL location and you
enter it incorrectly.
 

Edit Travel Partner Integration page for
GetThere
 

Retrieve Itinerary Locator WSDL location
 

RetrieveItinLocatorWS failed with
InaccessibleWSDLException
 
An error occurs only when the travel partner
asks you to change a WSDL location and you
enter it incorrectly.
 

Edit Travel Partner Integration page for
GetThere
 

Retrieve Itinerary Details WSDL location
 

RetrieveItinDetailWS failed with
InaccessibleWSDLException
 
An error occurs only when the travel partner
asks you to change a WSDL location and you
enter it incorrectly.
 

Edit Travel Partner Integration page for
GetThere
 

Note:  If you see a log file that indicates that the EndSessionWS failed with InaccessibleWSDLException, the Import
Travel Itineraries process won't result in an error even if the End Session WSDL location was updated incorrectly.
These atypical sessions are removed by your travel partner eventually.

If you want to reset the entries in the WSDL fields to the original values, the following table describes the original WSDL
locations.
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Web Service Name Web Service URL

Create Session
 

https://files.developer.sabre.com/wsdl/sabreXML1.0.00/usg/SessionCreateRQ.wsdl
 

Note:  To download all the necessary files, you can use: https://files.developer.sabre.com/drc/
providerdoc/usg/SessionCreateRQ.zip

 

Retrieve Itinerary Locator
 

https://files.developer.sabre.com/wsdl/sabreXML1.0.00/GetThere/
GT_ERP_TravelItineraryLocatorRead1.0.0RQ.wsdl
 

Note:  To download all the necessary files, you can use: https://files.developer.sabre.com/drc/
providerdoc/GetThere/GT_ERP_TravelItineraryLocatorRead1.0.0RQ.zip

Retrieve Itinerary Details
 

https://files.developer.sabre.com/wsdl/sabreXML1.0.00/GetThere/
GT_ERP_TravelItineraryRead1.0.0RQ.wsdl
 

Note:  To download all the necessary files, you can use: https://files.developer.sabre.com/drc/
providerdoc/GetThere/GT_ERP_TravelItineraryRead1.0.0RQ.zip

 

End Session
 

https://files.developer.sabre.com/wsdl/sabreXML1.0.00/usg/SessionCloseRQ.wsdl
 

Note:  To download all the necessary files, you can use: https://files.developer.sabre.com/drc/
providerdoc/usg/SessionCloseRQ.zip

 

Tip:  If web service connection issues persist after ruling out set up issues, contact your travel partner's administrator
or your support representative to validate WSDL locations or to determine whether the travel partner's portal or
booking site is down. For other unexpected errors, contact Oracle Support.

Process Completes with a Warning or Success But Doesn't Import
Itineraries
To review warnings, review the log and output details of the Import Travel Itineraries process by performing the steps
mentioned in the previous section of this topic.

The following table describes the results when the Import Travel Itineraries process completes with a warning or a
success but doesn't import any itineraries from GetThere travel partner.

Invalid Value Result Page

Site Identifier
 

• No errors in the log file.

• The count for new itineraries imported is
zero in the output file.

Create Booking Site dialog box
 
Here are the steps to navigate to the Create
Booking Site dialog box:
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Invalid Value Result Page

• The Import Travel Itineraries process
completes with a warning or success.

1. In the Setup and Maintenance work area,
 use the following to navigate to the
Manage Travel Partner Integrations page.

◦ Offering: Financials

◦ Functional Area: Expenses

◦ Task: Manage Travel Partner Integrations

2. On the Manage Travel Partner Integrations
page, select the link for GetThere travel
partner to open the Edit Travel Partner
Integrations page for GetThere.

3. In the Booking Sites section, click the
Create icon.

Process Completes with a Warning
Here are some conditions when the Import Travel Itineraries process or the Validation only process completes with a
warning:

• Itineraries fail importation

• Itineraries have critical validation errors

• Itineraries have invalid data

• Itineraries have unmatched values

To review warnings, review the log and output details of the Import Travel Itineraries or Validation only process by
performing the steps mentioned in the previous section of this topic.

The following table describes the cause and resolution for itinerary import failures.

Log Error Message Cause Resolution

The itinerary couldn't be imported because it's
missing a value in the Status attribute.
 

• The itinerary status is null. 1. Review the import failure message in the
Itinerary Import Failures dialog box.

2. The Import Travel Itineraries process
automatically reattempts to import failed
itineraries for a specified number of user-
defined days.

3. If itineraries continue to fail, contact your
travel partner's representative to resolve
issues.

The itinerary can't be brought in Expenses
because the time stamp that indicates whether
or not the itinerary has been modified is invalid.
 

The last modified time stamp on the itinerary is
null.
 

1. Review the import failure message in the
Itinerary Import Failures dialog box.

2. For GetThere, the Import Travel Itineraries
process automatically reattempts to
import failed itineraries for a specified
number of user-defined days

For other third-party travel partners, you
need to post the itineraries again with the
correct time stamps.
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3. If itineraries continue to fail, contact your
travel partner's representative to resolve
issues.

Missing message text.
 
The itinerary can't be imported because it
contains a reservation, which wasn't reserved
and is missing a confirmation number.
 

Itinerary has a reservation confirmation number
that's null.
 

1. Review the import failure message in
the Itinerary Import Failures dialog box.
The Import Travel Itineraries process
automatically reattempts to import failed
itineraries for a specified number of user-
defined days.

2. If itineraries continue to fail, contact your
travel partner's representative to resolve
issues.

This itinerary can't be imported because the
following error was returned by the itinerary
details web service: {ERROR}.
 

An unexpected error occurs while attempting to
import the details for an itinerary.
 
The Import Travel Itineraries process continues
to import itineraries, even if it encounters an
unexpected error with a specific itinerary.
 

1. Review the import failure message on the
Itinerary Import Failures dialog box.

2.
The Import Travel Itineraries process
automatically reattempts to import failed
itineraries for a specified number of user-
defined days.

3. If itineraries continue to fail, contact
Oracle Support.

Your request can't be completed at this time.
Verify your request and try again.
 

Itinerary details can't be retrieved since the
itinerary has multiple travelers.
 

1. Review the import failure message on the
Itinerary Import Failures dialog box.

2. The Import Travel Itineraries process
automatically reattempts to import failed
itineraries for a specified number of user-
defined days.

3. Your travel partner doesn't support
itineraries booked for multiple travelers.

Errors due to a validation failure are resolved by travel administrators. The following table contains the error, cause, and
resolution of critical validation errors.

Validation Error Cause Resolution

Invalid employee number:
 

• The employee number is null.

• The employee number doesn't match
the employee number in Oracle Fusion
Human Capital Management.

• The employee's user profile in your
travel partner's site has a null or invalid
employee number.

• The employee number isn't sent from your
travel partner.

• The traveler is an applicant and not an
employee.

1. Correct the user profile in your travel
partner's site.

2. From the Travel Administration work area,
 navigate to the Resolve Travel Itinerary
Import Errors page.

3. Assign the correct employee to the
itinerary.

Missing reservation pricing information
 

• Your travel partner booking site allows
employees to book a split flight across two
airlines in which pricing is unavailable.

1. Contact your corporate travel agency to
update the missing pricing information.

2. From the Travel Administration work area,
 open the Review Travel Itinerary Import
Results page to update the missing pricing
information for that itinerary.

3. To eliminate errors in the future, consider
a configuration change at the travel
booking site to prevent booking without
pricing information.
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Validation Error Cause Resolution

Unexpected error
 

• The application encountered an
unexpected error while validating an
itinerary.

• The Import Travel Itineraries process
continues to import itineraries, even if it
encounters an unexpected error with a
specific itinerary.

Review the Import Travel Itineraries process log
file by performing the following steps:
 

1. Navigate to the Travel Administrator work
area.

2. Select the applicable process.
3. From the Action menu, select View

Process Details.
4. In the View Process Details dialog box,

 click the log .txt file.
5. If you can't diagnose the error, contact

Oracle Support.

Note:  After itinerary import failures and critical validation errors are resolved, rerun the Import Travel Itineraries
process in the Validate only process mode to remove errors so a trip can be automatically created from the itinerary.

The following table describes the validation error, cause, and resolution of invalid data validation errors.

Validation Error Cause Resolution

Invalid data
 

• Missing data

• Invalid data format

1. From the Travel Administration work area,
 open the Review Travel Itinerary Import
Results page.

2. For GetThere, correct the errors and
rerun the Import Travel Itineraries process
to revalidate the errors or wait for the
next scheduled Import Travel Itineraries
process to revalidate.

For other third-party travel partners,
correct the errors or post the itineraries
again. Then, revalidate the itineraries.

3. Contact your travel partner and take steps
to prevent future errors.

The following table describes the validation error type, cause, and resolution of unmatched value validation errors.

Validation Error Cause Resolution

Unmatched values for policy violation.
 

Missing booking policy violation mapping
 

1. Review the values on the Review Travel
Itinerary Import Results page and select
the correct policy violation.

2. To add missing booking policy violation
mapping to reference data, create a new
lookup code for the lookup EXM_POL_
VIOLATIONS_TYPES and define the
meaning with the booking policy violation
text.

3. To enforce booking policy violation
validation for booking sites set up in a
foreign language, define the booking
policy violation as the lookup code
meaning for the foreign language.
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Validation Error Cause Resolution

4. If you use a company-defined lookup type
for policy violation validation, add the new
policy violations as lookup codes for this
company-defined lookup type.

5. If a lookup code for the missing booking
policy violation already exists, ensure
that the lookup code meaning is defined
exactly as the booking policy violation
that's provided by your travel partner.

Unmatched value for airline, hotel, rail, car
rental code, or name.
 

Missing merchant codes
 

1. Review the values in the Review Travel
Itinerary Import Results page and select
the correct merchant code.

2. To add missing merchant codes to
merchant reference data, navigate to the
Travel Administration work area.

3. Click the Manage Merchants link.
4. Download the spreadsheet, add new

merchants, and upload.

Unmatched value for class of ticket for air
reservation
 

Missing class of air ticket
 

1. Review the values in the Review Travel
Itinerary Import Results page and select
the correct air ticket class.

2. To add a missing class of air ticket to
reference data, create a new lookup code
for the lookup type EXM_TICKET_CLASS
and define the meaning with the class of
air ticket.

3. To enforce class of air ticket validation for
booking sites setup in a foreign language,
 define the class of air ticket as the lookup
code meaning for the foreign language.

4. If you use a company-defined lookup type
for class of air ticket validation, add the
new class of air ticket as lookup codes for
this company-defined lookup type.

5. If a lookup code for the missing class of
air ticket already exists, ensure that the
lookup code meaning is defined exactly
as the class of air ticket provided by your
travel partner.

Unmatched value for location.
 

Missing location
 

1. Review the values in the Review Travel
Itinerary Import Results page and select
the correct location.

2. To add a missing location to reference
data, define missing locations in Oracle
Fusion Trading Community Architecture
that map to the city, state, and country
values sent by your travel partner.

Navigation: Setup and Maintenance
work area > Manage Geographies task >
Manage Geographies page.

Related Topics
• How You Set Up Travel Itinerary Validation Rules
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Manage Trip Expense Reports  
This worked example shows you how to manage trip information in Oracle Expenses and in the corporate travel partner
site.

This example uses GetThere as the corporate travel partner. The example also demonstrates how to automatically
create an expense report from a trip.

It covers the following tasks:

• Explore the Trips tab

• Sign into the travel partner site

• Review booked trips in the travel partner site

• Review booked trips in Expenses

• Consolidate bookings

• Create an expense report from a trip

Explore the Trips Tab
To explore the Trips tab, complete these steps:

1. On the Home page, click Me > Expenses.
2. In the Travel and Expenses work area, click the Trips tab.

The Trips tab displays details of your booked trips. By default, Expenses creates a name for each trip, but you
can change it. You can also see the start and end dates of your trip, the type of reservations booked, and the
total amount.

Note:  The Trips tab is visible only when travel is enabled for your business unit.

Sign into the Travel Partner Site
You sign into the travel partner site to book travel or review the previous bookings. This example uses GetThere as the
travel partner. To sign into GetThere, complete these steps:

1. In the Trips tab, click Book Travel.
The GetThere travel site opens in a new browser tab.

2. On the GetThere login page, enter your user name and password.
3. Click Log in.

Review Booked Trips in the Travel Partner Site
After signing into the travel partner site, you can immediately book travel or review previous bookings.

To review booked trips in GetThere, complete these tasks:

1. Click the Book Travel tab to book new travel.
2. Click the Manage Trips tab to display previously booked trips.
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Review Booked Trips in Expenses
To review booked trips in Expenses, complete these steps:

1. Click the Travel and Expenses browser tab and return to the Trips tab.

The updated itineraries are displayed in Expenses after your Travel Administrator runs the process to import or
validate bookings from the corporate travel partner.

2. After the itineraries are available in Expenses, you can view them in the Trips tab.
3. To review the details of a trip, click the trip.

The Edit Trip page appears. The itinerary details are the same reservations that were booked in the travel
partner site. If you want to make changes to your trip, make them in travel partner site. The updated itinerary is
fetched from the travel partner again.

Consolidate Bookings
Employees don't always book their airfare, accommodations, and car rental at the same time. To consolidate separately
booked reservations into one, complete these steps:

1. On the Edit Trip page, click Add Travel Item to Trip.
2. Select a booking that you want to add to the trip.
3. Repeat Steps 1 and 2 for additional separate bookings.

Create an Expense Report from a Trip
After you take a trip, you can automatically create an expense report from the trip. The trip expense report selects all
eligible corporate card transactions within the date range of the trip. If corporate cards aren't used by employees, the
trip expense report creates cash expense lines for dates and amounts found in the itinerary.

To create an expense report from a trip, complete this step:

1. On the Edit Trip page, click Create Report from Trip.

Submit the Expense Report
On the Create Expense Report page, you can see the expense report that was created from the trip. For each expense,
you can see all the details.

1. To indicate that you have read and accept the travel and expense policies, click the I have read and accept the
corporate travel and expense policies check box.

2. To submit the expense report, click Submit.
3. In the Warning message regarding missing receipts, click Yes.

Although you have missing receipts, you can still submit the expense report now and attach or email the
missing receipts later.

4. In the Confirmation message, click OK.
5. Click Cancel to return to the Travel and Expenses work area.

Now you can see the trip expense report you created.
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Automatic Trip Expense Reports  
Your company can choose whether to automatically or manually create expense reports from business trips. A business
trip is a collection of items that make up an employee's business travel.

For example, a trip may include a travel itinerary and a cash advance. The contents of an automatic trip expense report
is based on whether an employee was issued a corporate card or uses cash only. The application automatically creates a
trip expense report if the employee selects the application to initiate report creation on the Expenses Preferences page.

If an employee was issued a corporate card, the automatic trip expense report contains corporate card transactions.
Expenses attempts to match the travel itinerary reservation with a corporate card transaction.

If an employee doesn't have a corporate card, the automatic trip expense report process creates a report with cash
expense items that correspond to each travel reservation item. Other nontravel cash expenses generated by the
employee aren't included in this trip expense report.

Generate Trip Expense Reports When Matching Card Transactions Are
Unavailable
You can configure the application to allow expense report creation from trips for corporate card employees, even if the
corporate card charges from the trip aren't available in Expenses work area.

For example, an employee booked a business trip using a centrally billed card. When the application creates corporate
card transactions in Expenses from the feed files, these card transactions of the trip will not be available in the
employee's Expenses work area.

You can configure the application to allow expense report creation from trips for these bookings. When you set the
value of Enable Report Creation for Users Before Card Charges Appear to Yes, the application creates a trip expense
report, even if the corporate card charges from the trip aren't available in the Expenses work area when initiated. The
default setting is No.

The application uses available data from the trip and creates the trip expense report. When creating an expense report
from the trip, the application checks for any matching card charges for the reservation:

• If there are matching card charges, the application creates an expense report with these card charges. In this
case, employees can’t update the expense amount.

• If there are no matching card charges, the application creates cash expense lines for the reservation and adds
them to the report. The application marks the cash expense lines as prepaid when the reservations are marked
as prepaid on the itinerary. Employees can modify the expense data, such as prepaid flag, amounts, and so on,
if needed.

To automate expense reports based on trips, the following people perform these setup tasks:

• The system administrator chooses to automate trip expense reports.

• The system administrator chooses to generate trip expense reports even if the matching card transaction data
isn’t available for the corporate card users in the Expenses work area.

• Each employee selects the timing of the automatic trip expense reports.
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Allow Automatic Trip Expense Reports
If your company chooses to automate expense reports from trips, your implementor selects Yes from the Enable
Expense Report Automatic Creation choice list in the Processing Options for Expense Report section on the Manage
System Options page.

In the Setup and Maintenance work area, use the following to navigate to the Manage System Options page:

• Offering: Financials

• Functional Area: Expenses

• Task: Manage Expenses System Options

Allow to Create Trip Expense Reports When Matching Card Transactions
Are Unavailable
To create expense reports from trips for corporate card employees, even if the card charges from the trip aren't available
in Expenses, complete these steps:

1. Sign in as an Application Implementation Consultant.
2. In the Setup and Maintenance work area, use the following:

◦ Offering: Financials

◦ Functional Area: Expenses

◦ Task: Manage Expenses System Options

3. On the Manage Expenses System Options page, in the Processing Options for Expense Report section, set
Enable Report Creation for Users Before Card Charges Appear to Yes.

Note:  You can set the value of Enable Report Creation for Users Before Card Charges Appear to Yes only
when the Enable Automatic Travel Expense Report Creation is set to Yes.

4. Click Save or Save and Close.

You can enable this at the implementation level on the Manage Expenses System Options page, which applies to all
business units. Alternatively, you can enable this for specific business units on the Create/Edit Business Unit window in
Corporate Options for Expense Report tab.

Select Timing of Automatic Trip Expense Reports
Once your implementor chooses to automate expense reports from business trips, employees can then select whether
they want themselves or Expenses to initiate automatic trip expense reports. Employees specify their preference by
selecting an option in the Expense Report Automatically Created from Trip section. Navigation: User's name choice list
> Set Preferences > Expenses Preferences

The following table describes the timing of the initiation options.

Initiation Option Description

Employee initiates
 

Employee selects a trip on the Trips page in the Expenses work area and clicks Create Report from Trip
or navigates to the Edit Travel Itinerary page.
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Initiation Option Description

Application initiates upon first expenditure
 

This option is the default value. The process, Process Trip Expense Report, automatically creates an
expense report when the first corporate card transaction related to a trip is uploaded to Expenses.
 
When the process is subsequently run, the expense report is updated with any new corporate card
transactions that are related to the trip.
 
If a new expense report is needed, the application creates one. For example, the application generated
one expense report, which was submitted for approvals. Any remaining transactions are added to a
new trip expense report.
 

Application initiates upon trip completion
 

The process, Process Trip Expense Report, automatically creates an expense report when a trip is
completed that contains corporate card transactions that are related to the completed trip.
 
When the process is subsequently run, the expense report is updated with any new corporate card
transactions that are related to the trip.
 
If a new expense report is needed, the application creates one. For example, the application generated
one expense report, which was submitted for approvals. Any remaining transactions are added to a
new trip expense report.
 

Tip:  Mobile device users who download corporate card transactions and submit them from their mobile devices are
advised to select the Employee initiates option.

Add Filters to Trip Age Filter
Using the View filter you can filter trips by status and trip age. Trip Age filter provides the following default values: Any,
Less than 30 days, Less than 60 days, and Less than 90 days. You can add filters to the Trip Age Filter if required.

To add a filter to the Trip Age Filter, perform the following steps.

1. In the Setup and Maintenance work area, go to the following:

◦ Offering: Financials

◦ Functional Area: Expenses

◦ Task: Manage Travel Policy Lookup Types

2. On the Manage Travel Policy Lookup Types page, in Search section, enter ORA_EXM_TRIP_AGE_FILTER in
the Lookup Type field and click Search.

3. In the ORA_EXM_TRIP_AGE_FILTER: Lookup Codes section, click the New (+) icon to add lookup codes.
4. In the Lookup Code field, enter TRIP_AGE_LESS_THAN_xx, where xx indicates the number of days, for

example. TRIP_AGE_LESS_THAN_45, and TRIP_AGE_LESS_THAN_120.
5. In the Meaning field, enter the description of the filter.
6. Click Save or Save and Close.
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FAQs for Travel  

How Do I Create Prepaid Cash Expenses for Prepaid Reservations?
 

You can create prepaid reservations in Expenses using the Create a travel itinerary reservation API by setting the Prepaid
Flag parameter to 'Y' in the reservation payload. When the application generates an expense report from the trip data,
the application will automatically create prepaid cash expenses for the prepaid reservations, if the expense type has
prepaid expenses enabled.
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5  Cash Advances

Set Up Approval Rules for Delegated Cash Advance  
Oracle Fusion Expenses enables you to delegate cash advance entry to another person on your behalf. In the delegated
cash advance process, the cash advance owner needs to approve the cash advance request after the delegated user
enters the request.

Then, the request is sent for manager's approval.

If you're an existing customer, the cash advance request is sent for manager's approval directly after the delegated user
enters the request. In this case, the cash advance owner need not approve the cash advance request.

However, you can modify the process and add the cash advance owner approval stage to the process.

Here are the steps to add the cash advance owner approval stage to the delegated cash advance process.

1. Navigate to the Oracle BPM Worklist application.
2. From the Settings and Actions menu, select Administration. The Administration tab appears.
3. Click the Task Configuration tab.
4. In the Tasks to be configured pane, select the FinExmWorkflowCashAdvanceApproval task.
5. Before you make changes to the workflow, verify these settings:

a. Click the Assignees tab and verify that the value of the Reviewers field is set as
ReviewersForDelegation.

b. Click the Go to rule icon in the Cash Advance Approval stage and verify that the
CashAdvanceOwnerApprovalRule rule file appears in the rule sets list.

c. Click Notifications tab and verify that REVIEWERS is assigned as the recipient of the Complete task
status.

6. Go back to the Assignees tab.
7. To modify the workflow, click the Edit icon in the Tasks to be configured pane.
8. Here is how you add a stage to the workflow:

a. Click the Edit icon in the first step of the workflow.
b. Select Add Stage > Add Sequential Stage. A new stage is added to the workflow after the first stage.

9. Here is how you edit the first stage:
a. Enter SoaOLabel.CashAdvanceOwner as the participant name.
b. Select Rule-based for the Assignees based on field.
c. Click the Edit icon for Business rule, enter CashAdvanceOwnerApprovalRule as the business rule, and

then click Create Rule.
d. Select Advanced.
e. Select the Specify skip rule check box and enter string-length(/task:task/task:payload/

task:SubmitterUserName)=0 in the field. This edits the rule to skip this participant if cash advance
submitter is the owner.

f. In the Tasks to be configured pane, click Save.
10. Here is how you edit the second stage:

a. Enter SoaOLabel.CashAdvanceApprover as the participant name.
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b. Select Rule-based for the Assignees based on field.
c. Enter CashAdvanceApprovalRuleSet as the business rule, and then click Create Rule.
d. In the Tasks to be configured pane, click Save.

11. Here is how you edit the CashAdvanceApprovalRuleSet rule file:
a. Click the Go to rule icon in the second stage.
b. Select the CashAdvanceApprovalRuleSet rule file.
c. Set the value of the Starting Participant field to

HierarchyBuilder.getManager("supervisory",Task.payload.ownerUserName,-1,"","").
d. In the Tasks to be configured pane, click Save.

12. To commit the modified rule set, click the Commit task icon in the Tasks to be configured pane.

Set Up Manual Application of Cash Advances  
You can set up manual application of cash advances on the Manage Cash Advance and Authorization Policies page,
which applies for all business units or specific business units.

Note:  If cash advances are disabled for a specific business unit, the application uses the method of application that's
defined for all business units. For example, if you’ve disabled the Enable Advances option for your business unit, but
it's enabled for all business units with the Methods of Applying Advances option set to Automatically Apply, any
available cash advances are automatically applied when the reports are processed.

To set up manual application of cash advances, follow these steps:

1. Log in as Expense Manager or Application Implementation Consultant
2. In the Setup and Maintenance work area, select:

a. Offering: Financials
b. Functional Area: Expenses
c. Task: Manage Cash Advance and Authorization Policies

3. Click the Manage Cash Advance and Authorization Policies link.
4. To enable manual application of cash advances for all business units, follow these steps:

a. In the All Business Units work area, select Manually Apply in the Methods of Applying Advances field.
b. Click Save and Close.

5. To enable manual application of cash advances for specific business units, follow these steps:
a. In the Specific Business Units work area, a list of business units is displayed.
b. You can create a new business unit or edit the business unit for which you want to enable the manual

cash advances.
c. In the Methods of Applying Advances field, select Manually Apply.
d. Click Save and Close.

Note:  For expense reports that are submitted using REST APIs, cash advances will be applied automatically
even if manual cash advance application is enabled for the business unit.

What happens when the method of applying cash advances is switched
This table describes what an employee, approver or auditor would see when the method of applying cash advances is
switched from automatic to manual or vice versa.
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What happens when the method of applying cash advances is switched

Business unit setting Expense report not
submitted

Expense report in
approval

Expense report in audit Expense report is ready
to be processed for
reimbursement

When the setting is
switched from automatic to
manual

For expense reports that
are not yet submitted,
 employee will see the
available cash advances
when submitting the report.

For reports that are in the
approval process, approver
will not have the list of
applied cash advances for
review as the report was
submitted when the setting
was automatic.

For reports that are in
the audit process, auditor
will not have the list of
applied cash advances for
review as the report was
submitted when the setting
was automatic.

The cash advances will be
automatically applied.

When the setting is
switched from manual to
automatic

For expense reports that
are not yet submitted,
 employee will not view the
available cash advances
when submitting the report.

For reports that are in the
approval process, approver
will be able to review the list
of applied cash advances.

For reports that are in the
audit process, auditor will
be able to review the list of
applied cash advances.

The cash advances that
are manually applied are
deducted from the expense
report amount.

Enable Payment Method Selection for Cash Advances  
You can use the Enable Payment Method Selection option to let employees choose their preferred method of having
their cash advances credited to them.

Here's how you can do it:

1. In the Setup and Maintenance work area, select these options:

◦ Offering: Financials

◦ Functional Area: Expenses

◦ Task: Manage Cash Advance and Authorization Policies

2. On the Manage Cash Advance and Authorization Policies page, set the Enable Payment Method Selection
option to Yes.

Note:  You must have the Financial Application Administrator job role to be able to configure this option.

You can choose to enable this option for all business units or for individual business units.
3. Click Save and Close.

Employees can now select their preferred method of payment, such as cash, electronic, and check, while requesting
cash advances.

If the Enable Payment Method option is set to No, then the default payment method for the business unit will apply to
all cash advance requests raised by employees assigned to that business unit.
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Upload a Cash Advance File from a Third-Party System  
You can provide cash advance data using a comma-separated plain text .csv file that is uploaded to Oracle Universal
Content Management using the File Import and Export page.

After the file is uploaded, the expense auditor runs the Upload Cash Advance process from the Scheduled Processes
page.

Valid cash advance records are created or updated directly into the cash advance tables. Rejected records are listed in
the output file, along with the reason for rejection.

The following table contains fields in the cash advance file that you create in TextPad and upload.

Note:  Each line in TextPad must contain at least 10 elements. If more than 10 elements are used, it's assumed that the
Purpose field contains one or more commas and these extra fields are concatenated.

Field Required Notes Maximum Characters

Cash Advance Number
 

Yes
 

Not applicable
 

60
 

Person Number
 

Yes
 

• Either the person number or
the email must be provided.

• If both, they must match.

• A valid and active employee
record must exist.

• When a person has multiple
assignments, only the current
assignment is used.

120
 

Email
 

Yes
 

• Either the person number or
the email must be provided.

• If both, they must match.

960
 

Unapplied Amount
 

Yes
 

Not applicable
 

18
 

Status
 

Yes
 

• Status must be either
APPROVAL_COMPLETE or
PAID.

• For a status of PAID, indicate
the unapplied amount.

30
 

Cash Advance Type
 

Yes
 

Must be one of the existing
lookup codes for the EXM_CASH_
ADVANCE_TYPE lookup type. The
values are OTHER and TRAVEL.
 

30
 

Due Date No MMDDYYYY 8

242



Oracle Fusion Cloud Financials
Implementing Expenses

Chapter 5
Cash Advances

Field Required Notes Maximum Characters

    

Trip Start Date
 

No
 

MMDDYYYY
 

8
 

Trip End Date
 

No
 

MMDDYYYY
 

8
 

Purpose
 

Yes
 

This last field can contain commas.
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Uploading the Cash Advance File
To upload the cash advance file, follow these steps:

1. Sign in to Expenses as the expense auditor.
2. Navigate to: Navigator > Tools > File Import and Export.
3. On the File Import and Export page, click the Upload (+) icon.
4. In the Upload File dialog box, click Browse to find the file that you want to upload.
5. From the Account choice list, select fin/expenses/import.
6. Click Save and Close .

Running the Upload Cash Advance Process
To run the Upload Cash Advance process, follow these steps:

1. Navigate to: Navigator > Tools > Scheduled Processes.
2. On the Scheduled Processes page, click Schedule New Process.
3. In the Schedule New Process dialog box, select the Job option.
4. From the Name choice list, select Upload Cash Advances and click OK.
5. In the Process Details dialog box in the File Name field, enter the same file name that you uploaded in Step 4

in the previous task.
6. From the Allow update of existing records choice list, select Yes and click Submit.

If you select Yes, you can update existing cash advances. If you select No, you can't update existing cash
advances. You can only create new cash advances.

Note:  If you select Yes to update an existing record, but the existing cash advance has already been invoiced,
the record is rejected.

7. Click the Refresh icon.

The upload cash advance details appear.
8. Review the .log and .txt files by clicking the attachment links.
9. Sign out as the expense auditor.

10. Sign in to Expenses as an employee.
11. From the Expenses work area, review the Cash Advances infotile.
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How Accounting Entries for Cash Advances Are
Distributed  
When a cash advance is paid to an employee, the amount to be reclaimed is tracked in the Cash Advance Clearing
account.

When the cash advance is applied to an expense report, the amount is reversed from the clearing account.

The following table shows an example of a cash advance of 500 USD and an expense report with a total amount of 500
USD.

Document Amount

Cash Advance
 

500 USD
 

Expense Report
 

700 USD
 

Data in the preceding table is used in subsequent sections to illustrate how accounting entries are distributed when
each document is processed.

Setting That Affects Accounting Entries
The setting that affects accounting entries for cash advances is the Cash Advance Clearing account on the Manage
Expenses System Options page. This setting can only be implemented for a business unit.

The clearing account for each cash advance is derived by overlaying the natural account from the Cash Advance
Clearing account on the Default Expense account of the employee.

How Accounting Entries are Distributed
After a cash advance is approved and audited, it is processed to Oracle Payables as a payment request.

The following table summarizes the accounting distribution that is generated when the cash advance is processed in
Payables.

Account Debit Credit

Cash Advance Clearing
 

500 USD
 

Not applicable
 
 

Employee Liability
 

Not applicable
 

500 USD
 

The following table summarizes the accounting distribution that is generated when the cash advance is applied to the
expense report and the expense report is processed in Payables.
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Account Debit Credit

Cash Advance Clearing
 

Not applicable
 

500 USD
 

Employee Liability: Reclaim cash advance
 

500 USD
 

Not applicable
 

Employee Liability: Expense report
 

Not applicable
 

700 USD
 

Expense
 

700 USD
 

Not applicable
 

Set Up Cash Advance in Nonfunctional Currencies  
Oracle Fusion Expenses enables your employees to get cash advance for use in international travels in a currency other
than the functional currency before they go on an international trip. When they come back from travel they submit their
expense report.

The cash advance is applied to the expense report for that specific international travel, when reimbursement currency is
selected to match the cash advance currency.

Before you set up this feature, ensure that these prerequisites are met:

• Your company has capability to pay the cash advance in the allowed currencies.

• The cash advance options for your business unit has the Enable Advances option set to Yes.

Here are the tasks you need to do to set up this feature:

1. Enable reimbursement currency selection
2. Specify cash advance currencies

Specify Cash Advance Currencies
Here are the steps to add cash advance currencies allowed:

1. In the Setup and Maintenance work area, select these options:

◦ Offering: Financials

◦ Functional Area: Expenses

◦ Task: Manage Cash Advance and Authorization Policies

2. On the Manage Cash Advance and Authorization Policies page, select the required business unit.
3. In the Edit Specific Business Unit dialog box, select the currencies for cash advance in the Advance

Currencies Allowed field.
4. Click Save and Close.

Your employees can now request cash advances in the currencies you specified.

Related Topics
• How can I enable users to select reimbursement currencies for each expense report?
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Cancellation of Payment Requests for Cash Advances
and Expense Reports  

When an employee notifies the auditor that an approved cash advance is no longer required due to a trip or event
cancellation, or due to incorrect entries, the auditor requests the Payables supervisor to cancel the cash advance.
Only the payment requests that are invoiced or validated are eligible for cancellation. When a cash advance request is
canceled in Oracle Payables, it triggers a cancellation event and the Expenses application sets the status of the cash
advance to Invoice Canceled. No further actions are allowed on a canceled cash advance.

Employees can see the expense report status in the Expenses work area thus reducing inquiries to the accounts payable
department.

The ability to cancel payment requests for expense reports allows companies to stop the reimbursement processing and
communicate real-time status to the employees.

When the Payables supervisor cancels the payment request for an expense report, the Expense application:

• Updates the expense report status

• Deletes both pay expense reports created to pay corporate card issuers

• Reverses the cash advance applications.

Only the payment requests that are invoiced or validated are eligible for cancellation. When a payment request is
canceled, the associated expense report status is changed to Invoice Canceled and a suffix (+1) is added to the expense
report number. All references to the original payment request are removed. The Expenses work area reflects the status
change and the new expense report number. Employees cannot take any action on an expense report in the Invoice
Canceled status. On the Audit Expense Report page, an auditor can update a canceled expense report and process it
again for expense reimbursement or return a canceled expense report to the employee. Employees can see the expense
report status in the Expenses work area thus reducing inquiries to the accounts payable department. The employee can
rework a returned report and resubmit it.

A payables supervisor can cancel the following types of payment requests for expense reports.

• Expense reports containing cash expenses
When reprocessed for reimbursement, a new payment request to an employee is created.

• Expense reports containing individual pay corporate card transactions
When reprocessed for reimbursement, a new payment request to an employee is created.

• Expense report containing both pay corporate card transactions
When the payment requests are in invoiced or validated statuses, the application alerts the supervisor that
payment requests for both the employee and the card issuer will be canceled. When the expense report is
reprocessed for reimbursement, the application creates two new payment requests, one for the employee and
the second for the card issuer.

• Expense report containing company pay card transactions
When a payment request for the card issuer is canceled, the invoice number is removed from the card
transactions and these transactions are available for reprocessing. When a payment request for the employee is
canceled, the expense report status is changed to Invoice Canceled.
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6  Spend Authorizations

Overview of Spend Authorizations  
A spend authorization is a request by an employee for approval of estimated expenses for a future activity.

A spend authorization request proceeds through the following process, which the employee initiates:

• Employee submits a spend authorization request

• Manager approves the spend authorization request

• Employee submits an expense report

Employee Submits a Spend Authorization Request
The process for a spend authorization begins when an employee requests authorization for future expenses. The
employee completes the Request Authorization page by clicking the Authorizations infotile on the Oracle Expenses
work area. Expenses tracks all requests by an employee for authorization of future expenses.

Manager Approves the Spend Authorization Request
The employee submits the spend authorization request to his manager for approval. If the manager rejects the request
or requests more information, Expenses returns the request to the employee who takes appropriate action.

Employee Submits an Expense Report
After incurring business expenses, the employee creates and submits an expense report to his manager for approval.
When an approved spend authorization request exists, the employer may require the employee to attach it to the
expense report at either the expense report header or at the lines.

Attaching the spend authorization to the expense report allows managers and expense auditors to compare approved
estimated expenses against incurred expenses. If budgetary control is enabled, the employee may be alerted when he
makes expense report entries that are contrary to a previous authorization. Such violations are visible to the manager
and the expense auditor.

Related Topics
• How Budgetary Control and Spend Authorizations Work Together

• Options for Setting Up Spend Authorizations with Budgetary Control

How You Configure Spend Authorization Request
Approval Rules  
You can configure approval rules for approval of spend authorization requests. Oracle Business Process Management
Suite (BPM) provides the UI to administer and manage approval rules.
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A BPM Worklist administrator can access approval rules in the BPM Worklist if he is assigned the role if he is assigned
the role of Financial Application Administrator (FUN_FINANCIAL_APPLICATION_ADMINISTRATOR).

When you submit a spend authorization request for approval, Expenses invokes the approval process. The approval
process prompts a set of approval rules created in the BPM Worklist to build the list of approvers. After an approver
responds to an approval notification, BPM sends an approval notification to the next approver. BPM continues sending
approval notifications to the approvers in the approval hierarchy until all approvals are complete.

To configure or modify spend authorization rules, complete these steps:

1. In the Setup and Maintenance work area, use the following to navigate to the BPM Worklist:

◦ Offering: Financials

◦ Functional Area: Expenses

◦ Task: Manage Expense Approval Rules

2. In the BPM Worklist, select the Task Configuration tab.
3. From the Tasks to be configured pane, select FinExmWorkflowSpendAuthorization.
4. Select the Assignees tab.
5. Click the Switch to Vertical Layout link. An approval hierarchy displays.
6. On the Authorization rectangle, click the diamond icon and select Go to rule.

The spend authorization approval flow contains a predefined rule set with its associated approvers as described in the
following table.

Rule Set Approver

SpendAuthorizationRuleSet
 

• SpendAuthorizationManagerRule

Supervisor
 

• Approval rule with one level of supervisory hierarchy

SpendAuthorizationRuleSet: Approval by Supervisor
The predefined rule set for approval of spend authorization that uses the supervisory hierarchy is called
SpendAuthorizationRuleSet. The predefined rule is as follows:

Approval by the immediate supervisor of spend authorizations with a total over 0

You can change the predefined rules, delete, or add rules as needed. The following table lists the parameters for the
SpendAuthorizationRuleSet.

Rule Field Predefined Value Description

SpendAuthorizationMan-
agerApprovalRule
 

Condition
 

AuthorizedTotal is same or greater
than 0
 

Attribute that stores the spend
authorization request total in the
reimbursement currency.
 

List Builder
 

Supervisory
 

The rule uses the supervisory
hierarchy to retrieve approvers.
 

 Response Type
 

Required
 

The approval notification requires
a response.
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Rule Field Predefined Value Description

 

 Number of levels
 

1
 

Number of supervisory levels
required for approval completion.
 

 Starting Participant
 

HierarchyBuilder.getManager
("supervisory",Task.payload .ownerUserName,-1,"","")
 

Person for whom the spend
authorization is requested.
 

 Top Participant
 

HierarchyBuilder.getPrincipa
l("FINUSER30",-1,"","")
 

Last approver in the approval
chain. Approval doesn't go beyond
this participant in a hierarchy. To
use this rule as is, you must change
the predefined last approver user
name to the last approver in your
organization.
 

Note:
This must be changed to
reflect the last approver in your
organization.
 

 Auto Action Enabled
 

False
 

Automatic approval action is
disabled.
 

 Auto Action
 

Null
 

No automatic approval action.
 

 Rule Name
 

SpendAuthorizationManagerRule
 

Name of rule.
 

Options for Setting Up Spend Authorizations with
Budgetary Control  
A spend authorization is a request by an employee for approval of estimated expenses for a future activity. For example,
if an employee plans a business trip, he or she can request approval for anticipated expenses before taking the trip.

When you set up spend authorizations, you can consider these options:

• Enable spend authorizations

• Specify attachment location of spend authorizations

• Define spend authorization behavior

• Specify spend authorization numbering

• Control visibility of spend authorizations

• Enable budgetary control
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You can set up spend authorizations for all business units in your organization or you can create exceptions for specific
business units.

Note:  Before you start, you must first select a business unit in Oracle Expenses on the Authorizations tab of the Edit
Specific Business Unit dialog box. Doing this enables budgetary control to validate anticipated expenses against a
specific budget, ledger, and business unit.

Enable Spend Authorizations
In the Setup and Maintenance work area, use:

• Offering: Financials

• Functional Area: Expenses

• Task: Manage Cash Advance and Authorization Policies

To enable spend authorizations on the Manage Cash Advance and Authorization Policies page, select Yes from the
Enable Authorizations choice list.

Specify Attachment Location
You can allow employees to attach an approved spend authorization at the expense report header level or at the
expense line level.

To specify the attachment location of spend authorizations on expense reports, from the Attach Authorization choice
list, select Header Only, Lines Only, or No.

Note:  The Header Only option is only applicable when budgetary control isn't enabled.

Define Spend Authorization Behavior
Depending on your business needs, you can specify the attachment of a spend authorization to an expense report as
optional or required. From the Behavior choice list, select Optional or Required.

Specify Spend Authorization Numbering
You can optionally specify alphanumeric prefixes for spend authorization identification numbers.

To specify a prefix such as SA, that stands for Spend Authorization, enter a value in the Prefix field.

Control Visibility of Spend Authorizations
Approved spend authorizations are visible in the Expenses work area for the number of days you specify in the
Visibility in Days field. The default value is 180 days. You can either increase or decrease the number of days by one or
you can enter any positive whole number directly.

Check or Reserve Funds
Depending on your business requirements, you can choose to only check funds or to reserve funds by selecting the
Check funds or Reserve funds option. If you select Check funds, you can decide whether to present a warning to
employees if funds are insufficient to cover an estimated expense. The warning options are Yes or No.
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The Display Warning to User option is applicable only when you select the Check funds option.

Enable Budgetary Control
If you want to check funds to determine whether sufficient funds are available for estimated expenses, you must enable
budgetary control. To enable budgetary control in the Setup and Maintenance work area, use:

• Offering: Financials

• Functional Area: Budgetary Control and Encumbrance Accounting

• Task: Manage Budgetary Control

Complete these steps:

1. On the Manage Budgetary Control page, click the applicable business unit.
2. On the Edit Budgetary Control and Encumbrance Accounting page near Budgetary Control, select the Enable

check box.
3. Select Yes from the Enabled choice list for the business function, Expense Management.
4. Click the corresponding Transaction Type Details icon and enable the transaction subtype of Spend

authorization expense item for the transaction type of Spend authorization by selecting Yes.
5. From the Enabled choice list for the business function, Payables Invoicing, select Yes.
6. Click the corresponding Transaction Type Details icon and enable the transaction subtype of Spend

authorization payment request for the transaction type of Invoice by selecting Yes.

Related Topics
• How Budgetary Control and Spend Authorizations Work Together

• Overview of Spend Authorizations

Create a Spend Authorization and Attach Authorization
Lines to Expense Items  
In this example, you request a spend authorization for an upcoming trip. After you return from the trip, you will create
an expense report and attach the approved spend authorization lines to their respective expense items in the report.

Watch video
 

This topic show you how to:

• Create a spend authorization.

• Approve the spend authorization.

• Create an expense report and attach authorization lines.

• Submit the expense report.
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Create a Spend Authorization
To create a spend authorization, complete these steps:

1. Sign in as an employee.
2. Click the House icon
3. On the Home page, click Me > Expenses > Travel and Expenses work area.
4. In the Travel and Expenses work area, click the Actions menu.
5. Select the Request Authorization option.
6. On the Request Authorization page in the Purpose field, enter Oracle Open World.
7. From the Expense Location choice list, search and select United States.
8. From the State Date field, enter a date one month from today's date.
9. From the End Date field, enter a date that is four days after the Start Date.

10. Click the Create icon near the Estimated Expenses section.
11. On the Estimate Expense page from the Template choice list, select Travel.
12. From the Type choice list, select Airfare.
13. From the Amount choice list, select USD.
14. In the field near the Amount choice list, enter 650.00.
15. In the Description field, enter Airfare to Oracle Open Word.
16. Click Save and Create Another.
17. On the Estimate Expense page from the Template choice list, select Travel.
18. From the Type choice list, select Meals.
19. From the Amount choice list, select USD.
20. In the field near the Amount field, enter 375.00.
21. In the Description field, enter Meals at Oracle Open World.
22. Click Save and Create Another.
23. On the Estimate Expense page from the Template choice list, select Travel.
24. From the Type choice list, select Hotel.
25. From the Amount choice list, select USD.
26. In the field near the Amount choice list, enter 800.00.
27. In the Description field, enter Accommodations at Oracle Open World.
28. Click Save and Close.
29. On the Authorization page, click Submit.

Approve the Spend Authorization
To approve the spend authorization as the manager, complete these steps:

1. Sign out as an employee.
2. Sign in as a manager.
3. On the springboard, click the Bell icon.
4. From the Notifications choice list, select Pending Notifications.
5. Locate the spend authorization you just created and click the Action Required: Authorization Approval link.
6. On the approval form for the spend authorization, click Approve.
7. In the Approve dialog box, enter the following in the Comment field: I approve this spend authorization request

for the trip to Oracle Open World.
8. Click Submit.
9. Click Approve.

10. Sign out as a manager.
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11. Sign in as an employee.
12. In the Travel and Expenses work area, click the Authorizations infotile.
13. Click the Approved link on the Authorizations infotile.

Create an Expense Report and Attach Authorization Lines
To create the expense report and attach authorization lines to the expense items, complete these steps:

1. In the Travel and Expenses work area, click the Expense Reports infotile.
2. Click the Create icon.
3. On the Create Expense Report page in the Purpose field, enter Attended Oracle Open World.
4. Click Save.
5. Click Create Item near the Expense Items section.
6. On the Create Expense Item page from the Template choice list, select Travel.
7. From the Type choice list, select Airfare.
8. From the Expense Location choice list, search and select United States.
9. Click OK.

10. From the Amount choice list, select USD.
11. In the field near the Amount choice list, enter 650.00.
12. In the Description field, enter Airfare to Oracle Open World.
13. Click the Attach icon near Authorization.
14. In the Select Estimated Expense dialog box from the Authorization choice list, select the authorization you

created.
15. Select the Airfare authorization line.
16. Click the OK.
17. On the Create Expense Item page, click Create Another.
18. On the Create Expense Item page from the Template choice list, select Travel.
19. From the Type choice list, select Meals.
20. From the Expense Location choice list, search and select United States.
21. From the Amount choice list, select USD.
22. In the field near the Amount choice list, enter 110.00.
23. In the Description field, enter Meals at Oracle Open World.
24. Click the Attach icon near Authorization.
25. In the Select Estimated Expense dialog box from the Authorization choice list, select the authorization you

created.
26. Select the Meals authorization line.
27. Click OK.
28. On the Create Expense Item page, click Create Another.
29. On the Create Expense Item page from the Template choice list, select Travel.
30. From the Type choice list, select Hotel.
31. From the Expense Location choice list, select United States.
32. From the Amount choice list, select USD.
33. In the field near the Amount choice list, enter 800.00.
34. In the Description field, enter Hotel stay at Oracle Open World.
35. In the Itemization section, enter these values:

Field Name Entry

Type choice list Room Charge
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Field Name Entry

  

Daily Amount
 

200.00
 

Days
 

4
 

Amount
 

800.00
 

36. In the Itemization section, click the Attachment icon near Authorization.
37. On the Select Estimated Expense dialog box from the Authorization choice list, select the authorization you

created.
38. Select the Hotel authorization line.
39. Click OK.
40. Click Save and Close.

Submit the Expense Report
1. On the Expense Report page, select the I have read and accept the corporate travel and expense policies

check box.
2. Click Submit.
3. In the warning that indicates one or more required imaged receipts are not attached, click Yes.

How Budgetary Control and Spend Authorizations Work
Together  
If your organization requires the ability to track and control expenditures against a budget, you can enable Oracle
Budgetary Control. This is especially helpful for public sector and commercial organizations that require:

• Visibility into budget commitments and expenditures

• Adherence to legal requirements

• Control of excessive spending

• Approval of anticipated expenses

• Validation of anticipated expenses against a specific budget for an applicable ledger and business unit

To support this requirement, Expenses integrates with Budgetary Control. The process begins when an employee
creates and submits a spend authorization for approval. The approving manager checks whether funds are available
against the budget and optionally views the results. When the manager approves the spend authorization, funds are
automatically reserved. After the employee incurs expenses, he or she creates an expense report and attaches the
approved spend authorization estimated lines to it. After the manager approves the expense report, it's processed for
reimbursement, which results in a payment request. The payment request generates an invoice, which is validated, and
subsequently the employee or the card issuer is paid.
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This diagram shows how the spend authorization and the budgetary control process work together to control excessive
spending.

Effects of Enabling Budgetary Control
When your company enables budgetary control, these actions are available:

• When an employee submits a spend authorization for approval, Budgetary Control evaluates whether funds are
available for the anticipated expenses for a specific business unit, ledger, and budget date.

• The status of the funds check is visible to the approving manager.

• The approving manager can recheck funds and view results directly from the authorization approval
notification.

• After the manager approves a spend authorization, funds are reserved automatically.

• After the employee incurs expenses, he or she can associate the approved spend authorization with the actual
expenses and submit the expense report for approval.

Related Topics
• Overview of Spend Authorizations

• Options for Setting Up Spend Authorizations with Budgetary Control
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7  Expense Reimbursements

How Third-Party Expense Reimbursements Are
Processed  
Expense reports can be reimbursed through Oracle Fusion Payables or any legacy or third-party application. If you want
to issue expense reimbursements through a legacy or third-party application, you can use the third-party expense
reimbursement process.

Settings That Affect Third-Party Expense Reimbursements
On the Manage Expenses System Options page, you can use the Pay Expense Reports Through option to choose one
of the following for expense reimbursement:

• Payables

• Third-party application

A third-party application may be a legacy application within your company or an outside supplier.

How Third-Party Expense Reimbursements Are Processed
The following diagram illustrates the export of expense report data from Oracle Fusion Expenses to a legacy or third-
party application, the issuance of reimbursement payments by the legacy or third-party application, and the import of
reimbursement payment data back to Expenses.

The following figure illustrates the export of expense report data from Oracle Fusion Expenses to a legacy or third-
party application, the issuance of reimbursement payments by the legacy or third-party application, and the import of
reimbursement payment data back to Expenses.

The following table describes the flow of expense report data when you use a legacy or third-party expense report
reimbursement application.
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Sequence Action Result

1.
 

In Expenses, employees create expense reports,
 which are approved, and audited.
 

Expense reports are eligible for reimbursement.
 

2.
 

In Expenses, you can schedule the following
processes to automatically export the expense
report data from Expenses to your legacy or
third-party application in .xml format:
 

• Process Expense Reimbursements and
Cash Advances

• Create Card Issuer Invoices

The exported expense report data files contain
all the information necessary to issue payments
and record accounting entries in your legacy
or third-party application. The Expenses
processes automatically export expense report
data from Expenses to the following locations:
 

• Universal Content ManagerNavigator >
Tools > File Import and Export link.

• Search Results section on the Scheduled
Processes page: Navigator > Tools >
Scheduled Processes.

UCM facilitates easy tracking and download of
expense report data files.
 

3.
 

From the fin/expenses/export directory, you
can download the expense report data files
in .xml format and transfer them to your legacy
or third-party application.
 

Your legacy or third-party application processes
the expense report data files.
 

4.
 

Your legacy or third-party application issues
expense report reimbursement payments to:
 

• Employees

• Credit card issuers

 

Employees and credit card issuers receive
payments.
 

5
 

To transfer reimbursement payment data from
your legacy or third-party application, you
upload your expense report reimbursement
data to the fin/expenses/import directory.
 

Expense report reimbursement information
transfers from the legacy or third-party
application back to Expenses in a specific .xml
format with a .txt or .xml extension.
 
The specific .xml format depends on the
expense report payment option selected by
your company for corporate card transactions
and whether the data file is for cash advances.
 

6
 

From Expenses, you schedule the Update
Expense Report Status process.
 

The Update Expense Report Status process
automatically:
 

• Updates the expense reports in Expenses
as paid

• Provides legacy or third-party
reimbursement references in the paid
expense reports

Related Topics
• Expense Report Data Flow Using a Third-Party Application
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Expense Report Data Flow Using a Third-Party
Application  
If you use a legacy or third-party application to process expense report reimbursements, you can export expense report
XML data files from Oracle Fusion Expenses and use them to process data in your legacy or third-party application.

After your legacy or third-party application processes reimbursement payments, you can import the reimbursement
payment XML data files back to Expenses.

Expense Report XML Data Exported to Universal Content Manager
To create expense report XML data files for export to a legacy or third-party application, schedule the following
automatic processes in Expenses using Navigator > Tools > Scheduled Processes:

• Process Expense Reimbursements and Cash Advances

• Create Card Issuer Invoices

The resulting XML expense report data files are available from the Search Results section on the Scheduled Processes
page or you can download them from Universal Content Manager (UCM) at fin/expenses/export directory using
Navigator > Tools > File Import and Export link.

The following figure shows an example of an expense report XML data file format that is automatically created when
an expense report containing cash expense items is processed by the Process Expense Reimbursements and Cash
Advances process.
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Note:  Expense report data files that contain corporate card expenses for Company Pay or Both Pay payment options
have a different XML format structure than the preceding example. Similarly, expense report data files for cash
advances also contain a different XML format structure.

Expense Report Reimbursement XML Data Imported Into Universal
Content Manager
To transfer expense report reimbursement data from a legacy or third-party application back to Expenses, the data
must appear in XML format. Upload the correctly formatted XML reimbursement payment data files to UCM at fin/
expenses/import directory.
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Tip:  For optimal file handling, the best practice is to use the following naming convention for reimbursement
payment data files: MM-DD-YYYY HH-MM ExmPaymentExtract.

CAUTION:  The XML files you upload to UCM must be in precisely the same structure as shown in the following
figure.

Related Topics
• How Third-Party Expense Reimbursements Are Processed
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8  Mobile Devices

Disable the Scan Option on Mobile Expenses  
You can disable the Scan option on the Expenses mobile application by configuring a profile option.

You must have one of the following roles to disable the Scan option:

• Application Implementation Consultant

• Financial Administrator

• Expense Manager

Defining the Profile Option
To disable the Scan option, define the profile option, EXM_MOBILE_DISABLE_SCAN, and set the profile option value to
Yes.

To define the profile option, complete these steps:

1. In the Setup and Maintenance work area, go to the following:

◦ Offering: Financials

◦ Functional Area: Expenses

◦ Task: Manage Profile Options

2. On the Manage Profile Options page, click the Create (+) icon.
3. On the Create Profile Option page in the Profile Option Code field, enter EXM_MOBILE_DISABLE_SCAN.
4. In the Profile Display Name field, enter a profile display name.
5. From the Application choice list, select Expenses.
6. From the Module choice list, select Expenses.
7. From the Start Date field, enter a start date.
8. Click Save and Close.
9. On the Manage Profile Options page in the Profile Options Levels section, select Site as the Level value.

10. Select both the Enabled and the Updatable check boxes.
11. Click Save and Close.

Defining the Profile Option Value
To define the profile option value, complete these steps:

1. In the Setup and Maintenance work area, go to the following:

◦ Offering: Financials

◦ Task: Manage Administrator Profile Values

2. On the Manage Administrator Profile Values page in the Search: Profile Option section, enter
EXM_MOBILE_DISABLE_SCAN in the Profile Option Code field.
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3. Click Search.
4. In the Search Results: Profile Options section, select the profile option you created.
5. In the Profile Values section, click the Create (+) icon.
6. From the Profile Level choice list, select Site.
7. From the Profile Value choice list, select Y.
8. Click Save and Close.

Enforcement of Miscellaneous Expenses Policy in Mobile
Application  
Your company can set up and enforce miscellaneous expense policies to help control, manage, and reduce spending for
miscellaneous expenses.

You can define or enforce policies based on different parameters such as days, employee role, daily or yearly limit,
gender, and employee location. For example, you can set an upper limit on the percentage of reimbursement to
process. You can set a policy to reimburse a maximum of $100 for a day and a maximum of $500 for a year.

When employees enter expense details and if you have enforced policy on any of the fields, the application validates the
details. If a tolerance limit is not defined for expenses above policy limit, the application will display an error message for
expenses above the specified limit. Employees must fix the error to submit the report. If a tolerance limit is defined for
expenses above the policy limit, the application asks a justification for expenses above the specified limit. Employees
must provide a justification before submitting the report.

The application will display an error message if the submitted expense violates any of the defined policies. For example,
you can define the minimum number of days for the miscellaneous expense accrued to be eligible for a reimbursement
under a policy. If you set the Minimum number of days for miscellaneous expense reimbursement to 3, the
employee must accrue at least 3 days of miscellaneous expenses so that the expense is eligible for reimbursement. The
application alerts the employee if the number of days entered for reimbursement is less than 3.

Related Topics
• Set Up a Miscellaneous Expense Policy

Enable Allocation of Project Expenditure Organization to
Expenses in Mobile Application  

To enable allocation of project-enabled expenses to expenditure organization, use the IT Security Manager role
to assign Allocate Project Expense privilege to employees. Assign the Labor Distribution Administrator role to the
employees to provide them access to the project-related fields in the mobile application.

Using the Expense Manager role, navigate to Setup and Maintenance, and Manage Descriptive Flexfields. Open the
project costing details and change the context to expense report line. Enable Organization ID and save the changes.

On the Manage Expense Report Template page, search for the template and open expense type, and enable project for
the expense type on the Project Expenditure Type Mapping tab.
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Multi-Factor Authentication in the Expenses Mobile
Application  
To avoid Multi-Factor Authentication (MFA) issues in your Expenses mobile application, Oracle recommends that you
use browser-based authentication when your single sign-on (SSO) provider requires MFA.

To allow the Expenses mobile application to launch your preferred mobile browser for sign-in, instead of the original
SSO URL, which is https://<pod url>, enter the host URL as listed below at the login page of the SSO tab (based on your
device):

• On Android, enter:
https://<pod url>?browser_auth=true

• On iOS:
◦ For the default browser (usually Safari), enter

https://<pod url>?scheme=https

◦ For other browsers, it depends on the scheme of each browser.
For example, in Microsoft Edge, enter:
https://<pod url>?scheme=microsoft-edge-https

In MobileIron, enter:
https://<pod url>?scheme=mibrowsers

If your preferred browser doesn't have a scheme, then you must make it your default browser and invoke
using ?scheme=https mentioned above.

Once the browser confirms your identity, you are automatically routed back to the Expenses application.

Can I configure my own prompts for the Expenses Policy
Agent?  
Yes. Fusion Applications offer the capability for you to tailor the prompt to meet your specific needs. Prompts are the
instructions you provide to generative AI agents. Configuring prompts is an advanced feature and entirely optional,
intended only for situations where your specific needs go beyond the seeded prompts.

To use this feature, at least one business unit must be enabled with Touchless Expenses with J.P. Morgan Corporate
Cards.

Here’s how you can configure prompts for the Expenses Policy Agent:

1. Use an existing sandbox or create a new sandbox.
To access the sandbox management page, click the hamburger icon and select Configuration > Sandboxes.
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The sandbox must have the HCM Experience Design Studio tool deployed.
2. Enter the sandbox and start the HCM Experience Design Studio using Tools.
3. Click AI Configurator.

The AI Configurator page opens with two sections:
◦ Overridden Prompts: currently overridden prompts

◦ Seeded Prompts: prompts that are available for configuring

4. Locate the Expenses Policy Agent prompt with the prompt label:
financials.exm.expense_policy_inquiry_agent_prompt.

5. Click the down arrow to view the prompt details, or click the Override Prompt icon on the right side of the
prompt entry.
This opens the Override Prompt drawer where you can make edits.

6. You can update the prompt as needed and test your changes using a Touchless Expenses user. Once you're
happy with how it works, save your changes.
The updated prompt will appear in the Overridden Prompts section. From then on, whenever a Touchless
Expenses user runs the Expenses Policy Agent, your custom prompt will be used instead of the default one.

7. If you ever want to change or remove the override, just click the ellipsis (…) next to the prompt and select Edit
or Delete.
If you delete it, the original, seeded prompt will be used again.

8. Once all your changes are saved in the AI Configurator, go ahead and exit the sandbox.
Notes:

• Lines that start with a # are either instructions or placeholders for variables.

• Prompt variables are written inside curly braces like this: {variable_name}. These are essential to how the
prompt works.

• Before making any changes, be sure to review all prompt management tips and considerations.

Sample prompts for common scenarios

Scenario Suggested Prompt

You want the agent to provide more
detailed reasoning in its response—
without overusing or heavily referencing
user context.

##User Context
 
User Job Name: {user_jobname}
 
User Location: {user_location}
 
## References
 
Context: {context}
 
## Instructions
 
Using the context, answer the following question: {user_query}
 
## Acceptance Criteria
 
Provide a concise and direct answer in 1-2 sentences.
 
Explain why your answer is correct by citing the original context. Do not mention the user context if it’s
not relevant to the answer.
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Scenario Suggested Prompt

 

In the default (seeded) prompt, there are
two variables that use user context. These
help the Expenses Policy Agent tailor
answers based on each user's specific
details:
 
 
{user_jobname} – the user's job title, as
defined in HCM
 
 
{user_location} – the user's office location,
 also from HCM
 
 
For example, if your policy document
includes rules that vary by job title or
location, the agent can use these variables
to tell users exactly which policy applies to
them.
 
 
However, if you prefer the agent not refer
to a user’s job title, you can simply remove
the {user_jobname} variable from the
prompt.
 

##User Context
 
User Location: {user_location}
 
## References
 
Context: {context}
 
## Instructions
 
Using the context, answer the following question: {user_query}
 
## Acceptance Criteria
 
Provide a concise and direct answer in 1-2 sentences.
 
Only mention the user context if it is relevant to the answer.
 

You want the Expenses Policy Agent to
guide users to create a support ticket on
a custom page when their question falls
outside the agent’s knowledge, you can set
this up using custom_page_info.

##User Context
 
User Job Name: {user_jobname}
 
User Location: {user_location}
 
## References
 
Context: {context}
 
## Instructions
 
Using the context, answer the following question: {user_query}
 
## Acceptance Criteria
 
Provide a concise and direct answer in 1-2 sentences.
 
If the {user_query} is out of the context scope, state "Sorry this is out of my scope. Please raise your
request to custom_page_info."
 

Related Topics
• Touchless Expenses with J.P. Morgan Corporate Cards
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9  Expense Assistant

Overview of Setting up Expense Assistant  
The Oracle Expense Assistant is a skill within the Oracle Fusion Applications Digital Assistant that allows users to create
and manage their expenses using a conversational experience.

After you enable Expense Assistant, users in your organization can use conversational channels, such as SMS from their
mobile phones to perform common expense tasks conveniently. Here are some of the tasks that users can perform
using Expense Assistant:

• Create expense items

• Modify expense items

• Check status of expense reports

Before You Start
Here are few tasks you need to do before you can configure Expense Assistant for your users:

• The expense assistant is included in the ERP product SKU and is available out-of-the-box to the customers.
The Expense Assistant is part of the overall Oracle Fusion Applications Digital Assistant (FADgitialAssistant).
To extend the out-of-the-box expense assistant or to build new digital assistants, customers are required to
purchase the Oracle Digital Assistant Platform for SaaS SKU.

• You need to setup Oracle Fusion Applications Digital Assistant using the instructions in the Getting Started with
Oracle Digital Assistant for Cloud Applications guide. Here is an overview of the instructions that you need to
perform to set up the Digital Assistant:

a. Identify users in your organization who you want to give access to the Digital Assistant platform and
assign them roles, such as service administrator, service developer, or service business user. Refer to the
Digital Assistant User Roles topic of the Configure Digital Assistant chapter in the Getting Started with
Oracle Digital Assistant for Cloud Applications guide.

b. Log in as ODA Service Administrator, select the latest version of Oracle Digital Assistant, and train the
digital assistant. Refer to the Access and Set Up Digital Assistant topic of the Configure Digital Assistant
chapter in the Getting Started with Oracle Digital Assistant for Cloud Applications guide.

c. Configure channels such as Oracle Web, Microsoft Teams, or Twilio SMS to associate them with the digital
assistant. See Configure Channels for more information.

• Once the Digital Assistant is set up, you can configure Expense Digital Assistant using these steps:

a. Schedule and run the Synchronize Financials Objects for Database Search process. This process creates a
repository of merchants used by the employees to aid in expense type derivation.

b. Set up Expense Assistant.
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Related Topics
• Before You Start

• Digital Assistant User Roles

• Set up Digital Assistant

Schedule Processes  
Schedule and run the Synchronize Financials Objects for Database Search and Automatically Submit Expense Reports
processes.

The Synchronize Financials Objects for Database Search process creates a repository of merchants used by the
employees to aid in expense type derivation. To run this process, you must sign in as a financial application
administrator.

Here are the steps to run the Synchronize Financials Objects for Database Search process:

1. From the Navigator, click Tools > Scheduled Processes to open the Scheduled Processes page.
2. Click the Schedule New Process button.
3. In the Schedule New Process dialog box, search and select the Synchronize Financials Objects for Database

Search process and click OK to open the Process Details dialog box.
4. Click Advanced.
5. In the Parameters tab, select the Expense Merchants option as the object name.
6. In the Schedule tab, configure the frequency of running the process. It's recommended that you run this

process at least once a week.
7. Click Submit.

The Automatically Submit Expense Reports process enables users to submit expense reports automatically from the
Expense Assistant. The process also matches the expenses with the corresponding corporate card changes and marks
the automatic submission date for expense items. In addition, the Automatically Submit Expense Reports process
synchronizes expense types, as well as synonyms, defined in the setup of Expense Assistant. You must schedule the
Automatically Submit Expense Reports process to run after you enable automatic submission of expenses.

You can schedule the Automatically Submit Expense Reports process with the travel manager role. While scheduling
the Automatically Submit Expense Reports process, you can specify the business unit for which you want to run the
Automatically Submit Expense Reports process. It's a good practice to schedule the Automatically Submit Expense
Reports process to run every hour.

Security
Privileges provide the necessary access to run specific scheduled processes. Privileges are granted to duty roles, which
are granted to job roles. To see which job roles inherit the needed privileges, use the Security Console or the security
reference manuals for the appropriate product family.
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Set up Expense Assistant  
You can set up Expense Assistant to work as per the requirements of your organization. To do this, you need to be
assigned the Corporate Card Account Administration role. You use the Manage Auto Submission and Matching Options
page to set up Expense Assistant.

To access this page, in the Setup and Maintenance work area, go to the following:

• Offering: Financials

• Functional Area: Expenses

• Task: Manage Auto Submission and Matching Options

The Manage Auto Submission and Matching Options page provides different options to configure Expense Assistant.
Here are the different settings you can configure using this page:

• Set up automatic submission of expenses

• Configure matching expenses with corporate card expenses

• Manage synonyms for expense types

• Configure expense digest

• Enable electronic receipt processing

• Configure notification email

By default, these settings apply to all business units. However, you can also modify these settings for individual
business units. To do this, select a business unit in the Specific Business Unit section of the Manage Auto Submission
and Matching Options page. The Edit Auto Submit and Matching Options dialog box has the following tabs where you
can configure settings for specific business units:

• Edit Auto Submit and Matching Options

• Email Digest Options

• Electronic Receipt Setup

Note:  Settings for matching expenses with corporate card charges apply to all business units and can't be configured
separately for a business unit.

Set up Automatic Submission of Expenses
After an employee creates an expense item using Expense Assistant, it needs to be submitted for approval and further
processing. Your company can automatically submit expense items, which are ready for submission, as part of an
expense report. This ensures that if an expense is ready, it's submitted without waiting for the end user to submit the
expense manually. To enable this automatic submission, schedule the Automatically Submit Expense Reports process
once or twice a week. You use the options in the Auto Submission for Expenses Digital Assistant section to configure
this feature. Here are the options available in the section:

Option Description

Schedule
 

Use this option to enable automatic submission of expense items. By default, this option is set to No.
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Option Description

Frequency
 

Specify the days of the week when the automatic submission process will run. This option is enabled
when the Schedule option is set to Yes. By default, none of the days is selected. You must choose at
least one day in a week otherwise the automatic submission process isn't run even when the Schedule
option is set to Yes.
 

Expenses Eligible for Automatic Submission

If a user doesn't have a corporate card, these expense items are eligible for automatic submission:

• Expense items were created using the digital assistant.

• There's no missing information.

• Receipts are attached when required.

• Policy violations have justification.

If a user has a corporate card, these expense items are eligible for automatic submission:

• Expense items were created using the digital assistant and corporate card wasn't used.

• Expense items were created using the digital assistant and exactly matched to corporate card charges.

• Tip charges on corporate card from merchants, such as Uber and Lyft, where a receipt was sent for the base
fare.

Expenses Not Eligible for Automatic Submission

Here are the expense items created from the digital assistant that aren't eligible for automatic submission:

• Expense items with missing information.

• An expense item that matches multiple corporate card charges.

• A corporate card charge that matches with multiple expenses.

• Expenses that violate company policies.

Configure Matching Expenses with Corporate Card Expenses
When a corporate card user creates an expense using Expense Assistant they can specify the payment method as either
corporate card or personal funds. When a user specifies the payment method as corporate card, the application looks
for a matching corporate card charge. If the match is found, the application merges the expense, assigns an expense
type, and makes the expense ready for submission. If the application doesn't find a matching corporate card charge, it
waits for a match indefinitely. In some cases, the application may match a corporate card charge to multiple expenses
and sometimes it's the other way around. In such cases, the user must resolve the match using the Expenses web
application.

Based on your company's requirements, you can configure how the application matches the expenses created by
Expense Assistant with the corresponding corporate card expenses. Here are the settings you configure to match
expense items:

• Category matching tolerance

• Merchant matching tolerance

Category Matching Tolerance
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You can specify the matching tolerance for different categories of expenses. This helps in matching the digital assistant
expenses to their corresponding credit card charges. The matched expenses and credit card charges are merged
and can be submitted automatically without user intervention. Here are the different matching parameters you can
configure for different categories of expenses:

Parameter Description

Amount Variance Percentage
 

The percentage variance in amount that's used to determine whether a digital assistant expense and a
credit card charge match.
 
You can specify any value between 0% and 50%. Use this field to accommodate any extra charges that
are charged to the credit card by a hotel, restaurant, taxi, and other similar vendors.
 
The default value for meals and entertainment expenses is 20% and 0% for the other expenses.
 

Amount Variance Direction
 

The direction in which the amount variance is applied. Here are the possible values:
 

• More than the Digital Assistant: Use for cases where the credit card charges are greater than the
Expense Assistant amount, such as for meals with tips.

• Less than the Digital Assistant: Use for cases where the credit card charges are less than the
Expense Assistant amount, such as for Uber or Lyft taxi ride with a tip.

• Both

The default for meals and entertainment expenses is More than the Digital Assistant and Both for the
other expenses.
 

Days Variance
 

The variance in the date of expense that's used to determine whether a digital assistant expense and a
credit card charge match.
 
The default value for accommodation, meals, and entertainment expenses is 2 days and 0 days for the
other expenses.
 

Merchant Matching Tolerance

Expenses for some merchants may deviate from the general variance of their category. For example, they may record
tip as a separate corporate card expense. To manage such cases, you can specific matching tolerance values. Here are
the parameters you can specify to configure specific matching tolerance for a merchant.

• Amount Variance Percentage: The percentage variance in amount that's used to determine whether a digital
assistant expense and a credit card charge match. The default value is 20%.

• Amount Variance Direction: The direction in which the amount variance is applied. The default value is Less
than the Digital Assistant.

• Days Variance: The variance in the date of expense that's used to determine whether a digital assistant expense
and a credit card charge match. The default value is 1 day.

• Wait Days for Tip Charge: The number of days a taxi trip charge waits for the corresponding taxi tip charge to
be picked for automatic submission. The default value is 5 days.
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Here is how you can add or remove a merchant:

1. In the Setup and Maintenance work area, go to the following:

◦ Offering: Financials

◦ Functional Area: Expenses

◦ Task: Manage Expense Report Auditing Lookup Types

2. On the Manage Expense Report Auditing Lookup Type page, enter ORA_EXM_MATCH_MERCHANT_NAME in
the Lookup Type field and click Search.

3. You will notice that Uber and Lyft are already mentioned in the Financials Generic Lookup Type section. You can
add more merchants as per the requirements of your organization

Manage Synonyms for Expense Types
When an employee creates an expense using a conversation, Expense Assistant predicts the expense type from the
information provided in the conversation. Expense Assistant uses the expense types defined in the setup and their
preconfigured synonyms to determine the expense type for an expense. A complete list of expense types across all
business units is stored in the Expense Assistant. However, only the expense types that applicable to business units of
a user are made available to them. You can view the list of all expense types and their synonyms in the Synonyms for
Expense Types section.

The list contains an existing set of synonyms for each expense type. To improve the conversational experience of
your employees and reduce additional questions from the Expense Assistant, you can add commonly used terms, or
synonyms, for different expense types. For example, lunch, dinner, and so on are all synonyms for meal in this context.
Similarly, when you add a new expense type, you can define synonyms for that expense type.

Here is how you can add synonyms for an expense type:

1. In the Synonyms for Expense Types section, click the expense type for which you want to add synonyms.
2. In the dialog box for the expense type, click Edit.
3. In the Synonyms text area, enter the new synonyms separated by commas.
4. Click Save.

After synonyms are added, the information has to be synchronized so that updates made to expense types and their
synonyms are available to Expense Assistant. You can use the Turn off Auto Sync option to configure synchronization
of expense items and synonyms. By default, the option is set as No, which allows automatic synchronization during the
next run of the Automatically Submit Expense Reports process.

Note:  If you haven't scheduled the Automatically Submit Expense Reports process, run this process to sync
information of expense types and their synonyms with the Expense Assistant.

Configure Expense Digest
The expense digest is a notification email delivered to the user's email. It includes an overview of all expenses and
highlights the expenses that require the user's attention, such as items with missing information, possible matches
to corporate card charges, outstanding corporate card charges, and so on. For more information, see the Configure
Expense Digest topic in the Expenses Configuration chapter.

Enable Electronic Receipts Processing
Your company can choose to allow employees to create their expenses by mailing electronic expense receipts. For
example, employees can forward electronic receipts, such as receipts from Uber and Lyft from their emails to a
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designated email. The application then uses the details in the electronic receipt to create expense items using the
settings configured for the Expense Assistant.

You use the options in the Electronic Receipt Setup section to configure processing of electronic receipts. Here are the
options available in the section:

Option Description

Enable Electronic Receipts Processing
 

Use this option to enable the processing of electronic receipts. By default, this option is set to No.
 

Forwarding Email
 

Displays the email generated by the application to which employees can forward their electronic
receipts for expense creation. To generate this email, you set the Enable Electronic Receipts
Processing option to Yes and then run the Create Expenses from Email Receipts process.
 

Custom Alias
 

Specify a custom email to which employees can forward their electronic receipts for expense creation.
Setting a custom alias is optional.
 

Here are the high-level steps to set up the custom alias:

1. Work with your IT administrator to create an email address where users can forward their electronic receipts.
You may want to create an email in your organization's domain, for example expenses@vision.com. It is
recommended not to use an existing account on the mail system.

2. Work with the IT administrator to set up server side redirect on the message transfer agent (MTA) that
handles the outbound emails. All email messages addressed to the newly created email must be routed to the
forwarding email. The employee's email address mentioned in the original email message should be preserved
when the messages are routed because that's used to identify the sender.

3. In the Electronic Receipt Setup section of the Manage Auto Submission and Matching Options page, enter the
newly created email in the Custom Alias field.

4. To verify the setup, send test electronic receipts to the custom alias and then check if receipts are processed.

Note:  When you specify the custom alias email, employees can send their electronic receipts to both the custom
email and the forwarding email for creation of expenses.

Configure Notification Email
Expense Assistant sends these notification emails to employees:

• Electronic receipt processing notifications

• Expense digest emails

You use the options in the Notification Email for Electronic Receipt and Expense Digest section to configure the email
address from which notification emails are sent to employees. These are the options available in the section:

Option Description

Default Email
 

Displays the default email from which notification emails are sent to employees. This is a read-only
field and the default value is Oracle Expenses <no-reply@oracle.com>.
 

275



Oracle Fusion Cloud Financials
Implementing Expenses

Chapter 9
Expense Assistant

Option Description

Custom Alias
 

If you don't want to send notification emails from the default email, specify a custom email from which
employees receive notification emails.
 

Note:  When you specify the custom alias email, employees receive notification emails only from the custom email.
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10  Troubleshoot

Fix Expense Account Issues  
Employees sometimes see this error in the Expenses work area:

You're missing a valid expense account for an expense item. Please remove the item to continue with the expense

report and contact your help desk. (EXM-630424)

Share this info with your help desk: In the Settings and Actions menu, use the Run Diagnostic Tests option to

search for and run the Expense Distribution Diagnostics test to review the expense account combinations.

To fix this error, you must be assigned a role to run diagnostic tests, such as the predefined Application Diagnostics
Administrator job role. You need to run the Expense Distribution Diagnostics test, review issues with the expense
account setup, and take corrective action.

Here's how to run the diagnostics test:

1. In the Settings and Actions menu, select Run Diagnostics Tests.
2. In the Search for Tests or Search for Tags panes, search for Expense Distribution Diagnostics.
3. Select the check box and click Add to Run.
4. In the Input Status column, click the check box icon to supply or edit input parameters.
5. In the Input Parameters dialog box, enter a value in the Expense Number parameter and click OK.
6. Click Run, then OK.
7. Click Refresh to display the latest status information.
8. In the row for the selected diagnostic test, click the View Test Results icon in the Report column.

This table lists the possible test results and the suggested actions:

Test Result Action

[ERROR] Assignment <ID>
(effective_start_date = <start
date>): The 1st record of
assignment has NULL set_of_
books_id
 
Or
 
[ERROR] Assignment <ID>
(effective_start_date = <start
date>): The 1st record of
assignment has NULL chart_of_
accounts_id
 
Or
 
[ERROR] Assignment <ID>
(effective_start_date = <start
date>): The 1st record of
assignment has NULL company_seq_
num
 
Or

The user is missing setup information. Run the Employment Diagnostic Auto Correct test in Report,
 Validate, and Commit modes to fix the error:
 

1. In the Settings and Actions menu, select Run Diagnostics Tests.
2. In the Search for Tests or Search for Tags panes, search for Employment Diagnostic Auto

Correct.
3. Select the check box and click Add to Run.
4. In the Input Status column, click the check box icon to supply or edit input parameters.
5. In the Input Parameters dialog box, leave person number as blank to run the diagnostic test for all

employees.
6. Enter the run mode as Report and click OK.
7. Click Run, then OK.
8. Click Refresh to display the latest status information.
9. In the row for the selected diagnostic test, click the View Test Results icon in the Report column.

10. In the displayed report, click the link following Execution ID to display the test output. The
incorrect id_flex_num should be displayed.

11. To correct the error, rerun the Employment Diagnostic Auto Correct test in Validate mode.
12. To commit the modified record, rerun the Employment Diagnostic Auto Correct test in Commit

mode.
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Test Result Action

 
[ERROR] Assignment <ID>
(effective_start_date = <start
date>): The 1st record of
assignment has NULL cost_center_
seq_num
 
Or
 
[ERROR] Assignment <ID>
(effective_start_date = <start
date>): The 1st record of
assignment has NULL natural_
account_seq_num
 

[ERROR] Not found any assignment
with expense date <expense date>
 

The expense date is outside of the employee assignment dates.
 
The expense report owner will need to update the expense date to fall within the active assignment
dates:
 

1. On the Home page, click Me > Expenses.
2. Click the card for the expense report.
3. On the Edit Expense Report page, click the date link for the expense item.
4. Edit the Date field to assign a date that falls between the employee's assignment start and end

dates.
5. Click Save and Close.

Things to keep in mind:
 

• If the employee assignment information is incorrect, the employee needs to work with HR to
update the assignment dates. For more information on updating dates in HR, see the Using
Global Human Resources guide.

[ERROR] Failed to get segments
of employee default account
identified by <code combination
id>. Skip overlaying and BSV
validation.
 

The employee's default expense account doesn't match the ledger. Update the employee's record to
reassign a default expense account:
 

1. On the Home page, click My Client Groups > Person Management.
2. On the Person Management page, search for and select the employee.
3. In the Assignment section, click Edit, then Correct.
4. Click OK.
5. In the Expenses Information section of the Assignment Details tab, update the default expense

account.
6. Click Save, then Save and Close.

[ERROR] Invalid balancing
segment <segment value> to
ledger <ledger ID>
 
Or
 
[WARNING] Unexpected exception
when calling GL API to validate
BSV. Please check BSV manually.
 

The balancing segment value for the default expense account isn't valid for the legal entity associated
with the user's business unit. Here are some ways to modify the company segment value:
 

• Correct the default expense account

Work with HR to update the employee's record to correct the default expense account:

a. On the Home page, click My Client Groups > Person Management.
b. On the Person Management page, search for and select the employee.
c. In the Assignment section, click Edit, then Correct.
d. Click OK.
e. In the Expenses Information section of the Assignment Details tab, update the default expense

account.
f. Click Save, then Save and Close.

278



Oracle Fusion Cloud Financials
Implementing Expenses

Chapter 10
Troubleshoot

Test Result Action

• Correct the company segment value

If the expense isn't imported to Payables, the expense owner can correct the company segment
value by modifying expense items:

a. On the Home page, click Me > Expenses.
b. Click the card for the expense report.
c. On the Edit Expense Report page, click the date link for the expense item.
d. Edit the Account field to provide the correct company segment value.
e. Click Save and Close.

Things to keep in mind:
 

• To modify the company segment value, the user must have full account or company segment
override privileges.

[ERROR] Failed to create/
validate account <concatenated
segments>
 
Or
 
[ERROR] concat new segment is
missing
 
Or
 
[ERROR] Not able to get CCID.
This might be due to: 1. Cross
Validation Rules 2. Segment
Security 3. Missing CCID from
the assignment of expense date
 

The new account code combination ID couldn't be validated. For example, the selected cost center
might not be compatible with the selected company. Review the error message details to correct the
invalid code combination.
 
Things to keep in mind:
 

• You can either select a valid account combination, or work with a General Ledger administrator to
update the accounting cross validation rules to allow the desired account combination.

[ERROR] Expense <ID>: Both
start_date and end_date are NULL
 

The expense report is missing dates. Update the expense report to add dates to the expense items:
 

1. On the Home page, click Me > Expenses.
2. Click the card for the expense report.
3. Select the expense items that don't have dates. Click Actions, then Edit.
4. In the Date field, enter a date for the expense item.
5. Click Save and Close.

If your issue isn't listed, contact My Oracle Support for assistance. You'll need to log an SR and attach your diagnostic
results.

Related Topics
• How Expense Item Accounting Is Derived

• Can't run diagnostic tests?
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